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1. Introduction

Welcome to Mixbus!

Welcome to Mixbus! Mixbus is an “analog-style console” that has been incorporated into a Digital Audio
Workstation. The Mixbus engine was developed at Harrison Consoles, where we have been designing high-
end digital and analog consoles for over 40 years.

Many great-sounding, influential, and legendary works were recorded and/or mixed on Harrison consoles,
including:

• Michael Jackson “Bad” and “Thriller” (the best-selling album of all time).
• AC/DC “Back in Black”
• Mike Oldfield “Tubular Bells II”
• Janet Jackson “Rhythm Nation”
• Queen “The Game”
• Sade “Diamond Life” including the hit single “Smooth Operator”
• Paul Simon “Graceland”
• Supertramp “Breakfast in America”
• many, many recordings on Manfred Eicher’s ECM Records
• ABBA – everything!
• much more by artists such as Led Zeppelin, U2, Madonna, and Frank Zappa.

Harrison continues to be a major force in the ultra-high-end professional audio community. World-class
facilities like Sony Pictures use Harrison consoles to mix top-tier films.

Harrison Consoles Mixbus - 9_en
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Image:
Harrison MPC4-D Console at
Sony Pictures
Sound Stage 6
Culver City, CA

For more information about Harrison, visit our website at http://www.harrisonconsoles.com.

Mixbus is not a tool for beginners. Although we strive to make Mixbus easy-to-use, digital audio editing and
mixing is a very complex topic. This document assumes that you are already comfortable with typical Digital
Audio Workstation (DAW) conventions. Additional online resources are available from the Mixbus “Help”
menu and at:

http://www.youtube.com/user/HarrisonConsoles
http://harrisonconsoles.com/mixbus/forum/

Harrison Consoles Mixbus - 9_en
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1.1. About Mixbus
Mixbus is a DAW (Digital Audio Workstation) created by console designers, not computer people. We
uniquely present a DAW mixer that looks and operates just like an actual console. This approach has
helped Mixbus be enthusiastically adopted by engineers of all specialties including those who worked with
or are still working with mixing consoles.

Mixbus is renowned for preserving the “Harrison sound” from our consoles in a uniquely flexible DAW
format. Superior sound plus comprehensive DAW features make Mixbus the premier choice for any project.

Harrison Consoles Mixbus - 9_en
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1.1.1. Difference between Mixbus and Mixbus
32C
Mixbus 32C is a separate product from Mixbus and is purchased and licensed separately. It is possible to
have both installed on your computer at the same time.

Mixbus 32C is the premium version of Mixbus. While it retains all of the superior features of Mixbus it adds
an important difference: the channel signal path models the analog circuitry of our classic 32 Series console
from 1975. It also adds additional mixing buses and has a more advanced channel EQ which is a model of
the EQ circuit in the original analog console.

If you already own Mixbus and you’d like to upgrade to 32C, please write us
(mixbus@harrisonconsoles.com) and we can provide you the best possible price.

Harrison Consoles Mixbus - 9_en
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1.2. About This Manual (online version and
PDF download)
The following image will help you understand a few conventions used in the online version of the Mixbus
manual. Don’t forget to use the “Feedback” feature near the bottom of each page. (Feedback is intended for
manual specific items only. If you need tech support or would like to make a feature request please email us
or visit our user forum.)

To download a PDF version of the manual for offline reading, please scroll to the bottom of
the Table of Contents and click the “Download PDF” button. On Mobile devices, the Table of
Contents is accessed from a menu in the top-left corner of the screen.
*

Harrison Consoles Mixbus - 9_en
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2. Features & Specifications

Mixer Features:
• Mixbus uses precision DSP algorithms developed by Harrison for our world-renowned large format

digital mixing consoles. Mixbus also incorporates elements from the rich history of Harrison analog
designs. Mixbus has been optimized to provide a classic Harrison sound.

• Straightforward “what you see is what you get” mixer layout based on Harrison’s renowned 32-series
and MR series music consoles.

• Unlimited stereo or mono input channels (based on available CPU power) featuring EQ, filter,
compressor, gate/expander, tape drive, mix bus sends, and mappable plug-in controls on every
channel.

• Like a hardware mixer, the DSP horsepower for EQs and compressors is preallocated. Enabling a
compressor or EQ will not increase the CPU usage of the computer.

• Dedicated stereo mix buses (can be used for groups or aux buses) featuring tone control,
compression, and tape saturation.

• Stereo Master that features tone control, compression, tape saturation, and final limiting.
• K-meter on master output helps you make dynamic, polished-sounding mixes.
• Stereo phase correlation meter indicates mono-compatibility of your mix.
• Plug-in delay compensation to support effects such as parallel compression.
• Plug-ins may be pre or post fader in the channel strip signal flow.
• VCA faders allow arbitrary grouping of fader and mute/solo between channels. Multiple VCAs may be

attached to any channel.
• Spill buttons are provided on each mixbus and VCA to show only the tracks that feed it.
• Monitor Section provides dedicated plugins, solo options and speaker-management features.
• Foldback section provides an unlimited number of cue feeds for your artist headphone mixes.
• Comprehensive metering with peak, peak hold, and compressor gain reduction visible on every track

and bus.
• The engine is internally dithered, ramped, and gain staged so that sound quality is preserved as close

to analog as possible.

Editor Features:

• Unlimited audio, MIDI, and virtual instrument tracks.
• Every track/bus has unlimited pre- and post-fader inserts, sends, and plug-ins.
• MIDI tracks with MIDI output to external devices OR virtual instruments.
• Non-destructive, non-linear editing with persistent undo.
• Comprehensive project management with Snapshots, Playlists, Templates, Mixer store/recall, and

more.
• Fast and intuitive audio editing with “smart” mouse editing modes.
• Dynamic automation of fader, pan, and plug-in parameters.
• Pitch/time stretching, transient detection, and varispeed playback.
• Object-oriented, per-region volume, dynamic volume, crossfade in/out, and mute functions.
• Standard file formats (BWF, WAV, WAV64, AIFF, CAF, MP3 & more…).

Harrison Consoles Mixbus - 9_en
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• Supports industry standard plug-in formats and I/O devices on each supported platform.
• Transport control via Level 2 MMC or MTC (master/source, or destination/chase ).
• LTC (SMPTE) and MTC chase and generation.
• Assign MIDI CC knobs to mixer controls with just 1 click.

General

• Refined workflow and graphics, including scaling and support for HiDPI (Retina) displays
• Multicore DSP processing allows more simultaneous tracks and plug-ins
• 64 bit builds provide extended memory for virtual-instrument sample libraries
• Synced video-playback window, with import and export
• Lua scripting engine allows automated workflows

System Requirements:

• Mac: 10.10 or newer, 64bit Intel, or M1, with any CoreAudio device
• Windows: Win7 or newer, 64 bit with MME or ASIO audio device
• Linux system (x86-64 gcc5) with ALSA
• Two or more processors/cores are recommended

*See our website for the latest details on OS compatibility, plug-in compatibility, and system requirements:

https://mixbus.helpscoutdocs.com/article/49-system-requirements

Harrison Consoles Mixbus - 9_en
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2.1. What’s Different About Mixbus?

“True Analog” Sound
Harrison is unique among audio companies: In 1985, we launched digitally-controlled analog consoles which
were installed at many world-class music and film mixing facilities. A few years later, digital recording and
playback became the new standard, and our customers requested a complete digital signal path in their
facilities. Harrison made a bold proposal: we would replace the existing analog processing racks with a
digital system, and leave the control surface in-place so the mix engineers could continue to work with the
same workflow and sound that had served them well. Of course, to make this practical we had to make the
digital engine “sound” exactly like the analog engine it was replacing.

During this process of replacing an analog console processor with a digital version, we made many
discoveries about how to make digital sound less like digital, and more like analog. We’ve been refining
these technologies for over 35 years since the launch of those first digital consoles. Harrison has made
several generations of analog and digital consoles since that time, and has been continuously improving our
DSP. This unique development path is what gives Mixbus a different sound than traditional workstations.

Analog-style Workflow
Most DAWs were first introduced in the stone-age days of computers. Processors were rated in megahertz
and memory was measured in kilobytes.

At that time, the standard tool was the studio console; it provided nearly every feature that was needed for
day-to-day recording, editing, and mixing tasks. With the addition of a few outboard boxes (such as reverbs,
delays, and maybe a final compressor ) it was possible to create a polished album.

When computers were introduced, they were unable to recreate the features of then-standard tools such as
a 48-track tape machine and console. Those early computer systems could only play back 4, 8 or 16
channels; and because CPU power was so desperately limited, you had to choose which of those channels
would be assigned an EQ. In this model, even the most basic console features had to be treated as
“outboard” gear. And so was born the “Plug-In” !

Fast-forward to the present, and you know that computers are fast enough to run hundreds of channels,
each with a half-dozen plug-ins. As a new-generation workstation, Mixbus takes advantage of today’s fast
computers to take the load off of the engineer, and return to the fun and creativity of mixing music.

Open Source, Open Standards, Open Community
Mixbus is largely open-source and is the collaborative effort of a worldwide team including musicians,
programmers, and professional recording engineers. Many workstations provide “open” control or plugin
protocols… Mixbus goes far beyond that. Like a good piece of vintage hardware, you can open the box and
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look inside. This transparency encourages Mixbus development to happen with integrity. We spend our time
on the issues that users want and need; not just items that look good in an advertisement. In the crazy world
of DAW software, it is nice to know that a sane option exists for your business or personal use.
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2.2. Operational Differences from Other DAWs
If you have some background in audio, but are new to computer recording, then you’ll find Mixbus very easy
to learn and navigate. If you are coming to Mixbus from another DAW, here are some of the conventions
that might seem different to you:

Console-like signal flow
Most DAWs allow the user to create tracks and buses, but the user is expected to assemble the tracks and
buses into a sensible signal flow. To do this, you create one or more buses as-needed, and then assign the
track output(s) to the bus inputs. If you later realize that you want another track assigned to that bus, you’ll
have to make that connection; and at the end of the day you might have lots of nearly-invisible and
arbitrarily-ordered connections all over the place!

Mixbus provides a fixed signal flow, modeled after an analog console. You don’t have to “choose” how many
buses you will need, or where they are assigned. This provides several benefits. The bus assignments/
sends are displayed in a fixed order, so you can quickly determine what channels are feeding the reverb
bus, for example. Additionally, the assignment and/or send-level to a bus can be automated.

Flexible signal flow in the channel makes lots of tasks easy!
Mixbus allows you to drag&drop the order of the plugins in the signal flow. This includes the channelstrip
inline EQ, compressor, and fader as separate elements. If you’d like to add a reverb “post fader” ( so the
reverb continues to ring-out when you turn down the volume of the instrument… ), you can do that directly in
the mixer strip. This saves you from creating a “bus” for adding effects to a single track.

Advanced users can right-click on a plugin and choose “pin connections” …. this opens up additional
possibilities ( depending on plugin capabilities) such as sidechaining, mono->stereo effects, mid-side, or
similar tasks. This is another way that Mixbus can save you from adding additional “aux buses”, with all of
their complexity and overhead, that is normally required in other DAWs.

Plug-ins are encouraged, but are not considered part of the
core workflow.
Most other DAWs serve as a “container for plug-ins”. They provide little or no signal processing or bussing,
by default. They expect third parties to develop the actual DSP processing.

Mixbus is different! Harrison provides our own high-quality DSP processing for the channel strip EQ and
compressor. We’ve tweaked the various EQ, compressor, saturation and limiter stages to complement each
other. You may still add plug-ins if you wish, but it is no longer necessary to purchase, and choose between,
multiple plug-ins each time you want to change your sound. You can make a great mix without any plug-ins
at all!
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Regions may be stacked in layers
Each audio “region” (or “clip”) is a discrete sound that exists on the timeline track, and it may have other
regions stacked above or below it – on the same track. Deleting the topmost region layer does not create a
hole; instead, you will see&hear the audio that was hidden underneath it. You might think of this like the
layers of an image editing program. Like an image editor, it is even possible to make regions “transparent”
so that the regions underneath it are still visible (or in this case, audible).

This provides 2 benefits. Firstly, it allows you to record an overdub, or part replacement, on top of an
existing track. You can then move, trim & fade (or even delete) the replacement part without having to worry
about the audio layer(s) underneath it. Secondly, you can use “transparency” to stack lots of sounds (such
as bird chirps) on a single track, and effect them together, without having to allocate multiple tracks so each
individual sounds is heard.

Region Fades are Crossfades
The start and end of each region has a “fade”, which gradually raises or lowers the volume. When you listen
to the region by itself on a track, you hear it fade from silence into the audio, and then back to silence. But if
the region is on top of another region, then something even more interesting happens: you will hear a
crossfade from the underlying region, into the top region, and then back to the underlying region. This
allows you to stack regions on top of one (or more!) regions underneath it, and set your crossfade to match
perfectly. Later, even if the underlying audio is changed, you’ll still preserve the fade of the topmost region.

Because digital audio streams don’t like abrupt changes in the audio stream, EVERY region has a start and
end fade. Mixbus’s default fades make it easier to edit with confidence that you won’t introduce a click.

Less emphasis on Tools, more emphasis on Actions
Most DAWs have a set of “tools” (or “mouse modes”) which modify how the mouse behaves. For example,
you select the “scissor” tool to make cuts, and the “trim” tool to trim region ends. In Mixbus, we have very
few tools. You can do most of your work using the “Grabber” (hand) tool. Point where you want to perform
the action, and then use the keyboard shortcut to initiate an action such as “S” for split, or “J” to trim a
region’s start (you can also grab the edge of the region to trim it, but the keyboard actions are faster).

For more helpful details about Mixbus’s operation, please visit: Mixbus Conventions & Tips
in the Getting Started section.*
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3. Installation
Platform-specific information

Mixbus works on 3 different desktop operating systems ( Mac, Windows, and Linux ). Each system has its
own conventions for installation. Rather than force the user to learn an unconventional installation
procedure, we have made Mixbus follow the conventions of the OS you are using.

• On Mac OSX, Mixbus is provided as an application “bundle” inside a DMG file. Just open the bundle,
and drag Mixbus to your Applications folder.

• On Windows, Mixbus is provided with a step-by-step installer that prompts you for the installation
location and then installs Mixbus.

• On Linux, Mixbus is provided as a zip file that, when unzipped, provides an installation script.

The following pages explain the details for installing Mixbus on various operating systems:

• Windows
• OS X
• Linux

When you first run Mixbus, you will be prompted to enter the license for your purchase. You can learn more
about that here: License Installation

System Requirements

Mixbus runs on nearly any desktop or laptop computer running Windows, Mac, or Linux. There is a free
“demo” version to see if Mixbus works with your setup.

Mac OS:

• MacOS version: Mac 10.10 (Yosemite) or newer
• M1 systems are natively supported with a separate installer for Mac ARM (M1, M2) computers
• Any CoreAudio-supported audio device
• Supported plugin formats: AudioUnit, VST, VST3, LV2

Windows:

• OS version: 64 Bit Windows 7 or newer.
• ASIO audio devices are preferred for high performance. But Mixbus can also use built-in soundcards

(choose the MME driver).
• Supported plugin formats: VST, VST3, LV2

Linux:

• Kernel version 2.6 or higher. An audio-based distribution such as AVLinux, UbuntuStudio, or CCRMA
is recommended.
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• ALSA or JACK-supported audio device.
• Supported plugins: VST, VST3, LV2

All platforms:

• 2+ cpu cores/processors are highly recommended.
• 2Gig or more RAM is highly recommended (or much more, if you use sample-based virtual

instruments).
• A 3-button mouse with scrollwheel is highly recommended. ( Mac touchpads and magic-mouse are

OK if you know how to right-click on them )
• A full-size keyboard with number pad is highly recommended.
• 600 MB available hard disk space (for program installation only).
• For Mixbus: A monitor with a height of 900 pixels (or more) is highly recommended.
• For Mixbus32C: A monitor with a height of 1200 pixels (or more) is highly recommended.
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3.1. Installation – Windows
Mixbus on Windows uses the Windows standard installation process. Double-click the installer to launch the
process, and follow the directions for a “Typical” installation. This will install Mixbus to the default location.

After the program installation, complete the installation process by installing your license files, see Install
the Mixbus License file

A note about “Audio Setup” on Windows:

On Windows, Mixbus will detect sound cards with a MME, WASAPI, or ASIO driver. This means that you will
likely see sound cards appear multiple times in the audio setup menus. If provided, the ASIO driver option is
preferable for stable, low-latency operation.

Many built-in desktop sound devices will not provide an “Input device” if a microphone is not physically
plugged in. If you plan to record with Mixbus, you must plug a device into the sound card’s input before you
launch the audio engine. If you would like to use Mixbus without a capture device, choose “None” for the
Input device. Mixbus does not provide a “None” option for the playback device.

When you select an ASIO device, the “Buffer size” setting will be automatically changed to the current
preferred buffer size of your ASIO device (normally set in the device’s manufacturer-supplied control panel).
It is important to use the device’s preferred buffer size. Otherwise you might incur a “buffer size adaptation”
process which reduces efficiency and may affect latency (delay) through Mixbus.

Non-ASIO devices will default to a buffer size of 1024 for stable operation. Changing this setting is possible
but is unlikely to have much effect on the performance because of the Windows sound infrastructure.

If you are upgrading from an earlier version of Mixbus, it is advisable to keep your previous
version of Mixbus installed on your computer in the event you need to revisit old sessions. It
is possible that opening a session created with a previous version of Mixbus may lose some
functionality.

!

Windows systems, and particularly laptop systems, often require some system optimizations
to operate without clicks and pops. Most importantly, you should visit the System-
>Advanced settings dialog, and tell Windows to optimize for “background tasks”. This will
dramatically improve the stability of audio I/O. For laptops, we highly encourage you to
leave your laptop plugged-in, and select the high-performance CPU mode when it is
plugged-in. There are many other optimizations (such as disabling virus-checks) that may
be beneficial. You can find some of these choices here: optimizing windows for audio
recording.

!
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A note about VST plug-ins on Windows:

After the initial installation, Mixbus will not have any knowledge about your third-party VST plugins. You
must add the path(s) to your VST plugins in the Edit->Preferences->Plug-in tab, and then initiate a “Scan”.
For more information about plugins, click here.

Continue to Download and Install the License File

Uninstalling Mixbus
You can use the uninstaller provided in “ Start Menu -> Programs -> Mixbus”, OR you can uninstall the
program from the Windows “Control Panel” menu.

Remember you can have multiple versions of Mixbus installed on your computer at the same time.
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3.2. Installation – OS X
Installing Mixbus:

To install Mixbus, download and double-click the .dmg archive to unzip it. Drag the Mixbus icon to your
Applications folder (or anywhere that you like to store your applications; Mixbus doesn’t care which folder it
is started from). If you would like Mixbus to be shown in the Dock, then you should drag Mixbus from your
selected location to the Dock.

After the program installation, complete the installation process by installing your license files, see Install
the Mixbus License file

Audio Input and Output:

Mixbus can use any CoreAudio-supported interface. Many newer soundcards work without a dedicated
driver; but some older interfaces (such as the Digi 00x series) may require a special driver from the
manufacturer before they appear in the list of CoreAudio devices.

Newer Mac computers have separately-clocked input (mic/line-in) and output (headphone/line-out) devices.
Prior versions of Mixbus required that you create an “Aggregate” device to combine the internal soundcard
input and output into a single device. Mixbus v3, and newer, provide a method to select separate input and
output devices without making an aggregate device; Mac will create an invisible “aggregate” for you. When
possible, it is always best to use a professional I/O card to avoid any internal sample-rate conversion that
may be performed by OSX.

You can combine multiple devices into an “Aggregate” device which provides all the I/O as if it were a single
device.. For example, you can “aggregate” 2 different 8-channel devices so that you can record 16 channels
into Mixbus. In a few cases, we have found that troublesome devices that don’t work well in Mixbus can be
improved by creating an “aggregate” device, selecting the device’s input and output for the aggregate. This
provides an extra level of separation from the device’s driver into Mixbus. To create an “Aggregate” device,
consult the Apple documentation for your version of OSX.

If you are upgrading from an earlier version of Mixbus it is advisable to keep your previous
version of Mixbus installed on your computer in the event you need to revisit old sessions. It
is possible that opening a session created with a previous version of Mixbus may lose some
functionality.

!

Do NOT drag Mixbus directly from the .dmg archive to the Dock; this would create a
shortcut to the Mixbus application inside the DMG file. If you do this, then when you click
Mixbus in the dock, OS X will have to extract and mount the .dmg file before launching
Mixbus. This will make Mixbus run very slowly.

!
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A note about third-party plug-ins on Mac OSX:

After the initial installation, Mixbus will not have any knowledge about your third-party AU plugins. You must
visit Edit->Preferences->Plugins to scan your AU, VST, and VS3 plugins and make them available in
Mixbus. For more information about plugins, click here.

To finish your installation, please continue to Download and Install the License File
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3.3. Installation – Linux

Some distro’s are designed for audio (such as Ubuntu Studio). A further list of distros is at: http://www.linux-
sound.org/distro.html. It is beyond the scope of this document to compare these distros.

Sound card (I/O) support:

Support for professional sound I/O is limited on Linux. However there are some excellent options available
at various price ranges. Normally, no driver or configuration is needed to use a sound card if it is supported
by your distro. It is important to choose a distro that has good pro-audio support.

Unfortunately, support must be determined on a per-device basis. The ALSA project provides a fairly
comprehensive list of USB, PCI, and built-in devices. There is a separate list of FireWire devices. When in
doubt, check with your distribution’s documentation, user forums, or support.

Downloading and Installing Mixbus:

After your purchase, you will receive a link to download the installation package. You must first unzip the
package using your desktop’s archive utility.

Once unzipped, a folder will appear with the installer (Mixbus_something.run). On most systems, you can
double-click the .run file in your file browser. If that doesn’t work, then you can launch Terminal, navigate to
the download directory, and run the installer manually by typing: ./Mixbus_(whatever).run

The installer will prompt you to uninstall previous versions. The installer will check the suitability of your
system for real time audio, and report any problems that it finds.

Continue to Download and Install the License File

A note about Linux distributions (distros): While an expert system administrator can adapt
nearly any distro for use with Mixbus, it is easier for most users to start with a distro that is
designed for use in high-performance audio.
*

If you are upgrading from an earlier version of Mixbus (v2.x or v3.x) it is advisable to keep
your previous version of Mixbus installed on your computer in the event you need to revisit
old sessions. It is possible that opening a session created with a previous version of Mixbus
may lose some functionality.

!
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3.4. License Installation – All Platforms

License Installation

At startup, Mixbus checks to see if a license is installed. If no license has been installed, you will see the
following “UNLICENSED” dialog:

The dialog provides 2 options:

Paste and Apply License
After purchasing Mixbus you will receive, both on the final page of the checkout process, and in your email,
a cryptographically signed license generated by us. This is the license that unlocks the full program. To use
this license:

1. Highlight the license text from beginning to end and then copy it.
2. Click the Paste button in the dialog.
3. Mixbus will verify the license’s signature and then allow you to apply the license to the program.
4. Click the Apply button.

This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)*
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Your license has your name encrypted in it so you should never share it with anybody!

Continue in ‘Demo Mode’
Upon pressing this, Mixbus will immediately launch your web browser and prompt you to buy a license.
However it will only do this once per program run and you can close your browser tab if you choose. Mixbus
will then continue loading in Demo Mode and allow you to use unlimited features. However, there is an
occasional, quiet “hiss” in the audio.

—

Alternative methods for licensing

After purchasing Mixbus you will receive, both on the final page of the checkout process, and in your email,
a link to download your license generated by us. This link is good for seven days after your purchase date.
Once you’ve downloaded this text file, you may keep a copy for your own use.

1. Download the license anywhere on your system.
2. Move the license file to your computer’s HOME folder.
3. Start the program.

Most licensing problems we encounter involve the user putting their license files in the wrong place. The
following should help determine the correct folder.
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Alternative locations for the Mixbus license file:

On MacOS,Mixbus searches the following locations (first found is used):

• $HOME/Library/Application Support/harrisonconsoles/
• $HOME/.
• /usr/local/share/ (intended for multi-user institution-wide licenses)

On Windows, Mixbus searches the following locations (first found is used):
You can type these in the address path bar of most modern versions of Explorer.
Simply drag your license file(s) into one of these folders.

• $HOMEDRIVE$HOMEPATH
• localappdata – typically C:\Users\NAME\AppData\Local\
• userprofile – typically C:\Users\NAME\
• allusersprofile + \harrisonconsoles\ – typically C:\ProgramData\harrisonconsoles\

The correct location for the license files is dependent on how your computer is set up. Typically in Windows
you can do the following (this works most of the time):

• open your C:\ folder
• open the USERS folder
• In the USERS folder you will see a folder with your computer’s name, or your name, or some name

that was chosen when your computer was set up.
Open this folder and drag or copy your license files into it.

Another way is to use the Window -> License Manager pulldown in Mixbus, then click on the “Open Home
Folder” button. This will open a window to the folder where Mixbus thinks your licenses should be. Drag or
copy your license files into it.

On Linux, Mixbus searches the following locations (first found is used)

• $HOME/.
• $XDG_CONFIG_HOME/harrisonconsoles/
• $HOME/.config/harrisonconsoles/
• /usr/local/share/ (intended for multi-user institution-wide licenses)
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3.5. Using Mixbus with JACK (optional)
JACK is a system service that allows for the interconnection of audio between applications. Early versions
of Mixbus required that JACK be installed on your system. Mixbus no longer requires or expects JACK to
be installed. Mixbus uses your sound card directly via ASIO (Windows), Core Audio (Mac) or ALSA (Linux
).

If you would like to interconnect the audio of different applications into Mixbus, then you can download and
install JACK for your system. JACK is not a Harrison product, and we cannot provide email support for
JACK users. However you will find a lot of JACK users on our forum, because JACK is a powerful utility.

JACK creates virtual audio and MIDI ports that can be connected and shared between nearly any
application on your system. If the application is JACK-aware ( i.e. it was compiled with the JACK libraries)
then it will have some additional features such as sample-accurate transport control and sync. There are
many third-party apps that can control JACK connections, save and restore your connections, or even route
the audio or MIDI using Ethernet. Mixbus is fully JACK-enabled, and it can save all the JACK connections
that are made to it. Mixbus can also use JACK as a sync source, or it can be the master sync source.

JACK control from within Mixbus is straightforward:

When you select JACK as the Audio System, there is only one parameter: the buffer size option. Buffer size
allows you to adjust the latency of the recording system. The 256 samples shown here is equivalent to
5.8ms, which creates less latency that having a sound source 6’ away from you (sound takes about 6.6ms to
travel 6’). You can also disconnect from JACK from this window.
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A full description of JACK timecode sync is beyond the scope of this manual. You can learn more about
JACK at JackAudio.org
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3.6. CPU Usage
Why does Mixbus require more CPU usage than my other DAW?

Because Mixbus is emulating the operation of an “analog console”, it requires significantly more CPU
resources than a typical DAW. Mixbus’s EQs, compressors, and other features are always active. The
benefit of this operation is that you can always confidently enable the channelstrip features without worry of
overloading your system. Once the mixer is running, it does not increase the load when you operate the
controls.

Although Mixbus requires a high CPU usage by default, it is actually quite efficient compared to other
DAWs, once you’ve added plugins equivalent to the high-quality EQ, compression, bussing, tape saturation,
limiting, metering, and the other built-in features of Mixbus.

How do I increase the number of tracks or plugins that I can use?

• Increase the “buffer size” in the Audio Setup dialog
• On Windows and Linux, you must take steps to optimize your system for audio ( see our Installation

section )
• Use high quality audio devices and drivers
• And of course using a faster computer, with more CPU cores, is desirable.

General comments about computer audio performance:

The CPU meter on your computer averages the cpu usage over a very long period (perhaps one second).
In digital audio, the timing is much more sensitive. When the soundcard passes us a buffer, then we have to
wake up, process the audio buffer, and return it to the soundcard before the soundcard needs to play it out.
If we don’t wake up in time, or we don’t get finished in time, then you hear a “click” caused by the dropout
(we call these xruns, short for over-run or under-run).

In the case of a 1024 buffer size, this has to be done within (1024/44100) 25ms, or about 1/40th of a
second.

This is complicated by the fact that it’s the OS’s job to “wake us up” and tell us that the soundcard has some
data for us. Some OS’s and drivers are better at this than others. But let’s say it takes 5ms before we are
even alerted that some data is available. We now have 20ms left to process the audio. If it takes us 10ms to
process the audio, then we are finished within 50% of the allotted time and that’s what we display in the
meter. This is a very accurate indication of your computer’s ability to process audio.

This also explains why the selected buffersize is so critical to the DSP load. A 256-sample buffersize is
about 6ms, so if your computer sometimes waits 5ms after receiving the soundcard interrupt before it
“wakes us up”, we only have 1ms remaining to do our work.

For more information on factors impacting the performance of your computer please see this video:
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CPU Performance vs. Real-Time Performance in Digital Audio Workstations
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4. Getting Started
Getting Started (Overview)

Mixbus is an editor that works on a document format called a Session. A session is a folder on your hard
drive that stores all of your recordings, edits, and mixer settings together. Unlike a word processor, Mixbus
does not allow you to start an empty document and then “save” it later. Instead, when you first launch
Mixbus, it will guide you through creating or selecting a session before you can start to record, import, edit
or mix your project.

A session is a collection of tracks. Use the “Add Track/Bus” dialog which can be found in the Session and
Track menus. You can also create tracks by right clicking in the gray track area under the track headers, or
by right-clicking in empty mixer-window space, or by clicking the blue “+” button in the top of the mixer
window’s left-side panel.

Alternatively, you can create new tracks by Importing existing audio from the Session-Import menu.

If you find yourself starting the same way for each session, you can create a session template which will be
available as a starting point next time you start a new session. You’ll find the list of available templates
when you create a new session. Click Session Templates to learn more.

You can save multiple snapshots of your settings inside that session. Snapshots conveniently save your
entire editing/mixing session for later recall. Saving a snapshot is instantaneous and takes up essentially no
extra disk space (snapshots all share the same audio data in the session folder). Click Snapshots to learn
more.

If you make a mistake while recording or editing, you can click “Undo” to revert your changes. Only a few
editing operations (such as adding or removing a track) cannot be undone. One of the cool features of
Mixbus is the fact that your “Undo” history for each session snapshot is stored when you save the session;
This means that you can return to a session after a few days, and still undo the last changes you made, if
you decide that they weren’t a good idea.

When you are finished, you can Export your session to an audio file using the Session->Export menu item.
The exported file can be shared online or burned to a CD.

Need Help?

Getting started with a new DAW can be a challenging task. While Mixbus shares conventions with many

Mixbus uses the right mouse button for many features. Try right-clicking on tracks,
regions, mute buttons, solo buttons, group panes, regions, selected ranges, markers, mixer
redirects, clocks, the region list, and the marker bar area. Each will launch a context menu
that provides many features.

*
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other popular DAWs, it can still be a little difficult at the beginning. Rest assured that it is worth your time
and effort to learn Mixbus. For technical issues, bug reports, and feature requests, email support is available
from Harrison Consoles: mixbus@harrisonconsoles.com.

If you’d like to interact with other users of Mixbus, you can visit our forum:

http://harrisonconsoles.com/mixbus/forum/

“Once you have reached the level of a Harrison Console, you are ready for new flights of
engineering imagination. Unlimited. Unhaltered. Uninhibited by the bounds of technical
obstructions. YOU BECOME THE STUDIO. You are the living extension of the electronic link
between the perfect sound and the perfect master. You are the ultimate conductor in the universe
of recorded music” – Harrison 4032 brochure, circa 1975
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4.1. Mixbus Conventions & Tips

General Conventions
Over 40 years, Harrison developed a methodology for our user interfaces. We aim to make the easy things
very easy, while keeping the hard things possible. If you are going to access a feature hundreds of times
each day (like: boost the bass, or start playback), then we assign it a very prominent space. If you use a
feature only a few times a day, then we make it slightly less prominent: for example you might have to right-
click to access it. And if it’s a feature that you only access once per week or once a year, then you might
have to open a preferences dialog, or even edit a text file somewhere.

The following tips will help you navigate Mixbus fluidly. These tips generally apply throughout Mixbus and
may not be documented in the individual sections where they apply. New users should learn these
conventions quickly, in order to avoid developing “bad habits” that impede fast operation.

Menus and keyboard actions:

Mixbus follows your OS’s convention for the main menu. On Mac OSX, the main menu will appear at the top
of your monitor. On Windows, the main menu will appear on the top of the main window.

Every menu item can have a keyboard shortcut assigned to it; you will see the assigned keyboard shortcut
next to each menu item, if one is assigned. You can change the keyboard shortcuts, but if you are a new
user we suggest that you learn the existing shortcuts before making changes. The existing shorcuts have
been painstakingly developed to be easily learned, be ergonomic, and provide access to the most-used
features of Mixbus. One exception to this rule: if you are using a non-US, QWERY keyboard, then you might
find the need to remap some actions for your keyboard layout.

Keyboard shortcuts are MUCH faster than accessing the menu item; so if you find yourself using a menu
item frequently, you might consider memorizing the action.

Selections:

• A Mixbus “selection” can be one of:
◦ One or more Tracks ( or their equivalent Mixer Strips, in the mixer )

▪ Optionally in addition to the track selection, there can be a “time” selection on those
tracks.

◦ One or more Objects on the timeline ( Regions and/or Automation Control Points )
◦ One or more MIDI notes inside a MIDI region

Advanced Users: In addition to this information, advanced users might want to visit
Operational Differences and Power User Topics. If you are experienced with several other
DAWs and audio engineering conventions, these 3 pages will likely provide you with
everything you need to master Mixbus in just a few hours.

*
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◦ One or more plugins in a mixer strip

However, these selections are mutually exclusive: you can select several tracks, but you can’t select a
track and a region. This avoids some common causes of confusion. For example, if you have selected a
region in the editor, and a plugin in the mixer, then what should happen when you press “Delete”? Mixbus
prevents you from selecting unlike items to avoid this possibility. The selection might change when you
select tools. For example if you have a Range selection with the range tool, and then you switch to the
“Object” tool, the range selection will disappear. ( in the very rare case when you didn’t want this, there is an
“undo selection change” in the Edit menu )

In almost every case, a selection will be identified with a “red border” around the selected items. And in
most cases the items will change to a red color to indicate selection.

Mouse wheel:

Mixbus uses the mouse-wheel ( or 2-finger drag, on a touchpad ) extensively. Here are just a few of the
things you can do with the mouse wheel:

• Zooming the editor canvas timeline by mouse-wheeling in the ruler-bar, or anywhere by holding Ctrl. (
“Cmd” on a Mac ).

• Adjusting knob and fader values.
• Adjust the metronome volume, by mouse-wheeling on the metronome button.
• Nudge the playhead forward & backwards in the Mini-Timeline.
• Advancing a clock value (such as bars) by mouse-wheeling over the appropriate number in the clock.

Right-click:

Mixbus uses the right mouse button extensively. Nearly every item has a context menu that can be
accessed with a right-click. Try right-clicking on tracks, regions, mute buttons, solo buttons, group panes,
regions, selected ranges, markers, mixer redirects, clocks, the region list, and the marker bar area.

Right-click actions are those items that aren’t necessary to see hundreds of times a day, but perhaps
dozens of times in a day. So for example the Solo button is activated with a click; but if you want to “isolate”
the solo (so the channel always plays even if other channels are solo’ed), then the Solo Isolate function is
accessed from the right-click menu on the Solo button.

The ESC (Escape) key will clear the current selection, so there will be no selected tracks,
regions, notes, or automation control points.*

macOS users: make sure to enable the “secondary click” functionality of your touchpad, in
System Preferences, so you can access the right-click functions. Cmd+Click is NOT a right-
click!

!
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Shift+Right-click: (Delete shortcut)

Shift+Right-click is a shortcut to Delete objects. Some examples include regions, plugins, and automation
control points. Holding shift while right-clicking on one of those objects will delete it.

Shift+click on mixer controls: (Group Override shortcut)

When two or more channels are in a “group”, and the group has “gain” enabled, many mixer functions will
function together. For example: if you drag a fader, then the grouped channels will all move together. But if
you hold Shift when you click the fader, then only the clicked fader will move; not the grouped channels.
This is called a group override. This also applies to “momentary” mutes and solos as described below.

Shift+Ctrl-click: (applies to ALL tracks)

Holding Shift and Ctrl (Shift+Cmd for Mac users) while clicking on a track button will apply that operation to
“all” tracks. Some examples include the Mute, Solo, and Record-arm buttons. Clicking on those buttons with
Shift+Ctrl held will apply your click to ALL tracks. This is a fast way to un-solo all tracks, or to rec-arm all the
tracks in a session simultaneously. Other functions also respond to Shift+Ctrl+Click: for example if you hold
these keys while selecting the “meter point” for a channel, the menu selection will apply to all channels.

Middle-click: (non-latching mute/solo)

Clicking a Mute or Solo button with the middle mouse button will trigger a “non-latching” button push; this
means that when you release the mouse button, the solo/mute button will also release. This provides a
quick way to temporarily mute or solo a track while you hold the mouse down.

Mixer Knobs and Faders:

• When a knob is in the “default” position, the indicator is very dim. This allows you to scan the mixer
for settings that are not at default.

• Mixer strip knobs can be double-clicked to instantly return them to their default value.
• Holding Ctrl/Cmd while turning the knob provides a fine-adjust mode, while Shift+Ctrl/Cmd allows

super fine adjustments.
• Hold Shift to override any actions that might be grouped; ( see Group Override, above )
• Mixbus knobs and sliders incorporate an “in-on-change” feature. When any knob or fader is clicked

and changed, it will automatically enable the control by also setting the “in” or “on” control for that
section.

Floating-Point processing:

Mixbus uses a floating-point internal architecture, it is possible to exceed 0 dBFS (decibel full scale i.e: the
loudest sound in the digital domain) on the channel and mix bus strip meters without ill effects. For this
reason there is no colored indication of overly-loud signals on input and mix bus strips.
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Master Bus Volume:

The master bus is not a “volume” knob for your speakers. The master fader level is applied to the exported
file; so if you turn it down to make your speakers quieter, you will likely make a very quiet mix, on export.

If you are not using the monitoring section built into Mixbus (Session>Properties>Monitoring tab) you will
use the volume knob provided by your computer or I/O device to control the loudness of your speakers. If
you are using the fader of the Master strip to control speaker volume, remember to set the fader to the
correct level before you export your project to a .wav file. Use the K-14 meter to verify that the export
volume is at a reasonable level.

“If you asked a hundred engineers, mixers and producers to define the “perfect console” you would
probably get a hundred answers. The answers, however, would all contain the same salient points.
The “perfect console” would have totally transparent sound, capturing the true musical quality of all
performances. It would have unlimited features, facilities, and functions. It would perform all required
tasks with a minimum of operator effort. It would be totally reliable and require no preventive or corrective
maintenance…
You can spend the rest of your life looking for the “perfect console”. You’ll never find it. You will find,
however, that we have what you need.”- Harrison MR20 brochure, circa 1982
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4.2. First Time Configuration
First Time Configuration Dialog boxes:

The first time you launch Mixbus on your machine, Mixbus will prompt you for a few basic setup options.
You can change these preferences later.

A welcome message will appear. Click the“Forward” button to continue
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An option to change the default session folder is given. If you have a preferred hard drive you would like to
use, the dropdown box will allow you to browse to it. Choosing a drive other than the one that your OS or
the Mixbus application resides on may increase performance (this is dependent on your computer
configuration).

Some soundcards provide a low-latency mixer interface which can be used to monitor yourself while you are
recording. If you want to use your interface to monitor yourself, choose “Use an external mixer or the
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hardware mixer of your audio interface”. Otherwise choose “Ask Mixbus to play back material as it is being
recorded”. You can find more information about monitoring, click here

The monitoring section provides an additional volume control between your master mix, and your
soundcard. You will want to enable this option if your interface doesn’t provide a monitor level knob. It also
provides some additional solo-ing features. For more on the monitoring section click here
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4.3. Starting a Session

What is a Session?
A “session” is the document type that Mixbus opens and edits. When a new project is started Mixbus will
create a session folder where it stores all information regarding that particular project. When a session is
saved and later opened, Mixbus will reload the saved settings and information so that all work previously
done is restored.

By default, a session has one snapshot file inside it. This snapshot is automatically generated for you, when
you create the session. The first snapshot will share the same name as the session folder.

A session folder can contain multiple snapshot files. For example, you might create a Session to record your
band’s live performance. And then you can save individual snapshots, each with their own track edits, mixer
settings, and locate-points that are specific to one song in the recording. But the audio data is all stored in
the session folder and is not required to be duplicated for each snapshot in the session.

Harrison Consoles Mixbus - 9_en

Page 45 of 848



Session setup:

3 options are given in the session setup window:

1. Open a Recent session list will be blank for first time users). The black window with in the dialog box
displays a list of a saved session’s name, sample rate, and bit depth. (The picture is from Mixbus32C, but is
the same for Mixbus).

2. “Click to create a New session”: When creating a new session a dialog box will allow you to name the
session, choose a location, and choose a Template to use for the new session.

3. “Click to open an Existing session”: If a previously created session does not show up in the session
window, for example if previous sessions have been stored in a different location from other sessions, you
can use the browser function to the left to locate and open an existing session.
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4.3.1. Opening a Recent Session
The most common way to open a session is to select it from the list of recently opened sessions. By default,
Mixbus will remember the last 10 sessions that you opened.

The black window with in the dialog box displays a list of a saved session’s name, sample rate, and bit
depth. (The picture is from Mixbus32C, but is the same for Mixbus).

If more than one snapshot is available in the session, an arrow next to that session will appear. Notice the
arrows next to the sessions “BCRK140718_raw” and “BCUP110419_1 but no arrow next to “WB230416”.
Clicking on the arrow will show all snapshots available in this session, as displayed for “BCRK140718_raw”.
In this case the engineer chose to name snapshots with their song names, “easycome” and “milkyway”.

You can click on a column header to sort the session list by date or by name. Click again to reverse the sort
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order ( oldest to newest, or newest to oldest ).

You can right-click on a session to remove it from the recent sessions list (note that this does NOT delete it
from your disk drive)

If you hover the mouse over a session, it will report the full path to the session folder on
your system.*

Harrison Consoles Mixbus - 9_en

Page 48 of 848



4.3.2. Opening an Existing Session

Opening an Existing Session on Disk

Navigate your computer’s file system to locate the desired session snapshot file.

When navigating to a session, you’ll actually choose one of the session ‘snapshot’ files to
open. This means you have to navigate fully into the desired session folder, you can’t just
choose the session folder itself.
*
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4.3.3. Creating a New Session

Template selection:

Click on a template (on the left side), and a description of the template will appear on the right side of the
dialog.

Session Location:

“Create Session Folder In”: click this button to choose a different location for your session. For example you
might choose to store a band’s recording on a dedicated external hard drive.

You can change the default session location when Mixbus is first launched on your*
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Naming a Session:

When creating a new session a dialog box will allow you to name the session, choose a location, and
choose a Template to use for the new session.

By default, a date-stamped temporary session name is created for you. In this case, you will be prompted
whether to keep the session, or discard it, when you close Mixbus. This is a convenience for those times
when you are making a temporary session but you don’t want to commit to keeping it. Note that the
temporary session and all its data does already exist on disk and is preserved (within some limits) even if
there is a power-outage. But you will be prompted to either name & save it, or delete it, when you close the
session.

If you enter a custom name, then Mixbus will store the session on disk and it is not necessary to rename it
later.

computer, or you can later change it in Preferences->General.

A session’s sample rate is determined when it is created. You cannot change the session’s
rate after it is created. If you plan to target CD as your primary deliverable, you should
choose 44.1 kHz. For most projects, Harrison recommends 48 kHz for today’s internet- and
video- centric world.

!
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4.4. Session File Management

Session Folders
Every session is stored on your disk as a folder. A session folder contains everything pertinent to the
session: Audio files (or links to them), snapshot files, the waveform display cache, your exported mixes
(unless the default location has been changed) and many other things. Deleting a session’s folder will
completely remove the session and all of its recorded audio (if any).

In the main menu “Session”, you will find several options to open a new session; or close, save and copy
the currently open session.

New: Calls up the Session Setup dialog and allows a new session to be created. This will save and close
any currently open session.

Open: Allows the user to open an already saved session. A navigation dialog will appear so that you can
locate your session.

Recent: Contains a list of recently opened session that can be opened.

Close: Exits the current session. If any changes have been made to the session a dialog box will present a
save option.

Save: Saves the current session

Save As: Saves the entire current session’s folder with a new name and/or new location

• Switch to newly-saved version: Closes the session you are currently working with and opens the new
session.

• Copy media to new session: All files within the interchange folder (audiofiles, midifiles, and videofiles)
will be copied to the new session/interchange folder. If this option is not checked Mixbus will refer
back to the previously named session’s interchange folder.

• Copy external media into new session: Same as above but also moves any files that may be located
in other directories or hard drives. See topic clean-up, sub topic real world example for similar
functionality and why you may need it.

Rename: Renames the current session’s folder

If you move the session folder to another location, Mixbus will no longer be able to find it,
and it won’t show your session in the “Recently Opened” list. But you can navigate to the
session folder and open one of the snapshots to re-add it to your history.
*
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Snapshot (& keep working on current version) …: Makes a copy of the opened session snapshot in its
current state for later recall. ( See: Session Snapshots )

Snapshot (& switch to new version) …: Saves a copy of the opened session snapshot in its current state
with a new name and/or location. ( See: Session Snapshots )

Save Template: Session templates are a fast way of recalling common session “layouts” such as hardware
connections, plug-ins, and number of tracks. If you find your current session is a common one, you can save
the it as a template (no audio will be saved).
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4.4.1. Session Snapshots

What is a session snapshot?
A “snapshot” is a file that stores the current session settings including the track layouts, audio & midi
regions, markers, tempos, faders, EQs, and plugins. Snapshots all share the same audio data in the session
folder.

Snapshot files require very little disk space, so you can store snapshots for multiple mixes or edit sessions
without worry.

Snapshots are a great way to keep a backup history of your session’s settings. You can save snapshots
while you work, and then return to a snapshot for futher editing, later.

Snapshots are also very useful in sessions that have more than one song on the timeline. After making
basic mix and edit decisions on the main timeline, you can create a snapshot for each song, and this allows
each song to have its own edits, mixer settings, plugins, automation, export settings, etc etc.

Creating snapshots:

Snapshots are created from the main menu (and associated shortcuts): see Session Menu for more details.

Selecting a snapshot:

Snapshots are accessed via one of these methods:

1. In the New Session dialog, you can click a triangle next to your session to display the list of snapshots
in the session.

2. In the editor sidebar, you can select from a list of this session’s snapshots.

Each snapshot has its own persistent undo history. If you open an old snapshot and click
UNDO, you will undo the last editing operation that was applied to that snapshot.*
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Choosing a snapshots from the New Session Dialog:

When a session includes multiple snapshots, a small triangle will appear to the left of the session’s name.
Double-clicking a snapshot will open that snapshot directly.

The bundled demo session “Mixbus_Test_Session” provides some snapshots for you to choose between.
Note that the snapshots can be drastically different, with completely different Cues, Tracks, Mixer and plugin
settings.

Harrison Consoles Mixbus - 9_en

Page 55 of 848



Selecting a snapshot from the Editor List:

In the Editor List, select the Snapshot tab on the right side. Double-click a snapshot to select the snapshot.

The current snapshot is highlighted, to show which snapshot file you are currently editing. (this is the file
that gets overwritten when you choose “Save” from the main menu)

Backup Snapshots

By default, Mixbus automatically overwrites a backup snapshot every few minutes. The backup snapshot
changes its name every hour. So there is a backup snapshot stored for every hour that you have worked on
a session; in addition to the most-recent backup file.

To recover from a snapshot in the backup folder, you must first drag it up one level into the main session’s
folder. Then you can open it normally. If you try to open it from within the backup subfolder, it won’t find the
audio files.

Here are the steps to recover a backup snapshot from the backup folder:

1. Quit Mixbus
2. Open the session folder and find the “backup” subfolder.
3. Choose the last-created snapshot file ( the file ending in .ardour )
4. Copy the file up to the main session folder
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5. Launch Mixbus
6. In the “recent sessions” list, you should see a triangle next to your session; click the triangle and

choose the backup snapshot.
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4.4.2. Session Archive
Using the “Archive” utiliity, you can create an “Archive” of a session snapshot which automatically
compresses the snapshot, the audio+midi files, and other necessary files into a single compressed file.

• Archive Name: the name of the resulting archive file.
• Target directory/folder: the location of the resulting archive file
• Audio Compression: Choose FLAC to reduce the size of the audio files using lossless compression.

The FLAC format preserves the exact digital values of the audio .wav file, but takes about half the
space This requires additional time for the archive process, but results in a smaller archive file.
Choose 24bit for full-quality archive, or 16bit for slightly lesser quality, and significant disk-space
savings.

• Exclude unused audio sources: if this is enabled, then the archive will not include any audio or midi
files that aren’t currently in use by the snapshot.

note that the session archive only stores the snapshot and source files for the currently-
open snapshot file. This is a convenience when delivering a single song to a publisher or
collaborator, and they don’t need the full session folder. The full session folder and all its
contents should be part of your regular disk backup routine. Always back up your important
data!

!

Harrison Consoles Mixbus - 9_en

Page 58 of 848



4.4.3. Session Templates

What is a Session Template?
Once you’ve created a session and set up your track routing, plug-ins, etc, you may want to reuse that setup
for a future project. A template contains everything except the actual audio and midi data: track layouts,
plug-ins, and your channelstrip EQ/Compressor/Bussing setup.

Any session can be stored as a session “template” for future sessions.

Using Session templates:
To save a template, choose Session->Save Template from the main menu, and name the template
something meaningful so you can find it in the future.

To use a template, you have to create a NEW session. In the New Session dialog, there is a list of your
templates, in addition to the factory-supplied templates.

Managing & Sharing session templates:
Session templates can be later renamed, edited, or shared using the Template Manager: see Templates

Where are my templates stored on disk?
Templates are stored in the user config area, under a folder called “templates”. You can find more details
about the user’s config folder in Power-User Topics.

Some plugins can store additional data that won’t fit in the session file. For example, a
convolution reverb might include the user-selected impulse response files. For that purpose,
there is also a “plug-ins” folder inside the template folder which stores this additional
information.

*
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4.5. Audio Midi Setup Dialog

Audio MIDI Setup

The Audio Midi Setup dialog appears automatically when you create a “New” session. This step allows
you to choose the session’s sample rate, as well as the soundcard settings and other details.

You can also launch the Audio Midi Setup dialog from the main menu, under “Window”.

Start/Stop

As seen in the figure there is an indicator showing “STOPPED” in red while you are setting up these
parameters. When you are done with the settings, press the “START” button to connect to the selected
audio device.

The sample rate that is selected during the initial session setup cannot be changed later.
However you can later change the soundcard setup, buffersizes, and other I/O details.*

It is sometimes useful to click the “Stop” button while you have a session open. This will
disconnect Mixbus from the audio device, and therefore use no cpu power. The audio
device must be re-started if you want to save your session.
*
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Audio System:

The “Audio System” selection tells Mixbus which way you will connect to your devices.

• To use your audio devices on Mac OS X, select “Core Audio” (this option is only available on Mac).
• To use your audio devices on Windows, select “PortAudio” (this option is only available on

Windows).
• To use your audio devices on Linux, select “ALSA” (these options are only available on Linux).
• “JACK” uses the JACK server to talk with your sound card and other software on your system. It is

only available if you have already installed JACK on your system. If the JACK server is already
running, then Mixbus will connect to the JACK server. If not, then Mixbus will start the JACK server for
you (the JACK option is available on Mac, Windows and Linux). You can learn more about JACK here.

Driver (Windows-Only)

This menu specifies the driver software protocol for the selected input and output devices detected. the
choices for Driver are:

• ASIO (preferred): Dedicated audio devices (usually connected with USB or similar) should be
provided with an ASIO driver by their manufacturer. ASIO provides multiple channels of high quality
sound, at low latency.

• MME: use MME for built-in devices or other soundcards that do not have an ASIO driver. MME
devices are limited to 2 channels of input and output, and incur additional latency (delay) of the audio
signal.

Input Device & Output Device:

• Select your preferred audio interface from the pulldown list. For best results, you should use Mixbus
with a high-quality audio interface.

• Some combinations of input & output devices will not work. Normally, you should choose the same or
similarly-named device for both input and output.

Sample rate:

• A drop down list with supported sample rates by your selected audio interface will be displayed with a
maximum of 192k.

Buffer size:

In conjunction with sample rate, buffer size is used to control latency and to manage hardware resources.
See more here.
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Hardware monitoring:

• Mixbus does monitoring: when this is selected, Mixbus will sometimes (depending on settings) allow
you to hear your input signal through the mixer. However, this incurs a latency (delay) caused by the
soundcard buffering, plugins, operating system overhead, and other potential sources of delay.

• Hardware does monitoring: when this is selected, Mixbus expects you to monitor yourself through
your soundcard’s audio device or built-in mixer. This avoids the latency caused by entering and
leaving the computer’s operating system.

You can learn more about track monitoring, and the settings that drive it, here

Device Control Panel:

This opens the control panel of the audio interface that has been selected on the “Device” list, when one is
provided.

Autostart

When enabled, Mixbus will skip the “Audio Setup” dialog, whenever possible (for example: when opening an
existing session, and the last-selected audio device is capable of the session’s sample rate).

When creating a New session, the Audio Setup dialog will always appear so you can select a sample-rate
for the session.

Refresh Devices

This re-scans your audio hardware to provide all the available devices in the Input/Output device menus.

Use Buffered I/O (Windows-only)

The “Buffered I/O” button tells Mixbus to use an older ASIO protocol which works better on some devices,
including Roland “Capture” devices. If you have trouble launching the audio system, and/or you are unable
to set the buffersize and sample rate, you might try enabling “Use Buffered I/O”

prior to v8.1, this control was provided in Preferences. It is now provided on the Audio MIDI
Setup dialog because it is common to change your monitoring needs when you select a
different sound card.
*
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Advanced Settings

MIDI System

This selection will default to the MIDI framework supported by your OS. You can select “None” if you think
the MIDI system is unneeded, or is delaying startup.

Setup & Calibration

This button will call up a dialog that lists your MIDI devices and allows you to assign a delay (latency) for the
device. The latency will be accommodated by entering notes ‘earlier’ on the timeline, after they are
recorded.

Hardware input * output latency:

When audio is routed from outboard equipment and back to Mixbus it must undergo a conversion from
analog to digital (ADC), the time it takes for this conversion can be entered to compensate for latency so
that all audio remains time aligned (This process can be automated, see “Calibrate Audio” below).

Most users will find that it is unnecessary to calibrate the input & output latency. The
converter latency is very small when compared to the delay incurred by the computer buffer-
size. Furthermore, small system changes (such as unplugging and re-plugging a USB
*
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Calibrate Audio:

This calls up a latency measurement tool with step-by-step instructions to compensate latency introduced by
external equipment and the digital to analog, and analog to digital conversion process.

device) can cause this value to change.
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4.5.1. Latency and Buffer Size

How do I choose a buffer size? And how does computer
audio (really) work?
Although Desktop computers are blindingly fast inside, they are optimized to interface with the world at
“human speed”… a user sends dozens of keyboard commands every second, at best; and the screen is
updated perhaps 30-50 times per second. But audio events ( or more accurately, “samples” ) typically occur
44,100 times per second, or more! Computers are not intended to be ‘interrupted’ by the outside world this
often; and if you did, it would severely compromise the amount of work that the computer can attend to.

When a computer soundcard ( whether internal, USB, Thunderbolt, or something else ) gathers audio data
from the Analog-to-Digital converters, it can’t “wake up” the computer CPU 44,100 times per second. So it
has to gather (or: “buffer”) the audio for a while, and then pass this larger buffer to the computer for
processing. This buffer size can be changed by the user to balance the system’s stability and power, versus
latency and responsiveness.

If you choose too low a buffer size, you will likely encounter ‘clicks’ when your system gets busy. If you
choose too high a buffersize, then you might hear a delay through the system, or notice that the computer is
not very responsive to you.

This video by Richard Ames provides an overview of your computer’s audio system, and why the buffer size
is such an important factor in your computer’s performance.

Latency

“Latency” is the amount of time it takes for digital audio to pass from the computer’s input to output. The
buffer size has a direct effect on latency: Larger buffer sizes will incur a longer latency. In many cases,
latency doesn’t matter much. If you just need to play your tracks for mixing, then a fairly large buffersize will
provide the best system stability.

Due to the nature of computers and digital audio, there will always be some latency in a DAW. Even if the
soundcard operated with no buffer ( a buffersize of “1” ) then the process of converting Analog to Digital,
and then back to Analog, will incur about 2-3 milliseconds.

If audio arrives at the output later than desired then it is considered to have high latency. If the latency is
minimal, we may not be able to perceive it. Low latency is desirable for recording, tracking, overdubbing,
etc. But there is a lot of debate about how much latency is too much. And it varies depending on the
situation and the performers.

Buffer

A buffer is an area in the sound-card’s memory that is set aside to temporarily store digital audio. By
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temporarily storing digital audio we can prevent any interruption in the flow of sound. Interruptions will be
heard as clicks and pops. We can set the size of the buffer to achieve a specific delay, usually measured in
milliseconds. The memory stores samples of audio, and the more samples that are “buffered”, the more
latency will be exhibited. Hence, the size of the buffer also determines the latency. Setting the buffer too
small can cause buffer underruns with audible pops and clicks. Setting the buffer too large might cause a
noticeable delay in the sound or operation.

In digital audio, buffer sizes are almost always defined in blocks of powers-of-2. Your soundcard driver will
define the available buffer sizes for you to choose. The most commonly available values are: 64, 128, 256,
512, 1024, and 2048.

Generally speaking, a buffer of 1024 is a good balance of stability and responsiveness when you are mixing.
That’s the default value that we choose for Mixbus. But if you are recording yourself and you want to play
through the computer, you might choose a smaller buffersize. Just be aware that you might cause pops &
clicks in your recording if you exceed the capabilities of your system.

Sample Rate Vs. Buffer size

If you choose to run at 96 or another high rate, you’ll notice 2 things:

1. Your soundcard’s buffer now “fills up” faster, and it wakes the computer more often.
2. Your computer is now processing twice as many samples, and therefore working harder.

For those 2 reasons, you will likely need to increase the buffersize when you use higher sample rates, to
maintain the same performance.

If you want to absolutely minimize the latency through Mixbus, you could choose the lowest possible latency
and the highest possible rate. This will minimize the latency from input to output. But it will likely exceed
your computer’s capabilities very quickly, and you might get clicks&pops in your recording.

Buffer size while mixing or editing

While mixing or editing, a large buffer will prevent pops and clicks at the expense of a slightly less
responsive system. This lack of responsiveness may be evident when pressing the play button and a slight
delay occurs before audio can be heard. Many times this delay is so small you may barely notice it. So while
mixing or editing, a larger buffer is advisable. A buffersize of 1024 samples is typical.

Buffer size while recording

If monitoring through a DAW and an artist needs to listen to themselves while recording ( such as a vocalist
listening to a headphone mix ) then low latency audio will be required. Adjust the buffer size to achieve a
latency of 10 ms or so. A value of 128 samples is typical. Furthermore it is important to avoid using plugins
that cause additional latency.

Our friends over at Sound on Sound have some great information on this topic
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http://www.soundonsound.com/sos/jan05/articles/pcmusician.htm

Hardware Vs. Software Monitoring

If you plan to record with Mixbus, one of the most important options is the Monitoring mode.

If you choose “Mixbus does monitoring” then:

1. Mixbus can control which channels you are hearing (subject to the Monitoring rules … see section
“Monitoring” ). So, for example, Mixbus will only “monitor” the inputs that are currently record-armed.

2. The inputs will automatically be mixed into the master output of Mixbus, so you can hear them in
context with your mix.

3. You will be able to hear any effects (eq, compression, and/or plug-ins) that are applied to the tracks.
4. HOWEVER: the signal path through your converters, Mixbus, and plug-ins can add up to a significant

latency. The latency can be minimized by using a small buffer size, and avoiding the use of plug-ins
with long latency

If you choose “Hardware does monitoring” then:

1. You will not incur the latency penalty of getting into and out-of the computer. However if your interface
or mixer uses digital signal processing, there may still be some latency.

2. You must use your external I/O controls, and/or mixing console, to build monitor mixes for your talent.
3. Mixbus cannot control which channels you are hearing. Record-arming a track in Mixbus will not

automatically route that track into the monitor mix.

Some artists may be more sensitive to latency than others. If the artist is not performing as
expected, one thing to check is latency; even if the artist does not perceive or complain of
latency. In some anecdotal cases, singers have been bothered by the “comb filter”
(frequency cancellations) caused by a very short delay between their headphones and
internal vocal cavities. In this case you can try decreasing the latency to see if that helps.
(sometimes increasing it will also help). If the singer finds this objectionable then you should
consider a all-analog, hardware-monitoring setup instead.

*

On Windows, using ASIO drivers, you must sometimes choose the buffer size from the
device’s control panel. In a few cases, Mixbus does not have control over ASIO buffer sizes.

!
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4.6. Status Bar
The status bar provides information about Mixbus’s status including current settings and realtime
performance indicators. Right-click on the status bar to enable or disable the available displays:

The status bar provides the following information, indicators are abbreviated compared to the selector
menu:

• Path to Session (Path): Shows the directory path of the session

• Snapshot Name and Modified Indicator (Name): Shows the session name. An asterisk ahead of the
name indicates that some properties in the session have been changed since opening.

• Active Peak-file Work: This selection box turns off and on an indication that Mixbus is very busy
calculating peak signal information, which might impact its responsiveness or performance. Like the
XRun indicator (described below) it is normally invisible and only displays when this condition actually
occurs. Enabling this indicator is intended for users (or developers) who suspect that such activity is
bogging down Mixbus processing.

• File Format (File): Audio file format setting (from Session->Properties->Media)

• Timecode Format (TC): Time code format (from Session->Properties->Timecode)

• Audio (Audio): Sample rate / Buffer latency (from Window->Audio/MIDI Settings)

• Disk Space (Rec): Estimated remaining recording time, given the current settings and number of
record-armed tracks.

• DSP (DSP): Time required to process an audio block / duration of the audio block, compared to the
available buffersize timing. This displays the worst-case maximum (not average).

• Wall Clock: Displays the current time of day.
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Not normally displayed on the menu tab:

• (X): Number of XRuns : an XRun ( under -run or over -run ) is caused when Mixbus cannot keep up
with your soundcard. ( see below ). NOTE that this indicator only displays when an XRun actually
occurs.

Of these reports, the Xrun counter is the most important. If the xrun counter is increasing while you are
recording or playing, it means that you have exceeded the capabilities of your system, and you are likely
hearing clicks and pops.

The typical methods to minimize the CPU load are:

• increase the “buffer size” in the Audio Setup dialog
• optimize your system for audio performance; such as choosing “optimize for background tasks” in

Windows.
• use a lower sample rate, reduce the number of tracks
• reduce the number of plugins in your session.
• And of course using a faster computer, with more CPU cores, is desirable.

The CPU meter on your computer averages the cpu usage over a very long period (perhaps one second).
In digital audio, the timing is much more sensitive. When the soundcard passes us a buffer, then we have to
wake up, process the audio buffer, and return it to the soundcard before the soundcard needs to play it out.
If we don’t wake up in time, or we don’t get finished in time, then you hear a “click” caused by the (we call
these xruns, short for over-run or under-run).

In the case of a 1024 buffer size, this has to be done within (1024/44100) 25ms, or about 1/40th of a
second.

This is complicated by the fact that it’s the OS’s job to “wake us up” and tell us that the soundcard has some
data for us. Some OS’s and drivers are better at this than others. But let’s say it takes 5ms before we are
even alerted that some data is available. We now have 20ms left to process the audio. If it takes us 10ms to
process the audio, then we are finished within 50% of the allotted time and that’s what we display in the
meter. This is a very accurate indication of your computer’s ability to process audio.

This also explains why the selected buffersize is so critical to the DSP load. A 256-sample buffersize is
about 6ms, so if your computer sometimes waits 5ms after receiving the soundcard interrupt before it
“wakes us up”, we only have 1ms remaining to do our work.

For more information on factors impacting the performance of your computer please see this video:
CPU Performance vs. Real-Time Performance in Digital Audio Workstations
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4.7. Primary Windows: Editor, Mixer, Recorder
and Cues
This topic will reference the Editor, Mixer, Recorder and Cue windows. These are the four primary windows
that are used to operate Mixbus since Version 8. You can navigate between the windows using the buttons
at the top right corner of Mixbus:

The Mixer, Editor and the Record buttons and pages are the same as in previous versions of Mixbus.
Version 8 added the Cue page which also has a dedicated button.

You can detach any screen by right-clicking on a button and choosing the Detach option, or by dragging the
button to the Desktop. This is useful in multiple monitor setups.

The Transport Toolbar
The top portion of the Mixbus main window is dedicated to the transport toolbar. The transport toolbar
provides transport buttons ( Play, Stop, Rewind ), the main Clock Displays, and the mini-timeline. You may
add or remove elements from the transport toolbar in Preferences->Appearance->Toolbar. For example,
when recording you might wish to show the “Punch” and “Monitoring” controls; but then you can remove
those when need more room for the tasks of editing and mixing.

The Editor Window
The first main window in Mixbus is the Editor window. The Editor window presents the Audio, MIDI and Cue
tracks that make up your session. You can reorder, resize, and rename the tracks from the Editor window.

Harrison Consoles Mixbus - 9_en

Page 70 of 848



Generally speaking, the Editor window provides all the features you need to edit your arrangement, while
the Mixer window allows you to balance the sounds in the arrangement so they can all be heard.

The top of the editor screen provides the transport buttons ( play, stop, etc) as well as the main clocks
that display the location of the playhead in the session. Just below the transport buttons are the editor tools
which are used to edit your arrangement.

The top right of the editor screen provides the Mini-Timeline, which allows you to jump around the
timeline. Left-click to jump to a specific place, or scroll the mouse wheel while hovering over the timeline to
jump around. You can hold down Control for finer jumping, and Control+Alt for still finer jumping. Right-
clicking on the Mini-Timeline allows you to select a time display range. If you create Location markers, they
will appear on the Mini-Timeline. You can click on a marker to jump to that location.

Just below the editing tools, you’ll see the ruler bar which helps to indicate your timeline position using
Min:Sec, timecode, samples, bars/beats, as well as providing a place to set Markers, Time Signature or
Tempo changes, and Loop and Punch ranges. Learn more about the rulers here.

The main editor canvas shows your tracks, and any regions (selected slices of an audio track) that are
present.

On the right of the editor is “Editor List”. The Editor List may be shown and hidden via the “View” menu.
Learn more about the Editor list here.

On the left of the editor is the “Editor Mixer”. The Editor Mixer shows the mixer channelstrip for the
currently-selected track or bus. The Editor Mixer may be shown and hidden from within the “View” menu or
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the associated keyboard shortcut (Shift+E by default).

The bottom of the editor is the Summary view. The summary view shows a light grey box that encompasses
your current view, with the entire session behind it. You can move the grey box around your session to
quickly move your view. The Summary may be shown and hidden via the “View” menu.

The Mixer Window
The Mixer Window may be shown using the “Window” menu, or the keyboard shortcut (ex: Alt/Opt+M) which
toggles between the editor and mixer windows. If you have the editor and mixer windows on different
monitors (screens), then the “Toggle Editor/Mixer” shortcut does not have an effect.

When viewed in the Mixer Window, Mixbus resembles a traditional analog console. Input Channels are on
the left, while the busses and master are located on the right side.

The audio signal flow is generally left-to-right. The signal starts at the input channels (which might be live
inputs, playback tracks, MIDI tracks, or virtual instruments), progresses through the mix buses, and into the
master. The signal path’s EQ, filter, gate/expander, compressor, panning, bus summing, and master bus
processing are performed inside Harrison’s proprietary signal path, are always present, and do not require
user-supplied plug-ins.

In Mixbus, like other audio workstations, each recording track has its own mixer strip. These mixer strips
resemble the input channels of a traditional analog mixing console. Input channels can be created to be
mono or stereo and by default include all the DSP processing as a real analog console channel. This is the
major difference between Mixbus and other DAW mixers. No time is wasted searching for and adding the
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necessary high-quality mixing tools.

Just to the right of the input channels are the 12 mix bus channels. Mix bus channels are used to collect the
outputs from the input channels into groups. For example, in a typical music project, you might send the
drums to mix bus 1, the vocals to mix bus 2, instruments to mix bus 3, and use mix bus 4 as a parallel
effects bus, like reverb. This allows you to easily adjust the relative levels of these groups and apply
processing to them.

The master channel is the final mixer strip on the right. Typically, the master channel will be connected to
your monitoring system (speaker outputs). The output of the Master channel is the final output of your
project i.e. your 2 track master file. This output is rendered to the final .wav file when you export the
session.

The monitor section on the far right is has been made available for those who do not have access to a
dedicated external monitoring section.

The Record Window
The Record window allows you to view, meter and monitor your physical inputs to Mixbus. This picture
shows an example:

The number of inputs shown is equal to the number of physical inputs on your audio interface. In the picture
you see 32 inputs although this particular interface has 64 inputs. The other inputs could be viewed using
the window scroll bar at the right. In this example, which came from a live concert, there are 13 inputs on
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the physical interface feeding 13 tracks with 11 inputs active, the other 2 inputs were other vocalists not
singing at that instant on the timeline.

As in previous versions of Mixbus, physical inputs can feed as many tracks as you want, there is NO 1:1
restriction. The Record page provides a quick way to assign physical inputs to multiple tracks, as an
alternative to using the routing tool.

Looking around the Record Window we see the following sections:

• the Transport toolbar remains as on the Mixer and Editor windows

• at the bottom of the page the physical inputs are shown. They are displayed horizontally until the
number of inputs is more than 16, then they display vertically

◦ each input has a real-time level meter (with peak hold bar) and a realtime 5-second waveform
display, buttons to display or add tracks connected to the input, and to PFL the input

• above the physical inputs is a section representing the tracks in use, with buttons to control track
arming, input source, playlist, track name, and monitoring options, and a horizontal meter

• to the right of the track controls is a timeline which shows record status vs. time for each track

• there is also a recording counter, and global track arming and monitoring buttons

More details about the Record window can be found in the topic page titled Record Window

The Cue Window
Cues and clips are managed in the Cue window, which is accessed by a button in the upper right of any
Mixbus page:

Harrison Consoles Mixbus - 9_en

Page 74 of 848



A Cue Channel or Cue Strip can be thought of as an audio or MIDI track that contains a list of audio or MIDI
clips. In the case of a Cue Channel containing audio clips, the audio comes from these audio clips rather
than an actual audio input or recorded track. A Cue Channel containing MIDI clips does not create any
sound on its own, but outputs MIDI information to an internal software synthesizer or external synthesizer,
both of which DO produce sound from the MIDI information in the clip. As Mixbus by default contains a
generic MIDI synthesizer, sounds may be heard from MIDI clips by default.

Maximize Mixer/Editor space
The “Maximize” commands can be found under menu> View. Enabling this function causes the editor
window to occupy all screen real estate. The title bar will be hidden as will the task bar. The exact behavior
of this function depends on your OS’s desktop “fullscreen” conventions. The same function is available for
the Mix window. To exit this mode uncheck Maximize Editor in Menu>View. ( if you are unable to see the
main menu, try moving your mouse to the top of the screen, and wait for the main menu to appear )

4.8. Adding Tracks and Buses >>
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4.8. Adding Tracks and Buses

Adding Tracks, Buses and VCA’s
This section describes how to add tracks, buses, and VCA controls to your session. If you wish to import
existing media, you should visit the Importing Files section.

What is the difference between Tracks, Buses and VCA’s?

Mixbus supports several kinds of objects that can appear in the editor and mixer windows:

• Audio tracks contain a sequence of audio “regions” on the timeline. Audio tracks also provide the
mixer features such as fader, panning, bussing, eq, compressor and plugins.

• MIDI tracks contain a sequence of midi regions on the timeline, so they can be recorded, edited and
played. MIDI tracks sometimes have a Virtual Instrument (VI) plugin, which converts the MIDI regions
into audio. When a VI is used on the track, MIDI tracks provide the mixer features such as fader,
panning, bussing, eq, compressor and plugins. If no VI is provided, then the MIDI data is sent directly
to an output; either to a MIDI Bus, or to an external gear.

• Audio buses are just like audio tracks, but they have no playlist of audio regions; the bus is only used
to process audio from another track or live input.

• MIDI buses are just like midi tracks, but they have no playlist of audio regions; the bus is only used to
process midi from another track or live input. Sometimes, a MIDI serves as a good location for a
single VI that is fed from multiple MIDI tracks.

• VCA channels are described here: VCA’s
• Foldback Buses are typically used to create a cue (headphone) mixes for the artist. These are audio

mix buses, not recorded, which are completely separate from the main mix buses. Foldback buses are
described here: Foldback Buses

There are 4 ways to open the “Add Track/Bus” dialog:

• Use the “Add Track/Bus” menu item, which can be found in the Session and Track menus.
• Right-click in the empty gray area in the editing canvas.
• Right-click in the empty gray area of the mixer window.
• Clicking the blue “plus” button to the right of the last channel strip (you may need to scroll to the last

channel or resize your window to see it).

A note about buses, and Mixbus’s mixing workflow: Unlike typical DAW workflow, where
track outputs are connected to other track(bus) inputs, the Audio Buses added here are not
intended to be used as part of the mixer panning & summing. The goal of Mixbus is to revert
to the buss-style mixing that is used in “hit-making” studios. It’s a subtle difference but very
important. Audio Buses are best suited for utilitarian tasks such as “live” inputs from an
external reverb, or grouping 2 similar tracks together for processing, before they are
assigned to a mixbus or master bus.

*
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The “Add Track/Bus/VCA” dialog

The “Add Track/Bus/VCA” dialog provides a list of the track types and templates that are available to be
created.

At the top of the list, there are generic entries for New Audio Track, New MIDI Track, etc. When one of
these items is selected, some of the options below will be provided:

• Add: Multiple audio tracks can be added at one time via the “add” setting.
• Name: A custom name may be assigned to the audio track before it is added. If multiple audio tracks

are added they will be sequentially numbered.
• Configuration: ( for Audio tracks only ) Allows for stereo or mono tracks with mono being the default.
• Instrument: (for MIDI tracks only) – this allows the user to choose the VI (Virtual Instrument) that will

be inserted in the MIDI track.
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◦ Selecting a synth for the track will change the audition synth.
• Group: Assigns the new audio track to a group. Whether a group is selected or not you can change

the group assignment at anytime after the audio track is added.

Session Templates

If a Template is selected, instead of the generic “Add Track/Bus” selections, then you can view the
description of the template, and any unused controls are greyed-out.

Mixbus supports 2 different kinds of templates, which both appear in this list:

• Scripted Templates: these templates are developed as Lua Scripts, and can prompt the user for more
input when they are run. It is possible for users to add their own scripts. These scripts currently report
“{Factory Template}” in the Created With column.

• User Templates: these templates are created by the user, and are created when the user clicks
Session->Save As Template in the main menu. These templates report the version of Mixbus (or
Mixbus32C) that was used to create the template. It is not guaranteed that templates made in one
version of the program will work perfectly in a different version.

At the bottom of the dialog, you’ll find 3 buttons:

• Insert: Determines where in the Mix/Edit window the new audio track will be placed.
◦ Before Selection: In the Mix window this will place the new track to the left of the selected track.

In the Edit window this will place the new track above the selected track.
◦ After Selection: In the Mix window this will place the new track to the right of the selected track.

In the Edit window this will place the new track below the selected track.
◦ Last: This will place the new track in the last position in the Mix/Edit window.

• Add (and leave dialog open): this adds the selected track(s) and leaves the dialog open, so more
tracks can be added

• Add and Close: this adds the selected track(s) and closes the dialog

NOTE: You can re-order tracks anytime, using either the Editor List, or by selecting tracks
and then using the Track menu { “Move Tracks Up/Down..” } to move the selected tracks
together.
*
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4.8.1. Track Templates
Track templates store the settings of a track so it can be re-used in another session. Track templates store
the track’s name, plugins, and mixer settings ( such as panning, EQ, compressor, and mixbus/master sends
)

Creating Track templates:
To create a track template, right-click on the channelstrip and choose “Save as Template”

Using Track templates:
In the “New Track” dialog, you will see your saved templates, along with the factory-provided templates, in
the left column of the New Track dialog.

Managing & Sharing track templates:
Track templates can be later renamed, edited, or shared using the Template Manager: see Templates
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4.9. Managing Tracks
On the left side of the editor canvas, you’ll find the Track Headers for each track. From the track header,
you can mute, solo, or otherwise affect the track.

Mixbus provides several methods to rename and re-order your tracks to help your workflow. You can
rename and reorder tracks from the editor view or the mixer view.

The editor list is a great place to manage your tracks, because it typically shows many more tracks at the
same time, and you don’t have to scroll the main editor canvas to rename or re-order tracks.

Naming Tracks

• In the mixer window, you can double-click on the track’s name-slate to rename it. Or right-click and
choose “Rename” from the menu

• In the editor window, double-click on the track’s name to edit it. Press TAB to advance to the next
track.

• In the editor list, “Track/Bus” tab, double click the track name to change it. Press TAB to advance to
the next track.

• In the mixer sidebar, right-click on the mixer-strip name, and choose “rename” from the popup menu.

Re-ordering tracks
There are 3 ways to change the order of tracks:

• In the editor window, you can select tracks by turning them red (clicking on them to select them), then
use the menu item Tracks->Move Tracks up/down (or the associated keybindings) to move the
selected tracks up and down together.

• In the editor list, you can drag and drop tracks to reorder them.
• In the mixer sidebar, you can drag and drop tracks to reorder them.

No two tracks or buses can share the same name. If you try to rename a track to something
that already exists, Mixbus will show an error dialog (when practical), or append a number
to the end of your newly named track.
*

You can’t rename a track while it is record-enabled, because the track name defines the
resulting audio wavefile name, and a record-armed track has an associated wave-file that
has already been assigned on disk, ready to be written to.
*
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Selecting tracks
Click on the track “header” ( the area which holds the mute, solo, and track name ) to select a track. The
track should highlight, with a red border, as shown below:

When you “select” a track, Mixbus will make an effort to scroll that track into view, in both the editor and
mixer windows.

You can multi-select tracks by using standard modifier keys:

• Hold Shift while selecting to select a contiguous range of tracks.
• Cmd+Click on a track to add or remove it from an existing selection.

What can I do with selected tracks?

With tracks selected, you can perform a wide range of operations including:

• Call operations from the Track menu, like “Remove” or “Move Up/Down” … this will apply to all
selected tracks

• Right-click on a VCA, and choose to “assign” (or de-assign) the selected tracks to a VCA
• Right-click in the Group box, and choose “make a new group -> from selection”
• Use items in the toolbar, or the View menu, to Fit the selected tracks in the editor

Unlike some DAWs, selecting a track does not select the “regions” in the track. In Mixbus,
you select tracks and time-ranges with the Range tool, and Objects (Regions) with the
Grabber tool. Those are distinct operations and they are used for different tasks. You can’t
have both selected at once.

*
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Other ways to select a track:

• Clicking anywhere in a mixer strip will select the mixer strip, and this also selects the associated track
in the editor.

• Initiating a “Range” selection on a track will select the track. See: Range Editing
• Clicking on the track in the editor sidebar ( Tracks/Buses tab ) will select the track, and also scroll it

into view if it is not currently shown.
• By default, “Alt + up&down arrow keys” will advance the selection up or down through the tracks.
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4.9.1. Coloring Tracks
Each track (or bus, or VCA) may have a color assigned to it.

To edit a track’s color, right-click on the track header (in the Editor window) or on the channel name-slate (in
a mixer strip) and choose “Color”.

You can also assign a track to a Group, and then set the color of the group, which the track will inherit while
it is part of the group.

Default track colors, and the track color palette
When a new bus is created, (including the 12 mix-buses), they are sequentially assigned a color from a
palette. So if you have a specific bus layout and color scheme, you can use the palette to enforce the color
scheme on new buses and VCA’s.

Once you’ve selected a color from the color wheel, you can drag& drop colors into the palette, in the bottom
right corner. Changes to the palette will be saved in your preferences.

When a new track is assigned,
it will be assigned the top-left
color of the palette.

starting in v9, Mixbus no longer assigns ‘random’ colors to new tracks when they are
created. If you want to revert to the prior behavior, you can visit preferences->appearance-
>colors and check the box for “use color palette…..”. Buses and VCA’s are still assigned
sequentially from the color palette.

*
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4.10. Audio Input & Output

Input
Mixbus uses an internal audio routing system to make audio connections between Mixbus, your I/O
hardware, and other parts of Mixbus.

With a new session, Mixbus automatically makes these connections by default:

• The master bus is connected to the first two physical output ports.
• Track/Bus inputs are assigned sequentially from the physical inputs whenever a new track/bus is

created.
• The Auditioner and the Click are connected to the first two physical output ports.

However it is possible to change any or all of these connections using buttons in the mixer strip, or selecting
the pulldown Window->Audio Connections.

Track I/O Selections

Track inputs can also be assigned directly from the channel strip, by selecting the “switcher” near the top of
the channel strip to reveal the channel’s redirect page. The Switcher may be displayed using the “Input”
button beside the Pan knob:
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The image above shows a channel strip before its switcher has been activated
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The same channel strips after its switch has been activated.
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To change the input to a channel click on the IN button. A selection of input sources will be displayed. It is
possible to:

- completely disconnect the input from anything
- connect it to the source of any other channel (if you want to do parallel processing for example)
- add an additional audio or MIDI input to the channel (for example: adding one audio input to a mono
channel makes it a stereo channel)
- access the Routing Grid for completely flexible selection of the source

See the switcher page for more details.

Output
For convenience, the Master Bus has an “output” button which can be used to select the ports that the
master bus output will feed. Normally, the Master Bus output is connected by default to the first 2 channels
of your audio interface outputs.
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In the above image the master bus has both of its outputs connected to the audio interface stereo output, or
the first 2 channels on a multichannel interface.

By clicking on the button the output may be rerouted as desired. Hovering the mouse over the button makes
a pop-up showing the current routing destination:
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If you are using the Mixbus Monitor section, the master output will be routed to the Monitor input:

Note how the popup now shows the Master output connected to the Monitor input.

NOTE that this connection is for monitoring your recording through the physical interface. The Master output
is still the source of your final mix. See the section Monitor Strip.

Audio Connections Manager – the Routing Grid

The Audio Connections Manager window allows you to connect any output port to the track/bus input:

Note: The redirect capability may not display a connection until you select it from the menu.
The redirect input and output points are provided as a quick way to override the current
setting, not a method to see what the track is connected to.
*
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In the above image an audio interface with 16 inputs is shown (viewed via the hardware tab on the left side).
The bottom tab labeled “Mixbus Tracks” shows a total of 4 tracks in the session. The green dots indicate
Mic1 is connected to the Mixbus channel strip input labeled VOX and Mic 2 is connected to the Mixbus
channel strip input labeled GTR. The other two channels labeled keys and drums have no connections
because in this example those tracks had been recorded previously. This is an example of having drums
and keys already recorded and a vocalist and guitar player coming to the studio for an overdub session.

The image below shows the output of the Master bus. You can use the grid to connect the master bus to
your speakers, and a stereo bounce track, and any other connections:

Note: audio connections use a floating-point 32-bit format, which means that headroom is
essentially unlimited. You don’t have to worry about “clipping” the sound when routing from
one application to another. You may route a single output port to several inputs, and an
input port can be routed from several different outputs (the summing of these signals is
done automatically).

*
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4.11. Transport (Play, Stop, etc) >>
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4.11. Transport (Play, Stop, etc)
“Transport” is the term used to describe the motion of the playhead. Mixbus can play forwards, backwards,
and at various speeds. Furthermore, you can instantly “locate” the playhead wherever you like. All of these
functions are considered Transport functions.

Transport is a fundamental operation, so there are many different ways to control the transport:

• Buttons in the Transport Toolbar
• The Transport menu
• Keyboard Shortcuts
• Remotely, from an external device

…and probably many more!

All of the operations in the Transport Menu can be assigned to a keyboard shortcut, so
advanced users will most often use keyboard shortcuts to navigate the timeline and control
the transport. But you can use the menu actions, and the buttons in the toolbar, until you’ve
mastered the keyboard shortcuts

*
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4.11.1. Transport Toolbar

Transport Toolbar:

The Transport Toolbar resides at the top of the main window. The transport buttons (far left) are always
available; many of the other elements can be shown or hidden from Preferences->Appearance->Toolbar

Transport buttons:
The transport buttons control the playhead’s location, speed and record-enable.

Transport controls are (from left to right):
MIDI Panic: Send note off and reset controller messages on all MIDI channels
Metronome: Enable/Disable audio click ( see The Click to learn more )
Start: Go to session’s Start marker
End: Go to session’s End marker
Loop playback: Plays loop range
Play: Activates “play”, starting from the current playhead location (shortcut: space bar)
Stop: Stops the transport (shortcut: space bar)
Record-enable: Toggles master record-enable ( you must also have tracks rec-enabled, to record on them )

Jog/Shuttle control: Allows for increased or decreased playback speed, the slider control returns to center
position when mouse is released.

Right-clicking on the slider allows adjustment of the maximum playback speed from 1.5 X to 8X of “play”
speed:
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The “VS” button controls the range of the varispeed adjustment, clicking on the button allows you to set the
range limits in Semitones and Cents:

To the left of the varispeed slider is Time Sync Button: This button toggles between Mixbus’s internal
transport control, and synchronization to an external device ( LTC (SMPTE), MTC (MIDI Time Code), or
JACK ):

Right-clicking on the button brings up the control window which allows you to choose the source to sync the
transport.

Harrison Consoles Mixbus - 9_en

Page 94 of 848



To learn more, visit: Clock Synchronization.

Record & Punch options:
To enable the “recording options” section of the toolbar, visit Preferences->Appearance->Toolbar and
enable “Display Record/Punch Options”.

• “In” enables the punch-in marker ( see Punch Recording )
• “Out” enables the punch-out marker
• “Non-Layered” is a special recording mode: when a new region is recorded, then all of the regions that

existed below that range will be removed, and the last-recorded audio will be the only region in the
layer stack. See: Object Editing

Transport modes:
The Transport toolbar has 2 mode buttons which change the behavior of the playhead:

Follow Range Mode ( previously called “Follow Edits” or “Join Playhead” )

Follow Range Mode is enabled with the button right of the transport control buttons. Follow Range Mode
automatically moves the playhead to follow the mouse when it is clicked on a track, and/or to allow quick
auditioning of the selected time range.

Behaviors with Follow Range Mode on:

• Starting playback (with the spacebar or any other means) will play the Range selection, if there is one.
• A single click in Range (or Smart-Range) mode will locate the playhead to that location.
• When a Range selection is made, the playhead will be located to the beginning of the range.

Behaviors with Follow Range Mode off:

• Editing clicks (such as object grabs or range selections) will have no effect on the playhead location.

Auto Return Mode

• If Auto Return is on, then the playhead will always return to the location where playback started.
• If Auto Return is off, then when the playhead is stopped, it will remain in the location when “stop” was

pressed.
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Clocks
By default, Mixbus provides 2 clocks at the top ( Note: if your screen is small, Mixbus will automatically omit
one of the clocks ). You can manually disable the secondary clock by visiting Preferences->Appearance-
>Toolbar

The clocks have identical operation, and each clock may operate in one of 4 different modes:

• Timecode
• Bars:Beats (musical time, or sometimes called BBT for Bars-Beats-Ticks)
• Minutes:Seconds
• Samples

To select a clock’s mode, you right-click on the clock to present the clock context menu:

• Copy contents to clipboard: copies the clock text to the clipboard, for pasting elsewhere
• Display Delta to Edit Cursor: when this is enabled, the clock will show the “difference” in time between

the playhead and the mouse cursor. This is a useful tool for measuring distances on the timeline.
• Tempo and Meter selections will launch the appropriate dialog. Learn more here: Tempo, Click & Grid

Tip: The combination of Follow Range Mode and Auto-Return mode provide a wide variety
of possible operations. If you are familiar with another workstation’s conventions, you
should experiment with these settings to see if one of them matches your expectations.
*

In all clock modes, you can use the mouse-wheel to adjust the subdivisions of the clock. For
example, in the Bars:Beats mode, you can mouse-wheel on the “Bars” value to increment or*
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Timecode Clock Mode:

In Timecode mode, the display shows timecode in Hours, Minutes, Seconds, and Frames.

Bars:Beats Clock Mode:

In Bars:Beats mode, the clock shows position in Bars (i.e. Measures), Beats, and Ticks. “Ticks” are
sometimes called “pulses per quarter note” or PPQN, and Mixbus uses 1920 Ticks per beat.

Minutes:Seconds Clock Mode:

In Minutes:Seconds mode, Mixbus shows the position in “wall clock” time.

Samples Clock Mode:

In Samples mode, the clock simply displays the sample-offset from time 0.

Pull-up/down values are displayed underneath the Samples clock. To change the pullup/pulldown value for

decrement the Bar value.

You may also click on a clock to enter the timecode manually. In this case, a Right-to-Left
convention is used. To locate to 1-hour in the Timecode clock, you would enter “1” followed
by 7 zeroes.
*

You may also enter “relative” times, by first typing a “+” or “-” before entering the value to
offset the current clock position.*
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the session, visit Session->Properties->Timecode

Alerts

These 3 buttons will blink “red” when one of the following occurs:

• Solo will blink red when any channel or bus is Solo’ed
◦ This is sometimes called the “rude solo indicator”
◦ Click the Solo button to clear all solos in the session

• Auditioning will blink red when an “audition” is occurring
◦ An “audition” is when Mixbus is playing a file directly to the speakers, bypassing the mixer

engine
◦ Auditioning can be triggered (for example) in the Import dialog, if the user chooses to audition a

file before importing it.
◦ Click the Audition button to cancel the audition.

• Feedback will blink red when Mixbus detects a feedback loop in the mixer processing order
◦ Each time the transport is “stopped”, Mixbus recalculates the latency offsets and other

information for the mixer engine
◦ If, when calculating the graph, Mixbus finds a “loop” or otherwise can’t determine the necessary

latency offsets, this button will blink
◦ If Mixbus can’t determine the engine offsets, then it will not play audio.
◦ If this happens, you should consider the last few routing assignments, and consider whether

you should revert one of your most-recent changes.

Selection Clock

By default, the selection clock is not shown. You can enable it in Preferences->Appearance->Toolbar.

If enabled, the “Selection clock” shows the start, end and length of the current selection. The selection clock
works for a “Range” selection as well as a series of Region selections.

Mini-Timeline
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The mini-timeline provides a compact and convenient way to
navigate the session.
Learn more here: mini-timeline

Master bus meter

This simplified meter gives an indication of the master bus level. By default, this meter is a K-14 meter,
using the same scale as the K-14 on the master bus, but shown in a different format.

You can adjust the “scale” of this meter in Preferences->Meterbridge->Default Type for Master Bus.

The vertical button on the far right will turn “red” when clip (0dBFS) is reached on the master bus. Click the
button to clear the red indication.

Scripted Action Buttons
By default, the Scripted Action Buttons are not shown. You can enable them, in pairs, in Preferences-
>Appearance->Toolbar.

These buttons can be used to directly trigger one of:

• Actions ( anything that can be bound to a key-binding ). Select “Shortcut”, and then click “Add”. You
will be prompted for which action you’d like to assign to the button.

• “Scripted actions”. Learn more in the Scripting chapter. Select from the available scripts in the menu.
Some scripts even provide their own icon!
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These buttons may be customized for many functions. In the picture button #1 happens to be configured to
do a Mixer screen shot. Button #2 is configured to provide a quick list of the plugins currently in use. These
buttons can be configured as a single-click trigger of a keyboard shortcut, as a trigger of a LUA script which
you might write, and many other functions.

Assigning these buttons is done by right clicking. Here right-clicking was done on button #3:
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When you hover your mouse cursor over an unassigned button, the “No Action Bound” box will pop up to let
you know its function is unassigned. Right clicking on the button will bring up the “Add Shortcut or LUA
Script” box shown.

“Shortcut” is the default function in the select tab but is not the only function you can select:

Harrison Consoles Mixbus - 9_en

Page 101 of 848



Harrison Consoles Mixbus - 9_en

Page 102 of 848



If you select “Bus Organizer” for example and click on the “Add” button, button #3 will now control the Bus
Organizer function:

Putting the mouse cursor over the button, the popup box will tell you how to change or clear the button
function:

If you select “Shortcut” and click on the “Add” button, you can select from a HUGE number of functions you
can assign to this button:
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Page selection buttons
These buttons are used to switch between the 4 pages of the main window – Editor, Mixer, Record and Cue
pages.

You can drag these buttons to your desktop to detach any page into its own window.

You can right-click on these buttons to detach or re-attach the windows to the main page.
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4.12. Navigating the Editor Canvas
Mixbus provides several ways to navigate the editor canvas.

Keyboard commands, buttons, the mouse-wheel (or 2-finger scroll on a touchpad ), and scrollbar-like
widgets are supported, and each method has its own strengths (and weaknesses).

Why is this so complicated?

Editing digital audio is not an easy task. Relatively few people have the interest, or need, to investigate all
the details that go into a high-end professional workstation. It’s a multi-dimensional problem with unlimited
tracks, which might be audio, midi, or even video. And it’s all changing on a timeline: a concept you won’t
find in a word processor or spreadsheet. Screen space is limited and there is a LOT of information that can
be presented.

Users have different expectations, different workflows, and different devices ( mice, touchpads, etc ). Nearly
every workstation has a different set of conventions, and if you’ve learned the conventions for one DAW,
you might expect those same conventions to work on Mixbus; but alas there is not a widely-accepted way of
working. ( the same problem occurs in image-editing and other software … there are very few conventions
that transfer from one system to another )

Furthermore, conventions that work on some software don’t apply well to an audio workstation. Consider a
scrollbar: you’ve probably found that a scrollbar works great for a spreadsheet until the number of items in
the list becomes several hundred screens worth of data; then the scrollbar jumps around too fast to be
useful. In an audio workstation, the timeline is potentially 24 hours long or more, and you can zoom in to see
a screenful of individual samples. This can require upwards of 100,000 screens of information, which
doesn’t fit well on a scrollbar.

Learning to navigate the editor canvas

The best way to learn about Mixbus’s conventions is by watching an experienced user – in person or via
video. An experienced user will navigate the timeline effortlessly, using each of the available tools for their
specific purpose.

These chapters provide an overview of the most common navigation features:

Scrolling and Zooming in the Editor Window

Basic Transport Features

Summary View

Mini Timeline
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4.12.1. Scrolling and Zooming in the Editor
Window

Scrolling
The editor canvas may be scrolled up/down and left/right to display a different selection of tracks or time on
the timeline.

Vertical Scrolling

• Mouse Wheel: The primary method of vertical scrolling is the mouse scroll wheel ( or the 2-finger
drag, on a touchpad ).

• Keyboard: The up/down arrow keys will scroll the view vertically
• Selections:

◦ Alt+up/down arrow (Ctrl+arrow on a mac) will move the selection up & down, which will cause
the editor to scroll to keep the selection in view.

◦ Selecting a track header will cause the track to be scrolled fully into view.

https://www.youtube.com/embed/3JY4mTboOow?rel=0

Harrison Consoles Mixbus - 9_en

Page 107 of 848

https://www.youtube.com/embed/3JY4mTboOow?rel=0


◦ Selecting a track name in the “editor list”, or the mixer window, will cause the selected track(s)
to be scrolled into view.

• Dragging an object:
◦ Dragging a region to the top or bottom of the screen will cause the canvas view to be scrolled

• Using the Summary View: Scrolling can be accomplished by grabbing the gray box in the summary
view window and dragging it, or by clicking the arrow buttons at the left and right sides of the window.

Horizontal Scrolling:

• The primary method of horizontal scrolling is to move the Playhead ( these operations require that
“Follow Playhead” is engaged )

◦ Click and release in the ruler-bar area to locate the playhead there;
◦ Click & drag in the ruler-bar area to drag the playhead. When you approach the left or right

edge, the screen will scroll to keep it in view.
◦ The editor canvas can be scrolled horizontally by locating in the Mini-Timeline.
◦ Various transport functions like “to start”, “to end”, or next/previous marker will move the

playhead and therefore scroll the view.
• Keyboard Shortcut: the menu item View->Scroll Timeline can be assigned a keyboard shortcut to

allow scrolling from the keyboard.
• Mouse Wheel: Hold “Shift” while turning the mouse wheel to scroll the timeline left/right.
• Mouse with side-scroll wheel ( or Touchpads with a 2-finger side-to-side drag. )
• Dragging an object:

◦ When you try to drag a region, MIDI note, or automation control point off the left or right edge of
the canvas, the screen will scroll to keep it in view.

• Using the Summary View: Scrolling can be accomplished by grabbing the gray box in the summary
view window and dragging it, or by clicking the arrow buttons at the left and right sides of the window.

Following the Playhead

In most cases, you’ll want the screen to automatically scroll sideways to keep the playhead in view. Mixbus
has 2 settings in the Transport menu which control this feature:

• Follow Playhead: when this is enabled, the screen will scroll sideways to keep the playhead visible,
each time the playhead leaves the one side of the screen, the screen will move to show it again.

• Stationary Playhead: when this is enabled, and Follow Playhead is enabled, the playhead will remain
in the center of the screen, and the waveforms will scroll underneath it.

Sometimes, you might prefer to scroll to a location, and prevent the playhead from moving your view. For
example you might zoom in very close to make an edit, and you want to remain looking in the same place
while the playhead plays over a selection. In that case, you can disable “Follow Playhead”.

Power-User tip: zooming with the mouse-wheel is a very fast way to horizontally navigate
the timeline. First zoom far out, until you can see the entire timeline. Then point the mouse
where you’d like to zoom, and zoom in to the desired zoom scale at the new location.
*
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Zooming
“Zooming” adjusts the scale of the timeline to show a greater or lesser portion of the timeline.

• Mouse Wheel: zooming with the Mouse Wheel is the preferred method:
◦ Hold “Ctrl” ( “Cmd” on Mac) to zoom in or out on the mouse’s location

• Zooming with the Summary view
◦ Dragging up/down in the summary view will zoom the session.

• Zooming with the ruler-bar (playhead)
◦ If the option “Preferences->Editor->zoom with vertical drag in rulers” is engaged, then dragging

up/down in the ruler-bar will zoom around the playhead.
• Keyboard: + (plus) and – (minus) keys increase or decrease the zoom around the Zoom Focus. (see

below)
• Zooming on a Range

◦ Select a Range with the range tool (or smart tool) and then click “z” to fill the screen with the
selected range

• View>Zoom Menu items:
◦ Zoom to Session: Brings the entire sessions audio clips into view.
◦ Toggle Zoom State: Alternates between the last 2 zoom states

• Zoom Presets widget: this button allows the user to select from predefined zoom scales:

Zoom Focus

Menu: View>Zoom Focus

Zoom Focus provides an anchor point by which keyboard zooming occurs around. For example, some users
expect the screen to zoom towards and away from the playhead (this is the default).
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Additional zoom focus options are available under View>Zoom Focus. They include:

• Left : leftmost side of the summary view is anchored
• Right : rightmost side of the summary view is anchored
• Center : center of the summary view is anchored and zooming occurs around it
• Edit Point : edit point is anchored and zooming occurs around it

Track Size & Waveform Scale

Track Size

Track heights can be adjusted using one of several methods:

• Grab the bottom edge of a track header to adjust its height with the mouse.
• Right-click on a track header, and choose the Height submenu
• Select a track and use View->Fit ( shortcut: “F” ) to fill the screen with the track contents
• Select a track, and use Track->Height from the main menu
• Track Height presets: Use the button in the editor to select predefined track views:

Waveform scale

The waveform scale can be globally increased, so that quiet signals are more easily visible. Visit
Preferences->Appearance->Editor:

• Linear: Displays the audio waveform in a linear fashion.
• Logarithmic: Displays the audio waveform so that quiet sounds can be more easily seen on the

screen. The display is disproportionate. This setting does not change the gain of the signal, it is
strictly a visual aid.
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Additional waveform display options can be found in Menu>Edit>Preferences>Editor. Click
here for more.*
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4.12.2. Transport, Markers, and Rulers

Ruler Bar

The ruler bar runs along the top of the edit canvas. A number of timelines can be shown via View>Rulers, or
by right clicking in the blank area just to the left of the marker labels.

Available Rulers include:

• Min:Sec : Minutes and Seconds elapsed since time “0”
• Timecode : Video timecode in SMPTE formats. Choose the display format in Session->Properties-

>Timecode.
• Samples : raw digital samples
• Bars & Beats : musical time
• Time Signature
• Tempo
• Range Markers
• Loop/Punch Ranges
• CD Markers
• Location Markers
• Cue Markers
• Arrangement Markers
• Video Timeline
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Marker bars in the ruler area

Marks can be set in the following ruler areas:

• Time Signature( a marker initiates a new musical timebase )
• Tempo ( a tempo marker initiates a new musical tempo )
• Range Markers ( Ranges can be exported simultaneously in the Export dialog )
• Loop/Punch Ranges
• Markers ( Location markers are typically used to quickly locate to a new time in the project, such as

“verse 1” ).
• Arrangement Markers (see Arrangement Tab)
• Cue Markers (see Arranging with Cues)
• CD Markers ( CD markers are used in the Export dialog to define CD track markers )

To set a marker in any of the rulers, simply right click to pull a dialog box.
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The Time Signature Marker:

A quick dialogue box can also be obtained by left-click on the Time Signature button:

The Tempo Marker Dialog Box:
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Right-clicking in the timeline along the Tempo ruler will quick-set a Tempo marker according to the setting of
the button above:

The Range Marker Dialog Box:

Harrison Consoles Mixbus - 9_en

Page 115 of 848



The Loop/Punch Ranges Marker Dialog Box:

The range start will be positioned at the mouse position. Click and drag a marker to move it around along
the timeline.

The CD Markers Dialog Box:

Video Timeline Ruler
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The “video timeline” ruler can show a thumbnail of a video, if you have imported a video file.

4.12.3. Summary View >>
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4.12.3. Summary View
The “Summary View”, located at the bottom of the edit window, is a condensed view of the entire session
between the “start” and “end” markers.

By default, the Summary view is not shown. But you can enable it by visiting the “View” menu.

Within the Summary view you can see a small representation for each audio/midi region on the timeline, and
a lightly shaded box that indicates your current edit canvas view. You can grab the light shaded box to pan
up, down, left, or right. And you can grab the edges of the light shaded box to stretch or shrink (zoom) in
either dimension. Additionally, arrow buttons are provided at either end of the view box for maneuvering the
shaded box if you prefer.

The height of the view box can be made larger or smaller by grabbing its top border and dragging.

In the image above three regions are shown with the shaded box fully encompassing the region contained in
track 2, indicating it will be fully visible in the edit canvas. The start of regions 1 and 3 will not be visible but
the regions ends will be.

4.12.4. Mini-Timeline >>
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4.12.4. Mini-Timeline
The mini-timeline appears in the transport toolbar, and it shows a condensed view of the timeline including
markers.

One of the benefits of the mini-timeline is that the scale remains fixed, regardless of the scale of your editor
window. This allows you to zoom very close or very wide in the editor, and still view the markers and make
20- or 30-second jumps in the timeline.

Click on a marker to locate to the marker.

Click anywhere in the mini-timeline (except on a marker) to locate to that time.

Right-click anywhere on the mini-timeline to change the zoom scale between several presets.

NOTE: unlike locating from the editor, the mini-timeline does NOT apply the Grid/Snap
settings.*
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5. Recording

Quick-Start for recording: following these steps to record
some audio tracks!

1. First, add one or more tracks via the main menu: Track>“Add Track or Bus”.
2. Record-arm the track by clicking the button with the red circle on the new track
3. Record-arm the transport by clicking the big button with the red circle, at the top of the main window (

both the track(s) AND the transport must be armed before anything will be recorded )
4. Now press “Play”, and you will be recording! Rewind to the beginning of the track and press “Play”

again to hear your recording.

You may arm tracks and/or the main transport anytime; so if you prefer, you can start playing first, and then
press the record buttons to start recording.

Once you’ve recorded a track, you might investigate some ways to refine your recordings further:

1. Set the tempo (optional). Click on the Tempo button (in the main Clock) to change the current tempo.
By setting the tempo, you can play the Click, and this will make editing the track much easier.

2. Change the way you hear yourself by visiting Monitoring.
3. You may choose any input to feed the track. Expose the “Input” button and choose the soundcard

input you’d like to record to this track.
4. Use “Punch Recording” to pre-select a recording range, and Mixbus will automatically punch-in the

https://www.youtube.com/embed/2LnjZC4UMAY?rel=0
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transport Record-arm when the punch-in point is reached.
5. Use “Pre-Roll Recording” to provide some count-in before your recording actually starts.

Recording Modes:

Mixbus can record in 2 different modes:

• Layered (default) : in this mode, any new recordings will be added as regions on a “layer” atop the
existing audio regions in the track.

• Non-Layered: In this mode, the underlying audio will be replaced with the resulting new region.

Both modes are “non-destructive”, meaning that you can undo your changes, or re-layer and re-trim the
regions to expose the parts that were hidden.

The mode switch is provided in the transport toolbar. If you don’t see this button, visit Preferences-
>Appearance->Toolbar and enable “Record/Punch Options”

To learn more about layers, visit Region Editing
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5.1. Record Window

Record Window
The Record window allows you to view, meter and monitor your physical inputs to Mixbus as well as
presenting just the information and controls you need while rolling in Record mode. This picture shows an
example:

Access the Record page by clicking “Rec” in the top-right corner, or choosing it from the Window Menu.

Physical Inputs

The lower part of the window shows details of the physical inputs on the interface.

The number of inputs shown is equal to the number of physical inputs on your audio interface. In the picture
above you see 32 inputs although this particular interface is 64 inputs. The other inputs could be viewed
using the window scroll bar at the right. In this example, which came from a live concert, there are 13 inputs
on the physical interface feeding 13 tracks with 12 inputs active, the 13th track/input was another vocalist
not singing at that instant on the timeline.

As in previous versions of Mixbus, physical inputs can feed as many tracks as you want, there is NO
restriction. Note that an input will be shown as long as it physically exists, even if it is not assigned to a
track.
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The following features are available on each physical input:

Harrison Consoles Mixbus - 9_en

Page 123 of 848



Input Display

For fewer than 16 inputs, the input displays will be horizontal. For more than 16 inputs, they will be
displayed vertically as shown here.

Level Meter

This meter measures the input level, with peak level indicator.

Input Waveform

This is a real-time display of the input waveform with 5 second history.

Track Connection Indicator

The number in parenthesis indicates the number of tracks connected to this input. When this button is
pressed, the track display above will “spill” (display only) the tracks connected to this input.

PFL

The input can be solo’d if you are using the Mixbus monitor section.

“+” Button

Add a track. Clicking on this button will create a new track attached to this input. This provides a quick way
to assign physical inputs to multiple tracks, as an alternative to using the routing tool.

Input Name

The Input Name tab allows renaming of the input. An important feature of this name is it is specific to the
physical interface, not your Mixbus session. Once set, the input name you enter will be displayed whenever
any Mixbus session opens this interface. If you have different physical interfaces, their inputs can have
different names. The input names specific to the interface being used will be displayed, for any Mixbus
session that uses it.

Tracks Section
Above the physical inputs are the tracks connected to the inputs:
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Each track has the following indicators and controls:

Track Arm Button

These buttons arm the track for recording. Recording on this track will not begin until Record mode is
invoked using the Transport buttons above, or by punching in.

When a track is record-armed, its input source is highlighted with a red box drawn around it.
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Input Selector

Clicking this button provides a way to disconnect or reassign the input to this track. Either a left-click or
right-click can be used. Left-click provides a simple list of sources:
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Right-click opens the Router page for this track’s input:
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Playlist Select

This button allows selection or creation of a specific playlist to record to for this track. Think of a playlist as a
separate piece of tape, or a 3rd dimension (into the screen) with different versions of your track or section of
a track. More about Playlists can be found in the section titled Playlists.

Clicking on this button brings up a menu with several options:

Here, the first playlist for the kick drum has been named kik.1 by default. The menu allows you to rename it,
or create a new playlist, either an empty one or one which is a copy of the current one.
“Clear Current” will erase everything presently recorded to the selected playlist.

“Select From All” allows you to create a new playlist on this track by copying from any other playlist, even
from a different track.

Track Name

Double-clicking allows you to change the name of the track. If a track is record armed, it is not possible to
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change its name.

Monitoring

The “In” and “Disk” buttons control individual track monitoring and are analogous to “Bus/Tape” monitoring
selection on a tape recorder (“PEC/Direct” for you film guys). “In” monitors the physical input and “Disk”
monitors the playback from what is already recorded on the track. When both buttons are selected, the sum
of both is heard.

The monitoring control buttons operate in two modes. When they are outlined in color it means they are
being controlled by Mixbus according to the state of the transport:

Clicking on a button to manually set it makes it solid color, and it will stay in that monitoring state regardless
of the state of the transport:
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Level Meter

The meter displays the signal level on the track, and has a peak indicator. Double clicking in this area will
reset that track’s peak indicator.

Track Number

The track numbers are displayed here. Right clicking on the track number presents a few options such as
changing the colors, input and output router pages, renaming the track and adding a hidden comment.
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Record Timeline

The Record Timeline indicates the recorded portion of the tracks vs. time. The area always shows the full
length of the recording, there is no scrolling of the timeline. When tracks are in record and the transport is
rolling the track timelines are red:
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When the transport is stopped the tracks change color and indicate the time span of the recording:

If recording on a track is disabled by turning off the track arm (either while the transport is rolling or by
stopping, turning off the track arms, then restarting the transport) the display will show a “hole” where the
track has not been recorded:
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The “hole” in the recorded tracks appears similarly, a blank area, in the Editor window.

Record Toolbar

On the Record page the Record Toolbar is just below the Transport toolbar:

Record Counter

This shows the elapsed recording time of the current take (NOT the total time of the recording). When in
record this counter will be red in color. If you stop the transport it will hold the time length of the last
recording. If you then restart recording, the counter will be reset before continuing.

Discard Last Take

This button will remove ONLY the last recorded take. There is no history to this, once the last take has been
removed, NO previous takes can be removed. Removal of the last take is destructive and cannot be
undone.
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X-Run counter

This counter shows the number of X-Runs that have occurred during the current take. An X-Run indicates
that new audio samples have arrived prior to the previous ones being grabbed from the input buffers and
saved to the recording. When this happens you may hear a click in the recording. Normally this counter
should read “0”.

Global Track Arming

These are speed buttons providing one-click arm or disarm of all tracks.

Monitoring Controls

“All In” sets monitoring of all tracks to Input. “All Disk” sets monitoring of all tracks to Disk. “Auto Input”
selects the track input monitoring to follow the state of the transport.

When the “All In” or “All Disk” buttons are filled in color, it is the same as having manually set all of the
individual track monitoring buttons to that state (with color fill). As described above, their setting in this
mode is hard set and will NOT change with the state of the transport:
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Auto Input

Auto Input selection is provided to facilitate monitoring when overdubbing.

Auto-Input OFF:

When playing prerecorded tracks, playback will be from disk EXCEPT for any tracks that are record-armed,
these will monitor from the input:
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When placed into Record (via the master record button at the top) monitoring of the recorded track will
remain on Input. This may be useful when adding a new track to previously recorded tracks:
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Auto-Input ON:

This mode is commonly used for overdubbing. When playing prerecorded tracks, playback will be from disk
INCLUDING any tracks that are record-armed, so you can hear what was recorded before on that track:

When recording on the armed track is engaged, monitoring automatically switches to Input, so the new
material for that track can be heard along with the prerecorded material:
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Monitoring is a complex topic with many different modes that is explained in detail in the section Monitoring.

Available Disk Space

This indicator shows how long the current recording, at the current sample rate and number of tracks, could
be if it were to completely fill your hard disk. It is not recommended to make recordings that long.

Reset Peak Hold

This button will reset the peak hold indicators on all track meters at once. Remember that individual track
peak holds can be reset by double-clicking in the meter area of that track.

Basic Recording
Recording involves the following steps:

• arm the individual tracks to be recorded
• set track monitoring as desired
• click on the master record button in the transport toolbar. The record button will flash until the

transport is started:
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• press the Play button to start recording:
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Basic Overdubbing
Overdubbing involves the following steps:

• arm the individual tracks to be recorded
• typically, set track monitoring to “Auto-Input” and “Disk”
• set the transport in Play
• listen to the playback up until the point where recording the new material is to begin
• click the master record button at the top to start recording at the desired point. If “Auto-Input” is

selected monitoring of the armed tracks will automatically switch to “Input” so you can hear the new
material along with the prerecorded material.
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5.1.1. Recording Takes with Playlists

Using Playlists as ‘Takes’
When you are recording yourself or a band with live instruments and vocals, it is common to record multiple
attempts or takes, and then sort through these takes to find the best parts.

One option for recording multiple takes is to record over each track repeatedly. Mixbus supports this by
recording each successive take in a layer. However, editing these layers together can be tricky … especially
when you are recording multiple tracks, and each track has its own stack of layers.

Another option is to use Playlists to record your takes. Playlists have some benefits over layers for this task:

• playlists maintain their order better than layers: you can’t trivially shuffle the order like you can with
layers

• if you record on multiple tracks at the same time, Mixbus knows to assign those playlists to a ‘playlist
group’ or pgroup

• if you switch a track’s playlist, other tracks with an associated pgroup can switch to follow

You will be prompted to name each playlist (take) so you can organize them later.

Comping the best takes into a new Playlist
Once you’ve recorded several takes, you can make a new empty playlist for your tracks (or start from the
best one….) and then copy/paste the best phrases from each take into this Comp take

You can learn more about comping playlists here: “

Playlist actions in the Track menu
The available Playlist actions, and their shortcuts, are listed in the Track menu:
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• Show Playlist Selector : (this option is only available if a Track is selected) – learn more here:
Editing with Playlists

• New Playlists for All Tracks : creates a new, empty playlist on all ALL tracks
• New Playlists for Rec-Armed Tracks : creates a new, empty playlist on all all tracks that are record-

armed
• New Playlists for Selected Tracks : same, but for selected tracks

• Copy Playlists for All Tracks : copies the existing playlist on ALL tracks, and assigns a new new
name to the playlist

• Copy Playlists for Rec-Armed Tracks : creates a new, empty playlist on all all tracks that are
record-armed

• Copy Playlists for Selected Tracks : same, but for selected tracks

Naming Playlists
Whenever you create a new playlist (either an empty playlist or a copy), you will be prompted for a name.
You can just click ‘Enter’ to accept the default value.

It is also possible to rename a playlist after it is recorded. This action is available in the track ‘P’ Playlist
menu. If you rename a playlist that is part of a playlist-group, then all of the accompanying playlists on other
tracks of the same group will be likewise renamed, so they stay in sync.

Use playlist names to keep tabs on your best takes (“after lunch”) or parts of takes (“great guitar in 2nd
chorus!”)
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Record Window ‘Playlist’ buttons
The Record window has dedicated buttons for the most common playlist tasks:

• New Playlists for All Tracks : This is a good option if you want to completely empty the track
timeline, but keep the existing material as a backup. (you’re not actually deleting the prior material,
just stashing it away so you can return to it later)

• New Playlists for Rec-Armed : This is a good option if you want to clear the timeline on the tracks
you are recording, but some tracks (like a midi drummer or backing track) should remain unchanged.
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5.2. Audio Tracks

What is a track? How do I create one?
A track is the fundamental building-block of a Mixbus session. You can create new tracks by creating empty
tracks ( using the New Track/Bus dialog ) or by Importing existing audio files as new tracks. Mixbus
supports audio tracks and MIDI tracks. The track type (audio or MIDI) defines what kind of data you will see
in the editor.

What is an Audio Track?

An audio track is a series of audio regions, sequenced in a Playlist, that receive the same channel
processing (the eq, compressor, plugins, panning, bussing, etc )

Each audio region (sometimes called “clip”) is representative of an audio file on disk. The region might
represent only a small part of the audio file, because you can edit the region non-destructively: this means
that whatever you do to the audio region in Mixbus, it doesn’t actually change the audio in the file.

You can record new audio into an audio track at any time. Because Mixbus is non-destructive, the previous
audio on the track will be preserved, so you can always revert to the previous recording if you want to.

How do I edit an audio track?

The track’s Playlist defines the order of audio regions (files), as well as properties such as their mute state,
volume levels, fade in/out, etc. So when you are editing a track with the editing tools, you are actually
editing a Playlist. The various editing tools and features are described in the Editing chapters:

• Object (Region) Editing
• Range Editing
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5.3. Monitoring
Monitoring

“Monitoring” is the process of hearing the prerecorded tracks (and/or hearing yourself) while the transport is
playing. There are several options that control how Mixbus will monitor the inputs of each track.

When the Switcher is displayed, as shown in the picture below, you’ll find selection buttons for “In”, and
“Disk” at the top of each channel:

If the “In” button is selected as in the leftmost channel above, then the input to the track will be heard. If the
“Disk” button is selected as in the second channel, then you will only hear the playback of the track. If
neither button is selected, then Mixbus will use automatic monitoring to switch between In (as shown in the
3rd channel) and Disk (as shown in the 4th, rightmost channel). Automatic monitoring is represented with an
outline around the currently-selected option.

Monitoring preferences
Mixbus has 2 global preferences that control automatic monitoring. You select the mode with the pulldown
tab in Preferences->Monitoring:
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Automatic monitoring is also affected by the “Auto Input” mode, which is found in the Transport menu. “Auto
Input” is enabled by default. When Auto-input is enabled, then Mixbus will monitor record-armed tracks any
time that you are aren’t playing.

Record Monitoring Handled by: Audio Hardware This option is best used with audio
interfaces that have the ability to monitor the inputs to the interface. Some interfaces come
with a software application to control this while others may have a knob or button on the
interface to allow direct monitoring. Other interfaces may need to be configured using the
operating system’s volume control application. In this case Mixbus will never automatically
monitor the input, because you are going to use your hardware device to hear yourself.
When Hardware monitoring is available, it is generally a better option because it provides
lower-latency monitoring. However it does not allow you to hear the effect of Mixbus’s
processing or plugins, because you are bypassing the computer in your monitor path.

*

Record Monitoring Handled by: Mixbus This setting is also known as “software
monitoring”. With this setting, when Mixbus is recording audio it will route the inputs of the
record-enabled tracks through the tracks instead of playing back the previously recorded
audio. This is best used on systems that work well with very low buffer sizes (128 at 44 or
48 kHz or 256 at 96 kHz). Very small buffer sizes are used to minimize the monitoring
latency.

*
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Auto Input
Auto Input changes the behavior of the monitoring system in the case where (a) the transport is rolling and
(b) the master rec-arm is enabled. If Auto Input is disabled, then you will hear the Input being monitored
whenever a track is armed, even if you aren’t actually recording. If Auto Input is enabled, then you will hear
playback when the transport is rolling, and the tracks will only switch to Input when the master-record arm is
engaged (so you are actually recording). Auto Input is most useful when you are “punching in” on an
existing track … you want to hear playback up until you actually “punch in”, and then you want to hear
yourself only.

Auto Input Does Talkback
Finally, there is an option to enable “Auto Input does Talkback”. If “Auto Input does Talkback” mode is
enabled, then Mixbus will monitor the input of all tracks, even unarmed ones, during stop. In a multi-room
setup, this feature allows easier setup of your instrument or communication among members of a band,
because all the live mics are passed through to the master bus output so everyone can hear themselves
through the monitoring system (which might consist of foldback buses). This option only takes effect when
Auto Input is enabled in the Transport menu.

Mixbus Monitoring Modes Chart

The following chart shows how the monitoring interacts with various settings in Mixbus.

Monitor
Mode

Is The Track Rec
Enabled?

Is The Master Rec
Enable On?

Auto Input
Status

Transport
Mode

Meter Monitor

Normal No No On Stop
Track
(silence)

Track
(silence)

Normal No No Off Stop
Track
(silence)

Track
(silence)

Normal No No On Play
Track
(Audio)

Track
(Audio)

Normal No No Off Play
Track
(Audio)

Track
(Audio)

Normal No Yes On Stop Track Track

Note: in versions prior to v6, the option was called “Tape Machine Mode” and it had the
reverse effect as “Auto Input does Talkback”. The option was changed to (hopefully) make it
less ambiguous, and to change the default value so that Auto Input does not monitor all
tracks, only the rec-armed ones.

*
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(silence) (silence)

Normal No Yes Off Stop
Track
(silence)

Track
(silence)

Normal No Yes On Play
Track
(Audio)

Track
(Audio)

Normal No Yes Off Play
Track
(Audio)

Track
(Audio)

Normal Yes No On Stop Input Input

Normal Yes No Off Stop Input Input

Normal Yes No On Play Input
Track
(Audio)

Normal Yes No Off Play Input Input

Normal Yes Yes On Stop Input Input

Normal Yes Yes Off Stop Input Input

Normal Yes Yes On Play Input Input

Normal Yes Yes Off Play Input Input

Talkback No No On Stop Input Input

Talkback No No Off Stop
Track
(silence)

Track
(silence)

Talkback No No On Play
Track
(Audio)

Track
(Audio)

Talkback No No Off Play
Track
(Audio)

Track
(Audio)

Talkback No Yes On Stop Input Input

Talkback No Yes Off Stop
Track
(silence)

Track
(silence)

Talkback No Yes On Play
Track
(Audio)

Track
(Audio)

Talkback No Yes Off Play
Track
(Audio)

Track
(Audio)

Talkback Yes No On Stop Input Input

Talkback Yes No Off Stop Input Input
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Talkback Yes No On Play Input
Track
(Audio)

Talkback Yes No Off Play Input Input

Talkback Yes Yes On Stop Input Input

Talkback Yes Yes Off Stop Input Input

Talkback Yes Yes On Play Input Input

Talkback Yes Yes Off Play Input Input
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5.4. The Click (Metronome)
The Metronome (or click) can be activated by toggling the Metronome button in the upper left of the edit
window, or the associated keybinding.

Enabling this function allows Mixbus to generate a click that musicians can play along to. If a song is
recorded to the “click” then editing can be eased with “snap” settings that automatically select snap to
measures, beats, or subdivisions of a beat. ( see Editing with the Grid 5.5. Punch Recording >> for more
details )

Once enabled, a click sound will be produced when the transport is engaged. An audible click with an
emphasis will be produced at the first downbeat of every bar.

Right clicking on the metronome button is a shortcut to open the Preferences dialog box, where more Click
settings can be found including the specific sound and volume of the click.

Mouse-wheel (or vertical scroll, on a touch-pad) on the Metronome button as a shortcut to adjust the click’s
level.

By default, the metronome connects itself to the first 2 soundcard outputs, or into the Monitor if you are
using a monitor section.

Sometimes (particularly if you switch the “monitor” section on and off), the metronome will lose its
connection. To re-connect it, open Window->Audio Connections and restore the connection from the
metronome to your speaker outputs, like this:

If you are recording to the click, you should take care to set the tempo for the song before
you start.*

An audio file can be substituted for the default click sound.*
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5.5. Punch Recording

What is Punch Recording?
Punch Recording (sometimes called “Auto Punch”) is a method to let Mixbus automatically initiate recording
during a part of the timeline.

A common usage of punch recording is the case of a person recording themselves, during an instrumental
solo. The player would like to hear the audio playback up to the punch point, and then have Mixbus begin
recording automatically when the solo section is reached.

How do I punch-record?

To enable punch recording, you must define a punch-range and enable the Punch In/Out buttons:

1. Pre select a time-range to record (example: the guitar solo) by dragging the mouse in Range mode.
2. Enable the punch markers by right clicking in the range and selecting “Set punch from selection” or by

pressing the { key on your keyboard
3. Enable the Punch In/Out buttons in the transport toolbar. (If you don’t see these, you can enable them

in Preferences->Appearance->Toolbar
4. arm the track(s) and the master record on the transport. As the transport rolls, recording will only

occur as the playhead rolls over the defined area protecting existing audio before and after the range.

• If the “In” button is enabled, then Mixbus will initiate the transport Record-arm when the punch range
is entered.

• If the “Out” button is enabled, then Mixbus will stop recording when the punch range is exited.

It is a good idea to set your “punch” points slightly before and after the desired range; this
way you will capture slightly more audio in case you start playing slightly early or late. You
can trim the region(s) later.
*
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5.6. Pre-Roll Recording

What is Pre-Roll Or Count-In Recording?
These recording modes allow the user to hear some prior material, or a count-in, before recording is
initiated.

How do I Record with Pre-Roll?
Record-with-preroll is an action that may be triggered from the Transport menu or by using the < shortcut.

When this action is initiated with the playhead at location “A”, Mixbus will rewind the specified preroll
amount, and play through it, before reaching the playhead location “A” where recording is to begin. The
resulting region will start at “A”, but you can trim the region back to expose more of the recording, if needed.

How do I Record with Count-In?
Record With Count-In is very similar to record-with-preroll, but there are 2 differences:

• You hear only the metronome click before recording starts, you don’t hear the previous material
• The tempo of the metronome is that of the recording start-point, not the prior material

Use Record With Count-In if you want to record at the very start of the session, so you can hear a count-in
before the music starts. Alternatively, you can use record-with-countin if you don’t want to hear the prior

Another benefit of recording with pre-roll is that Mixbus is actually capturing your signal
during the count-in period. So if you start to record slightly early, you can advance the
region’s start time until your full performance is revealed.
*

You can adjust the Pre-Roll time in Preferences->Transport. You can set the pre-roll time in
either Seconds, or Bars (Measures)*
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material and you want to “punch-in” after a countoff of the previous tempo
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5.7. Recording with Varispeed
Varispeed is a traditional tape effect/technique where the tape speed was sped-up or slowed-down for the
recording, compared to the regular Play speed. Because you recorded at a different speed, the resulting
playback of that track would be slightly or dramatically detuned from the other tracks.

Varispeed recording is most-often used for one of these 2 tasks:

• Slow down a recording by one or two semitones, and play along at the lower pitch to master a tricky
solo, or retune a song to match a singer’s range.

• Change the recording by a few cents and detune your guitar to match: now record a shimmering
doubled guitar without having to use a different guitar for each pass.

The main controls for Varispeed is the “VS” button in the Transport area, and the resulting Varispeed dialog:

The “VS” button blinks red when varispeed is operational. Clicking the button, or closing the dialog, will
disable the varispeed setting. (the last-used setting is remembered so you can revert to regular playback for
auditioning, then re-enable varispeed for additional recording passes)

Watch this video to see how varispeed might be used artistically:
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https://www.youtube.com/embed/4LN9lr8tCeY?rel=0&autoplay=1&start=186&end=390
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6. Editing
In Mixbus, audio and MIDI data is presented as “regions” on a timeline. All editing operations apply to the
regions. Some of the things you can do to a region: move it, trim the start/end, set the fade-in/out length,
and adjust the gain. Additionally there are many, many ways that you can manipulate those simple features
of a region to accomplish your task:

• Using editing tools, like the “Range” tool: A “range” is a selection on the timeline that can span over
multiple regions, and make cuts or moves as if they were a continuous piece of audio.

• Using editing modes, like Ripple mode: if you make a deletion or insertion using Ripple mode, then
the later regions (to the right) will respond to your moves so you don’t have to re-shuffle them if you
make cuts earlier in the session.

• Using the Edit Point: You can choose to make edits on the location of the playhead (“what you hear”)
versus the mouse (“what you point at”). Sometimes it makes more sense to edit with one point, and
sometimes it makes more sense to edit with the other. Learning when to use each mode is an
important skill to develop.

• Using the Grid: You can use the “Grid” to limit your edits so they only happen on musical times (such
as measure, or quarter notes)

Combining these techniques gives you a nearly limitless opportunity to work with regions on the timeline.
Like the tools and modes of a drawing application, you have to learn the combinations of the tools to get
your work done most efficiently.

UNDO: with all of these ways to edit, it is unavoidable that you will make mistakes. Mixbus
provides an “undo” feature that allows you to revert your changes. Perhaps more
interestingly, Mixbus supports persistent undo. Each time you save your editing session, the
“undo” information is saved alongside the session in a separate file. Upon reopening the
session, you can still “undo” the edits that happened prior to your closing it. The main
session file, and each of the snapshot files in the session folder, have their own persistent
undo storage file.

*
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6.1. Edit Window Overview
Basic Editing Concepts

Users familiar with other DAW conventions will quickly adapt to the recording and editing features of
Mixbus.

Track Management

On the far left of the edit window, the Editor Mixer can be displayed via Menu>View>Show Editor Mixer.
The Editor Mixer is a single mixer channel strip that “follows” the selected track. To see all of the mixer
strips for the tracks and buses on one window, show the Mixer window. Alt+M ( or Ctrl+M for Mac ) toggles
between the Mixer and the Editor windows. Located near the top of the mixer strip is an Input button for
selection of the physical input that feeds the track. For example if you have 8 tracks but only a 2 input sound
card, you must route the inputs to the tracks as-needed.

The right side of the screen is a pull-out window which accommodates several different functions. Most
panels have a right-click context menu for additional features:

LOGIC users: you will notice that dragging a region to the blank area below the editor tracks
will automatically create a new track for the region. This is a quick way to separate out a
region and make a new track for it.
*
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• Tracks/Buses – drag & drop to reorder tracks, or click to show/hide them.
• Regions – shows all of the recorded or imported regions. Drag & drop from here into the editor.
• Snapshots – Click a snapshot to recall all of the settings in the snapshot.
• Edit Groups – Click the +/- buttons to create edit groups, and enable them.

Using Tracks

To the left of the editing canvas are the track headers.

You can select or deselect a track by clicking on the empty area. You may shift-click to select a range of
tracks, or Ctrl/Cmd-click to select and deselect individual tracks. Right-clicking the empty track area will
open the track context menu. Certain functions such as mute, solo, and record-arm can be applied to ALL
tracks simultaneously by Ctrl-Alt-Shift-clicking (Cmd-Opt- Shift-click). You can manipulate multiple tracks at
once by selecting them and then using operations from the “Track” menu in the main application. Hovering
the mouse near the bottom of the header causes 2 horizontal lines to appear allowing the track to be
resized vertically.

The “P” key on each track allows selection of the track’s playlist. Playlists can be used to enable multiple
takes in a single track, or the sharing of playlist data across multiple tracks. Some users create a new

Note: Normally “snapshots” are used as backup states. You store the snapshot and
continue working on the main session. Future “save” operations will apply to the selected
session, not the snapshots. If you prefer that future “save” operations go into the newly-
created snapshot, then you will want to invoke the “Save As” command.

*

Tip: You can also select tracks in the editor and use the “Move tracks Up/Down” command
from the track menu.*
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playlist for each recording “take” while others use Layers to manage takes.

Tracks also support automation of the fader, panner, and other processing parameters including those of
plug-ins. The “A” button in each track opens the automation menu which allows editing of automation data.
Each parameter has multiple dynamic automation states: Manual, Play, Write, and Touch. These control
whether dynamic automation will play back or be recorded while playing. Automation lines can be created
and edited with the Draw Mode (green box in the image below).

You may also select a Range of automation for deletion, or to raise/lower the selected range.

Groups

Tracks may be assigned to “edit groups” using the G button. When tracks are assigned to an edit group, and
the regions align exactly on the start and end times, then all changes to one track will be applied to all other
tracks in the edit group, regardless of whether the grouped tracks and regions are selected for editing. This
is very convenient for editing multitracked instruments. Another convenience is that some playlist operations
(such as “New”) will apply across the edit group. Edit groups are created and enabled in the Mixer List to the
right of the screen. To enable the Mixer List go to menu>View>Toggle Mixer List See more on Groups here.

Recording, Loops and Punch Ranges

Above the recording tracks is the “ruler bar” area (highlighted by the yellow box in the image below).

Note: In addition to edit groups, you can create mix groups from the mixer window. Mix
groups allow the same sort of features as edit groups, but they apply to mixing functions
such as fader, mute, solo and record-arm. This is another convenient feature for
multitracked instruments.

*

Tip: Holding “Shift” will temporarily override a mix group assignment for the fader and mute.
For example, if you have 2 tracks in a mix group, the faders will move together if you move
one. But if you would like to move a single fader without disabling the mix group, you can
hold “Shift” while you move the fader, and it will not cause the other grouped fader(s) to
move.

*
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Left-click anywhere in the ruler bars to locate the playhead. You can also locate the playhead to the current
mouse location with the “p” key. Right-clicking in each of the “ruler bar” areas will allow you to create
location markers (cue points), CD markers, tempo markers, or meter markers. Clicking and dragging in the
“range” or “loop punch” ruler bars will allow you to define song ranges, loop ranges, or punch in/out
ranges. Right-clicking on the ruler bar names will allow you to show or hide the various rulers.

Navigating in the Editor window: Zooming and Panning

The area of the editor where the regions is shown is called the “canvas”. There are several ways to navigate
(pan and zoom) the editor canvas.

Go to Menu>View>Zoom Focus to select the zoom focus. The “zoom focus” affects the operation of the
zoom buttons and the zoom key commands by changing the focal point for the zoom.

Zoom focus can be one of:

• Left: Zoom focus is the left side of the summary view gray box.
• Right: Zoom focus is the right side of the summary view gray box.
• Center: Zoom focus is the center of the summary view gray box.
• Playhead: Zoom operations will center on the playhead.
• Mouse: Zoom operations will center on the mouse position (only makes sense when using the zoom

keyboard commands; when buttons are clicked the Playhead is used as zoom focus).
• Edit Point: When the Playhead is the Edit Point, it is used for zoom focus.

In addition, there are several scroll-wheel commands that can be used to navigate the editor canvas:

• Scroll: Scrolls vertically.
• Shift+scroll: Pan the editor canvas left/right.
• Ctrl/Cmd+scroll: Increase/decrease the zoom (note: this always uses the Mouse as zoom focus).
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• Alt/Option+scroll: Increase/decrease the height of the track that is currently under the mouse.

The Transport Menu and Toolbar

Many items in the Transport Menu and Toolbar are self-explanatory. For more details click here
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6.1.1. The Editor List
Track and Bus Management in the Editor

To the rightmost side of the editor window you can display the Editor List (Menu>View>Show Editor List).

On the right side of the Editor List there are several tabs. The tabs that may be selected are:

- Tracks & Buses
- Sources
- Regions
- Snapshots
- Track & Bus Groups
- Ranges & Marks
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6.1.1.1. Tracks & Buses Tab
Selecting the “Tracks & Busses” tab will show the status of all of the tracks and buses in use. The Tracks/
Buses tab is used to manage tracks. You can click on the checkboxes to hide/show tracks, and you can
drag/drop the tracks to change their order.

Features of the “Tracks & Busses” tab

• Name: Clicking on name will show that track/bus at the top of the Edit Canvas. Double click to rename
the track/bus

• V: Toggles the track or bus to Visible/Invisible in the edit canvas
• A: Toggles the track/bus to Active/Inactive
• I: MIDI input Enable/Disable
• R: Rec enabled button/indicator
• RS: Record/Safe button/indicator
• M: Mute button/indicator
• S: Solo button/indicator
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• SI: Solo Isolate button/indicator
• SS: Solo Safe Lock/Unlock

Tracks/busses can be reordered by clicking while dragging the track to the desired location.

A right-click menu provides these options:

• Hide/Show all.
• Hide/Show all tracks.
• Hide/show all buses.
• Hide/show all MIDI tracks
• Show tracks with regions under playhead (only shows the tracks that have active audio regions right

now).

Right clicking anywhere within the tab displayed calls up a context menu. “Show Tracks
With Regions Under Playhead” is a method which allows the users to quickly maximize the
editing canvas space.
*
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Double-click on a track to jump the editor to show that track.
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6.1.1.2. Sources Tab
The “Sources” tab shows the file sources used by the session, and whether they are used in the current
snapshot or not.

You can click on the sources in the list to select an entire track (or set of tracks). The example below shows
the bass track highlighted.

Right clicking anywhere within the tab displayed calls up a context menu. On this tab this
displays the source removal control.*
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6.1.1.3. Regions Tab
This shows the audio regions that have been recorded or imported into the session. The full-length audio file
is shown and the underlying “regions” are the different excerpts from it. You can grab a file, or a region
excerpt, and drag it into the timeline.

Pointing at a file shows the path to the file on your disk(s)

Right-click on a region entry to:

• audition (simply plays the wave file, outside of any context in the mix)
• hide
• Import a new file to the list (see: Import)
• Delete any regions that aren’t used in your session (see: cleanup)

For convenience, the table shows you the region’s start time, length. In the current version, these properties
cannot be modified.

It also shows properties such as muted, locked, etc. (see Object Editing) which CAN be modified.
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Right clicking anywhere within the tab displayed calls up a context menu. Various controls
such as layering and gain controls are presented.*

Harrison Consoles Mixbus - 9_en

Page 170 of 848



6.1.1.4. Snapshots Tab

The snapshot list:
A “snapshot” is a complete recall all of the track, region, mixer strip, and plug-in information.

All of the snapshots share the same session audio data; this means you can have multiple “snapshots” ( i.e.
songs, mixes, or remixes ) without recreating copies of all the audio data.

Double-click a snapshot to select the snapshot.

The current snapshot is highlighted, to show which snapshot file you are currently editing. (this is the file
that gets overwritten when you choose “Save” from the main menu)

Snapshots are also accessible in the New Session Dialog, when launching Mixbus. See “Starting a
Session”
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6.1.1.5. Ranges and Marks Tab
The Ranges & Marks tab summarizes 3 editor functions:

- Loop/Punch ranges: time ranges where looping or punch-in recording are active
- Markers: times where a marker has been placed
- Ranges: time ranges that have been defined in the editor
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6.1.1.6. Clips Tab
The Clips tab is identical to the Clip List on the Cue Page

Clips dragged to the editor timeline do not automatically loop or stretch to meet the session’s timeline. They
will appear as normal audio or MIDI regions on the timeline.
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6.1.1.7. Arrangement Tab
The Arrangement tab is used to quicky re-arrange your song arrangement (typically Verse and Chorus
sections).

Before a section can appear in the Arrangement tab, it must be assigned an Arrangement Marker in the
Arrangement Ruler:
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6.1.2. Track Headers
The “Track Header” provides quick access to key functions

Red Dot: record-arm
M: Mute Button
S: Solo Button
P: Playlist Button : see Editing with Playlists
A: Automation Button : see Automation
G: Group Selection Button : see Groups

The horizontal slider servers as a fader.

Right Clicking in the track header pulls up a context menu.

Selected tracks can be muted, solo’ed, record-armed or gain-adjusted directly from the keyboard.

Track Height
The waveform displayed in the editor canvas area can be made to appear larger or smaller by simply
hovering the cursor near the bottom of the track header. A double arrow and 2 lines will appear, at this point
click and drag the cursor downward to increase the size, or click and drag upwards to decrease the size.
You can perform this action to multiple tracks at one time by shift clicking a range of tracks or ctrl clicking for
discontiguous selection.

Alternatively the menu item Track>Height will provide additional methods.
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For additional information about track size and zoom, click here

For additional information about track reordering, naming, or selecting, click here

This action has no effect on the gain of the track, it is simply a visual aid.*
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6.2. Auditioning
Before you can edit, you must be able to hear what you are editing. Mixbus supports 2 different kinds of
auditioning:

Auditioning a raw sound file or region with the “Auditioner
Path”:
Mixbus provides a secondary audio path called the “Auditioner”. Whenever the Auditioner path is in use, the
“Audition” button will blink in the top of the Editor.

Typically, you will audition files through the Import dialog. On the right side of the dialog, you will find a fader
and meter that control the level of the auditioned file.

You can also audition regions that are shown in the editor by right-clicking on the regions and choosing
“audition”. This will start playback from the beginning of the region. You may also audition the regions in the
region list, to the right of the editor window. This is useful if you have a list of often-used soundfx imported
to the session already.

By default, the “auditioner” path is routed directly the first 2 outputs of your soundcard. You can choose a
different destination for the auditioner path.

If you have a “monitor” bus enabled, then the auditioner will feed the monitor bus automatically.

Auditioning a sound in-place with the “Audition Action” in
the editor:

MIDI files, of course, must be rendered to audio before they can be auditioned. You can set
the default MIDI-file renderer (for auditioning) in Preferences->MIDI.*
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https://www.youtube.com/embed/VAEx2MPPCX8?rel=0
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6.3. Regions and Ranges
Editing in Mixbus is based on two closely related but different ways to select audio in the Editor window: the
“Region” and the “Range”.

Regions

A Region is also commonly called a “clip”. It is a piece of an audio track spanning a defined period of time. A
track can comprise one Region, or a track can be composed of multiple Regions. A Region can be edited
and manipulated in many different ways, which will be presented in the next topic of this manual. Regions
can be created by recording a track, importing a file, pasting a selection into an existing track, separating
part of a track into a new region, or drawing a new MIDI region.

This picture shows that one track in this session is comprised of 3 Regions. The middle Region in this track
is highlighted in red. The other tracks in this session are comprised of only one Region.

Ranges

A Range is a selection of one or more audio tracks spanning a defined period on the timeline. A Range can
also be edited and manipulated in many different ways. The track selections within a range can contain
portions of or entire Regions of a track.
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This picture shows a Range selecting a time slice of several tracks. As most of the tracks are made of only
one Region, the Range is selecting only part of their Region. However note that as in the previous picture
the keys track has 3 regions. The Range selection is selecting the entire second Region, but only part of the
track’s first and 3rd Regions (which in this case extends to the end marker of the session).

Separating a Region Out of an Existing Track

Let’s say you need to tweak part of an existing track without affecting the other parts of the track. To
separate out a new Region on a section of an existing track (which may itself have one or several regions),
first select the Range tool (or click the keyboard shortcut ‘R’):
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Next, use the range tool (by left-click and drag) to select the desired timespan on the track that will be made
into a new region:

Hover the cursor over the highlighted timespan and right click, then choose “Separate” (or click the
keyboard shortcut ‘S’):
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The selected timespan will now be in a separate Region from the rest of the track. This Region can be
edited and manipulated separately from the rest of the track, for example fading it in and out at its
boundaries, giving it a different gain scaling from the rest of the track, and numerous other options.
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6.4. Object (Region) Editing

Click above for video instructions.

Object (Region) Editing

The basic element of audio editing in Mixbus is the Region. Another common name for a Region is a “clip”.
A region represents an audio file (or a portion of an audio file) on disk. Regions can be moved, stacked,
trimmed, copied, deleted, and otherwise edited. The maximum length of a region is the length of the file that
it uses as a source, but it can be much shorter. A region might represent just a small segment (such as one
syllable or drum hit) from the source file. Editing or deleting a Region does not change the source file in any
way. This is called non-destructive editing. Audio regions can only exist on audio tracks. You cannot drop an
audio region onto an audio bus, or a MIDI track. Similarly, a MIDI track can only hold MIDI regions.

https://www.youtube.com/embed/aFWfLfrn_vU?rel=0
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Regions have several “hot spots” that can be modified using the left mouse button when in Object or Smart-
Object mode. Object edits follow the Grid selection, so operations will snap to the nearest Grid location if it
is turned on.

The fastest way to learn about region actions is to right-click on a region. This will provide
a list of operations that you can apply to the selected region(s). The items in the Region
menu (in the main application menu) may also be applied to any selected regions. If you
don’t have any regions selected, then most of the items in the Region menu will be
disabled.

*
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Move Click in the waveform area to drag the region in time or across tracks.

Start/End
Trim

Near the start/end of a region, the mouse will change to a “trim” tool, allowing you to trim
the start/end of the region.

Fade In/
Out

Grab the handle in the top corner on either end to change the region’s fade.

Fade
Length

Grab the handle in the lower corner to lengthen or shorten the region’s fade time, while
leaving the endpoint of the fade fixed.

Additional mouse commands on regions include:

Middle-click
drag

Drag the region, overriding the edit mode. If the mode is Slide, then the region will be
locked in time and will only move up/down across tracks. If the edit mode is Lock,
then this will override the lock and allow the region to slide side-to-side in time

Ctrl-click drag Drag the region, while making a copy

Ctrl/Cmd-left-
click on region
start/end (slip
edit)

Slide the contents of the audio file inside the region, leaving the region
start and end times intact

right-click
anywhere in a
region

Open the Region Context menu (see below)

right-click in
the crossfade
area

Change the shape of the fade in/out

Tip: When you move/drag a range, it becomes visibly transparent. This allows you to see
the regions underneath. This sometimes helps if you are recording an overdub or replacing
one drum sound with another.
*

Tip: You can select multiple regions at the same time using Ctrl/Cmd-click or selecting them
with a rubberband box. Regions selected this way will edit together: you can move, trim, or
fade them all at the same time.
*

Tip: Combining the Trim, Fade In/Out, and Fade Length, you have complete control when
assembling a crossfade between two regions. With these operations you can find the
perfect location and length of a crossfade with a minimum of effort.
*
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For more keyboard shortcuts view Keyboard Shortcuts

Region Layers

Regions may be stacked on the same location in the timeline. This is called “layering”. Normally only the top
region is heard; it covers the audio regions below it. However there are cases where the region below can
be heard. One example is the top region’s fade-in or fade-out. Region fades operate as crossfades. If a
region is stacked on top of another region, then the region underneath will audibly “fade out”, while the
topmost region “fades in” across the length of the crossfade. The second way to hear a region below the
topmost region is if the topmost region is not *opaque *(the Opaque flag can be turned off in the Region
menu and/or the right-click Region context menu).

Region layering can be changed on-the-fly by the user. Try right-clicking on a region to change its layering.
Layering is one way to manage multiple “takes” of a performance. Each time a track is recorded, a new

Note: For many region operations, you don’t have to actually select the region. Just hover
the mouse over the region, and use the shortcut key. The shortcut keys are listed in the
Region menu. This is a fast way to mute/unmute regions in a session, for example.
*

https://www.youtube.com/embed/iLmHPtUiU5Y?rel=0
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region is written onto the topmost layer. But the layers underneath still exist. There are global options that
define the default behavior of crossfades and layers. While the defaults are suitable for most users,
understanding these options can be very important for advanced users (see Crossfade and Layer Modes in
Section 26.0 Mixbus Options).

You can see the stacked “takes” by right-clicking on a track header and choosing Layers->Stacked.

Mixbus can create a loop and record stacked takes. Just define your loop range, then define a “punch”
range inside it, and start rolling. Each successive recording pass will generate a layer on top of the
previously recorded regions.

Audio region fades

Every Audio Region has a fade-in and fade-out. By default, the region fade is very short, and serves to de-
click the transitions at the start and end of the region. By adjusting the region’s fade length, a more gradual
transition can be accomplished. Important: In Mixbus, each region’s fade is a crossfade with the audio below
it. In other words, if the beginning of a region overlays a region(s) below it, you will hear a gradual fade from
the underlying region(s), and a fade-in of the topmost region.

You may right-click on a region’s fade-in or fade-out to choose the shape of the fade.

Deactivate: The fade is completely deactivated. The audio in the region will be heard exactly as-is.
Linear: Cuts off abruptly at lower levels. Used as a crossfade between 2 audio regions. The signals are
each -6dB attenuated at the midpoint. This is the correct crossfade to use with highly-correlated signals
(such as test tones) for a smooth transition. This mode is rarely used on “real” material because you will
hear a distinct dip in the middle of the crossfade.
Constant Power: Used as a crossfade between 2 audio regions. The signals are each attenuated -3 dB at
the midpoint. This is the correct crossfade to use when you want to smoothly fade from one sound into
another.
Symmetric: This is not mathematically correct like the Equal Power or Linear curves, but it provides a
slower fade-out at low volumes. This is sometimes useful when editing 2 entire music works together so that
the transition is more gradual.
Slow: Normally used as a region fade-in or fade-out. This curve is similar to gradually lowering a fader. It
starts very gradually but then rapidly fades to silence. It is well-suited to fading out the end of a song.
Fast: Normally used as a region fade-in or -out. The level is reduced at a constant-dB rate, so it sounds
very smooth.

While it can be tempting to manipulate the crossfade shape, the location of a crossfade is
far more important than the crossfade shape. Placing a short crossfade before a loud
transient (like the downbeat of the new material) is generally the best and easiest way to
make a crossfade, and the “shape” of the fade is essentially moot.

*
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Region Context Menu

The region context menu (launched by right-clicking a region) has many of the same operations as the main
Region menu. The Region context menu always operates on the single region that was right-clicked on,
while the Region menu operates on all selected tracks. Many items in the Region Menu are self-explanatory.

Region Gain

Every region in Mixbus has a level control (called Region Gain in some menus) that applies to the whole
region. The Region’s level can be modified by the Region menu, or from the right-click context menu:

• Increase/Decrease Region Gain (Increase is limited to +10 dB)
• Reset Region Gain to Unity
• Normalize (Raises or lowers gain so that the highest value in the region is 0 dBFS, limited to +10 dB

max gain)

The Normalize entry will say “Denormalize” if the region is already normalized. This will return the region
gain to unity.

Description of Region Properties:

• Mute
• Opaque
• Lock
• Lock to Video: this is set when a video is imported with sound. The resulting regions have the “video

NOTE: MIDI regions do not have have fades*

Note: If you normalize a region, it will raise the region gain so that the waveform shown in
the region reaches 0 dBFS. If the region is extended to represent more of the underlying
audio file, this audio may reach above 0 dBFS.
*

Note: Mixbus has 5 built-in gain stages in a track: Region Gain, Region Envelope, Input
Trim, Fader, and Makeup Gain (when compressor is enabled). Each gain stage serves an
important purpose, and the combination of these stages makes it easy and fun to mix in
Mixbus.

*

Tip: Simply point the mouse at the region and use the gain up/down key to quickly adjust
region gain. You can also select multiple regions at once and then use the region gain key
commands to raise or lower all the regions simultaneously.
*
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lock” enabled so you can’t accidentally nudge them out of time with the video. This is separate from
the normal region Lock function. You must disable this lock before you can move the region on the
timeline.

Region Specific Editing Options

In the picture below a particular region (called 10.4) has been selected. Notice that there are a considerable
number of editing options available by right-clicking on the selected region. “Gain” as discussed above is
just one of the available options. Many of these options are only available by right-clicking directly on the
region and will not be displayed on the “Region” pulldown at the top of the screen, even if a particular region
is selected. The same editing options are made available when right-clicking on the desired region in the
Editor List which is also shown here. Notice how region 10.4 is highlighted in the Editor List when it is
selected on the waveform.

In this picture the user has selected the pitch change option.
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Nudging

What is “Nudge”?
Nudge has a lot of meanings.

If there is a selection on the timeline ( like some Regions, Markers or Notes), then clicking “nudge” will move
the selected items.

If there is no selection, then Nudge will move the playhead.

What is the “Nudge Clock”?

How do I nudge?
When a REGION (audio or MIDI) is selected for nudging,

• if Snap is enabled in the editor, then the Grid selection (quantization) is used for the nudge size
• if Snap is disabled, then the nudge clock value is used.

When a MIDI NOTE is selected for nudging,

• if Snap is enabled in the editor, then the Grid selection (quantization) is used for the nudge size
• if Snap is disabled, then the nudge clock value is used.
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6.4.1. Region Groups
Region Groups allow you to associate regions with each other. Associated regions will respond to ‘selection’
together

Implicit region groups: facilitate edits in a track-group

Region-groups are implicitly assigned when you record, import, or paste new regions to the timeline. You
can access these groups by making a track group (like: Drums). Now, all the ‘takes’ of a recording will be
implicitly grouped for you. Splitting any grouped region(s) will retain their relationship. The associations
between tracks are now much better retained, even if you use overlapping region layers and crossfades that
cause the regions to start & end at different times. The regions remember which ‘take’ they belong to.

Explicit region groups: connect groups regardless of their track or track-group
affiliation

To Group regions, you should first select them, and then right-click to access the context menu, or open the
main menu->Region:

By default, you can use the shortcut Cmd+G (Ctrl+G on PC) to “group” your selected regions. Or use
Shift+Cmd+G to ungroup the selected regions.

Explicit region groups can span multiple tracks: if you want your regions to select & edit together across
multiple tracks and track groups, just assign them to a group and have your way!

Un-grouping your explicit region groups:

Alternatively, if regions are selecting together and you don’t like it, it you can explicitly un-group them to
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break the relationship, even when the track group is trying to enforce it.

Overriding the region group:

You can momentarily override region groups with the Ctrl/Cmd modifier, if you just want to grab “one”
region.
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6.5. Editing Tools & Modes

Click above for video instructions.

Edit Modes

The edit mode selector is to the far left, directly underneath the transport controls. There are 3 different
editing modes when moving regions:

circled in yellow in the image above, you may select:

1. Slide is the normal mode that allows regions to be moved without any limitations.
2. Lock allows trimming, fades and track shuffling, but does not allow the region to be moved in time.
3. In Ripple mode, changes to a region are “rippled” to other regions on that track in the future. For

example, deleting a Range or Region will move the regions after (to the right of) it, to the left. Thereby

https://www.youtube.com/embed/uwOwtYJDSZ0?rel=0
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closing the gap. Learn more : Ripple Editing

Editing Tools

The Edit Toolbar allows selection between several different editing tools. Each tool also has an associated
shortcut key, and can be changed via the Edit menu.

Object Tool ( see Region Editing )

The object tool appears as a “pointer finger” icon while hovering over regions. Just a few of the operations
of the Object tool include:

• Click on a region to select it for editing, or drag a region to move it.
• Click inside the colored bar at the bottom of a region to trim the start or end points.
• Click on a region’s fade-in or fade-out handle to adjust the fade length

Range Tool

The Range tool allows the user to select and drag across a range of time. The time-range can span across
multiple tracks and regions, as if the range were a contiguous piece of audio tape. Tracks that are selected
in the current range are highlighted red in the edit window. You can add or remove tracks to the selection by
clicking with the mouse.

• Drag across a range of time to create a contiguous selection.
• Grab the edges of the selection to lengthen or shorten each end of the selection.
• Right-click on the selection to launch a menu that allows looping, bouncing, exporting, consolidating,

or analyzing the selection.
• Use the functions in the Edit menu to cut/copy/paste or otherwise manipulate the selection.

( see: Range Editing for more details about the Range tool)

If the “Smart” button is selected, the Object tool will also gain many features of the Range
tool; see “Smart Editing” below for more details.*
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Cut (scissor) Tool

The Cut tool allows you to split any region(s) under the cursor.

TimeFX Tool

The TimeFX (“stretch”) tool allows the user to stretch regions to be longer or shorter, without changing the
region’s pitch.

To use the TimeFX tool, drag on a region to lengthen or shorten the region. This will launch a dialog:

• Strict Linear: Click this to force Mixbus to use a simple resampling method (not typically used with

How to “Scrub”: “Scrubbing” is a term used for auditioning a short piece of audio – perhaps
by dragging the cursor over the desired audio. Mixbus doesn’t have a dedicated “scrub”
tool, but you still scrub effectively by starting playback, and then holding down the “P”
shortcut while pointing the mouse where you want to listen. The “P” shortcut will locate the
playhead to wherever you point the mouse.

*
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musical content).
• Contents: Choose an advanced resampling mode that best matches the sound of the region.
• Stretch/Shrink: Initiates the stretch operation.

Draw Tool

The Draw tool allows the user to draw midi notes and automation control points.

• Click inside a MIDI region to create a MIDI note event. Drag to set the length of the note
• Click on a region to create a new gain automation point. For more details, see “Region Gain and

Automation”.
• Click on an automation track to create a new automation control point

Contents Tool

The Contents tool allows the user to edit the “internal” contents of a region. For example you can use this
tool to select midi notes inside a region and move or delete them.

• Click and drag inside an audio region to select region gain control points
• Click and drag on a MIDI note to move it
• Click and drag inside a MIDI region to select one or more MIDI events
• Click and drag inside an automation track to select automation control points, and then move or delete

them

“Smart” Editing

When Smart Mode is engaged, the “Object” Mouse mode takes on some of the features of the Range mode.
The top-half of a track operates in range mode (allowing the user to drag-select a time range on one or
multiple tracks). The bottom-half of the track operates like Object mode, allowing the user to grab a single
region, or rubberband-select a group of regions. Other features of Object mode (such as trimming regions or
adjusting fade lengths) are still possible in this mode. The cursor will change to show either Range or Object
tools when the user transitions from the top of the track to the bottom of the track. “Smart” mode is only
lighted when the Object (hand) tool is engaged, but the Smart setting is remembered at all times.

Selection conventions

Selected items ( Regions, Tracks, MIDI Notes, Plug-ins, or Automation Control Points) will be outlined in
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RED.

Selection categories ( tracks, plugins, regions) are mutually exclusive. In other words, you can only have
Region(s) or Track(s) selected at one time. For example, if you have a Region selected, and you select a
Track, then the Region will be de-selected.

A Range selection implies a single time range selection and one or more Track selections. Range and Track
selections work together, they are not mutually-exclusive. You can’t have a Range selection without a track.
A Range selection implies that one or more tracks are selected. However you CAN have one or more Tracks
selected without a time range.

This convention makes it clearer, for example, what will be deleted when you click the “Delete” key.

Pressing the ESC (Escape) key will clear all selections.

Operation Priority

When an editing operation occurs, Mixbus must determine where the operation applies. This depends on
many factors including the type of operation, the location of the Edit point, the existence of a selected
Range, and Track Selections. Most of the time Mixbus will do exactly what you expect it to. If not, then it
might be due to an unexpected operation priority. See the table below.

Delete Functions:
Object (Region)
Editing Functions:

Edit Point Functions:
Range Editing
Functions:

Nudge
Functions:

Example: Delete,
Backspace

Example: Mute,
Normalize, Reverse,
Transpose

Examples: Split, Trim,
Align

Examples:
Separate,
Crop,

Examples:
Nudge

Priority:
1. Any Selected

Range,
2. Any Selected

Regions,
3. The region

directly under
the mouse (even
if the region isn’t
selected), IF the
Edit Point is
“Mouse”

4. Selected Plug-
ins

5. Selected MIDI
Notes

Priority:
1. Any Selected

Regions,
2. Any regions on

selected tracks
under the edit
point (even if
the regions
aren’t selected)

3. A region directly
under the
mouse (even if
the region isn’t
selected), IF the
Edit Point is
“Mouse”

Priority:
1. Any Selected

Regions at the
Edit point,

2. Any regions on
selected tracks
under the edit
point (even if the
region isn’t
selected),

3. The region
directly under
the mouse (even
if the region isn’t
selected), IF the
Edit Point is

Priority:
1. The

selected
Range

Priority:
1. Any

Selected
Regions

2. The
Playhead
(if
nothing
else
selected)

Harrison Consoles Mixbus - 9_en

Page 197 of 848



6. Selected
Automation
Control Points

“Mouse”

The Edit Point

Functions on regions such as splitting, trimming, and pasting will happen at the currently defined edit point.
The edit point can be the mouse cursor or the playhead. Mixbus allows you to choose between the two
modes on the fly using the edit point button.

in the above image the Edit Point is set to “mouse”.

The settings for Edit Point are:

• Playhead : Mixbus will use the Playhead position to determine the location of an edit.
• Mouse : Mixbus will use the Mouse cursor position to determine the location of an edit.

Note: In order to use the Mouse edit point, the mouse must be located inside the editing
area. This means you can’t use commands from the “menu”, because Mixbus doesn’t know
where you are trying to apply the edit. So if you want to use the Mouse as your edit point,
you’ll need to learn some of the basic editing keybindings ( such as “S” for split, and “J”/“K”
to trim the start/ends of regions)

*

Tip: Another advantage of using the mouse is that Mixbus can guess which track you want
to edit without having the track explicitly selected. In other words: in Playhead mode,
Mixbus has to know which tracks (or regions) are selected before it can edit. In Mouse
mode, if no tracks or regions are selected, then Mixbus will assume you want to edit the
region you’re currently pointing at. For these reasons, the Mouse mode can be faster for
experienced users.

*

Tip: However some users like to edit with their “ears”, and in this case choosing Playhead
as the Edit Point might be the preferred choice. Using Playhead mode, you can use your
ears to start fades, trims, and selections while the playhead is rolling. Selecting the track(s)
that you want to work on means that you can operate the editor using only the keyboard and
your ears, without referring to the screen at all!

*

Tip: In both Mouse and Playhead mode, all of the keybindings work. For example, the “,”/”.”*
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keybindings can be used to mark the start and end of a range selection while playing
through a section in Playhead mode.
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6.5.1. Grid Tool
The Grid Tool is a special tool that does not affect regions on the timeline directly; instead, it adjusts the
musical grid (ruler lines) to match them to a live performance of either Audio or MIDI on your timeline.

When the Grid Tool is activated, you’ll notice that the cursor changes to represent 2 different cursor modes.
Measure lines can be assigned a tempo; whereas ‘beat’ lines can only tweak the ramp between 2 tempo
markers.

• clicking on a measure line where no tempo marker exists, will immediately create a new tempo marker
in the tempo ruler

• dragging on a measure line that already has a tempo marker, will warp the position of the tempo
marker without moving any prior or later tempo markers

• dragging a measure line beyond the ‘last’ tempo marker will set the tempo of the immediately prior
marker, and also continue that tempo through the last marker

• dragging on a measure line that is between 2 tempo markers will adjust the prior and middle marker,
without moving the position or tempo of later markers

• dragging a beat line will ‘ramp’ or ‘warp’ the tempo between 2 tempo markers. This accommodates a
band’s natural tendency to speed up or slow down in the final beats before going into a new section
(chorus or breakdown or …)

When mapping a performance, you’ll want to start by locating a measure line on the first
beat of the song, and then advance through the song from left to right. Typically you will
only advance one or several measures at a time. It is not important that the measures or
beats land ‘exactly’ on the beat, because you can go back and fix that later. However it is
important that the correct number of measures or beats are counted-off during the process.

*
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Advanced users: if you have multiple songs on a timeline, or some other reason to require non-contiguous
tempo markers, then you should investigate BBT Markers. BBT Markers will prevent tempo-changes from
propagating through the entire tempo-map.

If you create a measure line for 4 bars, but only 3 bars have elapsed in the performance,
then it will require manually deleting or undoing the tempo markers after that change, to fix
it.
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6.6. Range Editing

Click above for video instructions.

Range editing allows you to select and delete contiguous selections of times, on multiple tracks, without
worrying about the individual regions in the track. Once a range is selected, the most common operations
are:

• Delete everything inside the Range by clicking Delete or Backspace
• Cut or Copy the Range to the paste buffer
• Use the Edit menu to operate on the range
• Right-click on the Range to perform one of many tasks

• Play Range : Locates the transport to the start of the range, plays through it, and stops at the end.

• Loop Range: Sets loop makers in the ruler bar and loops the range.

https://www.youtube.com/embed/gWs9TWv91fg?rel=0

The fastest way to learn about Ranges is to create a range on the timeline, and then right-
click on it. This will provide a list of features that you can accomplish with the selected
range. Most of the items in the “Edit” menu are also applicable to the selected range.
*
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• Zoom to Range: Re-sizes the canvas to accommodate the range.

• Spectral Analysis: Performs spectral analysis on the regions within the range.

• Optimize Polarity click here for more

• Move Range Start to Previous Region Boundary, etc: these functions help to fit the range to the
boundaries of nearby regions ( you can also use the Grid for this task )

• Separate : Splits the Region(s) inside the range, on each of the start/end boundaries of the Range.

• Select All in Range : Selects all the regions that are touched by the Range selection. ( Note: there’s
also “Edit->Select->Select all within Edit Range” which only selects the regions completely inside the
range)

• Set Loop from Selection : Sets the Loop Start/End markers to match the Range selection

• Set Punch From Selection : Sets the Punch In/Out markers to match the Range selection

• Set Session Start/End from Selection : Sets the Session Start/End markers to match the Range
selection

• Add Range Markers : Creates a new “Range Marker”, which is a persistent pair of start/end markers
that can be used to re-select later, name CD track indexes, or stored as an export range (for example,
a song in a multi-song project, or an excerpt of a song).

• Crop Region to Range : Trims the region start and end points to fit within the Range

• Fill Range with Region : Using the selected Region in the Region list, this fills the range with enough
copies of that region to fill the range.

• Consolidate Range : Removes all the region data in the Range, and renders all the regions into a
single region (and audio file). This file incorporates all region gain setting, region gain automation, and
fade in/out settings for the included regions.

• Bounce Range to Region List : Combines all the selected regions in the range, and creates a single
audio file that will appear in the Region List of the edit window.

• Export Range… : Launches the Export Dialog with the selected range defined as the export time
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6.6.1. Section Editing
When copying a ‘section’ of a song (like the chorus, verse, or similar), it is desirable to operate on the entire
timeline. Section Editing provides a way to re-arrange your timeline including the timeline data like unused
playlists, hidden automation lanes, and markers.

When you make a Region or Range selection (regardless of which tracks you select) you will see the
extents of your selection represented in the topmost time ruler. This represents the timeline extents that you
can Copy or Paste to another part of the timeline:

New actions in the Edit menu: “Cut/Paste Section” and “Copy/Paste Section” are now available. Watch the
video, below, to learn more!
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https://www.youtube.com/embed/j_FLOTmCtOQ?rel=0

in 9.1, the tempo-map is not copied with the timeline edits. A dialog warning appears if you
try to paste to the timeline, when multiple tempo markers exist on the timeline.

!

this feature is under development and will be extended to support 4-point edits and a
persistent ‘section ruler’ that allows reordering by dragging-and-dropping of named
sections.

!
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6.6.2. Automation Range Editing
Select a range of automation or region-gain, and drag the whole range of control points up/down.

• Click the “R” key to select the Range tool.
• Sweep a range across a Region, OR on an automation track.
• Click “D” to switch to the Draw tool.
• Click in the selected range, and drag up/down to move the automation line up/down during that time.

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0&start=135
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6.7. Ripple Editing

What is Ripple Editing?
A “Ripple” edit means that any changes you make on the timeline should be reflected in a change to the
regions ‘later’ (to the right) on the timeline.

For example if you delete a cough or ‘ummm’ from a voiceover, you might want the later regions to move
‘left’ to close the gap that was originally filled with the cough or ‘ummmm’.

Ripple editing is rarely used in a music project (except perhaps to remove the pauses between complete
songs).

What operations are affected by Ripple?
• If you select a time-range with the Range tool and Delete (or Cut) that range, then the events to the

right will ‘ripple’ leftwards to close the gap
• If you select a Region, dragging the region left or right will ‘ripple move’ the regions to the right by the

same amount

Types of Ripple Editing
When you select “Ripple” in the Edit Mode menu, an additional menu appears which allows you to select
one of 3 options for rippling:

• Selected: in this mode, the selected tracks will respond to the ripple edit, when possible
• All: in this mode, your Range and Region selections are always applied to ALL tracks, and any

timeline deletions or moves will also be reflected in the ruler markers
• Interview: in this mode, intended for use when 2 or more people are conducting a chat or interview,

you can cut one track without it rippling (for example, to remove a cough from one guest). But if you
select more than one track, Mixbus assumes you want to cut out that time on the other tracks as well.
In this mode the ruler markers do not ripple.

Ripple Edit demo
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https://www.youtube.com/embed/O_Zfrz4B3Zw?rel=0
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6.8. Snap and Grid

What is “Snap” and “Grid”?
Snap will cause mouse drags to jump to the nearest snap setting.
Snap can be set to multiple options: markers, region start/ends, Playhead, and the Grid. ( those are all
enabled by default, but you can change them in Preferences->Editor->Snap )

Grid can be enabled, and it will draw lines at selected intervals; which can be musical, like 16th notes, or
can be timecode based ( minutes and seconds ) . You can leave the Grid enabled, but snap disabled, if you
just want to see the lines but not snap to them.

For example: if the Grid is set to “beats” and Snap-to-grid is enabled, then any operations such as split,
paste, or range-select will happen exactly on a beat, according to the musical timeline and tempo.

Alternatively, you can leave “Snap” enabled ( so your mouse actions can snap to Markers, or region edges )
but disable the Grid.

The grid consist of lines running vertically in the edit canvas. If you zoom too far out, you
might see a coarser grid than you expect. Mixbus tries not to show “too many” or “too few”
grid lines depending on the zoom level. You might find that items snap in-between the grid
lines sometimes. That’s expected behavior. If you can’t see or snap to the grid you’d like to
use, you may have to zoom in or out.

!
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Snap Options:

General Snap Options:

• Snap Threshold (pixels) (default 25) : when you are within this distance of a snap-able location, the
mouse will jump to the snap-able location.

• Approximate Grid/Ruler Granularity (pixels): in order for grid lines to appear, there must space
between the grid lines. This preference sets the distance between grid lines.

• Show “snapped cursor”: when enabled, and you are using the Mouse as Edit Point, a blue line will
appear where the “snap” is going to occur.

• Snap rubberband selection to grid: when you select a “box” with the grab tool, this determines
whether the box edges will Snap, or not.

• Grid switches to alternate selection for Internal Edit tools: when you switch from a regular tool to
an “internal editing” tool ( Draw or Edit ), the Grid will automatically switch modes. In the past, this
was used to increase the Grid precision when drawing MIDI notes. With the current “Scalable Grid”
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implementation, this is no longer very useful so it is defaulted “off”.
• Grid mode selection may change ruler visibility: This option allows the user to select whether

rulers automatically appear and disappear when changing Grid selections, as contrary to the next
option below “Rulers automatically change to follow the Grid mode selection”. See the section
Transport, Markers, and Rulers for a refresher of the terminology.

• Rulers automatically change to follow the Grid mode selection: If enabled, when you select a
Grid, the appropriate ruler for that grid will appear.

“When Snap is Enabled, Snap To”

It is possible to select multiple “Snap” options simultaneously.

• Playhead: When enabled, and the Edit Point is set to Mouse, then the mouse can snap to the
Playhead location

• Markers: When enabled, Mouse Operations will snap to the nearest timeline location marker
• Region Sync Points: Mouse operations will snap to the nearest region Sync Points
• Region Start: Mouse drags will snap to the nearest region “start”
• Region End: Mouse drags will snap to the nearest region “end”
• Grid: Mouse operations will snap to the visible grid lines, which correspond to the selected grid unit.

Grid override:

To temporarily disable the Grid while dragging, hold “ALT” while dragging. ( this option can be changed in
“Preferences->User Interaction”)

Relative Snap:

Sometimes you want a region to move in units of the grid ( eight-notes, quarter-notes, or whatever ), but you
want it to maintain the same offset from the grid. In this case, hold “Shift+ALT” while dragging, and the
region or note will retain it’s relative offset from the grid. ( this option can be changed in “Preferences-
>Editor->Modifiers” )

If the Grid setting seems to be changing arbitrarily, it’s probably because you are switching
between Region-editing and Content-editing tools. You should disable the option “Grid
switches to alternate selection for Internal Edit tools”

!

To use Region Starts/Ends/Syncs as “Snap to” resolutions, you must have either
• No tracks selected, which allows “Snap to” regions on any track.
• One or more tracks selected, which allows “Snap to” regions on all selected tracks.
*
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Grid Units:

No Grid If this is selected, then no grid will be visible or effective.

Bar Whole bars.

Beats (i.e. quarter
notes)

Grid units consisting of various note-lengths (quarter-notes, sixteenths, triplets, etc)

Timecode The timecode duration refers back to the session settings.

MinSec Hours, Minutes, Seconds.

CD Frames
For CD mastering. The CD Frame is the smallest data entity in the Red book
standard.
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6.9. Rhythm Ferret Window
The Rhythm Ferret dialog is accessed by right-clicking on a region and selecting “(Region Name)->Edit-
>Rhythm Ferret”. This provides a method to quickly “split” an audio region (or selection of regions) based on
events. This can be useful when separating a recorded performance into its component strikes or notes for
further editing.

• Mode: Determines whether the Ferret will trigger on percussive onsets for unpitched percussion
instruments, or note onsets (for pitched instruments).

• Threshold, Sensitivity: adjust these parameters to refine the detection of events
• Trigger gap: the shortest distance between events that the Ferret will allow. Increase this number if

you get multiple triggers on a single note.
• Analyze: displays the results of the analysis on the selected track(s).

Once you are satisfied with the points that the Ferret has chosen to split, you can click “Split on Onsets” to
automatically split the selected regions on the marks.
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6.10. Region Sync and Alignment

What is Aligning?
Aligning regions means moving one or more regions based on the edit point. An alignment operation moves
the region(s) so that some part of the region is positioned at the edit point.

For example, you can select 10 regions in the timeline, and select “Align Regions”. (typically these regions
will be on different tracks, but that’s not necessarily so) . The regions will be moved so they all start at the
same time on the timeline.

Available alignment commands include:

• Align Region starts
Selected region(s) are moved so that their start is located at the current edit point

• Align Region ends
Selected region(s) are moved so that the end is located at the current edit point

• Align Region sync points
Selected region(s) are moved so that their sync point is located at the current edit point

• Align Region starts relative
Selected region(s) are moved so that the start of the earliest region is located at the current edit point,
and all others maintain their relative position relative to that region

What is the region’s “Sync Point” ?
By default, a region’s “sync point” is the start of the region.

However, consider the case where here is some blank space at the start of a region which should not be
trimmed away, but causes the region to align incorrectly with other regions. For example, imagine the case
where a drum hit is not at the immediate edge of the region’s start, but slightly delayed after it. If you “snap”
the region to the grid, you’d like the drum hit to land perfectly on the grid, not slightly off.

By defining a region’s “sync point”, you can align and snap regions with each other sensibly, while freely
trimming the starts of the regions for crossfades and such.

Sync Point:

By default, a region’s leading edge will snap to the grid but often this edge is not relevant to musical timing.
By setting a sync point within a region (ex: on the downbeat) the region can be snapped to the grid in a
musically meaningful way.
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To set a sync point:

Select the region and place the cursor where you would like the sync point. Press the “v” key and a yellow
line will appear. Now the region can be snapped to the grid using the sync point as the reference.

To move a sync point:

Simply repeat the procedure above (there can be only one sync point per region).

To remove a sync point:

Select the track with sync point then choose: Menu>Region>Position>Remove sync. (This effectively sets
the sync point back to the beginning of the region)
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6.11. Editing with Playlists

What is a Playlist?
A track has a series of Regions on a timeline. Each Region represents a part of a sound file (or MIDI file).
The order of these regions, and additional region properties such as gain/controller curves, fades, and mute/
unmute status, are stored in the track’s playlist.

Think of a playlist as a separate piece of tape, or a 3rd dimension (into the screen) with different versions of
your track or section of a track.

Tracks can have multiple playlists, but only one can be selected at a time. The selected playlist is the only
one you can see and hear. But you can quickly select any alternative playlist, or create a new one (or copy
the current one) anytime.

Some users like to use playlists to manage the recording “takes” in a tracking session. See: Recording
Takes with Playlists

Accessing a Track’s Playlist functions:
Clicking the “P” button on a track header opens the Playlist menu:

At the top of the menu, you’ll see the available playlists for this channel. Selecting a playlist will change the
playlist (for this channel and its group members). This is convenient for the simplest cases where you have
a single track, or a track Group, with a few takes or edits that you need to select between.

The remaining items are:
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• Select : this launches an advanced dialog that allows you to create and manage playlists, potentially
for multiple tracks at once. Learn more here: Playlist Selector dialog

• Rename… : you will be prompted to rename the playlist. NOTE: all other playlists with the same
pgroup will be renamed to match

• New Playlist… : this creates a new empty Playlist. You will be prompted for a name of the new
playlist. This only applies to the selected track or group

• Copy Playlist… : this creates a new Playlist, with the same information as the current playlist. You will
be prompted for a name of the new copy. This only applies to the selected track or group

• Clear : this deletes all the regions and their edits on this playlist. the playlist itself remains, now
empty.

• Advanced… (see below)

Advanced menu
The Advanced heading provides 3 additional power-user features. These features allow you to select a
playlist from some other track in the session.

• Copy From… : creates a copy of any playlist (on this or another track).
• Share with … : this allows the track to use the same playlist as the source track. Any edits on the

playlist from either track will be seen on both tracks.
• Steal from … : same as “Share with”, except the playlist is now ‘owned’ by this track. It won’t show up

in the P menu of the original track

The ‘copy’ option is useful when you duplicated a track, for example, but you forgot to copy the playlist
during the Duplicate operation.

The ‘share’ and ‘steal’ options can be used to create a parallel processing path: you can have 2 tracks with
different plugins and processing; and any edits will be kept in perfect sync (since both tracks actually share
the same playlist)

Comping Playlists
A “Comp” is a composite take that is assembled from the best parts of several original takes.

Mixbus does not have a dedicated ‘swipe-to-comp’ function. We allow overlapped layers, and we allow
multiple ‘comp’ playlists, and we allow you to ‘punch-in’ anytime, like a tape machine. Other DAW’s swipe-
to-comp does not allow for those real-world complexities. You’ll quickly see the benefit of using the full
features of Mixbus’s editor when you want to make a comped take (or multiple comps!)

To ‘comp’ a take on a single track, you might follow these steps:
1) prepare for editing by choosing the Range tool, setting your edit point to Playhead, and enabling “Follow
Range” so the playhead will always follow your mouse’s Range selection
2) prepare to switch layers by opening the “Playlist Selector” dialog on the track
3) select your best overall take, click ‘Copy Playlist’ and name it ‘comp’. This is the playlist that will hold your
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final result.
4) use the Range tool to select a phrase in the comp take, and press spacebar to audition it
5) use the Playlist selector to switch to the alternate playlists, and decide which one is the best phrase
6) when you’ve found the best phrase, copy it (Ctrl+C or Cmd+C on mac)
7) switch to the comp playlist, and paste the phrase (if you already have some material there, you might
Delete first, unless you want the extra layers)
8) select the next phrase, and repeat steps 5,6,7 until you’ve comped the full length of the track

Multi-track comps work the same way: Assuming the playlists share a pgroup, then you only need to open a
single track’s “Playlist Selector” and check the box for “rec-armed tracks” or “ALL tracks”. You’ll also want to
SELECT the desired tracks that you want to edit (typically the rec-armed tracks, to match the selector, but
not necessarily). Your Range selections, copies, deletes, and pastes will be applied to all selected tracks.

Using Playlists as a ‘backup’
A ‘snapshot’ stores the entire session state: editor and mixer.

But sometimes it is convenient to return to a prior arrangement (including all the edits, fades, and region-
gain adjustments) without reverting your mixer and plugin settings.

You can use playlists for this purpose. Try making a ‘Copy Playlists for ALL Tracks’ and name it something
special, so you can return to. Then do another ‘Copy Playlists for ALL Tracks’ to create a working copy
while leaving the backup copies intact and named appropriately. By creating the Copy on all tracks at the
same time, you can now switch between the copies and the other tracks will follow.
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6.11.1. Playlist Selector dialog
Every track has a single Playlist Selector dialog, and you may show more than one track’s dialog at a time.
You can show the Playlist Selector by clicking “P” in the track header, or by selecting a track and using the
shortcut in the Track menu.

The available playlists for the associated track are shown at the top of the dialog.

The left column is the name of the playlist, and the right column is the ‘Group ID’ which is a timestamp that
is assigned to a playlist in one of these cases:

• In the case of an empty track, a group-id is generated when you first record to the track. This allows
your initial playlists to be grouped together automatically when you make the first recording pass on
multiple tracks.

• any user-action that creates a playlist: either a New or Copy action. All the affected tracks will be
assigned a group-id for the new playlist.

The “Scope” checkbox is used to control the scope of both playlist selection and the New/Copy buttons.

• Just this Track/Group : apply the action to this track, or the active Group.
• Rec-Armed Tracks: apply this action to all tracks that are record-armed
• ALL Tracks: the action will be applied to all tracks.

NOTE: playlists created in versions of Mixbus before v7.1 will not have a “Group ID”
assigned, and some of the selection and renaming features will not work for those older
playlists. It is not currently possible to assign a Group ID to a playlist, but you can select the
playlists that you want to select together, and do a “Copy Playlist” which will create new
playlists and assign them a group-id.

!
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Two buttons are provided to generate new playlists for this track (and any others that correspond to the
Scope selection).
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6.12. Polarity Optimization

What is Polarity Optimization?
Polarity optimization is a way to take multi microphone recordings and automatically determine the best
polarity setting for each of the tracks. The resulting analysis uses RMS level as the criteria for deciding the
“best sound”. This mathematically optimized solution saves the user from comparing the many combinations
generated by individually toggling the polarity switches of every track, in every possible combination.

Polarity optimization can be used in any situation where you have multiple microphones recording the same
source, and it is important to find the polarity switch positions that generate the best sound.

The Polarity Optimizer finds the optimum polarity setting for your tracks, and then it utilizies the channel’s
polarity invert switches within the Mixbus mixer strip to implement the optimum polarity settings. After the
Optimizer runs, you can further view and edit the polarity selections by using the mixer-strip polarity buttons.

https://www.youtube.com/embed/f_f8G5tnkfk?rel=0
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Using Polarity Optimizer
To initiate the polarity optimizer, use the Range tool (or Smart Tool) to select a time-range. It is important to
select a period of time that represents all of the instruments being played.

Right click in the range, and choose “Optimize Polarity” from the context menu .

A mixture of mono and stereo tracks may be used in the analysis. Left/right sides of a
stereo track are treated as 2 separate mono sources.*
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Results Dialog Box:

Preprocessing Options:
The top row of the dialog box lists the 7 preprocessing options. Click on any of these buttons and roll the
transport to audition the results. To accept the results simply close the dialog box.

Explanation of the preprocessing options:

The preprocessing options help you make sure the the optimum polarity is found.

• The “normalization” options are provided to accomodate unusually quiet or loud tracks, which cause
the tracks to be over- or under- represented. Normalization can be implemented as “peak”
normalization, or “RMS” average normalization.

• A low shelf boost emphasizes the low end response (+6 dB at 160 Hz) and biases the analyzer to
prefer alignment of low frequency content which may result in a more obvious low-end boost.

The preprocessing options are applied only to the signal as it is being processed. The
processing isn’t actually applied to the tracks, it is just applied while the the Polarity
Maximizer is performing its calculations.
*
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Optimization Results:

The Results dialog shows a grid of the selected tracks and the applied preprocessing options. The buttons
across the top can be used to set (and audition) the calculated polarity settings, for each of the selected
pre-processing modes.

• Old: The polarity of the selected tracks before Polarity Optimization was applied
• N/N: Polarity optimization applied with no emphasis, and no normalization of the tracks
• Peak: Peak normalized. Normalizes the peak volume before processing.
• RMS: RMS normalized. Normalizes the RMS volume before processing.
• L:N/N: Low emphasis, not normalized.
• L:Peak: Low emphasis, peak normalized.
• L:RMS: Low emphasis, RMS normalized.

When “Old” is selected and the transport is rolled you will audition without the results of the Polarity
Maximizer. When any other option is selected and the transport is rolling, you can audition the results of the
Polarity Maximizer with the corresponding preprocessing options applied.

In practice, you will find that most of the different preprocessing methods result in the same settings. In
most cases, you should select one of the options that has the most “agreement” with the other selections.
This indicates that the polarity settings are robust enough to apply even when subsequent level and
equalization is applied.

Track name results list:
The name of all tracks used in the analysis are listed and whether the track has had its polarity inverted as a
result of the analysis.

The underlying technology of the Polarity Maximizer was provide by Jim Davis Ph.D. MIT, 2000 Dept. of
Computer Science and Engineering at Ohio State University.
http://web.cse.ohio-state.edu/~jwdavis/

The Polarity Maximizer applies a high pass filter (DC offset removal) to attenuate signals
below 5Hz to remove it from the computation. This processing, like the processing options
listed above, is not applied to the audio tracks.
*
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7. Triggering Clips and Cues

Video Demo : Triggering Clips and Cues

The addition of the Cue Page brings a NEW workflow to Mixbus!

Using the new Cue page you can assemble a grid of Audio and MIDI clips to creatively build a song’s
foundation or to add embellishments to an existing recording.

https://www.youtube.com/embed/DplR0QMEHSk?rel=0
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Clip triggering can be synchronized to your music with bar- or beat-quantization. Each Clip is an Audio or
MIDI file that can be assigned its own Quantization, Length, and other settings to define how it will play.

A row of Clips can be launched together, as a Cue.

You can use Follow Options to automatically advance the currently-playing clip, or even ‘Jump’ to one or
more random clips for a drum-fill, and then return to the main groove.

Alternatively you can add Cue Markers to your timeline’s ruler, so you can build a sequence of song
elements (verse, chorus, bridge…) as Cues and then trigger those repeatably on the timeline.

Or combine both Cue Markers and Follow Options to create an arrangement that follows your song structure
but still allows some algorithmic deviation for each part! The possibilities are endless.
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7.1. Cue Window Overview
Clips and Cues are managed in the Cue window, which is accessed by a button in the upper right of the
main window.

You can right-click (or visit the View menu) to ‘detach’ the Cue page into its own window. This can be useful
on systems with multiple monitors.

A Cue Channel or Cue Strip is an audio or MIDI Track that contains a list of clips which can be triggered.
This ‘clip playback’ takes the place of the Regions on the linear timeline.

An audio Cue Strip detail is shown here:

Tracks with Clips assigned in their grid (“Cue Channels”) still appear in the editor timeline,
so you can automate their plugin parameters. They also appear in the Mix window, so you
can mix the Cue Channels with your other tracks and buses.
*
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Major sections of the Cue Strip are as follows:

• Clip Grid: This is a list of clips that can be ‘triggered’ to play through this Cue Channel. Only one Clip
in each channel can play at one time.

The remaining controls are similar to a regular track’s channel strip:

• Plugin Area: This area is for audio plugins inserted in the signal path. It is also the area where input,
processing and sends controls appear when selected by the buttons beside the Pan knob.

• Input, Processing and Sends selection: These buttons select the visibility of the EQ, Gate and
Compressor/Limiter/Leveler processing controls, Bus Sends section, and Input Switcher section, as
on a regular channel strip

• Master Bus Assign Button: This routes the audio signal to the master mix bus
• Pan Control: This knob pans the cues signal to the mix buses and the master bus, with the same

panning options as on a regular channel strip
• Channel Nameplate: This displays the track’s name. If you create a new track by dragging in a clip,

the clip’s name is used to name the track
• Mute and Solo Buttons: These provide muting and solo functions, as on a regular channel strip
• Audio Trim control: This knob provides front end gain or padding of the clip audio
• Fader and Meter: The fader adjusts the signal level to the master bus and any mix bus assigned post

fader. If any of the audio clips are stereo files, the meter will be a stereo meter showing both left and
right post-fader levels. The channel fader on the Mix page follows the position of this fader

• Compressor and Gate Meters: These meters show the operation of the Cue Strip’s Gate and
Compressor/Limiter/Leveler on the audio signal.

IMPORTANT NOTE: Visibility of the EQ, Gate, Compressor/Limiter/Leveler, Bus Sends section and Input
Switcher section depends on the resolution of your video monitor. Because of the vertical space taken up by
the Clips Section, these may not display on your monitor even if selected. We recommend a 4K HD monitor
for unrestricted visibility of all controls.

Cue Channels on the Mix Page
Cue Channels also appear on the Mix page with all regular channel functions available. In this figure the two
cue channels are additional to two regular mono audio tracks:
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There is no distinction between Cue Channels and other Channels, except that Cue
Channels appear on the Cue Page and (if they have a clip loaded) their playback is
generated by the clip grid instead of the linear track playback.
*
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7.1.1. Cue Window Terminology: Slots, Clips,
and Cues
Before getting into the details of Cues and Clips, we need to define some terminology.

This image shows the main features of the Cue page, and some associated terminology:

• a Slot is a compartment within which you can place an audio or MIDI clip of your choice
• a Grid or Trigger Grid is the array of slots within a Track or multiple tracks on the Cue page
• a Clip is an audio or MIDI file which may be loaded into a slot.
• a Cue is a command which triggers all the Clips on its associated row
• a Cue Track or Cue Channel is differentiated from regular Tracks only in that they have clips loaded

into a slot, and they appear on the Cues Page.
• Cue Markers appear on the session timeline at time points when playback of specific clips are to

begin. They correspond directly to the Cues on the left side of the grid.
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7.1.2. The Trigger Grid – Rows and Columns
This figure shows details of the Trigger Grid for three Cue Channels.

The Grid is arranged in rows (Cues) and columns (corresponding to a Track). The details of the individual
Clips will be discussed later, but note that you can use the leftmost column (Cues) and the bottom-most slot
(Master Slot) to effect changes on an entire row or column:

Right-click on a Cue to assign settings to an entire row:
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Right-click on a Master Slot to assign settings to an entire column (track):

Right-click on the Cue Master to assign settigns to the entire grid (all slots):
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https://www.youtube.com/embed/kDiCRLF8wYw?rel=0
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7.1.3. Showing and Hiding Tracks in the Cue
Window
If a track is created by one of these methods then it will automatically be shown on the Cues page:

• Dragging a clip to the ‘+’ sign from the Clip Picker
• Selecting a Range or Region on an existing linear track and choosing Bounce to Trigger Clip

By default, these Tracks do not show up on the Cues page:

• Tracks from v7 (or older) sessions
• Imported tracks
• Tracks created from the Rec page

When you create a new track from the “Add Track/Bus” dialog, there is a checkbox to select whether the
new track will appear on the Cues page:

However, in all cases it is possible to manually show or hide any Track on the Cues page.
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Manually hiding and showing tracks from the Tracks list

There is a tab on the far right labeled ‘Tracks’. Select that tab to display a list of available tracks in the
session.

By clicking in the “C” column, you can choose to show, or hide, a track from the Cues page. While hidden
from the Cues page it might still show up in the Mix, Editing and Recording pages. The ‘V’ checkbox hides a
track globally from all pages.

The “A” column, as on other lists in Mixbus, indicates the track is active in the session. Clicking the
checkbox for ‘A’ will de-activate the channel, which prevents it from generating sound and using CPU
resources. This can be useful when you ‘bounce’ a track: rather than delete the source track you can
disable and hide the track so you can return to it later, if needed.
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7.2. Playing and Stopping Clips
The basic operation of the grid is accomplished by launching (playing) the audio or midi clips inside the grid.

To play a clip, you must first load an audio or midi file into the slot. This can be accomplished by dragging
from the Clip Picker window.

Playing a Clip
Once a file is loaded into a slot, you can click on the ‘Play” triangle on the left side of the slot to play that
clip:

Some notes about clip playback:

• Only one clip can be playing, at a time, on a track.
• A clip doesn’t start playing until its quantization boundary occurs. For example, the default setting is

for a clip to wait until a measure boundary. This allows your clips to play in sync with each other, even
if you don’t click the Play buttons at exactly the same time.

• whenever you launch a clip, you’ll notice that the main session transport plays as well. This is
necessary because the clip needs to know the timeline position (for quantized launching) and tempo
(for stretching).

If you click a second clip’s Play button while the first clip is still playing, then the prior clip will continue
playing until the new clip’s quantization boundary occurs. Then the new clip will take over playback and the
prior clip will stop.

Clip Progress Indicator
When a Clip is playing in a Track’s trigger-grid, an indication is shown for the playback progress of the
current clip:

The ‘pie chart’ on the left side shows the percentage of the clip that has been played.
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The “G” indicates the row of the currently-playing clip.

The “3/4” indicates that this clip has been assigned a ‘Follow Count’ of 4, and it has already looped 3 times.

Stopping a Clip

There are several methods to stop a clip, depending on what you want to accomplish:

1. Click on any empty Slot in the same track. That will stop the playback of the current clip in this track
(column), at the end of this measure.

2. If there is no easily available empty Slot, you can click the “trigger master” at the bottom of the grid.
That will stop the current clip in this track, at the end of this measure.

3. To stop “all” playing Clips at once, click the stop button in the Cues column (far left column). That will
stop ALL playing Clips, at the end of this measure.

4. Press the master transport Stop button. That will immediately stop all playing Clips.

Follow Options
When a clip reaches the end of its length, the clip’s “Follow Option” is triggered. This might cause the clip to
play again, to advance to the next clip, or to stop, among other options. see Aranging with Follow Options

Note that the first three methods all have the behavior of stopping “on the start of the next
measure” while the 4th method will stop all playback, immediately. Also note that the first
three methods do not stop the master transport, they only stop clip playback.
*
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7.3. Launching Cues (Rows of Clips)

What is a Cue?
A Cue is an event that triggers all the clips on a horizontal row of the trigger grid.

Cues are represented by orange circles on the leftmost column of the Clip Grid. Cues are lettered A through
H for easy recognition and assignment on the Cue and Edit pages.

Cues can be triggered in one of several ways:

• Left-click one one of the circular orange Cue buttons
• Place a Cue Marker on the timeline, and roll the playhead through that point (see: Arranging with Cue

Markers)
• If the Cue page is selected in the main window (or has keyboard focus when it is detached in its own

window), then the F-keys 1..8 will launch cues A..H

What is Cue Isolate?
Enabling a Slot’s “Cue Isolate” in the Launch Options will prevent it from responding to the Cue button. This
means it won’t launch the clip in this slot (if there is one) or stop the playback of this track (if there isn’t one)

Example usage of Cues and Cue Isolate
In this image, the first Cue ‘A’ represents the verse of a song, and the second row ‘B’ is the chorus:

It is currently impossible to add more than 8 cue rows, nor is it possible to re-order or copy/
paste rows. These feature is under development and will be added in a future update.*
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Clicking the ‘A’ cue will launch the sounds for the verse
Clicking the ‘B’ cue will stop the clips on ‘A’ and start playing the chorus

The third row ‘C’ is a group of sounds that can be triggered anytime in the verse or chorus. Since the ‘Cue
Isolate’ is engaged on the first and third tracks, it won’t stop the sounds that are currently playing on those
tracks.

For more complex examples, see Arranging with Cue Markers and Arranging with Follow Options. Note that
you can combine both techniques. For example you can arrange a verse with random fills, and a chorus
with random fills. And then use Cue Markers to sequence a specific series like verse, chorus, verse, chorus,
bridge, chorus ….
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7.4. Auditioning Clips

Video Demo – Bundled Clip Content

“Auditioning” is the ability to listen to and evaluate a clip before putting it into your Mixbus session.

Click on a clip in the Clip Picker to select it for auditioning. If the “auto play” is checked, the file will
immediately start playing:

https://www.youtube.com/embed/rlJFgiVMnfc?rel=0
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You can use the arrow keys or the mouse to quickly jump between files in your library. If ‘Auto Play’ is not
checked then you must click the Play button to initiate auditioning.

Special Considerations for Auditioning MIDI Files
MIDI files report some extra properties when selected. They report which MIDI channels (1 through 16) are
being used in the file, and also whether the file includes any program (patch) changes.

Since MIDI files contain no audio, a synthesizer is needed to listen to a MIDI clip. Mixbus contains a built-in
auditioning synthesizer by default, the “General MIDI” synth. This synthesizer can respond to all 16
channels of MIDI. By default it uses a piano sound on channel 1, and a drum sound on channel 10. However
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some MIDI files will not sound correct with these settings. In those cases you can change the patch settings
for the auditioner synthesizer

If you have a preferred synthesizer for auditioning your midi files, you can select it in the pulldown for the
audition synth:
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7.4.1. Selecting Patches for Audition of MIDI
Files

In the case where a MIDI file is selected, a display is provided with some MIDI file information including the
type of MIDI file, then number of notes in the file, the channels used, and whether program-changes are
included or not.

Files that are created for the General MIDI specification will often have programs (banks and patch
information) provided to select the instrument. There might also be cases where a MIDI file intended for a
specific synth will have patches for that synth. In the absence of any patch-change information, then it is
necessary to choose a suitable synthesizer (or patch on the synthesizer) so the correct sound (or an
approximation of it) is heard.

For this purpose, there is a small button in the bottom-right corner that allows you to show the audition
synthesizer’s GUI:

NOTE: This button is grayed out and does not become active until you audition (play) the selected clip for
the first time.

Each audition synth will have its own unique control panel. In the case of the default synth, GMSynth, this
displays a grid of 16 buttons, each button indicating a patch selection for the 16 channels:

https://www.youtube.com/embed//3vJQhfhmy8I?rel=0
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In the GMSynth, each MIDI channel selection offers a HUGE selection of patches to pick from.

why do my MIDI files sound different when I select them? some midi files have program-
changes (patch changes) embedded in them, and others do not. This can result in cases
where a midi file sounds like piano (for example) while another .mid file (with patch-
changes) sets the channel to use a drum patch. Returning to the prior file (the one without
any of its own patch changes), it might now sound like drums instead of piano. By
displaying the GMSynth’s GUI, you can see the selected patches, and you can see when a
midi file sets its own patch.

*

if a .mid file has patches defined for its channels, you will see the GMSynth’s settings
change to match the file’s settings. You cannot override those settings. But when you drag
the clip to a track, you can override its patch settings per-slot, per-channel.

!

if you are using a synth other than GMSynth, you should check the product’s manual to see
which channel(s) it responds to, and whether it responds to program-changes or not. You
might need to disable program-changes in your synth’s control panel, and/or tell it to accept
or ignore individual channels.

!
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7.5. Bundled Clip Content

Video Demo – Bundled Clip Content

Upon opening the Cue page, you should see a list of clips on the rightmost left pane:

https://www.youtube.com/embed/rlJFgiVMnfc?rel=0

https://www.youtube.com/embed/rlJFgiVMnfc?rel=0
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Mixbus Bundled Content:
• GrooveMonkee MIDI Drums: This is a collection of drum arrangements played with the ‘feel’ of a live

drummer. These files have all notes on channel 10, so the default GMSynth auditioner will play them
as drum sounds. You can override the patch setting to make the drums sound more laid-back,
aggressive, or electronic, depending on the patch selected or the synth used.

• Goldbaby Audio Samples: This collection of eclectic sounds was generated by vintage synthesizers,
drum machines, and other electronic gear. You can use this material to add flavor and contrast to your
session.

• Raw MIDI Chords: This is a collection of over 1500 chords organized by the key and major/minor
variations. There are also chord progressions for each key, provided as 1 bar per chord change.
These .mid files have all notes on notes on channel 1, so the default GMSynth auditioner will play
them as piano sounds. You can override the patch setting to use an electric piano, organ, strings, or
even drum sounds.

• Raw MIDI Drums: This is a collection of over 2000 individual drum patterns, organized by musical
style and then provided as one or more of kick drum, snare drum, hihats, cymbals, and percussion.
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These .mid files have all notes on channel 10, so the default GMSynth auditioner will play them as
drum sounds. You can override the patch setting to make the drums sound more laid-back,
aggressive, or electronic, depending on the patch selected or the synth used.

The ‘Goldbaby’ and ‘GrooveMonkee’ content has been licensed from the content developers
by Harrison, for your personal use. The content may be used without license or additional
payment in your projects. However you may not re-publish the material without changes as
your own. You can find the each individual collection’s licenses by navigating to the bundled
content folder in the Mixbus application folder.

!

Mixbus’s bundled content may change in the future. But any files that you’ve imported to
your sessions will remain playable in the session, even if the files are no longer stored in
our bundle.

!
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7.6. Adding New Clip Content
There are many sources online for third-party looping content. When you download a folder of this content,
you’ll want to make it easily accessible from the Clip Selector.

At the top of the Clip Sector list, there is a button to select from various folder sources on your computer.
These are your Clip Library folders.

Click “Edit” to launch the Library editor; from here you can add new paths or remove paths from your Clip
Library:
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Items added to this dialog will appear as menu pulldowns at the top of the clip selector.

You can drag&drop a folder from your file-browser, and it will be added to your library.*
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https://www.youtube.com/embed/K8pyFju_rMg?rel=0
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7.6.1. Saving Clips to your User Clip Library
You may drag a clip from a slot into the Clip Selector. This will:

1. Create a new folder named “Clip Library” on your computer.
2. Add that folder as a new entry in your Clip Library list (the pulldown menu at the top of the clip

selector)
3. Display your user clip library in the Clip Selector
4. Store the new file there
5. Display a button to expose that folder in your file browser (this is a convenient way to organize your

files into folders, and zip them up for transmission to a collaborator or collector)
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7.7. Slots and Clip Properties

What is a Slot?
Individual grid elements on the Cue page are called Slots. Slots are a container for an Audio or MIDI Clip
(depending on the type of track).

When a clip is loaded, the Slot displays 3 critical pieces of information:

• The Play button, which shows when the clip is stopped (triangle outline), queued for playback (square
outline), or is currently playing (solid triangle)

• the Clip’s name (with customizable color)
• an icon for this slot’s Follow Option, if any

Empty slots provide only a square ‘stop’ button which, when triggered by the user or by the Cue button for
this row, will stop playback of all clips on this track.

Selecting a Slot
A slot may be selected by left- or right-clicking on it. A red border appears around the selected Slot:

When a slot is selected, the clip’s Properties appear in the bottom portion of the screen:

When a clip is selected, 4 panels of clip properties are displayed; they are:

• Clip Properties
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• Launch Options
• Follow Options
• Stretch Options (only shown on audio clips)

Slot Actions – context menu
Additionally, Right-clicking on a Slot will provide options to:

• Clear the slot (i.e remove the clip)
• Load a new clip from a file selection
• Change the color of the Clip

Launch Options
Right -clicking on the Play Arrow (here, for the clip in Cue A) brings up a menu which allows you to set the
clip’s Cue Isolate or Quantization properties:

An audio clip ‘trimmer’ and a midi piano roll editor are not yet provided, but are a high
priority. These features are in development for a future update.*
The ESC button on your keyboard always clears your selection. If you have a slot selected,
then pressing ESC will clear the selection and hide the slot properties area, making more
room for you to adjust plugins or other channel controls
*

In the Cue page, only one of the clip properties, channelstrip EQ, or channelstrip Sends can
be displayed at once. Selecting any of those 3 items will hide the others.*
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Details of changing the Launch Options are covered here: Launch Options

Follow Options
The rightmost area is the Follow Options icon. Right-clicking on the icon (here, for the clip in Cue A) will
bring up a choice of actions to occur when the clip reaches its end:

You can simultaneously set the Launch Options for a row, a Track, or the entire grid using
the row and column controls. See Trigger Grid: Rows and Columns*
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Details of changing the Follow Options are covered in Follow Options and Arranging with Follow Options

Stretch Options (Audio clips only)
Details of changing the Stretch Options can be found here: Stretch Options

You can simultaneously set the Follow Options for a row, a Track, or the entire grid using
the row and column controls. See Trigger Grid: Rows and Columns*
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7.7.1. Clip Properties

Clip Properties Panel
The ‘Clip Properties’ panel displays basic information about the clip, like its file source, name, and color.

In this panel the following is visible:

• Clip Name ; Double-click here to enter a name for this clip.
• Load button : Click here to load a file from disk, replacing the contents in this slot (if any)
• Color Selection: This button brings up a color selection window, to give the clip name a custom color

in the slot. This can help to quickly identify related types of clips.
• Gain Adjust: The gain of this clip can be adjusted relative to the other clips in the same Cue Channel.

This works for both audio and MIDI (by scaling the Velocity of notes)
• Send Patches and MIDI Patches (MIDI clips only) : see Setting MIDI Patches for a Clip
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https://www.youtube.com/embed/4T17whX0w34?rel=0
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7.7.2. Launch Options

Launch Options Panel

Launch Quantize: When you launch a Clip (either by clicking directly on it, or by clicking on a Cue, or when
a Cue Marker is passed on the timeline), the clip will wait until the launch quantization point is passed
before the clip is actually triggered. For example you can set your clips to fire on 4-bar boundaries, and then
you have up to 4 bars of time to choose the clips that you would like to launch; they will all launch
synchronously on the next 4-bar boundary. Choose ‘none’ to allow clips to fire instantly when they are
queued to launch.

Cue Isolate: If this is selected for a clip, the slot will not respond to Cue events, either starting or stopping.

• The clip’s Play-button (or Stop-button) is overlaid with a dark shadow from the left side.
• If the slot is empty and the Follow Options would normally trigger this slot, it would normally stop the

sound of any triggers on the same track (indicated by the square Stop symbol rather than a Play
arrow). If Cue Isolate is enabled, then the current clip will continue playing for this track and ignore
the Stop action.

• If the slot is populated with a clip, then the clip would normally start playing when you fire the cue
(row). If Cue Isolate is enabled, then the currently playing clip (if any) will continue playing for this
track, and this clip will not launch.

Ignore Cues can allow you to build a more complicated arrangement using Follow Options.
For example you can have a sequence of 4 clips that are initiated by the topmost clip. You
can prevent this arrangement from being interrupted by a Cue by enabling the Cue Isolate
on the lower 3 clips. This allows you to fire a Cue (or Cue Marker) on other tracks, while
leaving this track’s arrangement undisturbed.

*

Note that you can set ‘many’ quantizations at once by right-clicking on the Cue button (for a
row), the Clip master (for a track), or the Cue Master Stop button, to set ALL your
quantizations to a single setting. See:Trigger Grid – Rows and Columns
*
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7.7.3. Follow Options

Follow Options Panel

Follow Options are triggered automatically when the clip reaches its end. The Follow Options section has
these controls:

Follow Options (Left and Right, respectively): The 2 Follow Action menus may have one of these choices
selected:

• Inhibit – If None is selected, then the Follow Options items are disabled throughout this section. The
settings are preserved in case you want to re-enable FA’s later.

• Stop – After the clip finishes (Follow Count and Follow Length are taken into account), the clip will
stop playing but no other action will occur.

• Again – The same clip (taking Follow Count and Follow Length into account) will be repeated again
(i.e. looped)

• Forward – playback will advance to the next (lower) clip in the track’s grid. Empty slots are skipped
over.

• Reverse – playback will revert to the prior (higher) clip in the track’s grid. Empty slots are skipped
over.

• Jump – playback jumps to the selected slot(s).

The Follow-Option Probability slider assigns a probability (0..100%) between the Left and Right follow
options. This allows you to make a semi-random arrangement where the clip ‘usually’ repeats but
‘sometimes’ jumps to a different clip.

Follow Count defines the number of times that a clip will repeat before the Follow Option is engaged. For
example you can cause a 1-bar clip to repeat 3 bars, and then Jump to another clip (as a fill).

The Follow Length selection defines a number of beats that the clip will play, before the Follow Option is
initiated. This number can be longer or shorter than the natural clip length. For example you might choose
to Jump to another clip after only 2 bars of a 4-bar clip have played. Or alternatively you might allow a silent
section to follow a 4-bar clip by setting the Follow Length to 8 bars. The Follow Length may be engaged or
disengaged while remembering its setting.
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To learn more about arranging with Follow Actions, visit the page: Arranging with Follow Actions

the Follow Count is implemented after the Follow Length; If you set the Follow Length to 16
beats (4 bars) then the full 16 beats will play, and then repeat as many times as required by
Follow Count, before the Follow Option is activated.
*
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7.7.4. Stretch Options

Stretch Options Panel (Audio clips only)

Stretch: If Stretch is disabled, then the remaining buttons are de-sensitized and their settings are ignored
by the playback engine

Stretch Mode: stretch mode currently has 3 options:

• Crisp (default) : this prioritizes the timing and crispness of drum transients, but might cause
interruptions in a sustained note

• Mixed : a compromise setting for loops that have both transients (drums) and sustained notes
• Smooth : this prioritizes the smoothness of sustained notes, at the expense of a blurring or phasing

of drum transients

BPM: this reports the current BPM (tempo) of the clip. This value is used to ‘stretch’ the clip to match the
timeline’s tempo map.

The BPM value is populated from one of these cases:

• If you are importing a file to a slot, the bpm can be inferred from a filename, for example: “rock
120bpm” can automatically populate the bpm to 120

• If you are bouncing a selected region or Range to a slot, then the timeline tempo at the start of the
Range is assigned to the bpm value

• Given no other tempo information, an algorithm is used to ‘guess’ the tempo

In all cases, mixbus will first try to guess the bpm and then it will round the bpm up or down so that the file’s
length is exactly an even number of beats. This works for the vast majority of downloaded material which
might say 110bpm, but given the exact number of samples it should be looped at (for example) 110.07bpm.
However, especially in the case where we algorithmically guessed the tempo, this can result in nonsensical
lengths: for example a 4-bar 120bpm file might instead be interpreted as a 8bar, 240bpm file. Additional
controls are provided to fix this issue. You can specify the clip’s length in beats, which will correctly set its
tempo.
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As a helper function, the number of bars are displayed so for longer sections you can see “8 bars” instead of
“32 beats” (sic).

One-shot or non-stretched files: If the detected BPM is unusually fast or slow, or if the file is very short, or if
the filename says “0bpm”, then Mixbus will assume the file is a one-shot and should not be timestretched. In
this case the Stretch button will be disabled automatically. But the user can re-engage Stretch if desired.

If you import a file and it plays at the wrong tempo, you should first check the ‘Clip Length’
and adjust it to the length of the clip (assuming you know it). That almost always solves the
problem.

!

https://www.youtube.com/embed/jO41kal2BX4?rel=0
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7.7.5. Dragging and Dropping Clip Properties
You may directly drag a Clip to another slot. Dropping a clip on a slot will replace the contents (if any) in the
receiving slot.

Some properties: the slot’s Name, Gain, and Color; will be copied identically.

In the case where a ‘receiving’ slot (the drop target) has an arrangement style follow option …. Forward,
Reverse, or Jump … or if the Ignore Cues button is engaged, the arrangement will be maintained and the
source clip’s settings will be ignored. That allows you to build an ‘arrangement’ using Follow Options and
then replace the clips with different sounds to play in the arrangement.
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7.7.6. Setting MIDI Patches for a Clip

What is a Patch Change?
MIDI files may have an embedded message that tells the receiving synthesizer what ‘patch’ to use. The
message is actually made of 3 separate messages which define the Bank(MSB/LSB) and Program.
Furthermore, there are 16 channels which may be addressed. For example, a MIDI file can tell a synth to
use bank 1, patch 1, on channel 1.

Many plugin-instrument synthesizers do NOT respond to patch-changes at all. Instead you are expected to
control the plugin from the control panel, and this chapter will have no effect. Similarly, plugin instruments
generally only support a single sound at a time, and may not respond on multiple channels of MIDI.

A Patch-change message may occur anywhere in a MIDI stream. This can be useful to increase the number
of sounds at your disposal. If 2 instrument voices never play at the same time, then you can put a patch-
change before each instrument’s passage and use a single MIDI channel.

Patch-changes are generally only useful if both the midi file and they synthesizer agree what each patch’s
sound is. This is the purpose of the General MIDI specification: it defines that (for example) bank 1, patch 1
is a “grand piano” sound. The quality of the sound can vary widely with different synthesizers. Mixbus
provides a synthesizer called General MIDI Synth which provides reasonable sound quality for the most
popular GM sounds, with a fairly small download. To learn more about patch-changes and General MIDI,
visit this chapter of the manual: General MIDI and General MIDI Synth

Enabling or disabling patches for a Clip
The “Send Patches” button controls whether a clip will send ANY bank or patch changes. If this button is
disabled, then neither the clip’s patch-changes nor the embedded file’s patch-changes will be sent to the
synthesizer.

If your synthesizer changes sounds unexpectedly or otherwise acts strangely, there’s a
chance that it is responding to patch-changes in the MIDI file you are playing. Some
instruments have a button to ignore incoming patch changes. If your synth ignores patch
changes then this chapter will have no effect on the synth.

!
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Choosing the patches for a Clip
Click the ‘MIDI Patches’ button to launch the clip’s patch selector dialog. The dialog provides tabs for up to
16 channels. Only the channels used by the Clip will be provided.

Where are patch names defined?
The patch-selector dialog uses the selected instrument “midnam” file specification, which can be selected in
the track header. In the case of an external synth connected only with a MIDI cable, this is the only way to
fill the names of the bank/patch selector. Here is an example showing the Roland Juno-106 synthesizer
picked in the track header, and the resulting list of default patch names:

Some synthesizers (like Mixbus’s included General MIDI Synth) can specify the bank/patch list without the
user having to choose the instrument specification on the track.
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7.8. Arranging with Follow Options

What is a Follow Option?
A Follow Option is the event that is triggered when a clip reaches the end of its length.

• None means to do nothing after the clip finishes playing
• Stop means stop playback at the end of the clip
• Again means to replay the clip after it finishes playing
• Forward means to advance and play the following clip (on the next row of the grid, but within the

same Cue Channel)
• Reverse means to advance and play the preceding clip (on the previous row of the grid, but within the

same Cue Channel)
• Jump allows you to explicitly select a clip (or clips!) to be queued when this clip has finished playing

(including any repeats caused by Follow Count)

https://www.youtube.com/embed/FrRm0PLwkzw?rel=0
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Jump -> Multi
Multi allows you to select multiple slots. When the Jump->Multi Follow Option is initiated, one of the
selected slots will be selected and queued for playback.

An example using Jump and Multi-Jump
In this image, the ‘verse’ Clip is a 1-bar pattern that is set to repeat 3 times and then Jump to one of 3
random ‘fill’ patterns (Fill 1,2,3). The fill patterns jump to the Chorus pattern (E), which then jumps to one of
3 different ‘fill’ patterns (Fille 4,5,6), which then jump to the verse pattern (A). This creates a semi-random
song arrangement that alternates verse and chorus parts, with a potentially different fill every 4 bars.
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7.9. Arranging with Cue Markers

Video demo of Cue Markers

What are Cue Markers?
Cue Markers are markers in the timeline ruler, just like regular location markers.

When the playhead reaches a cue marker, it will trigger the corrensponding Cue, just as if you clicked on a
Cue manually.

https://www.youtube.com/embed/EmCycKeEpbg?rel=0

If you locate the playhead between 2 cue markers, Mixbus will calculate the position of the
triggered clips so that playback resumes as if you had passed the prior Cue on the timeline.
Awesome, eh?
*
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Cue Marker Controls: Record and Play
At the top of the Mixbus window beside the mini- timeline are the Record Cues and Play Cues buttons:

Play Cues button: This button enables playback of clips when triggered by cue markers on the session
timeline. If not set, Cue Markers will not trigger clip playback when the playhead passes over the marker
position.

Rec Cues button: This button enables recording of Cue Markers onto the session timeline when triggered
manually from the Cue page.

Triggering Cues on the timeline using Cue Markers
It is not necessary to record cues in real time while listening to playback. Cues can be placed directly on the
timeline at the desired point in the Editor Window using the Cue Markers lane:

This button has no effect when playing cues manually from the Cue page, either by clicking
on a cue row or by clicking the play arrow on an individual clip. It only affects the behavior
of the Cue Markers in the editor ruler.
*

The recorded cue will not appear in the session timeline window at the top of the page until
the transport is stopped.

!
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The Cue Marker will be placed at the selected point:

In this case, Cue Marker A will trigger clip playback when the playhead passes over the marker.

Similarly, clip playback can be stopped by right-clicking and selecting the stop button at the desired point:
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The Stop button will be placed at the selected point:

Clip playback of all cues will stop when the playhead passes over the marker.

Tweaking the Cue Trigger and Stop Positions
In the Editor Window, you can move the time positions of the Cue start and stop by simply clicking and
dragging them along the timeline:

Harrison Consoles Mixbus - 9_en

Page 275 of 848



By Right Clicking on the Cue or Stop marker, a number of additional options are provided such as
changing the cue, moving the play head to the cue, moving the cue to the play head, locking the cue
position to the beat reference, and so on:
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7.9.1. Recording Cue Markers in real time
These figures show how to record a cue onto the timeline in real time. To enable the recording of Cues, you
must click the “Rec Cues” button to the left of the mini-timeline:

(not shown: the Cues buttons (the column of buttons on the far left) are colored ‘red’ when recording.)

With the transport rolling, click on the Cue circle (here, Cue A) at the point where you you want the clips in
that row to play:
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Pressing the Stop button will stop all Clip playback and record a ‘stop’ marker in the timeline.

After you stop the transport, the cue playback interval will be displayed in the mini-time window. The cue
start and stop (if any) positions will also be displayed in the Editor window in the “Cue Markers” ruler lane.

While on the Cues Page, you can also use key shortcuts F1…F8 to trigger the first 8 clips A
through H*
Clips may not start playing immediately. Each clip will instead wait for its quantization
interval to occur. This helps to ensure that loops sound in-sync. If you want your sounds to
start ‘immediately’ when the Cue is clicked, then set those clips to Quantization=None
*

When requested to stop, Clips always continue playing until the end of the next bar.
However, if you place a Stop marker exactly on a bar boundary, then Mixbus knows you
really want it to stop there, rather than the end of the next bar.
*
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7.10. Combining Clips and Linear Tracks
(advanced)

• every Audio and MIDI Track has a trigger-grid that can be enabled by loading one clip into a slot of
the track’s trigger grid

• you can select a Region or a Range in a track, and bounce that selection to a slot. You can do this on
multiple tracks at once.

• when a trigger slot is enabled, then the ‘monitoring’ behavior of a track changes:
◦ if both Disk and IN are disabled (i.e. the track is in Automatic mode) then the track will monitor

only the playback of the trigger slots
◦ if Disk is enabled, then you will hear BOTH the trigger-slots and the track playback
◦ if IN is enabled, then you will hear BOTH the trigger-slots and the live input
◦ if both IN and DISK are enabled, then you will hear ALL THREE trigger-slots, live input, and

track (disk) playback

It is not currently possible to record the output of a trigger-slot into the same track. That
feature is under development.*
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7.11. Comparisons to Ableton Live™
Why does Mixbus’s Cue Window look so similar to Ableton Live™?

In the same way that Harrison developed many conventions of inline signal-flow, eq, bussing, automation,
solo-ing, VCA faders and other console concepts which have been copied many times since 1975, it is our
opinion that Ableton Live™ has defined the canonical ‘looping grid’ workflow. Rather than develop our own
conventions, we decided to follow the familiar operations and layout of this well-known software.

Terminology Differences between Live and Mixbus

• When you trigger a horizontal row of clips, Live calls this a Scene. We prefer the term Cues, which is
well-known terminology for triggering an event on a timeline. We want to reserve the word Scenes for
mixer scenes.

• Mixbus uses the term “Cue Isolate” instead of “Remove Stop Button”.
• In the clip properties, Mixbus uses the term “Stretch” instead of “Warp”.
• Mixbus uses the term “Follow Options” rather than “Follow Actions”.
• In the clip properties, Mixbus provides a button to override a Clip’s length and instead define a Follow

Length. This is comparable to Live’s “Unlinked” option which allows a separate Follow Action Time.
• otherwise, terminology and behavior should be largely the same for features like Quantize, etc.

What is different about Mixbus’s Cue Window when compared to the Session
View of Ableton Live™?

• When you stop the transport in Live, the currently-playing clips are left in a queued state, which
means they will play again when the transport is started. Mixbus does not provide that feature.
Instead we encourage you to use Cue Markers to trigger your clips on the timeline ruler. This helps
maintain the ‘phase’ relationship between multiple playing clips when you start and stop the transport.

• Live has a ‘Looping’ checkbox for audio and midi clips which allow them to loop forever even without a
follow-action or follow-count enabled. Mixbus does not provide that feature. Instead you should use
Follow-Count (for a specific number of loops) or Repeat Follow-Option (for unlimited looping).

• Mixbus has Cue Markers: Cue Markers allow you to define points on your linear timeline where a Cue
(row) will be launched by the trigger grid. This allows you to develop your arrangement on a linear
timeline while still allowing full flexibility of swapping clips and follow-actions before you commit to a
final arrangement.

• Clip Groups: Live has Follow-Actions labeled ‘Next’, ‘Previous’ and ‘First’ which operate on a group of
clips (groups are defined by clips that are vertically adjacent, separated by an empty slot). In our
testing, many users (even experienced ones) did not understand that these terms apply to grouped
clips. We also found it hard to use groups for arrangements, since it requires you to add empty rows
to organize your groups, and that can impact adjacent tracks. Instead, we provide Forward, Reverse
and Jump actions which can provide all the same operations of groups but do not require using blank
slots to build a group.
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Other differences between Live and Mixbus:

• Mixbus supports Jump Follow Options (recently introduced in Live v11) with the added ability to
choose multiple clips for the jump target. This allows an additional level of pseudo-random behavior
when using Follow Options to build your arrangement.

• Mixbus supports multiple MIDI channels in a single Track. This also works for triggered Clips: you can
have up to 16 channels of MIDI, with patch changes, and deliver this to the track’s instrument.

• Mixbus can load Apple Loop (.caf) format audio files, so you can use the Apple Loop Content on your
Apple device.

• Mixbus provides the ability to set many properties for rows, columns and ALL clips at one time. See
Trigger Grid: Rows and Columns

• Mixbus does not have selections for “Global Quantize setting” “Global Follow Action Enable” “Back to
Arrangement” “Phase Nudge Up/Down” or a “Crossfader Section”. These features are not currently in
development, but they could be added in a future update if users find them desirable.

Mixbus does not currently allow more than 8 cues (rows), nor allow the user to re-order or
create new rows. These features are currently in development and will likely be provided in
the near future.
*

Mixbus does not currently provide the option to print your clips and cues to a linear track
(other than a manual ‘bounce’ recording from the source to a new track). That feature is
currently in development and will be provided in a future update. You can use Cue Markers
to arrange Clip playback on your linear timeline.

*

Mixbus does not currently provide an audio ‘trimmer’ tool or a midi piano roll editor for the
contents of a Clip. These features are currently in development and will be provided in a
future update.
*

Mixbus does not currently provide warp-markers or Groove templates. These features are
also under development. You can edit a Region on the timeline using all the features of the
Editor, and then import that region into a Clip.
*

Mixbus does not currently provide the option to launch clips from a pad-controller using
MIDI. Launch-modes Gate, Toggle, and Repeat are not currently provided. Those feature
are currently in development and will be provided in a future update. The initial release of
the Cue Window is intended to introduce nonlinear looping clips to our linear timeline,
rather than DJ-style live performance.

*
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8. Mixing

What is mixing?
“Mixing” is the process of combining multiple sounds ( usually “tracks” ) into a final, deliverable sound.

In the case of music mixing, the goals of mixing might be:

• To make the overall timbre of the mix convey the feeling that the creator has chosen.
• To make each element clearly heard, so that a listener can focus on a single instrument if s/he

wishes.
• To make the volume level consistent enough that the user isn’t required to constantly adjust the

volume knob.

Of course all of these rules are subject to the artistic wishes of the creator.

What are some mixing techniques?

Here are some of the techniques that we use to create a “mix”:

• Balance the volumes of each element (instrument) so they don’t occlude each other.
• Dynamically adjust the volume of elements to accentuate parts of interest at different times of the

piece.
• “Pan” the signals into the available speakers so they can be separated by position.
• Create a “space” around each element so they can be perceived as close or distant.
• Tweak individual elements to accentuate their desirable character, or attenuate undesirable character.
• Limit the frequency range of elements, so that more elements can be distinguished in the same

space.

You’ll find that Mixbus provides tools for all of these tasks right underneath your fingertips.
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8.1. Mixer Window Overview

Mixer Strips – Inputs, Mixbuses, Master, Monitor, and VCA’s.
When viewed in the Mixer Window, Mixbus resembles a traditional analog console. Input Channels are on
the left, while the busses and master are located on the right side.

The audio signal flow is generally left-to-right. The signal starts at the input channels (which might be live
inputs, playback tracks, MIDI tracks, or virtual instruments), progresses through the mix buses, and into the
master. The signal path’s EQ, Filter, Compressor, panning, bus summing, and master bus processing are
performed inside Harrison’s proprietary signal path, are always present, and do not require user-supplied
plug-ins.

In Mixbus, like other audio workstations, each recording track has its own mixer strip. These mixer strips
resemble the input channels of a traditional analog mixing console. Input channels can be configured to be
mono or stereo, virtual instrument or MIDI, and by default include all the DSP processing that makes up a
real console channel. This is the major difference between Mixbus and other DAW mixers. No time is
wasted searching for and adding the necessary high-quality mixing tools.

Just to the right of the input channels are the mix-buses. Mix bus channels are used to collect the outputs
from the input channels into groups. For example, in a typical music project, you might send the drums to
mix bus 1, the vocals to mix bus 2, instruments to mix bus 3, and use mix bus 4 as a parallel effects bus,
like reverb. This allows you to easily adjust the relative levels of these groups and apply processing to them.

The master channel is the final mixer strip on the right. Often, the master channel will be connected to your
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volume control, which is then connected to your speakers (or headphones). The output of the Master
channel is the final output of your project ( i.e. your 2-track master file). This output is rendered to the final
.wav file when you export the session.

The monitor section on the far right has been made available for those who do not have access to a
dedicated external monitoring section.

Finally, on the far right you will find the VCA Faders. You may create 0, 1 or unlimited VCA faders. VCA
faders may be attached to multiple channels, and they give you the ability to mute, solo, or adjust the level
of all the attached channels simultaneously.

You may adjust the size of the Mixbus and VCA “Panes” by clicking and dragging the vertical bar:

Tip: Shift+Ctrl+Click ( Shift+Cmd+Click on Mac ) on a track’s Mute, Solo, or Rec enable to
toggle ALL the tracks in a session.*
Tip: You can Ctrl+click (Cmd+click on Mac) on the track’s name slate, and make the track
wide or narrow. Shift+Ctrl+click (Shift+Cmd+Click on Mac) to make ALL the tracks or ALL
the buses narrow/wide.
*

Tip: You can also control the mixer page via the keyboard. Select a channel by clicking on it
with the mouse, then you can use the ‘S’ to solo, ‘M’ to mute, ‘R’ to record-arm the track.
The up/down arrow keys nudge the fader up and down, while the left/right keys scroll the
mixer left & right.

*
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8.2. Metering
Mixbus provides a wide range of meters. Each meter is suited to its particular task.

Some DAWs try to put a lot of different scales on a single meter, and/or they expect the user to switch
modes to see different values. Mixbus provides several “different” meters in the places where they are
useful.

Track Meters

In the editor, to the right of each track’s name, you’ll find a small meter that indicates the channel’s level.
This meter grows in height when you increase the size of the track. This meter follows the settings in
“Preferences->Meterbridge->Default track meter type”. The colors for peak-hold time, among other options,
can be applied to these meters. The meter follows the selection for “meter point” in the bottom-right corner
of the associated mixer strip. When a channel is record-armed, the meter point will automatically move to
meter the channel’s input. Due to their scaling, and their location in the editor window, these meters
are well-suited to checking your recording levels while recording

Master Meter (editor toolbar)

In the top of the transport toolbar, you will find a meter indicating the master bus. This meter can be hidden
in Preferences->Appearance->Toolbar. This meter follows the settings in “Preferences->Meterbridge-
>Default meter type for master bus”. By default, Mixbus uses a K-14 meter (the same scaling that is used
for the master bus K-14 meter). In addition, there is a peak-hold indicator with adjustable decay time. The
colors for peak-hold time, among other options, can be applied to this meter. This meter serves to provide
a condensed view of the master bus output when you are editing

Meter Bridge Window
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The Meter Bridge window can be accessed from the main menu, under “Window”. The meters in this window
follow the settings in “Preferences->Meterbridge”. The colors for peak-hold time, among other options, can
be applied to these meter. The meter-bridge is well-suited to tracking a live band, as you can see
several high-resolution meters in a condensed view. You can also show the track rec-arms and
monitor switching from this window

Channelstrip meters
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To the right of each channel’s fader, you’ll find a small meter that indicates the channel’s level. The meter
follows the selection for “meter point” in the bottom-right corner of the associated mixer strip. When a
channel is record-armed, the meter point will automatically move to meter the channel’s input. The scaling
and ballistics of these meters are fixed, so that they are directly comparable across all channels of the
mixer. The channelstrip meters are well-suited to balancing your mix. The scaling is optimized to
show the upper range ( -20dB to 0dBFS ), and it is scaled to match the fader and the compressor
threshold sliders.

The meter beside the fader is a mono meter if the channel strip is created as a mono channel strip. It will be
a stereo meter if the channel strip was created as a stereo channel. Similarly all of the mix buses and the
master bus are stereo and have a stereo meter beside the fader. The picture below shows an example of a
stereo meter, this on on one of the mix buses.
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Channelstrip Compressor and Gate Gain-Reduction Meters

These meters indicate the gain-reduction applied by the channelstrip compressor/limiter and gate/expander
( see Compression Techniques ). Note that the meters display in opposite directions, the compressor meter
displays more gain reduction moving up. The gate meter indicates more gain reduction moving downwards.
The scales have been selected to display the most useful and audible range of gain control.
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Mixbus & Master Bus – Tape Saturation Meter

A Tape Saturation meter is provided on each mixbus, as well as the master bus. This meter indicates the
amount of distortion applied by the tape-saturation stage which emulates the soft compression of tape. If the
meter is fully left, then no distortion is applied. If the meter is fully right, then the signal is heavily distorted.
You can use the “Drive” knob to adjust the amount of tape saturation / distortion. The two buttons to the
right of the Drive knob provide a selection between gentle and aggressive saturation characteristics.

Master Bus K-14 Meter

The K-14 meter is an RMS (averaging) meter, originally specified by mastering engineer Bob Katz as a
means to compare and help control the dynamic range of pop music mixes. (see : http://www.digido.com/
how-to-make-better-recordings-part-2.html ) Use this meter to monitor the perceived “loudness” of your
music mix, and compare the loudness of your mix to other mixes of the same genre

The K-Meter displays the level of the signal directly before the output of the master bus. The K-Meter comes
after the fader, EQ, plugins, and final limiter in the master bus.

If the K-14 meter indicator is straight up, at 0, this indicates that the sound’s average level is at -14dBFS.
This was selected as a good target for most pop/blues/jazz/rock recordings. At this level, a song will sound
quieter than most contemporary pop music, but when the listener turns the volume up to match, the
increased dynamic range of this mix will allow the song to sound much better than a typical pop song played
at the same volume.

Increasing the volume beyond the “0” indicator will result in a louder mix, at a cost of decreased fidelity and
impact when the user turns the volume up.
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Master Bus Phase Correlation Meter

The stereo correlation meter provides an indication of the “mono compatibility”, or stereo width, of your mix.
The indicator uses a bright bar which simultaneously indicates the range of in-phase (highly correlated) and
out-of-phase (decorrelated) sounds in your mix.

• If the indicator is fully to the right, and yellow, this indicates a completely “mono” mix. (the signals in
the left and right channels are the same)

◦ many signals (such as a spoken-word recording with one microphone) should be mono.
• If the indicator is fully to the left, and fully red, this indicates a mix that is completely “out of phase”, in

other words the left and right channels are equal, but one is inverted with respect to the other. This
almost certainly indicates a technical fault which should be investigated.

• If the indicator is largely to the right, and green, then it indicates a mix with some stereo width, but
largely mono compatible. This is optimal for pop music recordings that might be played in a variety of
playback systems.

• If the indicator is in the center, showing a range of red and green, then the mix is very wide stereo.
This is probably not optimal for pop/rock recordings, but can be acceptable for natural or orchestral
recordings. Mono compatibility of this mix is questionable.

Mono compatibility is largely defined by low frequencies. If your mix indicates poor mono compatibility ( red
bar on the left ), then you can probably solve this by reducing the number of bass instruments in the mix,
high-pass filtering any non-bass instruments, and high-pass filter any stereo effects, such as reverb, in the
mix.

Master Bus Limiter

Each segmented LED represents 1 dB of gain reduction in the Master Bus Limiter. The master bus limiter is
a brickwall, lookahead limiter that prevents the digital signal from exceeding -1dBFS. When mixing, use
this bright yellow meter to alert you when you “would have” exceeded the -1dBFS threshold. The
lighted button is provided to enable or disable the limiter.
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8.3. Gain Staging

Click above for video instructions.

What is Gain Staging in Digital Audio?
Digital audio represents the audio waveform as a series of numbers, each number indicating a voltage in the
electrical signal when it was converted from (or to) an analog signal. More numbers (voltage levels)
represents more accuracy in the signal’s representation. Too few numbers introduces “quantization noise”.

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0&start=135

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0

Quantization noise happens whenever you represent the signal with fewer steps than you
had before. This happens quite often inside the computer, where the bit depth changes
depending on many factors. Quantization noise is slightly more offensive than “regular”
(random) noise. For these reasons, we must make sure there’s enough random noise to
cover up any quantization noise that we’ve introduced. This technique is called Dithering,
and careful use of dither is one of the reasons that Mixbus sounds great.

*
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For our purposes, the “noise floor” of a signal is the noise level in the quietest part of the recording; this
might include noise that was picked up by the microphone, or dither noise that was used to cover up
quantization noise inherent to digital maths. If the noise floor is less than the noise in your environment,
then you won’t even notice it.

Generally speaking, 16-bits worth of numbers can recreate everything between a typical quiet-room noise
and a very loud sound (i.e.“CD quality sound”). A 24 bit number can store signals from an infinitesimally
small noise floor (lower than a very quiet studio), all the way up to a roaring jet-engine volume.

Regardless of the number of voltage steps, there will be a value that indicates “maximum volume”, and if
you exceed that value, then the system must “clip” the excessive values to the largest possible value.

A very short “clip” is almost always unnoticeable (just at the peak of a snare-drum hit, for example). But
sustained clipping, when the signal is significantly outside the bounds of the “real world”, creates lots of ugly
distortion that we want to avoid.

So our goal is to prevent signals from clipping, but keep them well clear of and above the noise floor. Luckily
with modern 20+ bit converters, this is very easy to do.

With modern A/D converters, we recommend that you record your signals with the peak meter never
exceeding -15 dB. This indicates that the signal was far from the clipping level when it was converted to
digital. With the increased low-level resolution of modern converters, it is not necessary to record at high
levels.

This video discusses some additional thoughts about gain staging:
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Floating-point processing
Internally, Mixbus uses a technique called floating-point math. For our purposes, this means that some extra
bits are reserved to store numbers outside the range (both louder and quieter) than the range of the analog
world. This means that it is essentially impossible to “clip” the math inside Mixbus. In practice, this means
that you can boost a signal very loud – even louder than would normally be allowed in the analog realm –
and as long as you reduce it by the same amount later, it won’t be clipped when it is heard at the output.

To this end, Mixbus provides many levels of gain adjustment which will allow you a wide range of creative
options.

Region Gain and Region Gain Curves

• Region Gain and/or Gain Automation: Increasing a region’s gain in the editor will provide:
◦ Each region has a volume setting (accessed with the Cut Gain and Boost Gain shortcuts). The

gain increase/decrease visibly affects the waveform display
◦ Region gain curves allow the gain to change through the length of the region

https://www.youtube.com/embed/A7rPJw6wN_4?rel=0
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Channel Strip Gain stages

• Channel Input Trim: This stage is used to bring the overall level of the track to a usable level. The
trim knob is located near the fader for easy access.

• Fader: Used to achieve an overall balance of all tracks in a session. This is also a good place to
make artistic changes such as bringing an instrument forward during a solo.

• Make up gain within the In-line compressor: Make up gain is used to restore perceived level loss
during compression. If the compressor meter is hitting -3 dB during transients, a make-up gain of 1 or
2 dB may be useful. It can also be used as a fast and easy way to adjust the level post fader.

Mix bus

• Input Trim: This knob is used to adjust the volume at the input of the master bus.
• Tape saturation: The tape saturation meter does not monitor level, rather it monitors the amount of

saturation effect. This effect will add harmonic density which can result in an increase in perceived
loudness. Turning the tape saturation knob off will allow signal to pass unaffected.

• Fader Used to achieve an overall balance of all tracks in a session.
• Make up gain within the In-line compressor Make up gain is used to restore perceived level loss

during compression. It can also be used as a fast and easy way to adjust the level post fader.

Master bus

• Input trim This knob is used to adjust the volume at the input to the master bus. This is a useful tool if
you’ve balanced the mix with the track faders, but the overall level is still too low or high.

• Tape saturation The tape saturation meter does not monitor level, rather it monitors the amount of
saturation effect. This effect will add harmonic density which can result in an increase in perceived
loudness. Turning the tape saturation knob off will allow signal to pass unaffected.

• Fader Used to achieve an overall volume of all tracks in a session.
• Make up gain within the In-line compressor Make up gain is used to restore perceived level loss

during compression. It can also be used as a fast and easy way to adjust the level post fader.
• Final Limiter The final limiter is a brickwall, lookahead limiter with a very fast attack and release. The

threshold is preset at -1 dBFS. If a signal peak is going to exceed -1 dBFS, the lookahead limiter will
reduce the volume slightly before and after the peak. Yellow indicators show gain reduction in
increments of 1 dB.

Monitor Section (if enabled)

• Attenuator provides an output level for the speakers, as well as mute and a configurable “dim”
control. Use these controls to reduce the volume in your speakers WITHOUT affecting the level of the
master bus output. For more details, visit the Monitoring Section

VCA Faders (if enabled)

• A VCA Fader can be used to adjust the level of multiple faders from one master fader. For more
details, visit the VCA Strip section.
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8.4. Signal Flow

What is signal flow?
“Signal Flow” is the path that audio follows through an electronic system of wires, and/or its equivalent
inside your computer. The “signal flow” of a recording starts with the performer, and ends with the listener.
This incorporates the microphones, converters, computers, mixers, effects, amplifiers and speakers that
make up the signal path. In this manual we refer to ‘signal flow’ of Mixbus itself. The signal flow starts with
the A/D converter of your soundcard’s input, and proceeds to the D/A converter on the output. Mixbus’s
signal flow consists of input tracks, mixer-strip processors, buses, and monitor stages that execute the
various processes of recording, mixing, and exporting.

Mixbus’s signal flow
The Mixbus signal flow is modeled on an analog console.

Mixbus may have an unlimited number of mono and stereo channelstrips (Tracks). Each channelstrip may
be assigned to any of the mixbuses, and/or directly to the master bus.

In one small way, Mixbus differs from traditional mixing console: each of the mixbus assigns
have level controls, so each of the mixbuses can be used as either an “aux send/return
path” (using the level controls to adjust the send level) or a “grouping bus”, (using the hard
assign buttons with the level control at unity) depending on the user’s needs. Typically in an
analog console, a separate selection of aux sends and grouping buses are provided. If you
are a live-sound engineer familiar with stage monitor consoles, then you already know about
having a level control on each bus send, and Mixbus is exactly the same.

*
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The “redirect” areas are represented by the black box at the top of the mixer strip. Sends, Inserts and
Plugins are “redirects”, and they may be placed in any order, before or after the fader. If a redirect is above
the fader, then it is considered a pre-fader redirect.

The signal flow through each plugin may be modified with Pin Connections.

An important tip about signal flow: The Mixbus “bussing” structure (mix buses + master
bus) is stereo-only. Typically a channel has one (mono) or two (stereo) inputs. This defines
the channel width through the channelstrip. However, it is possible to change the channel
width via plugins. For example you can have a mono-input, stereo-output effect (such as a
chorus or autopanner effect). The last redirect (plugin) in the post-fader redirect box will
define the signal width just before it goes into the panning/bussing section. If the last plugin
has a single (mono) output channel, then the mono panner will be used. If the last plugin
has 2 (stereo) output channels, then the stereo “balance” panner will be used. If the last
plugin has 3 or more channels, then the stereo “balance” panner will be used and the
remaining channels will be ignored by Mixbus.

*

Not shown in the diagram is the Pre-Fader and Post-Fader send mutes. Sometimes when
you mute a track, you still want a Send to remain active (for a headphone feed, for
example). It is possible to disable the mute for pre- and post- fade sends separately. To
enable or disable the pre- and post-fader send mute, right-click on the Mute button in the
editor window.

*
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8.4.1. Mono vs Stereo
When you create a new Mixbus track (or bus), you have the option to make the track either mono or stereo.

What is the difference between mono and stereo?
A stereo signal is typically recorded with 2 (or more) microphones such that a single sound (like a drum) is
captured with both microphones; but because of their separate locations, each microphone will record the
sound with slightly different timing & reflections. It is this difference (similar to the difference detected by our
2 separate ears) that causes stereo recordings to have additional width & depth beyond simple mono left/
right “panning”.

In this document we will always use the word stereo in italics, if we mean a true recorded-in-stereo signal.
Otherwise we will use the term stereo or “stereo” (in quotes) to indicate 2-channel audio with left and right
sides.

2-channel audio is not necessarily stereo

Mixbus is designed to support 2-channel playback throughout. If you feed a true stereo signal into Mixbus,
then Mixbus (by default) will maintain the _stereo_-ness of that recording throughout the signal flow.

You can also take multiple mono signals, and “pan” them to the 2 channels (left and right) by adjusting the
level of each channel. This is sometimes called “pan-pot stereo” or even more commonly just “stereo”. But
this is not strictly a stereo signal.

2-channel files are not necessarily stereo

You might receive a file that has 2 channels (“stereo”) but in fact it does not represent a stereo signal.

For example, you might have a 2-channel file recorded with a handheld recorder. The first channel is the
host interviewer, and the second channel is the guest. In this case, the file has 2 channels but the
information is not stereo and should not be treated as such.

Some other examples might be:

• a vocal track is provided in a “stereo” file. The singer is louder in the left side. But it’s the same
(mono) signal in both tracks, just panned slightly left.

• a snare-drum track might be provided in the upper (head) and lower (snare) mics, but this is not a
stereo signal.

• a kick-drum might be provided with “inner” and “outer” (sound hole) mics, but this is not a stereo
signal.
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In Mixbus, what is the difference between a mono and stereo
CHANNEL (i.e. TRACK)?

Mono channels/tracks

Mono channels use a panner – this means that the mono signal is sent to the right and left channels
simultaneously, and then one side or the other is attenuated to make the sound appear farther to the left or
right of the stereo field.

Stereo channels/tracks

Because stereo is a special case, Mixbus’s stereo channels operate differently. A stereo channel uses a
balance knob instead of a pan knob. A balance knob preserves the left channel in the left speaker, and the
right channel to the right speaker. Then one side or the other is attenuated to “balance” the signal to the left
or right. But the left signal is never mixed into the right side, or vice versa. This preserves the stereo phase
information in the signal.

When you mix a combination of mono-panned and stereo signals into a stereo mixbus, then the mixbus
applies a “balance” control as well, and this maintains the phase relationship of the stereo signals
throughout the mix.

Mixbus also treats stereo signals differently in the channel’s compressor: it is important that the
compressor’s gain-reduction works on both left and right sides equally. This prevents the stereo image from
shifting left or right when the signal is compressed. Mixbus’s stereo channelstrip compressor does this
correctly. This is another reason that, when you have a true stereo signal, you should assign it a stereo
channelstrip. Similarly, if 2 channels are together in a file but not really “stereo”, then you should create 2
mono strips instead of a stereo one.

How do I resolve the problem if I’m given tracks/files that
don’t match my needs?
The easiest way to solve your mono/stereo questions is to resolve it during file “import”.

When you import a file, in the import dialog, there is a “mapping” pulldown menu which allows you to either:

a) select “one track per channel” to split selected stereo files into mono tracks.

Some workstations (like Apple Logic) will export tracks in 2-channel (“stereo”) by default,
even if the information is exactly the same in both the left and right tracks ( i.e. center-
panned mono ). In this case, you might want to import the track as 2 mono tracks, and then
discard the redundant track from the editor.

*
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b) select “one track per file” to import stereo files as stereo tracks.
c) select “sequence files” to import all the selected files into one track, sequentially.
d) select “merge files” to combine 2 mono files of identical length into a stereo track. ( this option ONLY
appears when 2 files of identical length are selected ).

How do I convert a mono signal to stereo?
Strictly speaking, a mono signal cannot be converted to stereo. It wasn’t recorded with stereo phase
information from a spaced pair of microphones.

However there are several ways to make the mono signal occupy both channels in a left/right “stereo” mix:

• Every mono channelstrip has a “pan” knob that allows you to pan the signal left or right.
• Insert a plugin that changes the channel’s signal from mono to stereo. Normally Mixbus uses only the

“left” side of a plugin, if you insert a stereo plugin on a mono channel. But you can right-click on a
plugin and choose “pin connections”, “add output” to split the channel into stereo for a mono-in,
stereo-out plugin.

• Assign the channel to a stereo mixbus, and apply an effect that enhances the left/right panning, such
as a reverb, haas delay, auto-panner, chorus or doubling plugin.

How do I convert a stereo signal to a mono signal?
Generally speaking, if you have a true stereo signal, you shouldn’t just sum the 2 channels together and
make a “mono” signal. The different time/phase relationship between the left and right sides will cause
frequency cancellations and other artifacts.

If you have a truly stereo signal, it is rarely necessary or desired that you would want to make it mono. One
exception might be the case where the stereo mic selection/location was poorly chosen. In this case,
perhaps the best solution is to use only the “left” side, or the “right” … whichever sounds better for your
needs.

If you have a stereo signal and you feel you must make it mono, some solutions might be:

• Assign the stereo track to a mixbus, and use the mixbus’s width control to make the signal “mono”. (
this mono-summing happens at the top of the channelstrip, before any plugins )

• Insert a plugin that provides a stereo-width control. (optionally: right-click on the plugin and choose
“pin connections” if you want the plugin to have a single (mono) output)

How do I convert a stereo track to 2 mono tracks?
If you are “importing” a track to mix, the best way is to make this decision during the import operation.
Select the option “one track per channel”, and your stereo file will be split into 2 mono tracks which you can
manipulate separately.
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If you have recorded a stereo track, and later want to split it into 2 mono tracks, you should first ask yourself
why you did this recording in stereo, at all :)

Mixbus provides a Lua script which can split a stereo track into 2 mono tracks. The stereo track’s Playlist
(including all edits) will be split into left and right components, and assigned to 2 new tracks. Each track has
the same processing applied as the source track. To access the script, click Window->Scripting->Actions-
>Stereo To Mono->Run

How do I convert 2 mono tracks to a stereo track?
If you’ve read the prior information on this page, you might understand why converting 2 mono track to
“stereo” is not as easy as it sounds. Consider the case where each of the mono channels has slightly
different plugins, EQ, edits, and other details. We can’t trivially convert 2 mono tracks into a single stereo
track.

The only sensible way to convert 2 mono tracks into stereo is to solo the 2 tracks, export the mix to stereo,
and re-import the resulting file as a stereo track. (then de-activate or remove the original mono tracks) We
might make a convenience function that does this automatically in the future.

In many cases, you don’t want to convert the tracks to stereo at all; instead you should consider making a
“group” for the 2 tracks. This will “tie the tracks together” so that selections, fader levels, colors, and other
parameters will be changed together, as if they were a single track. But you’ll still have individual panning,
plugins, EQ’s and such. Since you can’t “really” make 2 mono signals into stereo anyway, this is usually the
best choice.
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8.4.2. Bussing

What is a Bus?
A bus is a signal path onto which one or many audio signals are combined to arrive at a common place for
further processing. In the earliest days of analog circuitry, a “bus” was simply a wire onto which a number of
signals were summed together, and then directed to the next stage of processing.

In digital audio, the electrical wire is replaced by a series of numbers representing a signal that is the
arithmetic sum of a number of individual signals. This final value is then passed to the next processing
stage.

Buses are typically used for these fundamental mixing tasks:

1. Combining multiple signals onto the “master bus”, or main mix which feeds your speakers or
headphones.

2. Making a monitor mix, similar (but not necessarily identical) to the master bus, in which an artist can
hear themselves and other musicians.

3. Combining a subset of similar signals into a subgroup or “group bus”: for example you can make a
bus that combines the drum tracks into a Drum Bus.

4. Developing a secondary (effects or aux) mix, which is then processed with an effect such as reverb.
For example you can “send” multiple signals to a single reverb effect, with varying levels.

https://www.youtube.com/embed/cuInwhnrtlk?rel=0
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How do I use buses in Mixbus?
Mixbus has a built-in bus summing structure that is very similar to an analog mixing console. Visit Sends
Section to learn more.

Mixbus also has the ability to create an arbitrary number of “buses” ( some DAWs call these Aux Tracks, or
Inputs ) from the “New Track/Bus” dialog. You can connect these buses in various ways via the the channel
input, outputs, and “sends” mechanism. You can learn more about this in the DAW-Style Mixing Buses
section.

However, we encourage users to focus on the provided mixbus summing architecture, which operates like
an analog console. In most cases, this will result in the easiest, fastest, and best-sounding operation. This
bussing structure is what makes Mixbus special.

Rather than adding a plugin to every channel, using buses can be less taxing on your
computer. Inserting a plug-in, such as a reverb, on a bus saves the need of inserting a
reverb across many individual tracks. This also ensures the plug-in applies the same effect
across all the tracks being bussed for a more coherent and realistic sound.

*

A “bus” has no recorded audio stored in it like an audio track does. A bus serves to sum and
processes audio signals “live”. Buses do, however, have a representation in the editor
timeline, so their controls can be ‘automated’.
*
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8.5. Input Strip
The input channel strip is the fundamental element in the mixing window. This is where an audio signal is
routed, processed, and then sent to either a mix bus or the master channel. An input channel strip can be
mono or stereo.

• New in Mixbus v6 are the positions of the Polarity and VCA assign buttons. They are now always
displayed at the bottom of the channel strip.
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The features of the input strip include:

• The Rec/Input switcher – see section Rec/Input (“Switcher”) Section
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• The redirect box – see section Redirects – Plugins, Sends & Inserts

• The EQ section: see section EQs
◦ EQ “IN” – Enables the EQ section
◦ 3 EQ bands, each with +/-15 dB gain:

▪ low and high bands are shelving with adjustable corner frequency
▪ the midrange band is parametric with proportional-Q peaking ( Q increases with additional

boost/cut ) with frequency and cut/boost variable

• highpass filter knob – changes the the highpass filter corner frequency
◦ filter is second-order ( 12 dB/octave ) and always enabled when the EQ is enabled

• Mixbus Sends Section: see section Bussing
◦ 8 mixbus sends, each with On/Off switch, and level control

• Stereo Pan Knob
• Master Bus Assign (“Mstr”) : when this is lit, the signal will be sent directly to the Master bus (in

addition to any mixbus assignments) post panpot

• Channel Mute and Solo

• Input Trim knob : the input trim value is applied immediately after track playback, and BEFORE any
plugins in the redirect box

• Fader
• Meter : the channel meter is a digital peak-reading meter; the scale is the same as the fader and the

compressor threshold

• The Compressor Section: see section Compression Techniques
◦ Comp “IN” – Enables the compressor section
◦ Makeup Gain – provides up to 10dB of Makeup Gain; this gain is only active when the

compressor is enabled
◦ Threshold – the threshold indicates when the compressor will begin working on the signal;

reduce the threshold slider to compress more
◦ Gain-Reduction meter – indicates gain reduction, in 1dB increments
◦ “Speed” & “Mode” knobs : see Compression

• Fader level : this displays the curent fader position, in dB. Click to enter a value.
• Meter peak-hold : this displays the loudest digital-peak value that has been detected by the meter. It

turns red when the value is over 0dBFS. Click to reset the value.

• Fader Automation selector : select between Manual, Play, Write, and Touch. This control only affects
the channel’s fader
.

• Group selector : click this button to assign the channel to a Group ( see: Groups )
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• Meter Position selector : click this button to select the meter position ( Input, Pre-Fader, Custom,
Post-Fader, Output )

• Polarity switch

• VCA Assign

View Pulldown
There is an additional method for displaying the Rec/Input menu on the channel strips. Rather than clicking
the button on the channel strip, the View pulldown menu provides either a menu click or keyboard shortcuts
for switching the display. The display changes for ALL channels, not just a selected channel. The figure
below shows how to access this control and also shows the associated keyboard shortcut.
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Other Buttons and Controls

Polarity

• Click this button to invert the signal’s polarity. On a stereo channel, you will see 2 polarity switches,
one for each channel.

VCA

• Click this button to assign one or more VCA faders to control this channel’s fader and mute. See the
section VCA Strip for details.

Grp

• Grouping links faders together for common control. Click this button to assign this channel’s fader to a
group. See the section Groups for details.

M

• Click this button to select the desired fader automation mode. The choices are Manual, Play, Write,
Touch and Latch. See the section Fader, Pan and Plug-in Automation for details.

General Operation
Channel strip operation is the same as everywhere in Mixbus.

• mouse left-click on a button to activate it
• to turn a knob or move a fader, click and hold on it and move the mouse up and down
• double clicking on most knobs will snap it to its center position, 0dB position (3 o’clock) on a mixbux

level knob
• right-clicking on the channel slate will bring up a menu where you can change the name, colour, input

or output routing, and other options:
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• right clicking on the compressor button allows you to select between leveller, compressor or limiter
operation:
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8.5.1. Rec/Input (“Switcher”) Section
At the top of any mixer strip, you’ll find a “Switcher” control which allows you to toggle the visibility of the
Rec/Input section, which provides controls for the Record-arm, Input selection, Monitor modes, and
Comments. When the internal controls are hidden, the Rec’/Input switcher provides an overview of the
channel’s record-arm status.

The track controls vary slightly between Tracks, Buses, Mixbuses, and the Master strip. The buttons on an
Input strip include:

• Record arm: Click this button to arm the track for recording. An armed track shows a solid red dot.
• Monitor: Input : This button forces the channel to monitor it’s input. See monitoring
• Monitor: Disk : This button forces the channel to monitor it’s disk playback. See monitoring

◦ In version 6 both monitor input and monitor disk can be enabled
• Input : Use this button to select the soundcard input(s) or other sources to feed this channel.
• Comments Button : Click this button to enter comments for the channel.

On Mixbuses and the Master strip, only the Comments Button is presented. It will displayed or hidden
when the switcher on any channel strip is selected.

Click on a “switcher” to change ALL channelstrips and mix buses to show the same
controls. This is a quick way to view all of your channel I/Os and other settings while
preparing for your mix. Then Click again to switch all the channels back to show the signal
flow.

*
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8.5.2. EQ Section
Channel Strip EQ

The Channelstrip EQ provides a very wide range of frequency and gain changes ( up to 15dB! ) to help tame
your tracks. The high and low bands are shelving filters for general tone sculpting, while the middle band is
a “proportional Q” bandpass design.

The proportional-Q design was used in the original Harrison consoles to allow an engineer to use the EQ as
either a subtle tone shaping tool, or a steep filter problem-solver, with only 2 knobs. As the gain is
progressively increased (or cut), the bandwidth becomes progressively narrower (“Q” increases). A typical
technique to eliminate an unwanted tone or resonance is to increase the gain to maximum cut, sweep the
frequency to find the offending sound, and then turn the gain to the minimum cut required to “notch” out the
unwanted frequencies (remembering that reducing the amount of cut widens the bandwidth and attenuates a
wider range of frequencies).

Specifications:

Gain Range +/- 15dB

Frequency Ranges (adjustable):

• HI: 800 Hz to 15,000 Hz Q=1.0 Shelf
• MID: 200 Hz to 4000 Hz Proportional-q bell
• LO: 40 Hz to 400 Hz Q=1.0 Shelf

HPF 12 dB/octave, frequency ranges 20 to 1,000 Hz
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You can copy EQ settings from one track to another by dragging the EQ processor (in the
processor list at the top of the channelstrip) onto another channel’s EQ processor.*
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8.5.3. Sends Section
The picture below shows the Mixbus v6 send controls:

Mixbus provides these bus send features from each input strip:

• 8 stereo mixbus “sends” which correspond to the 8 available Mixbus Strips in the mixer window.
◦ Each mixbus send has an on/off indicator, and a level control.
◦ Mixbus sends occur at the end of the processing redirect list, and therefore are post-fader and

post-pan ( by default, they follow the master bus pan setting )
◦ In the image above Mixbus send “1” is enabled, and the name corresponds to the name set on

Mixbus strip 1

• Master bus, with on/off indicator and stereo pan control
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Bus Assignment

To assign to a mix bus, click on the button or the label for the desired mix bus. A lighted button will indicate
an active assign to the mixbus. All of the lit buttons have slightly different colours to help distinguish them.
To adjust the level of the bus send click and hold on the knob, moving the mouse up or down will turn the
knob in the desired direction. Double clicking on the knob will restore it to the default 0dB position at
approximately the 3 o’clock position. If the bus send is OFF, double clicking the knob will also turn it ON.

As all mix buses are stereo, the channel strip signal is panned into the selected mix buses. By default a
channel is panned to a mixbus according to the position of the master bus pan knob.

Utilizing a mixbus as a “Group Bus”:

To use the mixbus send as a “group bus”, you will typically click the Bus assignment button, and leave the
bus send knob at the default position of “unity” or 0dB.

For example, you might assign all of the “drum” tracks to mixbus #4, and name it “Drum Bus”. In this case,
you have a single volume control (fader), EQ, compressor, and series of plugins that can be applied to the
drum group overall.

Utilizing a mixbus as an “Effect Send”

To use the mixbus send as an “effect bus”, you will typically click the Bus assignment button, and then
adjust the “send” knob to the desired level.

For example, you might assign the snare drum to mixbus #4, where you’ve placed a reverb plugin. You can
now adjust the level of the snare in the reverb bus, as compared to other instruments that are also feeding
the reverb bus.

Bussing shortcuts

• Control clicking (Command on Mac) a bus on/off will exclusively-assign the track to that bus (other
buses will be turned off, so the track ONLY goes to the selected bus)

From an input channel, you may send to any combination of the multiple mixbuses and/or
master bus simultaneously. Latency compensation is provided in the mixer so that these
signals will reach the master bus with coherent timing.
*

By leaving the master send on and engaging a Mixbus send, you may hear both audio feeds
simultaneously. The result will be an increase in volume. For that reason, you might want to
use the “exclusive assign” shortcut, by holding Ctrl ( or Cmd on Mac ) which will assign the
channel to the desired bus, and immediately de-assign from any other buses, including the
master bus.

!
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• Shift+Control clicking on a bus will assign ALL tracks to that bus. This is a quick way to send (or
remove!) every track from a bus.
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8.6. Mixbus Strip
There are 8 “mixbus” buses. All 8 are fed from the mix bus sends of the input channels.

Harrison Consoles Mixbus - 9_en

Page 317 of 848



Harrison Consoles Mixbus - 9_en

Page 318 of 848



Mixbus EQ

Each of the 8 mixbuses provides a 3-band “Tone” control.

The Mixbus EQ provides carefully chosen center frequencies, and wide tone-shaping shapes, to provide
overall tone control of the signal on the bus. The gain range is slightly lower than the channelstrip EQs and
the bandwidth is wider, to provide more nuanced controls.

Specifications:

Gain Range +/- 9dB

Frequency Ranges (fixed):

• HI: 2000 Hz Q=1.0 Shelf
• MID: 800 Hz Q=0.7 Bell
• LO: 300 Hz Q=1.0 Shelf

Additional Feature
• If the Mixbus is renamed, the new name will be propogated beside that mix bus’s send knob on all

channel strips:
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8.7. Master Strip
Mixbus provides a single Master channel. The Master channel provides the final output signal for listening
via speakers or exporting to wav files.
The Master channel has a built-in transparent signal limiter (with look-ahead) to avoid the distortion that
occurs in overly loud digital signals.
The various controls on the Master are very similar to those on a channel strip and all operate exactly the
same way.
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Master Bus EQ

The Master Bus EQ provides very fine control of the final output tone. The band frequencies are carefully
chosen to address the problem areas of a typical pop music mix: very low frequencies, mid-low frequencies,
and “very high” frequencies ( leaving the primary mid-band relatively unchanged, as the reference ) The
limited gain range ( +/- 6dB ) provides for very fine adjustments.

Specifications:

Gain Range +/- 6dB

Frequency Ranges (fixed):

• HI: 4000 Hz Q=1.0 Shelf
• LO/MID 300 Hz Q=0.7 Bell
• LO 90 Hz Q=1.0 Shelf

Tape Saturation Distortion Meter and Drive knob
This is an emulation of saturation characteristic of recording tape. The Drive knob controls the amount of
additional distortion added to the signal. The identical function is also available on every Mixbus strip.

This video demonstrates the use of this feature.
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Monitor Panel Button
Optionally, a monitor section can be added between the Master Bus output and the physical audio interface
(soundcard input, etc) so that monitoring can be controlled without affecting the actual Master Bus output.

• When the Monitor section is added, another button is added to the Master strip which controls display/
hide of the monitor strip.

• The monitor panel is added or removed by selecting Session -> Monitor Section -> “Use Monitor
Section”

https://www.youtube.com/embed/N2axraYt2p4?rel=0
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See the details of the monitor panel and its functions here: Monitor Strip
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8.8. Monitor Strip
The “monitor section” is a signal path that may be inserted between the master bus in Mixbus and the input
of your interface, particularly useful if you do not have a good hardware monitor controller in your setup. The
Monitor Section allows you to control what you hear, WITHOUT affecting the main mix which will be
exported. It is important to avoid using the master bus fader as your “volume control” while mixing, because
changes to the master fader will be applied to your final mix, which not only changes the volume of the mix,
but can also affect any post-fader processing (such as the Master Bus Limiter or the Tape Saturation on the
output bus). Instead you should use the master bus to set the level of the final mix, and use a separate
volume control to adjust your “listening level”. The Monitor section in Mixbus provides a way to do this, and
more.

This “listening level” can be provided by your laptop speaker volume, your powered speaker volumes, a
mixer, or a dedicated monitoring solution. In many cases, such as mixing on-the-go with headphones and no
external gear (among many other examples), the Mixbus “monitor” section might be the preferred option for
controlling your listening volume.

The monitoring section serves these functions:

1. It provides a “volume control” that can be used to adjust your listening level, without affecting the level
of your actual mix.

2. It allows some conveniences such as “mono”-izing your mix, or muting speakers, so you can audition
your mix in mono.

3. Because the monitor path provides a separate listening path outside of the mixer, it is possible to
send Solo’ed tracks to the monitor, without affecting what is happening to the main mix. This is called
AFL or PFL soloing. (more details below)

4. It allows the insertion of plugin processors. These processors can be used for room EQ or other
corrective measures. The processors only affect the listening path, not the main mix.

5. It allows the selection of any physical output ports on your D/A converters. This can be used to switch
between alternative monitoring systems.

The monitor panel can be added or removed in 2 ways:

• selecting Session -> Properties – > Monitoring -> “Use Monitor Section in this session”:
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OR

• selecting Session -> Monitor Section -> “Use Monitor Section”:
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Once activated, the monitor section will be visible on the rightmost side of the Mix window as shown.

The Monitor volume knob does not adjust the volume of the Metronome ( “click”). By default,
the outputs of the click are connected directly to the first 2 outputs on your soundcard,
which typically feed your speakers directly. You can adjust the volume level of the click by
visting Preferences->Misc->Click. And you can change the outputs of the click by visiting
Window->Audio Connections.

*
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The Mixbus Monitoring Section:
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Clicking on the “Processors” button opens the redirect section of the monitor strip, permitting plugin
processors such as room correction or monitor EQ to be inserted in the monitoring path.
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Examining the Various Volume Controls in a Typical System

The Volume Control on Your Monitors

Usually you can find a volume control on your monitors (if they are active) or on an outboard amp (if they
are passive). This volume control is suited to calibrating your monitors to a reference SPL. Once calibrated
you can forget about this control other than periodic re-calibrations (SPL calibration of monitors is beyond
the scope of this document but much information is available on the internet).

The Audio Interface, or external Monitor Controller

Some people prefer to use a Monitor Controller to control the DAW output, as well as a few other sources,
that can also drive multiple sets of speakers and headphones. These devices have various features that
allow you to control exactly what you are listening to. Sometimes, audio interfaces can also provide this
functionality with either a hardware or software based volume control that accesses the internals of the
interface. Some are elaborate and some are simple; consult the documentation for your interface to find
details.

The Master Fader

The pitfall of using your master fader as a monitor level control:
Lets say you adjust your master fader to achieve the ideal monitoring level, and later you attenuate it to give
your ears a break. If you forget about this attenuated setting it could easily lead you to make some poor
mixing decisions later. Additionally, you may print your mix at this attenuated level (bad mix decisions and
all) and not realize it. And, the dynamic tonality of the mix can be modified if you lower the master fader and
the output “hits” the Master Bus Limiter and Tape Saturation differently, providing more or less limiting and
saturation.

PFL or AFL Headphone setup.

Using Dual Monitor paths are a way to solo tracks to hone in on a problem track or isolate a certain sound in
your mix but have this soloed track just go to your headphones and not affect the entire mix. This can be
useful in a live environment whether for a live stream in the studio or an a live venue.

To set this up:
1. Assign the Master Bus to “Monitor In” so your main mix will feed the Monitor Bus
2. Open the Routing Grid and chose Main Output 1 and 2 to send to your studio monitors or main speakers
of the venue
3. Assign the outputs of your Monitor Bus to where your headphones are connected. In this example I have
them routed to 3 and 4

Whether your monitors are calibrated to a reference SPL or not, a monitoring section is still
vitally important in achieving a consistent sound.*

Harrison Consoles Mixbus - 9_en

Page 332 of 848



To test this setup assign your Solo mode to PFL or AFL. You will now hear your soloed tracks just in your
headphones and will not affect the main mix you are sending out to your monitors.
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https://www.youtube.com/embed/czN_KwvKlI4?rel=0
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8.9. VCA Strip

What is a VCA Strip?
A VCA, or VCA Master, is similar to an input strip; it has a fader, mute and solo button; but it does not pass
audio itself. Instead, it controls the value of the mute, solo and fader of the channels that are “attached” to
it.

Watch this video to learn more about Mixbus’s VCA implementation:

In the screenshot below, 4 VCA masters are visible on the right side of the mixer:

https://www.youtube.com/embed/4yr-eodbdvs?rel=0
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Mixbus allows a channel to be attached to “unlimited” VCA masters. You can add VCA masters in the
“Track->Add Track/Bus” dialog from the main menu.

Creating a VCA Master

To create a VCA master, select Track -> Add Track,Bus or VCA -> VCA Masters:
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Assigning a track to a VCA Master:

To assign a track to a VCA master, click on the “VCA” button at the bottom of the Channel or Mixbus strip,
and click the boxes of the the VCA you wish to assign to control the strip.
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After VCAs are assigned, you will notice that the “VCA” button is replaced with indicators showing which
VCAs are assigned to control this strip:

Alternately, in the Editor window select the tracks, and then right-click in the black area to the left of the
track boxes, and choose “Assign Selection to VCA…”
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VCA Strip Operation:

The “Spill” button, when activated, will hide all channels that are NOT attached to the VCA Master. If you
have a group of channels assigned to a VCA master, this is a very quick way to display those channels in
the main mixer area. Only one “Spill” ( either VCA or Mixbus ) can be active at one time.

The Mute button will mute ALL channels and buses that are controlled by this VCA.

The Solo button will provide a solo which is the pre-fader sum of all channels and buses that are controlled
by this VCA.

The VCA name displayed is the name you entered when creating and adding the VCA.

Fader Automation mode button. This control only affects the VCA’s fader. Select between
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• Manual
• Play
• Write
• Touch
• Latch

The VCA Control button always displays the VCA number. Right-clicking on the button provides these
features:

• Rename
• Color
• Assign Selected Channels
• Drop All Slaves
• Remove

The VCA control button always displays the VCA number.
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8.10. Foldback Buses
“Foldback Buses” are summing buses specifically intended for cue/headphone mixes. You can build a
custom mix on a foldback bus, independent of the master mix, and send it to a performer’s headphones.

Creating Foldback Buses
On the Track menu select “Add Track, Bus or VCA -> Foldback Busses

You may select:

• the number of foldback buses to add
• the names of these buses
• whether they are mono or stereo

The Foldback Strip
The image shows the Foldback strip when displayed. Unlike mix buses or channels, there is only one
foldback strip displayed. You can select which of the foldback buses you are looking at by clicking the
arrows at the top of the strip. The entire foldback strip is hidden by pressing the “hide” button. The foldback
strip may be redisplayed by going to the View tab and selecting “Mixer: Show Foldback Strip”.
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Some Foldback Strip operations are as follows:
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• Foldback Control Button
- Click this button to show and select from the list of Foldback buses created. Right-click to access a
menu for output routing, renaming, commenting or removing

• Polarity Button(s)
- Inverts the polarity of the Foldback bus. If it is a stereo bus, there will be a button for each channel
as shown here.

• Sends Area
- this area will display the sends to the displayed foldback bus. A slider sets the send level from each
source. If the foldback bus is stereo there will also be a pan knob displayed. As elsewhere in Mixbus,
to adjust the pan click and hold on the knob and move the mouse up and down.
- The “Show Sends” button will flash when engaged. The level indicator at the bottom of the channel
(or Mixbus) strips assigned to this foldback will indicate the send level, rather than the channel fader
level.
- If the foldback bus is stereo a balance control will display above the plugin area. Click and hold to
move the yellow arrow left or right to adjust the balance. This control can be disabled by right-clicking
and selecting the “Bypass” box. The balance control will remain visible but grayed out if disabled. The
right-click also provides a few other controls such as balance law selection and numerical balance
entry.

• the plugin area works the same as elsewhere on Mixbus. Plugins can be inserted and ordered relative
to each other and the rotary fader.

• at the bottom there is the standard comment box, and the output routing button.

Routing to the Foldback Buses
To route a channel or Mixbus to a foldback send, right click in the plugin area of the strip, select “New
Monitor Send” and choose the foldback bus to be routed to. The foldback bus must have been created
already in order for you to be able to route to it.

• on the foldback bus the send level slide control described earlier will appear, and if the foldback bus is
stereo, a pan knob as well.
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Getting It Out
At the bottom of the Foldback strip is the standard Mixbus routing button. You can access the Routing
Matrix feature to send the foldback bus output to your audio interface. If the foldback bus is stereo, you will
have to route both outputs explicitly in the routing grid.
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8.11. “DAW Style” Mixing Buses
Mixbus was created to specifically look and operate like an analog mixing console. The built-in Master bus,
Mixbuses and grouping and VCA features supplemented by the new Foldback bus feature should facilitate
99% of your workflow requirements. However some users may want to retain the workflow used by other
DAW products i.e. creating your own summing buses (sometimes called “Aux” buses). Mixbus provides this
operating flow should you choose to use it.

“Aux” or “Utility” buses are audio channels, just like tracks, but they do not record or play back audio.
Instead, they accept audio at the input, process it, and send it to the mixing buses. (In ProTools, these are
called Aux Tracks)

Creating a Mixing (“Aux”) Bus
To create a “DAW Style” mixing bus (also sometimes called an “Aux” bus), go to the “Track” pulldown and
select “Add Track, Bus or VCA”. Then select “Audio Busses”. You can select the number of buses to add,
whether they are mono or stereo, their names, and whether they are assigned to a group.

An Aux bus, like a mix bus or master bus, has no recorded audio stored in it. A utility bus
serves to sum and processes the audio.*
These buses are provided to support DAW-like workflows, and exist outside of the Harrison
mix engine. These kinds of buses are good for utilitarian tasks, but they do not have the
same controls as a “True Analog” Mixbus bus.
*
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Note that the “Aux” bus strip looks and operates exactly like a channel strip, except that its input is the sum
of whatever audio is routed to it, and its audio content is not recorded. It’s output can be routed in the usual
way to the master stereo bus, the 8 (12 in Mixbus32C) mix buses, or anywhere else desired using the
Mixbus routing grid. For more on routing a bus using the Mixbus routing grid see the section Sends and
Inserts.
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Routing to an Audio (“Aux”) Bus
To route to an audio bus of this type, right-click in the Redirect section of any channel or Mixbus. Select
“New Aux Send” and the bus you wish to route to.

In the Redirect section of the sending channel or Mixbus an AUX bus send button and a level slider will
appear as shown in the picture above. As with all other items in the Redirect area, dragging the bus send up
or down will permit the send to come from anywhere in the signal path.

More details of the AUX bus send can be viewed by double clicking on the AUX bus button. Double click the

If “New Aux Send” is disabled (grayed out), it probably means that you haven’t yet created a
bus to send to. Create a new Audio Bus first, and then the option for “New Aux Send” will
appear.
*
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button again to return to the regular channel strip view:
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In this picture you see the AUX send level slider and level send meter (which measures POST the send
level slider). The regular processing and bus send sections (if displayed) remain above (this picture is a
Mixbus32C example with the regular mix bus sends displayed).

You can delete a bus by right-clicking on it, in the editor or mixer view, and choosing “Remove”.

Panning Options
Pan operation to an AUX bus depends on the type of AUX bus you created.

• If the AUX bus you created is MONO, the channel pan control has no effect on the send to the AUX
bus. The AUX strip’s main pan control controls panning to the main stereo bus and mix buses in the
usual way. The AUX bus send detail will appear as in the picture above.

• If the AUX bus you created is STEREO, there are additional options that can be selected:
◦ by default, pan to a stereo AUX bus follows the channel main pan knob (which controls panning

to the mixbuses and the master stereo bus). The pan slider will be shown when displaying the
AUX bus details, as shown in the next picture:
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The pan slider follows the channel strip main pan knob, and vice versa. Panning to all buses can be
adjusted with either one.

• To pan the AUX bus send independent from the main channel pan knob:
◦ right-click on the AUX bus send button, go to “Send Options”, and UNCHECK the “Link Panner

Controls” box:
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This feature gives you independent pan control for each stereo AUX bus you create, independent of the
main pan knob to the master stereo and mix buses.
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Feedback Option
Note the “Allow Feedback Loop” check box in the figure above.

By default Mixbus prevents you from creating signal routing paths where the output somehow ends up at its
own input, a bad thing that should always be avoided. This is especially possible with AUX buses when you
aren’t paying attention to what you are doing. However if you need this capability, checking this box will
allow you to do it at your own risk.
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8.12. Mute and Solo

What are Mute and Solo?
The simplest explanation of Mute and Solo are:

Mute: When enabled, the mute button prevents the track from being heard.
Solo: When enabled, the solo button mutes all the tracks except this one.

….but there are many subtleties, especially for Solo, that are called upon to solve vexing problems that we
encounter as audio engineers.

Mixbus provides Mute and Solo buttons, and a wide range of options, to meet these needs.

By default, when you solo a track, the other (non-soloed) tracks are drawn with a yellow frame. This
indicates they are “implicitly muted”. ( i.e. muted by someone else )
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You can disable this “implicit mute” display in Preferences->Monitoring->Solo

Solo Operations
Exclusive Solo:
ctrl + alt + click on a Solo button (OSX: command +control + click). Normally, if more than one track/bus is
solo’d, they will all play, but this allows you to listen to only one solo’d track when more than one have been
solo’d.

On the solo/mute controls left-button (button 1) mouse clicks do the following, depending on holding these
keyboard modifiers:

• no mod: toggle solo on/off
• Primary mod (usually ‘Shift’): override track group
• Primary + Secondary modifiers (usually ‘Shift’ and ‘Ctrl’): exclusively solo this track
• Primary + Tertiary modifiers + click: apply to all

Middle-click (button 2):
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• no mod. : momentary toggle (until release)
• Primary mod: assign generic MIDI. (if generic midi control surface is enabled)

Right-click (button 3) brings up a context menu:

• Solo Isolate
• Solo Safe
• Mute-points

Solo Isolate
“Solo Isolate” is a mode which prevents the channel from muting when other channels are soloed. This
mode is used, for example, on a reverb return where you’d like to always hear the reverb, even when a
channel is soloed which would normally mute this channel.

You can Ctrl-click (Cmd on Mac) on a channel to Solo isolate it. Or Right-click on a Solo button to see a
context menu with this option.

When a channel is Solo-Isolated, the word “ISO” will appear in the “switcher” area at the top of the strip.

Solo Safe
“Solo Safe”, when enabled, will “lock” the current state of the Solo button so the user cannot accidentally
change it by clicking on the Solo button. If the channel is Solo’ed, it will not be possible to un-solo the
channel by clicking the Solo button.

To activate this option, Right-click on a Solo button to see a context menu.

Solo’ing with a Monitor section
If the session has a monitor section (Session > Properties > Monitoring), there are additional controls for
Exclusive Solo, Mute/Solo overrides and Pre/After Fader Listen available. Click here for details.

Solo’ing Mixbuses
Like a real console, the mixbuses are a separate mixing stage. Imagine the 8 (12 in 32C) mixbuses are like
a second, standalone mixer. So when you solo a mixbus, the other mixbuses are “implicitly muted”. There’s
no interaction between the inputs and the mixbuses, so soloing a mixbus does not implicitly mute or solo
any tracks.

These shortcuts (group override, apply to all) are also available for other controls where
applicable (e.g meter-point,..). See Mixbus Conventions & Tips*
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Utility buses aren’t really a mixing stage at all; they are just a signal path where you can combine other
paths (or split them out from a multichannel plugin, for example). In this case, when you solo a utility bus
then it also has to solo all the things feeding into it. Similarly, if you solo anything, it has to make sure that
the “utility buses” that it feeds are soloed and this causes other stuff to get implicitly muted.

The best plan is to keep your signal paths simple, and you’ll get the best results. Just because you “can”
add a bunch of buses and options, doesn’t mean that you “should”.
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8.13. Redirects: Plug-ins, Sends & Inserts…
The black box near the top of each channel strip, mix bus, and master bus is the “redirect box”. Mixbus uses
the term “redirect” for the items that can be inserted into a channel strip: plug-ins, sends, and inserts. In
the image below, the track on the left has the “XT-BC Bass Character” plug-in, the track on the right has an
insert and a send. The XT-BC Bass Character plug-in and the send are pre-fader (because they are above
the fader entry) while the insert is post-fader. The signal flow of Mixbus is very flexible: you can order sends,
inserts, plug-ins and the fader arbitrarily simply by click and dragging up or down (note: the XT-BC plug-in
shown is for display purposes and may not be included in your purchase of Mixbus).

• Plug-ins
• Sends and Inserts

Plug-in Control Sliders

Below each plug-in, you may add one or more “Plug-in Control Sliders.” Each Slider controls a single control
parameter for the plug-in it is under. You may show or hide plug-in control sliders by right-clicking on a plug-
in and selecting “Controls.” In the above image the “XT-BC” plug-in has control sliders shown for “Body –
Freq” and “Clarity -In.”

Note: By default, plug-ins and inserts will be created pre-fader, while sends will be post-
fader. But you can drag them into any order you choose.*
Channel strips are created preconfigured with an EQ and Compressor plug-in already
installed (the top two reddish plug-ins in the above image). Signal routing can be changed
by reordering here. The controls for these are found within the GUI of each channel strip.
*
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The Redirect Menu

Right-clicking in a redirect box will launch the redirect menu. These choices are available in the menu:

• New Plug-in>
◦ Favorites: a list of favorite plug-ins, pre-selected from the Plug-in Manager (more here).
◦ Plug-in Manager: launch the Plug-in Manager (more here).
◦ By Creator: a list of plug-ins, sorted by their creator.
◦ By Category: a list of plug-ins, sorted by type (note: this is only useful for plug-in formats that

support this).

• New Insert: create a new Insert (Send and Return).
• New External Send: calls up routing matrix
• New Aux Send: create a new Send.

—————————————-
• Controls: Allows the addition of one or more “Plug-in Control Sliders” to be displayed.

—————————————-
• Clear (all): Remove all redirects from this track/bus.
• Clear (pre-fader): Remove all redirects from this track/bus pre-fader.
• Clear (post-fader): Remove all redirects from this track/bus post-fader.

—————————————-
• Cut/Copy/Paste/: Cut/Copy/Paste/ the selected redirect.
• Delete: delete the selected redirect (you can also shift-left-click any redirect to delete it).

—————————————-
• Rename: Rename the redirect (yes … even inserts and sends)

—————————————-
• Select All: Selects all redirects
• Deselect All: Deselects all redirects

—————————————-
• Activate/Deactivate All: Activate/deactivate all redirects on this track/bus.

—————————————-
• Pin Connections: Click here for details.

—————————————-
• Edit: Pop open the editor for the selected redirect (you can also double-click on any redirect to edit it).
• Edit with generic controls

Redirect Box Signal Routing
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Within the redirect box, and in between the plug-ins, are a series of green and/or red dots called “pips” that
represents the signal routing between plug-ins.

Mono audio = one green pip: In the image above the channel strip on the left is a mono audio track. A
single green pip representing one channel of audio is routed to the EQ, then to the compressor, and on to
the fader.

Stereo audio = two green pips: In the image above the channel strip in the center is a stereo audio track.
Two green pips representing two channels of audio is routed to the EQ, then to the compressor, and on to
the fader.

MIDI data = red pip(s): In the image above the channel strip on the right is a MIDI track. One red pip
representing MIDI data is entering the MIDI plug-in. The MIDI plug-in then generates audio based on that
data. In this example the audio is stereo as can be seen by two green pips passing to the EQ, on to the
compressor, and then to the fader. MIDI data is also passing thru the MIDI plug-in. The EQ, compressor,
and fader are not processing this MIDI data, just passing it thru.
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8.13.1. Processor Signal Flow

Signal Flow through the Processor List:
The “processor list” is the black box at the top of every Mixbus channel strip. You can imagine the
“processor list” as a container for a series of guitar-pedal processors; each processor must be connected to
the processor before and after it.

Often, the signal flow is very simple. For example, a mono track will most likely have a series of mono
effects applied. In this case, you’ll see a picture like this:

In this example, the signal is processed by the channelstrip EQ, the Compressor, the
Fader, and finally a Gate plugin. The signal flow proceeds from top to bottom, and the
green “pips” between each plugin show the audio signal connections between each
redirect.

But what happens if you want to use a plugin that has stereo I/O? Just like a guitar pedal,
you might choose to use only the left-side signal for the mono track. But there are other

possibilities as well. The plugin might have 1 input, and create a stereo output (such as an auto-panner, or
reverb/delay effect). Or the plugin might have an extra “sidechain” input to trigger a gating or compression
effect. Or the plugin might be an instrument that has 16 individual outputs for different drum sounds.

Starting with Mixbus version 3.3, the signal path between redirects is highly flexible, while also using
sensible defaults.

Sessions created with Mixbus versions before 3.3 will have tracks that preceded these
rules. For backwards-compatibility, we will load those sessions with the old rules. In some
cases you might want to use “Pin Connections” (described later on this page) to improve the
routing of those old sessions.

!
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Why is this so complicated?
Mixbus tries to do the “right thing” by default. Mono channels will get mono plugins, and stereo channels will
get stereo plugins. Virtual instruments will appear with stereo outputs, by default. But if you want to change
these settings, there are quite a lot of variables that must be considered.

There are several challenges inherent to the signal flow through a channel using plugins:

• Plugins may be drag/dropped into any order
• Some plugins can be fed a “sidechain“signal which should allow the possibility of being sourced from

any other track.
• Often you need to use a plugin in ways that it wasn’t intended (only using one side, for example)

Additionally, each of the Mixbus-supported different plugin formats provide different rules:
1) LV2 and LADSPA plugins typically have fixed I/O such as 1->1, ( 1 input, 1 output ) or 2->2
2) VST plugins typically have a fixed I/O configuration, but can be told that some signals aren’t connected.
3) AudioUnit plugins (Mac) allow the HOST to define how many connections they will have. So Mixbus can
request a mono (1->1) or stereo plugin as-needed. But the user also has the option to change the
configuration, if they want to do something unusual.

https://www.youtube.com/embed/XCTGs2p3P74?rel=0
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Finally Mixbus can “replicate” plugins. If you try to insert a mono plugin on a stereo strip, Mixbus will
automatically create 2 plugins, and send the controls from the first plugin to the second. This allows you to
process both sides of the stereo signal using the same settings of an EQ, for example. You can add or
remove replicated plugin instances using “Pin Management” ( see below )

Pin Connections
Right-click on a plugin to reveal the “Pin Configuration” dialog:

By clicking on the pin connections, you may drag a connection between the channelstrip signal flow, and the
embedded plugin processor. Right-click on a pin to remove all connections to that pin.

One can also bypass plugin instances with a ‘thru’ connection by dragging an input pin directly to an output
pin. This connection is latency compensated to match the delay through the plugin.

The “Pin Configuration” dialog provides these additional features:

• Manual Config : click to enable the configuration buttons, below:
◦ Instances : increase/decrease the number of plugin instances inside the processor
◦ Audio Out : increase/decrease the number of audio outputs that the plugin can access
◦ MIDI Out : increase/decrease the number of MIDI outputs that the plugin can access

• Output presets ( virtual instruments only ) : click to choose how many outputs the instrument will
provide

• Side Chain : click to enable a sidechain input for the plugin.
◦ When Side Chain is enabled, the sidechain source may be managed with the buttons below it.
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8.13.2. Plug-ins

What is a Plug-In?
Plug-ins are small pieces of signal-processing software that Mixbus can load inside itself and assigned to
channels. Channels may have an unlimited number of plugins, inserts and sends on a channelstrip.

Mixbus comes with a selection of Plug-Ins installed. Some are free, while others require an additional
purchase to use fully. You can learn more about Mixbus’s included plugins here.

Additional plugins may be installed on your system, and these will be provided by third-party developers.

How do I add a Plug-In to a channel?

You can add plug-ins in several ways:

• double-click in the black “redirect” area to launch the Plug-in Selector
• right-click in the black area, and choose New Plug-in, then:

◦ Favorites
◦ Plug-in Selector (see: Plugin Selector)
◦ By Creator
◦ By Category

Adding, Removing, Reordering, and Disabling Plug-ins

Each plug-in is displayed as a rectangle in the redirect box. Plug-ins are red if they are pre-fader (above the
fader), and green if they are post-fader (underneath the fader)

• double-click the plug-in to show the plug-in control panel
• click the plug-in to select it ( it will turn red ). Now click “Delete” to delete it.
• click & drag the plug-in to change its order in the signal flow
• click the small green indicator on the plugin to enable/disable the plug-in

◦ (you can also middle-click on a plug-in to enable/disable it)

When you first install Mixbus, it does not recognize your third-party plug-ins. To scan your
plug-ins (and tell Mixbus to scan for plug-ins on startup in the future), please visit Edit-
>Preferences->Plug-ins and click the “Scan” button.
*

A note about categories: some plug-in formats (such as LV2) provide a very well-defined
method to categorize plug-ins. Most older formats (including VST2 and AudioUnits) do not
provide good support for categories.
*
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• right-click on a plug-in to see the plug-in context menu
• shift+right-click a plug-in to delete it

Drag and Drop of Plugins

• Dragging a plugin from one channel to the blank area of another channel will duplicate the plugin and
its settings on the destination strip

• Dragging a plugin to a plugin of the identical type will copy the settings of the source plugin to the
destination

Plug-in Favorite Window
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In the upper left side of the mix window is the Plug-in Favorite Window. You can drag and drop plug-ins to
and from a channel strip.
A new favorite can be save and even a preset for the plug -in can be saved and recalled from this window.
Multiple channel strips can be selected and a plug-in can be inserted.
Left clicking on a plug-in or preset name is another way of adding plug-ins to the channel strip.

Learn more about the Plugin Favorites here: Plugin Favorites
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8.13.2.1. Plug-in Selector
The Plug-in Selector window provides a rich set of controls for browsing your installed plug-ins, and making
them quickly available when needed.

To access the Plug-in Selector, double-click in any channel strip’s redirect box ( it’s the empty black box
near the top of a mixer strip )

Alternatively, right-click in the redirect area, and choose “New Plugin->Plugin Selector”.

If some of your plugins are not appearing, you might visit the Plugin Manager, accessed
from the Window menu to scan your system for plugins, and troubleshoot any resulting
problems.

!
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Main Plugin Window

• Fav: If this column is checked, the plug-in will appear in the “favorites” shortcut in the redirect menu,
and also in the Favorites list on the top of the mixer sidebar.

• Name : the name of the plugin
• Tags : arbitrary tags ( categories ) which can be applied to the plugin. See: Plug-In Tags for more

information.
• Creator : the developer of the plugin
• Type : the type (format) of the plugin ( VST, VST3, AU, LV2, Lua, or LADSPA )
• Audio I/O : the number of audio inputs and output channels that the plugin allows. Asterisk (*) means

“any number of channels”
• MIDI I/O : the number of midi inputs and output channels that the plugin allows. Asterisk (*) means

“any number of channels”
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Plugin “Search” Box
• Search: the search entry bar allows you to instantly find plug-ins by searching for a string of text
• Clear: this clears the text in the search entry bar.
• Name: if enabled, the plugin’s “Name” will be matched to the text in the Search entry bar
• Tags: if enabled, the plugin’s Tags will be matched to the entry in the Search entry bar.
• Ignore Filters when searching: When you are searching, you probably want “all” available plugins that

match your search text. If you want the filters to continue operating when you search, then you should
disable this option.

“Filter” section
• There are 6 “filter” selections that control what appears in the list. “Show All” will disable the filters and

show all available plugins. The default is “Show Effects Only”.
• Format selection: select a format here to show plugins that match a specific format ( “Type” ).
• Creator list: select a creator to show only plugins from that creator.
• I/O list: select an option to show only plugins with a specified audio or midi I/O configuration.

“Tags for Selected Plugin” section
When a plugin is selected, this field will become enabled, and you can add or change the “tags” for the
selected plugin. See: Plug-In Tags for more information about plugin tags.

Plugins to be connected
This window indicates the plugins that will be added to the channel. It is possible to add several plugins
here, before clicking ‘Insert Plugins’ to actually instantiate the plugins on the track.

Click on a column header to sort the list by that column.*

Try using the Search bar when looking for a plug-in. Just type the first few letters of the
name of your plug-in, and your plug-in will be sorted to the top window instantly.*

If you like to use a particular plugin for vocals, you can add a tag like “vocal-chain” and then
search for that term when you want to find the plugin quickly.*
For your convenience, Mixbus comes with a collection of tags for over 3,000 popular
plugins.*
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Once Installed, plug-ins will be visible within the redirect box of the channel strip. Click here and here for
more information.

For information on Virtual Instruments click here.
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8.13.2.2. Generic Plugin Controls
In some cases, it is desirable to see a generic display of a plugin’s controls, rather than the plugin-provided
UI. Some cases might be:

• A generic UI is provided when the plugin doesn’t provide its own control panel
• If a plugin’s control panel is incompatible with your setup, this provides a way to control the plugin

without showing its panel
• The generic UI can access hidden parameters or settings that are not accessible from the plugin’s

control panel
• The generic UI allows you to type values directly into a slider, which might not be available in the

plugin’s control panel.
• The generic UI provides direct access to Mixbus’s automation ( Read/Write/Touch )

A typical generic plugin ui is shown below:

The topmost portion of the control panel provides access to the latency compensation, pin-connections,
presets, and global bypass.

Switches are provided on the left side of the dialog.
Sliders and selector menus are provided on the right side of the dialog.

To the right of each parameter is an automation button to access Read/Write/Touch automation modes for
that plugin parameter. The “All Automation” buttons near the top of the dialog can be used to put all plugin
parameters in Read/Write/Touch

Double-click inside a slider to type a value into the control.

Plugin Analysis

At the bottom of the dialog, you will find 3 additional features.
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• Description: expose this section to see a longer description of the plugin (this is only available for
LV2-format plugins)

• CPU Profile: expose this section to see a visual indication of the plugin’s average and peak (worst-
case) CPU usage.

• Analysis: expose this section to see a “live” display of the plugins magnitude and phase response.
This can help to expose the behavior of a plugin that you don’t understand, or suspect is
malfunctioning.
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8.13.2.3. Plugin Favorites
In the Mixer Sidebar, you’ll find a list of your Favorite Plugins, and the ability to quickly assign them to
tracks.

Select one or more tracks, and then right-click on a plugin to access the context menu:

• Add at the Top: adds the selected plugins to the selected tracks, at the start (top) of the signal flow
• Add Pre-Fader: adds the selected plugins to the selected tracks, immediately before (above) the fader
• Add Post-Fader: adds the selected plugins to the selected tracks, immediately after (below) the fader
• Add at the End: adds the selected plugins to the selected tracks, at the end (bottom) of the signal flow

Mode Selector

• Favorite Plugins: this selection shows your favorite plugins in the list. You can add items to the
Favorites list by dragging them out of the mixer strip and into this area. Alternatively you can enable
and disable the “Favorites” checkbox in the Plugin Manager. The search field, at the bottom of the list,
allows you to filter the plugins for their name and/or tags (just like the plugin manager search field)

• Recent Plugins: this option shows the 10 plugins that you’ve used most recently
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• Top-10 Plugins: this option shows the 10 most often-used plugins in your workflow. This data is
managed by Preferencs->Plugins->Statistics; you can reset the plugin usage statistics there.
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8.13.3. Sends and Inserts

What is a “Send”?
A “send” is a connection point that is created inline with the channel’s signal flow; it allows you to send the
signal out of the channelstrip, and into something else. You might “send” to another channel, or a plugin
sidechain, or a physical output on your soundcard.

Sends are in addition to the mixbus-send knobs in the channelstrip. They provide more flexibility ( for
example, sends can be moved “anywhere” in the channel’s signal flow, among the other plugins and sends/
inserts. ) However, they operate outside of the Harrison “True Analog” summing & panning engine. These
sends are similar to features found in other DAWs and we sometimes call these “DAW Sends” instead of
“console sends” or “console buses”.

Aux Sends

Create an “Aux send” by right-clicking in the plugin area, and choosing “new Aux Send”, then choosing the
bus you’d like to send to.

Aux sends can only be connected to the input of a “bus input strip” and cannot be sent to an external port,
such as a soundcard output.

External Sends

When a new send is created, a window for connecting the Send’s output ports will immediately appear. You
may connect a Send’s outputs to any connections available in the system.

As implemented in v4.3, “Aux Sends” from the channelstrip do not have pan/balance
controls.

!
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By default, Sends have no outputs and must be configured as needed. Click “add” to add ports, and connect
them to the destination that should receive the output of the send.

• Add/Remove: adds/removes a port to the send.
• Disconnect All: disconnects all ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).

After a send has been configured, a double-click on the send will launch the Send Editor:

Note: The number of “ports” created will define the channels of the send. Sends can have 1
(mono), 2 (stereo) or more (multichannel) ports assigned.*
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In addition to the output management, The Send Editor also has a volume slider and a panner (if the
number of outputs is > 1).

What is an “Insert”?
An “insert” is similar to a Send, but it both sends the signal out, and then provides a method to return the
signal immediately back into the channel. The most common usage of an “insert” is to send the channelstrip

Sometimes when you mute a track, you still want a Send to remain active (for a headphone
feed, for example). It is possible to disable the mute for pre- and post- fade sends
separately. To enable or disable the pre- and post-fader send mute, right-click on the Mute
button in the editor window.

*
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signal out of Mixbus and into a hardware device for processing. Then the insert provides a return path from
the device, so you can hear its effect. You can enable and disable the “insert” to compare the signal with
and without external processing.

Inserts

An Insert incorporates a “send” output and a “return” input. The Insert send/return allows the audio signal to
be routed out of a channel and back into it, after performing some external processing. Inserts are often
used to “patch in” a piece of outboard gear that is not available as a plug-in (just like you might do with a
patch bay on an analog console)

• Measure Latency: Once your insert is connected to an external piece of gear, then click this button to
measure the latency. If the Insert is used on a track or mix bus, this delay will be accommodated
automatically.

Outputs

• Add/Remove: adds/removes a port to the insert “send”.
• Disconnect All: disconnects all sending ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).

Inputs

• Add/Remove: adds/removes a port to the insert “return”.
• Disconnect All: disconnects all return ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).* Available connections: This is a list of all
the available connection ports, with one tab for each application, and one for the system sound I/O
(“system”).

This video demonstrates the setup and use of an insert to an external hardware processor.
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https://www.youtube.com/embed/QOa2i7rJ4_g?rel=0
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8.14. Sidechain Compression

What is Sidechain Compression?
Compression is an automated way of reducing a signal’s level, dependent on the signal’s own loudness.
The louder the signal is, the more the compressor will reduce it. Side-chain compression reduces the level
of the signal using a different signal to trigger the volume reduction.

In pop/rock music, this technique is sometimes used to “duck” the bass guitar on each kick-drum hit, making
the bass and kick drum sound like a single instrument. In dance/EDM styles, it is often used to generate a
“pumping” effect using the kick drum or a “ghost” kick drum track that is not actually heard. In this case the
release is set very slow; after each beat the signal slowly rises, reaching full intensity just before the next
beat.

Other Uses of Sidechain
Alternative uses of a sidechain include feeding a gate or vocoder. A sidechain is any input that affects the
plugin processing, but isn’t directly heard by the user.

Sidechains Using Third-party Plugins and the Plugin Pin-
management Dialog
Mixbus can feed “any” audio track or input source to a side-chainable plugin. To access the plugin’s input
connections, you should use the pin manager as described in this video:
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Mixbus provides 2 side-chainable plugins by default: a-Compressor and a-Expander

Using Sidechains in Mixbus32c V9
As noted above, the built-in sidechain feature has been removed from Mixbus6. The following is a general
description of how to connect the sidechain control on plugins.

In this example we will show a popular third party VST plugin product called FabFilter Pro-G. The
instructions presented are intended to be generic and should be similar for other kinds of plugins with a
sidechain control from other vendors.

First, go to your plugin list and select the plugin you want to use:

https://www.youtube.com/embed/XCTGs2p3P74?rel=0

https://www.youtube.com/embed/XCTGs2p3P74?rel=0
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Once inserted the pin connections will look like this:
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Next click on the Sidechain button. NOTE: getting at this may be different depending on the plugin you are
using:
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Next select the source that you want to use for the side chain signal:
(Remember this process may be different on the plugin you are using).
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Next click on the blue box on the right side of the pin connection box and drag a connection to one of the
green side chain inputs. If this is a stereo plugin repeat this a second time to connect the side chain signal
to both signal paths of the plugin.

NOTE: This will differ depending on what plugin you are using, but the procedure should be similar.

NOTE: Most plugin formats will will identify sidechain inputs with a blue connection point. VST plugins like
this one do not explicitly show these as sidechain inputs, but merely as additional inputs as in this example.
However you will not be able to route signal to these inputs until you select with the Sidechain button.
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The sidechain control inputs of this plugin are now connected. The signal path inputs and outputs were
already connected by Mixbus when you installed the plugin into the redirect area.

NOTE: The built-in sidechain feature has been removed as of Mixbus v6. This feature was
provided in Mixbus version 3,4, & 5 because we had limited support for sidechain-able
plugins. Since most sidechain tasks benefit from precise control over the threshold, ratio,
attack and release, we decided to remove the limited sidechain bus that was incorporated in
the channelstrip compressor. Instead, you should use the full-featured “plugin” sidechain
buses described below.

!
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8.15. EQ Techniques
The following videos cover some common uses of equalizers. Remember your ears are the final judge!

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
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https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
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8.16. Mastering Techniques

What is Mastering?
“Mastering” is the process of preparing a sound track for distribution. It might involve, but is not limited to:

• Critical listening, to verify that there are no technical errors in the final product.
• Fixing equalization problems that were caused by poor acoustics in the original production/mixing

room.
• Applying final tone control to match the overall tone of other tracks in the collection, or comparable

tracks in the same genre.
• Applying final loudness adjustments to match the level of other tracks in the collection, or comparable

tracks in the same genre.
• Sequencing of tracks into a collection ( i.e. sequencing songs on a CD ).
• Applying frequency-limiting and dynamic-range adjustments, to match the media that will be

distributed.
• Creation of metadata (such as track markers, song name(s), performance rights, etc ) for the

distribution media.
• Exporting/packaging the distributable in a format that is suitable for the next stage of duplication/

distribution.

Although many of these tasks are outside the scope of Mixbus, Mixbus provides several tools that can help
with the mastering process.

Master Bus Processing and Metering
The master bus provides a suite of processing and metering that helps achieve the overall tone and
loudness that the artist wants.

Master bus strip tone controls

The master bus provides a 3-band EQ (“tone”) control for the final output. The tone control has a fairly
limited range ( +/-6dB) for fine control. The center frequencies are optimized to solve problems that are
commonly used in the final stages of mixing:

• Low: a low-frequency shelf at 90Hz : the Low band is provided to balance the low bass content of the
track, without having to re-mix the bass instruments.
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• Low Mid: a wide bell shape at 300Hz : many instruments have strong output in the low-midrange, and
they can combine to make too much energy in this range. This range is also a site for tape-saturation
harmonics. The “Low Mid” band is provided to increase or decrease the main band of music.

• High: a high-frequency shelf at 4,000Hz : A high-frequency shelf at 4 kHz allows you to brighten the
entire track without unduly affecting individual instruments.

Master bus strip compressor

The master bus strip compressor operates like the channelstrip compressors. ( see : Compression
Techniques )

Because the master bus strip compressor is applied before the Master Limiter, this provides a chance to
level-match parts of a song (using the leveler mode), or to clip outstanding transients before they reach the
master limiter (using the limiter mode).

Typically a very small amount of compression is needed on the master bus, therefore the master bus limiter
threshold has a very different “scaling” than the channelstrip compressors. You have to pull the threshold
down much lower before it has any effect.

The order of master bus compressor, fader, and EQ may be manipulated to achieve a wide range of desired
effects before the signal is finally sent to the master bus limiter.

Master Limiter

The master bus limiter. It has no controls other than an on/off indicator.

The Master Limiter is a lookahead limiter with a very fast attack and release time.
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The “lookahead” feature imparts a short 5ms delay on the input signal. This delay allows the limiter to “look
ahead” and begin reducing the gain before a loud peak occurs. This dramatically reduces the distortion that
is caused by hard limiting.

The limiter’s threshold is fixed at -2dB. This value is intentionally less than digitally clipping so that your final
processing (sample-rate conversions, or lossy encoding like mp3) are provided extra headroom for their
interpolation. This can result in better sounding mixes. If you want your exported file to peak at a higher
value, you can implement that in the “normalization” setting for each of the file formats you are exporting.

Each segmented LED represents 1 dB of gain reduction.

Plug-ins

There are many plug-ins that are developed specifically for the master-bus output, for the purpose of
increasing the master output level. These may be placed in the channelstrip signal flow, and used instead
of, or in conjunction with, the Mixbus master bus processors.

Stereo Correlation (“Phase”) Meter

The stereo correlation meter provides an indication of the “mono compatibility”, or stereo width, of your mix.
The indicator uses a bright bar which simultaneously indicates the range of in-phase (highly correlated) and
out-of-phase (decorrelated) sounds in your mix.

• If the indicator is fully to the right, and yellow, this indicates a completely “mono” mix. (the signals in
the left and right channels are the same)

◦ many signals (such as a spoken-word recording with one microphone) should be mono.
• If the indicator is fully to the left, and fully red, this indicates a mix that is completely “out of phase”, in

other words the left and right channels are equal, but one is inverted with respect to the other. This
almost certainly indicates a technical fault which should be investigated.

• If the indicator is largely to the right, and green, then it indicates a mix with some stereo width, but
largely mono compatible. This is optimal for pop music recordings that might be played in a variety of
playback systems.

• If the indicator is in the center, showing a range of red and green, then the mix is very wide stereo.
This is probably not optimal for pop/rock recordings, but can be acceptable for natural or orchestral
recordings. Mono compatibility of this mix is questionable.
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Mono compatibility is largely defined by low frequencies. If your mix indicates poor mono compatibility ( red
bar on the left ), then you can probably solve this by reducing the number of bass instruments in the mix,
high-pass filtering any non-bass instruments, and high-pass filter any stereo effects, such as reverb, in the
mix.

K-14 Meter

The K-14 meter is an RMS (averaging) meter, originally specified by mastering engineer Bob Katz as a
means to compare and help control the dynamic range of pop music mixes. (see : http://www.digido.com/
how-to-make-better-recordings-part-2.html )

The K-Meter displays the level of the signal directly before the output of the master bus. The K-Meter comes
after the fader, EQ, plugins, and final limiter in the master bus.

If the K-14 meter indicator is straight up, at 0, this indicates that the sound’s average level is at -14dBFS.
This was selected as a good target for most pop/blues/jazz/rock recordings. At this level, a song will sound
quieter than most contemporary pop music, but when the listener turns the volume up to match, the
increased dynamic range of this mix will allow the song to sound much better than a typical pop song played
at the same volume.

Increasing the volume beyond the “0” indicator will result in a louder mix, at a cost of decreased fidelity and
impact when the user turns the volume up.

In the past, it was highly encouraged for mastering engineers to create music at the highest
possible average level, because this made the songs noticeably louder when they were
played adjacent to other performer’s songs on a CD or mp3 player. However, in the case of
modern radio broadcast, online channels such as YouTube, and internal processing in
iTunes and iPods, it is now likely that your music will be level-matched (based on average
loudness) with other songs. In this case, it is advantageous to mix at a lower volume, and
leave more headroom for short musical peaks which will make your mixes sound louder and
better than the more heavily-processed tracks that were popular in the early digital era.

*
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8.16.1. Normalization
Mixbus’ export page allows for easy customization of loudness targets that help you meet the loudness
standards of the medium you will eventually end up in, whether it be a Redbook CD, Streaming, or other
client specifications.

The Normalization Process
The normalization process will apply a single “gain” value to the whole resulting export file, so that the
loudest part of the file reaches the desired target peak or loudness value.

Traditionally, the most common usage of this feature is to set the peak to 0dBFS. That means the loudest
sample of the resulting file will reach exactly 0dBFS.

However, a single “peak” digital sample has very little to do with the perceived loudness of the file. For
example you can have a single loud peak in a 10-minute file, and the normalization function will decrease
the level of the file so the peak fits in without clipping. This is pedantically useful in many cases, but not
really important step for a deliverable mix.

Normalizing to LUFS is a better solution, because it is a much better indication of “perceived loudness”. You
can have a very peaky file that still sounds quiet; whereas LUFS takes the “average” level into account. If
we normalize a file to -9 LUFS, we know that we have a very loud mix indeed!

But: there is a limit with LUFS normalization: if Mixbus increases the loudness too much, it will push your
“peaks” into clipping. (side note: if the LUFS normalization would result in a signal above your peak target,
then Mixbus normalizes to the peak, not LUFS … this is why your resulting file is not reaching the LUFS you
want)

The important point is: normalization only provides clean gain (either increasing or decreasing the volume
for the entire file). It does not change the peak-to-average ratio of your song.

Said another way: normalization has no effect on the sound or quality of your mix, or its perceived loudness.
That’s up to you. Normalization can only adjust the final measurements to prevent exceeding your
maximums.

(another side note: Mixbus’ K-14 meter is an instantaneous RMS meter, not LUFS; but if you mix to the
RMS level it should get you in the ballpark of desired LUFS)
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Best Practices
This is highly subjective and can change with the industry, but as it stands now, there are a few practices
most mixing engineers follow and we make that easy to adhere to in Mixbus!

You should first develop your mix so that the master bus’s “K-14” meter is reaching near the ‘0’ meter during
the loudest part of your mix. This will help ensure that your average-to-peak ratio is high enough to meet
your medium/broadcaster’s expectations.

Reaching the ‘0’ mark on the “K-14” meter means that your mix is something near -14LUFS; and so when
you run it through the normalization during export, Mixbus can then reduce it to meet your deliverable
needs.
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8.17. Loudness Analyzer-Normalizer
The Loudness Analyzer & Normalizer is a tool that is useful at the end of the mixing process to make the
final audio file comply with different specs regarding loudness.

It is enabled by checking “Enable Master-Bus Output Gain Control” in the Preferences:

The Master Bus strip then shows a button marked “LAN”, and a volume slider that is the global gain that can
be set either manually or by the loudness normalizer.
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The LAN can also be started from “Session -> Loudness Assistant”. If the option above is not enabled,
Mixbus will open the relevant page of the Preferences.

Click on “Analyze” to start the loudness analysis. A choice is offered between freewheeling (i.e. Mixbus
renders the session as fast as possible to measure the loudness) by default, or Realtime, for cases where
freewheeling would not accurately render the session. This might be the case if a hardware or JACK effect
is used in the session.

After the analysis is over, the Loudness Analyzer and Normalizer is shown:
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A number of different statistics are displayed for the standard indicated in the “PRESET” tab. The analysis
standard can be changed with the “PRESET” tab:
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Notice in the next figure that a different set of analysis statistics will be presented.

Normalization Parameters

As loudness is a perceived sonic energy, and depends on the level, frequency, duration and nature of the
sound, this window allows to base the calculation of the loudness normalization on different parameters :

Peak : is the highest signal level value
True Peak : is the highest signal level value where the signal has been oversampled to figure out more in-
between values between the samples (interpolation)
Integrated Loudness : is the loudness computed from the whole session or range
Max Short Loudness : is the maximum loudness computed on short time ranges (3 seconds)
Max Momentary Loudness : is the maximum momentary loudness

Any combination of these parameters can be taken into account when determining the gain normalization,
by checking its momentary button, and setting a Target value.

Shown are both the Measured value of the parameters, and the Delta value, i.e. the difference between the
Target and Measured values, hence the gain correction. The maximum Delta value is the Gain correction to
apply to fit all the Target values.

Also shown under the parameters is a summary of the calculation :
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Gain to Normalize: is the max Delta value
Previous Output Gain: is the current Master track gain
Total Gain: is the difference between these two values, hence the correction to apply

Presets

A selection of presets is offered to simplify the normalization. These presets apply the relevant parameters
and their target values. Here is a table of these presets:

The Conformity Analysis Panel
At the bottom of the window the Conformity Analysis arrow can be rotated to display, for the presets above,
if the corrected gain would fit the required values:
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✖: the signal is too loud
✔: the signal is too quiet, but satisfies the max. loudness spec
✔: signal loudness is within the spec.

Notice here as we have run the analysis for only the CD case, only the digital peak (applicable to ALL
formats) and the CD case are checked.

Lastly, the gain correction is, by default, applied after all the processors of the master bus. This can also be
changed, either by selecting the Custom Amplifier Position button in this window, or in the Master strip, by
Right-clicking the gain slider and selecting the Custom LAN Amp Position. The gain normalizer then
becomes a processor in the processors box of the Master strip, that can be moved as needed like any
processor/effect:
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Notice here that with the gain normalizer added, +0.47 dB of gain (as was indicated in the last figure) has
been added as a result of the normalization.

To show the results graphically, click on the “Show Graphical Analysis” button:
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A graphical representation of the analysis will be displayed:

At the top of the graphical analysis is a histogram of the levels in the recording, i.e. how often (vertical axis)
the signal spends at various levels (horizontal axis). In this example we see that the signal is between -33
and -8 dBFS most of the time.

In the middle are the Left and Right output waveforms. The colored vertical bars in the waveform indicate
where the signal is at True Peak shown in the histogram statistic above.

At the bottom is a frequency distribution histogram with time (horizontal axis) and frequency (vertical axis).
This histogram indicates by color (legend to the right) the levels of the frequencies present in the signal
versus time.
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9. Mixer Sidebar
On the left side of the mixer window, there is a sidebar that allows you to manage your Plugin Favorites,
Tracks, and Groups. You can hide and show this list using “View->Mixer List” in the main menu.

Favorite Plugins
The “Favorites” bar allows you to store a selection of plugins, and their presets. Learn more here.
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Track/Bus List

The “track/bus” list shows a list of available tracks and buses.

• Click the ‘show’ box to hide or show a strip in the mixer page.
• Click and drag an item to reorder the strips in the mixer page.

A right-click menu provides these options:

Reordering the mixer strips will also reorder the tracks in the Editor window.*
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• Hide/Show all.
• Hide/Show all tracks.
• Hide/show all buses.
• Show tracks with regions under playhead (only shows the tracks that have active audio regions right

now).

Below the track/bus area is a list of the mix buses which can be shown or hidden.

Group List
Below the mixbus area is the Group section. For more information about grouping, visit the Groups topic.
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10. Mixer Scenes
Mixer Scenes allow you to quickly save and recall your knob settings of the mixer: this includes the fader,
panner, sends, send levels, eq settings, compressor settings, and plugin settings. You can use this to
temporarily stash a mix, like “wetter vocals” or “vocal +2dB” and compare the 2 mixes.

Using Mixer Scenes

Left-click on a scene to recall the mixer settings to your mixer. Right-click on a scene button to store (and
name) the scene.

After a scene is stored, you can right-click on a mixer scene button to see these additional options:

• Store: stores your current mixer settings into the scene (this operation is not undo-able)
• Clear: delete this scene (this operation is not undo-able)
• Rename: enter a new name for this scene

Momentary Audition: middle-click with the mouse to momentarily recall the settings, then release the
mouse to revert to your prior settings. This can be used to compare your current mix against a prior mix,
and then restore your current settings. (if you don’t have a middle-click button on your mouse or trackpad,
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you can use Cmd+click (or Ctrl+Click on windows)

More details about mixer scenes

Mixer Scenes are stored inside each session snapshot file. If you have a session folder with 8 different
songs stored as snapshots, then each song (snapshot) will have its own bank of mixer scenes, and they do
not affect each other (although if you create a new snapshot it will inherit the parent’s mixer scenes)

When you store a mixer scene, it stores all of your current mixer settings, for all of your tracks and buses.
However, note that if you’ve created a new track since you saved a scene, the scene will not have any
settings for the new track so no changes will occur on a new track until you re-save a scene with the new
track’s settings in it.

if you want to restore the complete mixer-strip settings including the plugins, plugin order,
and vca assignments, or if you want to apply a mix template from another session to this
one, you should use “Mixer Save/Recall” instead of Mixer Scenes. You can find
documentation on this feature here: Mix Tools. The benefit of “Mixer Scenes” is that they
are near-instant, and they do not cause an audible disruption. This makes them more
suitable for a quick mix-compare, or a live mix snapshot.

*

In a live broadcast situation, mixer scenes can be used to quickly set your mix for different
events like “studio hosts + guest”, “go to commercial” etc. Switching scenes is near-
instantaneous and (if the settings are not too dramatic) click-free.
*
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https://www.youtube.com/embed/laX15wXghuA?rel=0
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11. Plug-ins
Plug-ins

Mixbus can load plug-ins in several formats, depending on your platform. Mixbus can only use plug-ins that
meet these criteria:

• The plug-in must be a supported format on your OS (see below)
• The plug-in must be compiled for the same platform as the Mixbus you are running. ( for example,

64bit Mixbus loads 64bit plug-ins, but not 32bit plug-ins )

A summary of plug-in support in Mixbus:

AppleTM AU plug-ins (supported on OS X only)

AU (Audio Unit) is the native (Apple-developed) plug-in format for OS X. Most commercial plug-in
developers make AU plug-ins for Mac, because this is the native format for Apple’s Garageband and Logic.

Unlike other formats, AU plug-ins normally provide a “variable” number of inputs and outputs. The host
(Mixbus) must tell the plugin how many inputs and outputs we want, and then the plugin can respond
whether that is a valid choice. This can get quite complicated. Mixbus chooses the I/O based on the number
of signal “pipes” at the insertion point of the plug-in.

Scanning of AU plugins must be initiated manually in Mixbus->Preferences->Plugins. If a plugin causes
Mixbus to crash during the “scan” procedure, then this plugin will be placed on a “blacklist” which prevents
that version of the plugin from scanning in the future.

Steinberg VST plug-ins (supported on all platforms)

VST (Virtual Studio Technology) plug-ins were developed by Steinberg TM and are the most common plug-in
format on Windows. VST plug-ins can be developed for Windows, OS X, and Linux.

VST plugins typically come in 2in/2out versions (stereo I/O). Mixbus channels are typically mono or stereo;
but the signal width can vary in the redirect sections. Mixbus will try to accommodate the audio and MIDI

This chapter covers the general principles of plug-ins in Mixbus. To learn about using
plugins in your mix, visit Using Plug-ins*

It is Harrison’s intent to support every plug-in available, whether commercial or free.
However there are many reasons why a third-party addon might not work in Mixbus, or
might crash, or might behave unexpectedly. This is true of any DAW.

!
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“pipes” that are present in the signal flow at that location. For more details, see Processor Signal Flow.

Scanning of VST plugins must be initiated manually in Edit->Preferences->Plugins. If a plugin causes
Mixbus to crash during the “scan” procedure, then this plugin will be placed on a “blacklist” which prevents
that version of the plugin from scanning in the future.

Unlike AU and LV2, the VST specification does not specify where plugin files should be installed. When
using VST plugins, you must take note of the folder location that the installer reports. You may find it easier
to redirect the installer to one of the default locations that Mixbus uses. You can find these locations in
Preferences>Plugins>VST>Path.

Or you can create a new folder of your liking and install all of your plug-ins there. This way Mixbus has to
scan fewer folders. For every new folder created, Mixbus has to be made aware of its existence. If you have
20 different folders, then it places a burden on the user to inform Mixbus of their locations. Simplifying the
plugins location upon installation may prove useful.

Steinberg VST3 plug-ins (supported on all platforms)

VST3 plug-ins were developed by Steinberg TM as a successor to the VST format. VST3 plug-ins can be
developed for Windows, OS X, and Linux.

VST3 improves on the VST2 spec with more flexible I/O choices, sample-accurate automation, logical
parameter organization (for automation). https://www.steinberg.net/en/company/technologies/vst3.html

Unlike VST, it is not necessary to define the installation folder for VST3’s. The installation path is predefined
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for all manufacturers.

LV2 plug-ins (supported on all platforms)

LV2 is the “next generation” open-source plug-in format. LV2 plug-ins have several advantages over other
formats. For example, LV2 plug-ins do not have to be instantiated to be scanned, so startup is much faster
and less likely to crash. For developers, LV2 is completely unencumbered by licensing restrictions.
Harrison’s bundled plug-ins currently use the LV2 format, and the same plug-ins operate on Windows, Mac,
and Linux. This allows you to share sessions with users on other platforms, and have your sound remain
unchanged.

LADSPA plug-ins (supported on all platforms)

LADSPA is the “Linux Audio Developer’s Simple Plug-in Architecture”. LADSPA plug-ins are simple to
develop and are freely available. LADSPA plug-ins do not support customized GUIs. The “generic” GUI will
provide sliders and knobs on a simple window. Being very portable, most LADSPAs are available for all
platforms (OS X, Linux, and Windows). LADSPA makes an excellent starting point for developers that want
to learn plug-in development. The quality can vary significantly, but there are a few good plug-ins available.

Mixbus can load a mono LADSPA plug-in into a stereo channel (by duplicating the plug-in and assigning the
same controls to both sides of the signal). This works well for some plug-in types (such as EQ) but less well
for compressors, which might introduce a shift in the stereo image if they aren’t truly stereo. In these cases,
you should choose a stereo LADSPA, not a mono one.

Digidesign AAX/TDM/RTAS plug-ins (no support currently).

AAX, RTAS and TDM plug-ins are proprietary formats for Pro Tools TM. Mixbus does NOT support RTAS or
TDM plug-ins. It is unlikely that Mixbus will ever support AAX, RTAS or TDM plug-ins.

Windows DirectX plug-ins (no support currently)

The DirectX plug-in API was developed by Microsoft and is the native plug-in format for Windows. Few
professional plug-in manufacturers provide DirectX plug-ins, so Mixbus does not currently support DirectX
plug-ins.

Latency Compensation

Some plug-ins, particularly plug-ins that use hardware “accelerators” or convolution-type processing, can
cause significant latency (time delay) from the input to the output. This can cause problems if the delayed

Note: While we have taken care to follow the specifications for each plug-in format, plug-ins
are developed by third-party vendors. This means that Harrison cannot take responsibility
for plug-ins that don’t work as expected. Please use caution when trying a plug-in for the
first time. Verify that all the functions work as expected before committing to using a
particular plug-in in a session.

*
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signal is mixed with a signal that is not delayed. A long delay can cause the tracks to sound “out of time”,
while a very short delay can cause comb filtering (“phasiness”). Mixbus can automatically accommodate
plug-in and insert latencies for you. To do this, Mixbus delays the non-affected tracks to match the track with
the longest latency. Please be aware of these facts:

• Adding or bypassing a plugin can change its latency. Some plugins have internal controls (like
“lookahead”, “oversampling”, or “quality”) that change their latency.

• Latency offsets are recalculated when you “stop” the transport. So if you hear a delay or phasing
caused by plugin latency, try stopping and restarting playback.

• Tracks can accommodate “unlimited” latency by buffering the audio from disk earlier than it is needed.
• Mix buses are limited to 8192 samples of latency compensation. If the total latency of all plug-ins in a

mix bus exceeds 8192 samples, then a time offset will occur.
• “Buses” created with the Add Track/Bus dialog (we call these “utility buses”) do not support latency

compensation.
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11.1. Scanning for Plug-Ins
Mixbus loads a wide range of third-party plugins that might be installed on your computer. There are 3 ways
to initiate a plugin scan:

• When you first open the Plugin Selector dialog (by double-clicking in the black plugin-area of a
channel)

• Via the “Scan Now” button in Preferences->Plugins
• From the Plugin Manager window

When a Scan is initiated, the Plugin Scan Dialog appears:

When each plugin is scanned, the dialog reports the filename of the plugin, and a scan-time progress bar.

There are 3 buttons provided to change the scan behavior:

• Skip This Plugin : if a plugin is taking a long time to scan, and/or requires a license or other user input
that you cannot fulfill, you can click this button to skip the plugin. The plugin will not be available in the
Plugin Selector or other menus in Mixbus. It will be shown in the Plugin Manager window, and can be
re-scanned from there.

• Auto-Skip Unresponsive plugins: click this button to initiate a “untended” scan session. This allows
you to leave Mixbus while it scans, and Mixbus will automatically skip any plugin that takes longer
than 15 seconds to complete (this value can be changed in Preferences->Plugins). Plugins that are
auto-skipped can be re-scanned from the Plugin Manager window, at your convenience.

• Abort Scanning (for all plugins) : this button will abort the scan completely. Plugins that were scanned
prior to clicking the button will be available. But any plugins that were not yet scanned will not appear
in the Plugin Manager or the Plugin Selector windows.
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11.2. Plug-in Tags

Tagging Plug-ins
Tags allows the user to append their entire collection of plug-ins with an arbitrary amount of tags to make
plug-ins easier to find across all of Mixbus’ interfaces.

The Plug-in Selector window allows for plugins to be tagged, and searched via their tag, name, or creator
(or a combination of all three) making it very quick to find plugins you need for your session. By default we
take whatever the plugin reports as its category. However, for most plugin formats, these aren’t very useful.
So for your convenience we have ‘pre-tagged’ over 4,000 popular plugins so you don’t have to!

To tag a plugin all you need to do is:

1. Select it in the plugin in the plugin selector
2. Click in the Tags field
3. Replace or extend the tag text

Multiple tags can be included by adding a space after every word. For instance, “bass eq parametric” is
three separate tags. Now that plug-in will appear in three separate locations simultaneously.

Additionally, plug-ins that appear in the favorites pane will now be able to be searched by tags. In this case,
I’m searching for “EQ” and this finds all my favorite plugins that are tagged “EQ” even if EQ doesn’t appear
in the plugin’s name:
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And they will appear in a strip’s right click menu under plug-ins:
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For information on Plug-ins click here, or on how to use them in Mixbus click here.
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12. Groups

Tracks (and busses) may be assigned to a “group” which imparts some special behaviors. For example, you
might want to put the drums in a “group”; in this case, adjusting the fader on one track will apply to the
others.

What is a Group?
A group is a mechanism of connecting several tracks together when they have a strong inter-channel
relationship. By default, tracks in a group will be ‘selected’ together whenever one track is selected; they will
be edited together; they will share the same color; moving one fader will move all of the group faders; and
assigning a track to a mixbus will assign all the group’s tracks to a Mixbus.

The most common usage for “groups” is when the tracks are separate, but they actually represent a single
“recording”, such as a stereo pair, or a drum kit that was recorded live, or a 5.1 multichannel track. The
“group” helps to preserve the togetherness of the tracks.

A track can only be assigned to a single group, whereas a track can be assigned to multiple mixbuses or
VCA Faders.

A group of tracks should not be confused with a mix bus. Confusion sometimes comes from the fact that
much of the time a mix bus has more than 1 track bussed to it. Likewise, a group has more than 1 track
associated with it. However, a group of tracks will not sum their audio, but will group certain software

https://www.youtube.com/embed/cuInwhnrtlk?rel=0
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Harrison Consoles Mixbus - 9_en

Page 419 of 848

https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0


functionality which allows for better session organization and more efficient mixing and editing. That’s
not to say you can’t have all tracks in a group bussed to its own mix bus. It’s quite common in fact.

For instance, a session may have 6 drums tracks and after finding the right balance between those tracks
you might group them so that moving one fader moves all in that group, causing all the drum tracks to
change level. Or soloing one track in the group solos all in that group. Clicking on the group header will
disable the group allowing individual changes to the tracks, after which the group can be re-enabled.

How do you create a group?
By clicking and dragging in the Group Bar, you can quickly assign multiple consecutive channels to a new
Group. See: Group Bar

A group may be created or altered by clicking on the “Grp” button below the track fader. Once the group is
named the “Grp” will be replace with the groups new name or a shortened version of it.

Click here to view a video on groups and bussing, and here for a video on subgroups.*
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Alternatively, a group may be created or altered by clicking on the “G” button located in the track header.

Creating a group from the mixer window “Group” area.

The Group section of the mixer window, showing the +/- and Enable/Disable for each group

Here all groups that have been created for the session are listed. A check box labeled “Show” is provided.
Un-checking this box will hide a group from the edit and mix window. Hiding a group is a convenient way
of un-cluttering your sessions. Groups can also be added or deleted clicking the + or – buttons at the
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bottom of the window. Clicking on the name of the group allows you to rename it.

Options within a Group
Grouping tracks allows the sharing of certain functionality and the functions available within a group are
customizable. Right-clicking on a group tab calls up these options:

• Active: makes the group active/inactive
• Gain: syncs all faders to the same level

◦ Relative: preserves fader differential between tracks
• Muting
• Soloing
• Record Enable
• Selection: links selections made in the editor canvas
• Active state
• Color
• Monitoring
• Mixbus Assignments: Channel assignment to a mix bus will follow the group assignment. If checked,

assigning one channel of the group to a particular mix bus will also assign all channels in that group
to the same mix bus.
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Left-clicking on a group will enable or disable the group.

Grouping behaviors when the “Gain” is enabled

• Dragging a fader will affect all the others in the group
◦ By default, this a “relative” move. ( the faders will retain whatever dB offset they have prior to

the move )
◦ You can disable the “relative” checkbox, and all the faders will be forced to the exact same

value, whenever you move one fader in the group
• Muting or soloing will affect all the others in the group
• Assigning or de-assigning a mixbus will affect the others in the group

Group Override

Holding “Shift” will override the group, resulting in these behaviors:

• Dragging a fader will affect only the current channel, not the others in the group
• Muting or soloing will affect only the current channel, not the others in the group
• Assigning or de-assigning a mixbus will affect only the current channel, not the others in the group
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12.1. Group Bar

What is the Group Bar?
The Group Bar is an empty area to the left of the track headers (in the editor window) or above the mixer
channels (in the mixer window).

The group bar provides convenience functions to create groups from your channels, or assign them to a
grouping master bus, or assign them to a VCA master fader.

Operations from the Group Bar:

Right-click in the black (empty) group-bar area to display the Group-Bar context menu:

• Create New Group From : Select either “Selection, Record-Enabled, or Soloe’d” to create a new
Group with those channels.

• Create New Group With Master From : Select either “Selection, Record-Enabled, or Soloe’d” to create
a new Group with those channels. A new “bus” will be created, and your channels will be assigned as
the input for that bus.

• Assign Selection to VCA: The selected channel(s) will be assigned to the VCA selected from a
submenu

• Assign Record-Enabled to VCA: Any record-enabled channel(s) will be assigned to the VCA selected
from a submenu

• Assign Soloed to VCA: Any solo’ed channel(s) will be assigned to the VCA selected from a submenu
• Enable all groups
• Disable all groups

Creating an Edit Group with the Group Bar:

In the edit window, a group selection can be be made by clicking in the black bar to the left of the track
header. While holding the left click, slide the mouse vertically along-side the tracks you wish to group. Right
click on the name of the group to rename it. To add tracks to that group just left click and slide the mouse
alone-side the track you would like to add. This will create a group tab that extends the width of the tracks
assigned to that group. Many times it is convenient for a group to contain tracks adjacent to one another but
it is not absolutely necessary, a group of tracks does not have to be contiguous.
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Learn more about the grouping functions here: Groups.

Right-clicking on a group tabs calls up a context menu for groups:
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• Edit Group : launches the Group editor
• Collect Group : Moves the grouped tracks together into a contiguous series
• Remove Group : Deletes the Group (but not the tracks in it)
• Assign Group to VCA: The channel(s) in the selected group will be assigned to the VCA selected from

a submenu
• Add new Subgroup Bus : Creates a New Bus, and assigns the output(s) of the grouped tracks to it
• Add New Aux Bus (pre-fader) : Creates a New Bus, and creates a pre-fader Send to it, from each of

the grouped tracks
• Add New Aux Bus (post-fader) : Creates a New Bus, and creates a post-fader Send to it, from each of

the grouped tracks
• Fit to Window : the channel(s) in the selected group will be sized to fill the editor window (vertically)
• Create New Group From : Select either “Selection, Record-Enabled, or Soloe’d” to create a new

Group with those channels.
• Create New Group With Master From : Select either “Selection, Record-Enabled, or Soloe’d” to create

a new Group with those channels. A new “bus” will be created, and your channels will be assigned as
the input for that bus.

• Assign Selection to VCA: The selected channel(s) will be assigned to the VCA selected from a
submenu

• Assign Record-Enabled to VCA: Any record-enabled channel(s) will be assigned to the VCA selected
from a submenu

• Assign Soloed to VCA: Any solo’ed channel(s) will be assigned to the VCA selected from a submenu
• Enable all groups
• Disable all groups

The mix-window group bar.
In the mix window, a group can be be created by dragging in the black bar above the channel strips. While
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holding the left click, slide the mouse horizontally over the channel strips you wish to group. This will create
a group tab that extends the length of the tracks being assigned to that group. Many times it is convenient
for a group to contain tracks adjacent to one another but it is not absolutely necessary. You may have any
tracks in a group.

In all other ways, the Group Bar in the Mixer window operates identically to the Group Bar in the Editor
window.
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12.2. Quick Groups
To make a temporary group (“Quick Group”), you can simply select the desired tracks. The Mute, Solo,
Fader and Input Trim are ‘linked’ when you select tracks

Use the Shift modifier to override the linking, if you want to adjust just one track while leaving the selection
intact.
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13. Automation

Region Gain and Automation
Mixbus has 2 separate types of automation: Region Gain Envelopes and Processor Automation.

Region Gain envelopes are often used for repair work, such as reducing unwanted breaths, accentuating
syllables, or reducing noise. The “region gain envelope” is part of the audio region, and is applied before
any other processing is applied in the mixer strip. Region Gain only adjusts the volume (level) of the region
across time.

Learn more about Region Gain automation in this video: Mixbus Gain Staging

Processor Automation is often used for creative changes such as fading elements in and out during a
song. Automation can be applied to many different mixing parameters including the input trim, fader,
panning, muting, or plug-in parameters.

https://www.youtube.com/embed/UJbjPbpoWlk?rel=0
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13.1. Fader, Pan and Plug-in Automation

Automation
‘Automation’ is used to change the settings of a knob (or other control) as the playhead advances on the
timeline. For example you might want to increase the volume of a delay effect during the “chorus” part of a
song, or automate the master fader to make a smooth fade-out at the end of a track.

Many mixer parameters may be automated: fader, mute, pan, mix bus sends, eq, compressor, and plug-in
settings.

The short video below demonstrates how to open an automation lane:

Alternatively, you may enable the menu item “Edit->Show Automation Lane On Touch” in the main menu. In
this case, any time you touch any automatable parameter (including those in plugins), it will automatically
open its associated “automation lane” in the Edit window so that you can set or modify it. If you ‘draw’
automation into the lane, then it will stay exposed. If you don’t write any automation then the lane will be
automatically hidden when you touch a new knob. This feature streamlines your display down to just the
automation parameters you are adjusting when you have a lot of tracks, a lot of plugins and a lot of
automated things.

This short video gives some examples of using this feature:

https://www.youtube.com/embed/B0DKjABQ6MA?rel=0
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Real-time (“Touch”) Automation:

In Real-time automation the parameter is put into a “record” mode. While the transport is rolling, the user
moves a knob, and these moves are recorded.

In the Mixer window below every fader, there is an automation button dedicated to that fader because this is
a very commonly-automated control:

https://www.youtube.com/embed/T_hoXHhBaow?rel=0
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( this button only affects the automation mode of the fader )

Additional parameter automation can be accessed from the the track’s header: click the “A” button to view
fader and mute automation. Under “Processor Automation” are EQ parameters, Compressor parameters,
and plugin parameters. You’ll find the Pan and bus sends under “POST”.
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Here is a description of the modes:

Manual Automation is ignored.

Play
Whenever you locate, the parameter will jump to the value that is recorded in the automation.
You cannot change the value manually.

Write
When locating, the value will stay as it is (no playback of automation). During playback (only),
the current value will be written to automation. You can move the control manually and your
move will be written to the automation.

Touch The parameter will act like it is in Play, unless you “touch” it with the mouse (or a control
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surface that is touch-sensitive). Then it will record your moves until you release the mouse
button, at which point it will revert back to the saved value at that time point.

Latch
Operates like “Touch” mode except it will retain the last value of your moves when you release
the mouse button.

The mouse wheel has a slightly different automation mechanism. It works in “Latch” mode even if a different
automation mode is selected. When the wheel is turned, it “touches” the parameter and begins recording the
move. The automation continues to record until the transport stops.

Automation Thinning:

When automation is recorded in real time, the automation data points are “thinned” so that only enough
control-points are created to adequately capture the moves. The points will appear very sparse if the control
is moving slowly, and will be created very close together during fast moves. The aggressiveness of thinning
can be adjusted if necessary via menu Edit>Preferences>Misc.

Punching in your automation with “Touch” mode:

When you punch-in, 2 points are created: one to hold the previous value, and one to start the new changes.
Similarly, when you release the control (or stop a pass in Write mode) then 2 points are also created: one
which ends the new changes, and one to hold the previously-existing value.

Graphical Automation Editing: Automation tracks

You hide and show automation lines using the “A” button on the track header, or right-click on the track
header and select the parameter for automation.

Automation appears in a separate track from the audio. Multiple automation tracks may be shown
simultaneously. If the automation track is associated with an audio track, a “ghost” of the region’s audio will
appear in the track. Buses do not show waveforms in the automation tracks.

Tip: “Write” automation is a quick way to copy settings from one place to another. Locate
the playhead while the parameter is in “play” to pick up the value you want to apply
somewhere else. Now change the mode to Write, and locate to the new place. Then play
through the desired section to apply the setting.

*

Automation is only recorded during forward playback. However it is possible to record
automation while the transport is looping! Using this feature you can audition several
different passes of the automation. When playback is stopped, the most recently-recorded
moves will be kept. For example, if you loop 3 times and then stop halfway through the
looped section, the resulting automation will be the first half of the 4th pass and the last half
of the 3rd pass.

*
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Automation may be graphically edited using either the Draw, Grabber or the Edit (Contents) tool. The rules
for each are slightly different (and may change in the future)

Grabber tool

• Click a control point to grab it and move it
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Range Tool

• Drag a Range, then you can:
◦ Click Delete (or Backspace) to delete the automation in that range ( with guard points that

prevent you from adjusting data outside your range selection )
◦ Switch to the Draw tool, and drag up/down to move all the points in that range ( with guard

points )
◦ To view a demonstration, see this video clip: Region Gain editing with the Range tool. … this

technique also works with automation lanes.

Draw tool

• Click anywhere in the track to create a new control point, and connect it to the points on either side.
• Click a control point to grab it and move it. ( now it is selected so you can delete it )
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Edit Tool

• Click a control point to grab it and move it.
• Shift+right-click a control point to delete it.
• Click anywhere in the track to start a “box select”, then:

◦ Click Delete ( or Backspace ) to delete the selected points
◦ Grab one control point, and move them all together

• Right-click on a control point to Edit or Delete it.

This is a case where Mixbus is much smarter than some other DAWs you might be familiar
with. When you select a “range” of automation and delete the range, Mixbus doesn’t just
delete the automation ‘points’ inside the range. Instead, Mixbus creates a “guard point” at
the start and end of your range, and preserves the automation timeline before and after the
range selection. In other words, it only deletes the automation “inside” your range selection.
Sounds obvious, eh? But strangely that is not how some other DAWs work.

*

Note: The Grabber tool can grab an automation point, and move them up or down, but it*
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Clicking with the Draw tool will create the first control point, and also draw a line to the very beginning of the
track.

• Click anywhere in the track to create a new control point, and connect it to the points on either side.
• Click a control point to grab it and move it.
• Click a line to move the gain points on either side of the line.
• Use the Range tool (or Object+Smart mode) to create a “range”. Now switch to the Draw tool, click

inside the range, and you can drag the entire range up/down.

Clearing Automation
To clear saved automation in an individual Automation lane, right click on the automation lane (NOT the
audio track) header and select “clear”. All of the automation saved in that lane will be cleared.
Note that if you are automating multiple controls on a particular track, each automated control will have their
own automation lane. So for example you could clear and re-do your fader moves without affecting the other
automation controls on the track.

can’t move their location in time.

Note: Using the Edit tool, you can click in empty space, and begin a “box selection” to select
multiple points at once. You can then click on a point to move them all, or you can press
Delete(or Backspace) to delete them together.
*

Note: Remember that in order for the automation to be auditioned, the parameter must be in
“Play” mode. You do NOT have to be in write or Touch mode to graphically edit the
automation though.
*

Note: Past the extents of the automation line, the “Play” value is the value of the last control
point.*
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Automating Mix Buses
Normally the mixbuses are not shown at the left of the screen with the track headers. This is because
mixbuses do not store audio. While automation of the mixbus fader can be selected on the mixbus strip in
the Mixer panel, it is sometimes necessary to automate other functions on the mixbus.

To display a mixbus at the left along with the track headers so that its parameters may be automated, first
open the “Editor List”:

Harrison Consoles Mixbus - 9_en

Page 437 of 848



In the Editor List make the desired mix bus(es) visible by checking the “V” box:
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The mixbus header will now be displayed at the left along with the other track headers. Clicking on the “A”
automation button allows you to set up any parameter on the mixbus to be automated.
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13.2. Region Gain Automation

Region Gain

Click above for video instructions.

Region Gain is a volume envelope that extends for the length of the region. By default, the region envelope
is “unity” (i.e. no change) across the entire region and it is hidden. To adjust region gain with the mouse,
you must use the Draw tool.

In many situations you may find it useful to turn grid mode off. Clicking on a region with the Draw tool will
cause a control point to be placed. By default, a region has 2 control points, one each at the start and end of
the region.

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0&start=135

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
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Mouse operations using the Range, Draw, and Edit tools inside a Region:

Range Tool

Tip: If you want to quickly change the gain over the entire region, then click on the region to
show the line, and then grab the line and move it up/down. This is an alternative to Region
Level.
*

Tip: This is an excellent way to tweak a syllable or reduce a section of noise, and it is often
more transparent than deleting it entirely. Also, looking through a waveshape and finding a
few of hot the spots and reducing the gain will allow the compressor to be set more
conservatively, providing a more transparent sound.

*
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• Drag a Range, then you can switch to the Draw tool, and drag up/down to move all the points in that
range ( with guard points )

◦ To view a demonstration, see this video clip: Region Gain editing with the Range tool.
• Drag a Range, then click Delete to remove that range

Draw tool

• Click anywhere in the region to start drawing a freeform automation curve
• Click a control point to grab it and move it.
• Shift+right-click on a control point to delete it.
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Edit Tool

• Click a control point to grab it and move it.
• Click in empty space to make a rubberband-selection ( box selection ). This will select the enclosed

automation points which can then be moved or deleted together.
• Shift+right-click a control point to delete it.
• Right-click on a control point to Edit or Delete it.

Temporarily bypassing region gain

Menu>Region>Gain>Envelope Active
or

This is a case where Mixbus is much smarter than some other DAWs you might be familiar
with. When you select a “range” of automation and delete the range, Mixbus doesn’t just
delete the automation ‘points’ inside the range. Instead, Mixbus creates a “guard point” at
the start and end of your range, and preserves the automation timeline before and after the
range selection. In other words, it only deletes the automation “inside” your range selection.
Sounds obvious, eh? But strangely that is not how some other DAWs work.

*
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Right click on the region and click on the track name>Gain>Envelope Active
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14. Using MIDI

What is MIDI, anyway?
MIDI is a wire-protocol that was developed in the 80’s to allow synthesizers to send musical performance
data between devices. So a MIDI keyboard can send performance data ( i.e. “notes” ) to an instrument that
actually creates the sound. It is beyond the scope of this manual to explain MIDI in detail. But a MIDI Primer
has been provided here.

What can Mixbus do with MIDI?
Here are some of the tasks that are typically implemented with MIDI:

1. Play a multitimbral MIDI file through a General MIDI instrument, as a backing track. Learn more here:
General MIDI

2. Add a Virtual instrument to a track, and record MIDI data to play through it. Learn more here: Virtual
Instruments

3. Send MIDI to an external device. Learn more in Setting up an External MIDI device
4. Arranging a song by triggering MIDI loops and phrases. Learn more in Triggering Clips and Cues
5. Using a MIDI as a controller ( for knobs and faders ). You can learn more about that in the External

Control section

Currently Mixbus does not have a musical-staff “notation” view. That might appear in a
future version of Mixbus.*
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14.1. MIDI Tracks

What is a track? How do I create one?
A track is the fundamental building-block of a Mixbus session. You can create new tracks by creating empty
tracks ( using the New Track/Bus dialog ) or by Importing existing audio files as new tracks. Mixbus
supports audio tracks and MIDI tracks. The track type (audio or MIDI) defines what kind of data you will see
in the editor.

What is a MIDI Track?

MIDI tracks are just like audio tracks, but they store MIDI performance data on the timeline, rather than
audio regions.

Otherwise, MIDI tracks are identical to audio tracks; they can have MIDI inputs and outputs, audio inputs
and outputs, plugins, and they have the full complement of Mixbus EQ/Compressor/bus sends. MIDI tracks
are most often used to host virtual instrument (VI) plug-ins, which will render the MIDI data into audio which
is then available to mix within the Mixbus mixer. It is also possible to route the MIDI data directly to a MIDI
synthesizer device, and then patch the audio (if desired) back into the same MIDI track, thereby
incorporating the external device as if it were a VI.

MIDI data may be generated by importing a MIDI file, by playing a MIDI instrument into the track, or by
drawing notes with the Draw tool. Each time you draw or record MIDI notes and controls, Mixbus creates a
MIDI region with a corresponding MIDI file inside the session folder.

https://www.youtube.com/embed/nMPqBaQOW-o?rel=0
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MIDI editing was designed to operate with the same conventions as Mixbus’s audio region editing. You can
cut, copy, move and trim MIDI regions. And your operations apply to a Playlist which can later be reverted
or changed, or even shared with other tracks.

Because MIDI data is always recorded into a MIDI file, this has some implications for MIDI
continuous control data (CC’s). You can only draw controller automation underneath an
existing MIDI region. These controller moves are part of the MIDI region and will move with
it. Note that you can still write fader, EQ, plugin and other mixer-strip automation linearly on
the track, as these exist outside of the MIDI realm.

*
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14.1.1. Adding MIDI tracks

Adding MIDI tracks

Importing MIDI files to a new track:

See Importing Files.

Creating a new MIDI Instrument track:

See Adding Tracks and Buses.

Listening to a MIDI track.
With MIDI tracks, it is fairly common for multiple tracks to be fed from a single MIDI keyboard or device. This
adds an additional level of complexity to the task of “monitoring” the MIDI input.

Once a MIDI track is added you will find a MIDI input Enable/Disable button near the top of the channel
strip. If you want MIDI to be delivered to the track, the MIDI Input button must be enabled for that track.

Harrison Consoles Mixbus - 9_en

Page 448 of 848



14.1.2. Recording MIDI

A step by step guide to record MIDI performance data.
1. Plug in your external MIDI equipment into the input of your MIDI interface or USB connector on your
computer.

2. During session set up be sure system MIDI is enabled (CoreMIDI for Mac and MME for Windows).

3. Add a MIDI track(s) to your session. Click here for more on adding tracks. By default “Reasonable Synth”
plug-in will be inserted into the redirect. You can select a different plug-in at this point or it can be changed
after the track has been created. More on Plug-ins here
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4. Route the system MIDI to the track input. In the image below the MIDI device happens to be called
“Launchkey 25 capture”. You should look for the name of your device here.

5. Enable MIDI input. The default is on as shown in the image below. Click on the green MIDI connector to
disable if you don’t want to hear the MIDI input.

A convenient set up is to switch to the Edit window and turn on the Mixer Editor
(Menu>View>Show Editor Mixer). This way you can manage the MIDI channel strip and
view your performance as you record it. More on Editor Mixer here
*
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6. Be sure to set the channel strip to monitor input.

7. Record arm the MIDI track

8. Record arm the master record button in the Edit window, roll the transport and record your performance.
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9. Once a performance is recorded (or perhaps you have imported MIDI data to the track) you can send the
audio output to a track to be recorded (bounced). Click the output connector ( find the Output connector by
switching the switcher at the top of the mixer strip) and route the MIDI output. In this image it has been
routed to a stereo audio track (audio 7). Click here for more on recording.
Additionally you can route MIDI performance data to outboard equipment via your MIDI interface (many
audio interfaces have a MIDI interface built-in).

You can also visit “Window->MIDI Connections” to see a grid of your track outputs (on one side) and
hardware outputs (typically on the bottom right tab)

A short cut to arming the master in the edit window: rec arm the channel strip then press 3
on the number pad. This will record arm the master and roll the transport simultaneously.
This is especially useful if you are managing the session while recording yourself.
*
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14.1.3. MIDI Track Operations
Right-click on a MIDI Track Header to initiate a pulldown menu of actions. Many of the actions are the same
that are available in audio tracks and buses. But some items are specifically for MIDI:

Note Range:

• Show Full Range: The midi “scroomer” will be scaled to show the full range of MIDI notes 1..128
• Show Contents: The scroomer will be scaled to fit all of the existing MIDI notes in the track

Note Mode:

• Sustained: Notes will be represented as a rectangle, where the rectangle’s width displays the note
start and end.

• Percussive: Notes will be represented as a “diamond” shape, showing only the note “start”.
Percussive mode is useful when showing drum tracks and there is no “length” for each drum hit.

Channel Selector:
The MIDI Channel Selector Dialog will appear:

Select Patch:
Click the menu to send a Bank/Patch message for the selected channel. For more information, see: MIDI
Banks and Patches

Color Mode Selection:

• Meter Colors: (default) The note color indicates velocity” of the MIDI notes.
• Channel Colors: The CHANNEL of the note event will be used to color the MIDI notes
• Track Colors: All notes will be colored with the track’s color
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14.1.4. MIDI Filters
In addition to Virtual Instruments which accept MIDI notes and render audio, Mixbus also supports “MIDI
plugins” or MIDI filters.

What is a MIDI Filter?
A MIDI Filter is a plugin that has only MIDI I/O, and no audio I/O. A MIDI filter can change the incoming MIDI
stream ( forcing all events to a given velocity, for example ) or a MIDI Filter can generate its own MIDI
stream ( such as an arpeggiator or algorithmic-music-creation plugin )

How do I add a MIDI Filter to a track?

MIDI Filters appear in the Plugin Selector just like plugins. But by default they are not shown. To display
MIDI filters, click the small “Utils” button in the plugin manager twice, so it is highlighted & filled:

What MIDI filters are supplied with Mixbus?

See List of Inlcuded MIDI Filters
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It is also possible to create your own cross-platform MIDI filters using Lua scripts
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14.2. Virtual Instruments

What is a Virtual Instrument?
Virtual Instruments (VI) are plug-ins that convert MIDI performance data (notes) into sound. Otherwise
Mixbus treats them like a normal plug-in. They can be inserted anywhere in the channel’s signal flow. This
allows you to insert a MIDI-generating plug-in, or a MIDI “filter” plug-in before the VI. But normally, you
should ensure that the VI is the first plugin at the top of the redirect list.

Mixbus supports four Virtual Instrument formats:

• VSTi (using the VST plug-in specification, the VST format has been extended to include MIDI note I/
O).

• VST3 instruments
• Audio Unit Instruments – this is an Apple technology and is only supported on Mac OS X. Most

plugins on Mac are available in both AU and VST formats.
• LV2 instruments – LV2’s can be compiled for Mac, Windows and Linux. Currently there are very few

commercial LV2 instruments available.

How do I create a Virtual Instrument track?

When you create a new MIDI track, there is a menu selection for the Instrument you would like to use on
this channel. By default, the instrument will be inserted at the top of the redirect list.

What can I do with a virtual instrument?

Just like a plugin, you may double-click on the VI to display its custom user interface.

You may add additional plugins before or after the VI. And you may drag the order of instruments and
plugins. The signal flow through a channel is shown in the redirect box; Red lines indicate the MIDI path,
and green lines indicate the audio path(s). Advanced users can investigate Pin Connections to further refine
the signal flow through the channelstrip.

It is also possible to create a MIDI track without a virtual instrument. In this case you will
likely send the MIDI output to a hardware synthesizer, and return the signal into the MIDI
track’s audio inputs (or whatever track(s) you choose). See Setting up an external MIDI
device

*

In most cases, the fader, EQ, and Compressor elements should come AFTER (below) the
Virtual Instrument in the channelstrip, so they can operate on the audio stream created by
the VI.

!
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Using a virtual instrument with multiple outputs ( such as virtual drum
instruments )

By default, Mixbus creates virtual instruments in their “stereo output” mode (or “mono” if that’s the only
option they provide). Some plugins provide multiple outputs; for example you can configure the kick drum to
appear on a separate output than the snare drum. This is a fairly complicated topic for advanced users. See:
Multichannel instruments

Feeding a virtual instrument from multiple tracks

In some cases, you might have multiple tracks with MIDI data, and you want all of the tracks to feed a single
instrument. To do this, you should create multiple MIDI tracks, with no instrument. Then create a single MIDI
“Bus” with the desired instrument. Use this image as a reference

Note that because the VI is in the plug-in window, after the channel’s input, the input trim is
not effective on the VI. Most VI’s have their own internal volume control which can be used
as a trim.
*
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In this image the 4 MIDI tracks are ‘feeding’ the MIDI Bus track at the top. The MIDI tracks themselves do
not have instruments on them, but have MIDI data in regions on the track that will flow to it

Finally, connect the MIDI outputs of the tracks to the input of the MIDI bus. As shown in this image.

The MIDI “bus” will sum (merge) the inputs of several MIDI tracks, and provide the resulting MIDI stream to
a virtual instrument.

If your VI is multi-timbral, each MIDI Track can be set to output to one or more channels of
MIDI by right clicking the MIDI Track and choosing the ‘Channel Selector’ menu option.
There you can chose from one or more of sixteen MIDI channels.
*
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14.2.1. Multichannel instruments
Some virtual midi instruments provide more than stereo outputs. This allows (for example) a drum
instrument to provide a separate output for each virtual “microphone”.

Mixbus provides 2 multichannel “drum” instruments: “Black Pearl Drumkit Multi”, “Red Zeppelin Drumkit
Multi” and “Blonde Bop Drumkit Multi”.

Some examples of third-party multichannel drum instruments include Native Instruments Kontakt,
Toontrack’s EZDrummer, or Melda’s MDrummer.

The different plugin formats behave differently for multichannel outputs. AU instruments can have a variable
number of outputs; while VST instruments, and Mixbus’s bundled LV2 instruments, pre-define how many
channels they can support.

When a multichannel instrument is created, you want each sound to appear on its own mixer strip in Mixbus.
Rather than make these connections yourself, it is much faster to let Mixbus do these connections for you.
Mixbus calls this feature “Fan Out”.

Setting up a multichannel instrument with fanned-out tracks:
To utilize these plugins in multichannel mode, it is necessary to initiate the operation from the “Add Track”
dialog:

There is a convention among VST and AU plugins that the “Fanned out” buses should be
stereo pairs. Starting with v5.3, Mixbus creates stereo buses and connects them to each
pair of instrument outputs. (the bundled Black Pearl and Red Zeppelin kits are smarter, and
can create a mix of mono and stereo outputs)

*

If your instrument does NOT use stereo outputs (Addictive Drums is one example) then
you’ll have to visit “Window->Audio Connections” and assign your outputs to both the
left&right inputs of the desired track. Perhaps in the future we will add an option to create
mono tracks instead of stereo tracks.

!
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And then in the “Plugin Setup”, select ’9 Channels’ and ‘Fan Out’ (these are enabled by default)

…this will result in 9 additional tracks. In the bundled drum plugins, each resulting bus will be labeled with
the drum it represents (kick, snare, etc). In third-party plugins, the resulting buses will be numbered 1….N.

Other operations and their effect on multichannel
instruments:
- If an instrument plugin is drag-copied from one channel to another, it will be configured as a stereo-out
plugin.
- If you drag an instrument from the “favorites” list in the mixer window, it will be configured as a stereo-out
plugin.
- If the default stereo “fan out” isn’t desired, then disengage the “fan out” checkbox. The instrument will still
be created multichannel outputs, but no resulting buses will be created. The user must manually create
buses and/or tracks to receive the separate outputs of the instrument track.

Printing your tracks:
Once the arrangement is complete, you can print the instrument outputs by record-arming the tracks,
record-arming the master rec-enable and rolling through your song. Once you’ve printed the tracks to audio,
you’ll need to switch the track monitoring from “IN” to “DISK”. The fan-out process forces the monitor to
INPUT so you can hear the tracks without having to rec-arm them.

You’ll notice that the instrument track’s “MSTR” master-bus-assign button has been
disabled. This prevents the first 2 outputs of the instrument being double-assigned to the
master bus, because the first 2 outputs of the instrument are still playing through the strip.

!

In versions before v5.3, Mixbus created “buses” instead of tracks. But it is desirable to
“print” the drum tracks to audio, once the major arranging is done. This future-proofs the
session, in case the instrument is no longer available. It also allows fine-grained editing, just
like real drums.

!
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https://www.youtube.com/embed/X8uhN4o6HUk?rel=0

Harrison Consoles Mixbus - 9_en

Page 461 of 848

https://www.youtube.com/embed/X8uhN4o6HUk?rel=0


14.3. Sending to an external MIDI device

External MIDI devices
In some cases, you might prefer to send MIDI from Mixbus’s MIDI tracks to an external MIDI sound module (
“synthesizer” ) rather than use a software Virtual Instrument inside Mixbus.

How do I send my MIDI to an external device?

Click the “Switcher” at the top of the mixer strip to expose the channel’s input and output buttons. Click the
“output” button and choose the physical MIDI port that you’d like to send out to.

How do I change the sound preset (“patch”) of the external device?

See: MIDI Banks and Patches

Alternatively you can set up the MIDI patching via the main menu, Window->MIDI
Connections*

Harrison Consoles Mixbus - 9_en

Page 462 of 848



14.4. Multitimbral and “General MIDI”
Mixbus can record, edit and render multitimbral MIDI files, often used for backing tracks or
“sweetening” tracks to fill-out a live recording with additional instruments.

What is “Multitimbral”?
MIDI performance data ( such as notes from a MIDI file ) may be provided in up to 16 different channels on
a single MIDI connection. Typically, each of the channels represents an instrument. A channel can change
instruments anytime by sending a “patch change” message, which the receiving synth may (or may not)
respond to.

At the start of the file, a “patch change” MIDI message will typically be sent for each of the channels in use,
and these patch messages will define what instrument should be sounded on that channel … perhaps a
saxophone, guitar, or piano.

What is General MIDI?
General MIDI is an agreed-on set of patches to render performance data with a variety of common
instruments from various ethnicities. As MIDI can only send messages like “Channel 7, patch 21”, it was
found necessary to define some instruments for these generic patch messages. In this way, a .mid file that
follows the “General MIDI” specification can be reliably played in a synthesizer that is also General MIDI
compliant.

For example, it is generally agreed that drums will be played on Channel 10.

How does Mixbus implement Multitimbral and General-MIDI
synthesis?
Mixbus is optimized for high-quality mixing of audio. Support for General MIDI, multitimbral MIDI, and
backing tracks is not a high priority for us. Nevertheless, it is a feature that is sometimes desirable, and with
Mixbus v4 we have added some mechanisms to import, edit, and render multitimbral MIDI data.

Mixbus provides 2 multitimbral synths:

• a-FluidSynth, a multitimbral MIDI-capable synthesizer that loads .sf2 soundfonts.
• General MIDI Synth, a simplified version of FluidSynth that automatically loads the GeneralUser

It is beyond the scope of this document to describe all of the conventions that have been
developed for MIDI and Generic MIDI.*
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soundfont by S. Christian Collins. GMSynth provides a very thorough implementation of the General
MIDI specifications.

What is a soundfont?

A “soundfont” is a file that contains audio samples and a “mapping” of each sample which defines the MIDI
notes it will be played. Fully-featured soundfont players, such as Fluid Synth, provide full support for many
MIDI features such as pitch-bend and modulation; as well as a built-in chorus and reverb to improve the
sometimes lackluster sounds of General MIDI.

How do I use the General MIDI Synth?

To use the General MIDI Synth, simply add a new MIDI track ( or Bus, if you intend to feed it from multiple
tracks ), and leave General MIDI Synth as the Instrument selection.

How do I choose a different patch/sound in the GeneralUser soundfont?

See: MIDI Banks and Patches

How do I use other soundfonts?

There are many Soundfont (.sf2) files online, from both commercial and “free” vendors.

You may download any .sf2 file, and use the selector menu inside a-Fluid Synth to navigate to, and load, the
desired soundfont file. Note that the quality of sound fonts can vary widely, and you might need to check the
soundfont’s documentation to learn which patches and note ranges are implemented.

Some soundfont files are optimized for General MIDI, and multitimbral operation. While other soundfonts are
intended to provide only a single instrument, or several instruments, and do not implement the General MIDI
specification. For example you can download a soundfont file that provides only a high-quality piano, a
virtual orchestra, or a vintage electronic drum machine. A full investigation of .sf2 files is outside the scope
of this manual, but you can find more information by searching the internet for “sf2” or “soundfont”.

NOTE: while searching the internet, you might find a wide range of free soundfonts. In our
experience, the provided GeneralUser soundfont provides an excellently curated set of
drum and instrument sounds. In many cases, we’ve found that free online soundfonts are
only a subset of the patches that GeneralUser already has included. Furthermore, the
curator has made an effort to verify that every sample is freely licensed for your use. For
casual users, we highly encourage you to use the provided General MIDI Synth for free
drum and instrument libraries. Professional users might want to purchase commercial
players and libraries online from established vendors such as Kontakt, UVI, VSL…

!
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14.5. Step Entry
Step entry of MIDI data is an alternative method of entering MIDI arrangements. In step editing, you set the
length of notes, and the transport is automatically moved forward each time you play a note (or chord) on
the keyboard. This is a fast way to enter a long sequence of chord progressions or a drum pattern. Or it can
be helpful for users that are not proficient in keyboard performance, but would like to enter notes using the
keyboard.

To initiate step entry, right-click on the track’s “REC” button. A keyboard will be displayed.

Use your externally-connected keyboard to enter notes and chords; the step-entry dialog will automatically
advance the playhead with each event. This is a fast way to enter a chord progression or drum parts.
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14.5.1. MIDI Step Entry: Tutorial video
This video demonstrates the Step Entry Method for creating MIDI tracks.

https://www.youtube.com/embed/bYbykVr5_DI?rel=0
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14.6. MIDI Banks and Patches

What is a MIDI Bank or Patch?
A MIDI patch is a preset sound in a sound-generator (synthesizer). For example a keyboard might have a
patch for “piano”, and a drum machine might have a patch for “jazz drum kit”. MIDI Patches are numbered
from 1 to 128. Mixbus can send a “patch change” message to a device, to request the patch at that index.

A MIDI bank is a mechanism to access additional sets of 128 patches. Banks were added to support
devices with more than 128 sounds, or patches. Mixbus allows the user to select from 128 banks, and each
bank allows up to 128 patches.

The MIDI specification allows up to 16 “channels” on a single connection, and each channel can be
assigned a “patch” from one of the “banks”. However very few devices have a full set of banks and patches
available on all 16 channels. You must consult your device’s manual to determine what banks and patches
are supported, and how many channels can be used, and how many notes may be sounded simultaneously.
( Mixbus’s built-in synth, GMSynth, has quite a wide range of patches & banks. Learn more here: General
MIDI )

How do I audition the patches in my external MIDI synth or VI plugin?

Right-click on a MIDI track header, and you will be presented with a list of actions:

With the advent of “virtual instruments” rather than external MIDI gear, bank/patch changes
are much less common. Virtual instruments typically use their own GUI or preset
mechanism to change sounds, not MIDI events. So if you are using Virtual Instrument
plugins, you can likely ignore MIDI banks & patches.

*
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Click “Patch Selector” to launch the patch selection dialog:

The patch selector has these controls:

• Channel selection: Each Mixbus track provides 16 MIDI channels
• Bank: If a patch map is provided for the track/instrument, you’ll see a list of available banks here.
• MSB / LSB : if no patch map is provided, use these selectors to manually select the MIDI bank values

that are sent to the device.
• Patch buttons: if a patch map is provided, the available patch names will be shown here. If no map is

provided, or if the map doesn’t specify a patchname for a position, then the button will show the patch
number. * Audition on Change: when enabled, selecting any patch will trigger a series of MIDI notes
to the synth.

• Start Note: If “Audition on Change” is active, this is the first note that is played.
• End Note: the last note that will be played.
• Velocity: select the MIDI “velocity” (loudness) of the notes sent to the plugin
• MIDI Keyboard: the keyboard can send MIDI notes directly to the instrument for auditioning ( these

notes are not recorded into the track )

Where do I specify the patch names that should appear in the patch dialog?

Mixbus’s built-in multitimbral synths ( GMSynth and a-FluidSynth ) automatically publish their patch
information to Mixbus when they are instantiated on a channel.

Other commercial plugins normally provide their own patch management inside the GUI, and do not publish
their patch settings to Mixbus.

For tracks with no plugin instrument on the track, the “External MIDI Device” menu allows the user to define
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what external device is connected to the MIDI output:

Advanced users can add additional patch maps ( .midname files ) for their device. Editing .midname files is
outside the scope of this document. Contact Mixbus support for more details.

Inserting a patch change during playback

In some cases, you might want to introduce a “patch change” during playback of a track. For example this
might be desirable to change your “violin” track to switch to the “plucked violins”, temporarily. To insert a
patch change event, right-click on a region, and choose “Insert Patch Change” from the MIDI submenu:
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The dialog will prompt you for the bank and patch number. NOTE: if the patch doesn’t appear where you
expect it, select “Playhead” for the Edit Point, and use the playhead to define the patch change location.

Once inserted, you can use the Edit (“E”) tool to move the patch change. Scrolling the mouse wheel over
the patch change will increment the patch number. Use the shift+right-click convention to delete a patch
change.
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In the current version of Mixbus (4.2), patch changes are only sent when they are “played
through”. In other words, locating to a time after a patch change does not automatically
send the patch. This feature might be implemented in a future version.

!
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14.6.1. Adding MIDI Patch files

What is a .midnam file?
The .midnam file specification is defined by the MMA ( MIDI Manufacturers Association ) and is part of the
official MIDI specification, to allow interchange of a device’s patches & controller settings between different
sequencers.

You can learn more information about these files here: https://www.midi.org/specifications/item/midi-in-xml

Where are Mixbus’s .midnam files located?
The files are located in the Mixbus application folder, in a subfolder called “patchfiles”. The location of this
file varies with each operating system.

1. On MacOS, right-click on the Mixbus application, and select “Show Contents”. Then navigate to
Contents->Resources to find the patchfiles folder.

2. On Windows, Navigate to Program Files\Mixbus\.. and find the patchfiles subfolder.

How can I find a .midname file for my device?
In many cases, you can find a .midname file for your device by searching online. These files are sometimes
provided by the manufactuer. Download the file and drop it into the patchfiles subfolder. Once installed,
you’ll see the list of patches in the patch-selector.

If I can’t find an existing .midname file for my device, how do
I create one?
If you can’t find a device file online, then you can make a copy of an existing device file, and edit it
manually. The files are plain text, using the XML text format, and are fairly easy to read and edit.

1. Locate a .midnam file that is most similar to your desired device. ( such as
“Korg_Volca_Bass.midnam”, if your device is a Korg )

NOTE: keep a copy of your new .midnam file, because when you re-install Mixbus, the
.midnam file in the application folder will be overwritten.

!

You can also remove unnecessary .midnam files, to reduce the size of the list in the menu.
But the .midnams will be replaced when Mixbus is reinstalled.*
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2. Open the file in a plain text editor: most common errors occur when the editor tries to re-save the file
in a different format.

3. Save the file with a new name. (such as, “My Korg Device.midnam”)
4. Edit the internal values of the file to meet your needs. For example, change the text of the author to

reflect your own name.

The most important parts of the file are:

The device’s manufacturer and model name:

The patches that are provided in the device:

Harrison Consoles Mixbus - 9_en

Page 473 of 848



The names for the MIDI controllers (CC’s) that are supported by the device:
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14.6.2. MIDI Follow Selection
There are times when you are using one midi keyboard to control multiple MIDI tracks but you want them to
be triggered depending on the track you are working on.

To allow this behavior you can go to Mixbus Preferences/MIDI/MIDI Port Config and choose Follow
Selection in the MIDI Inputs section.

Now you can simply select the track you want to hear and start playing.

This is especially useful when you want to hear what your drums sound like and then select a different track
to listen to your strings or whatever sound you have called up.
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14.7. Editing MIDI Regions
A MIDI region is exactly like an audio region, except that the information inside the region is MIDI
performance data, not audio.

MIDI regions may be cut, copied, pasted, and trimmed in much the same way as audio regions. Region
editing is accomplished with the same tools: the Grabber (Hand) tool and the Range tool.

Grabber Tool

Range Tool

Editing features like the Grid, Sync Points, and Ripple Mode apply to MIDI regions just like audio regions.

There are 3 major differences with MIDI regions vs audio regions:

1. MIDI regions do not have fade in/out handles.
2. MIDI regions are “transparent”. This means that if you layer 2 regions atop each other, you will hear

the notes of the region below. This allows you to overlap regions so you can sustain one note through
the start of a new region.

3. By default, a copy of a MIDI region is a “linked” copy. So if you move the note in the source region,
the same note will be moved in the copy (and vice versa).

MIDI regions do not only contain MIDI notes; they also contain performance information such as pitch bend,
aftertouch, controllers, etc. This has one side-effect: in order to draw controls (with the Draw tool), there
MUST be an underlying region. MIDI data cannot exist on a track without an underlying MIDI file, and this is
represented by a midi region in the track. If you record MIDI data, then a region is created to hold any notes

In the same way that audio regions have underlying audio files that are actually stored on
disk, a MIDI region has a MIDI file in the session that it represents.*
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or controls that you play into the track. If you want to draw notes or controllers, you must first use the Draw
tool to drag a region, and then you can draw notes or automation into the region.

Using the Grabber (“G”) tool, you can right-click on a MIDI region and navigate to the MIDI context menu:

• Transpose – transposes all the notes by a given octave/semitone offset.
• Insert Patch Change – Inserts a patch change event in the region.
• Quantize – Quantizes the note start/ends to a defined grid.
• Legatize – Extends note ends to meet the next note’s beginning.
• Remove Overlap – After this operation, each new note onset will cut off any notes that were held on

before the new note was struck.
• Unlink from other Copies – unlinks this MIDI region from its copies. Any edits done to this region will

no longer apply to the region(s) it was copied from.
• List Editor – shows MIDI notes in a text list. Each note can be individually edited in the list.

It was a design goal of Mixbus to edit MIDI regions “just like audio regions”. To some users this is going to
feel inelegant. To others it will be a breath of fresh air.
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14.7.1. Editing MIDI Notes and Controls
In the image below: Highlighted in green is the Draw (“pencil”) tool, and to the right is the Edit (“points and
lines”) tool. These tools are used to edit MIDI notes inside MIDI Regions.

In the image below: 2 MIDI notes have been selected for editing.

Draw tool Edit Tool

• Click anywhere to start dragging a new MIDI • Shift+right-click on a MIDI note to delete it

Remember, the Grab and Range tools are used to edit Regions, while Draw and Edit
operate on the contents of regions.*
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note; drag to extend the length of the note
◦ Newly-created notes get the average

“velocity” of other nearby note velocities
• Click in the middle of a note to select it ( the

note will turn red ). Ctrl+click ( Cmd+click on
Mac ) to add/remove notes from the selection

• Shift+right-click on a MIDI note to delete it
• Click the left or right edge of the MIDI note to

trim the start and end times of the note
• Click in the middle of a note to drag it
• Shift+right-click on a MIDI note to delete it
• Scroll the mouse wheel on a note to increase/

decrease the velocity

• Click in the middle of a note to select it ( the
note will turn red ). Ctrl+click ( Cmd+click on
Mac ) to add/remove notes from the selection

• Click the left or right edge of the MIDI note to
trim the start and end times of the note

• Click in the middle of a note to drag it
• Scroll the mouse wheel on a note to increase/

decrease the velocity
• Click an empty space in the region to initiate

a “box select” rectangle. With multiple notes
selected, you can:

Once a note (or multiple notes) is selected (red), you can:

• Click Backspace or Delete key to delete the selected note(s)
• Click the up/down arrows to transpose the note pitch up/down
• Point at the selected note, and use the mouse wheel to adjust all of the selected note velocities
• Right-click on a selected note to open the MIDI context menu

MIDI context menu:

• Delete – Requires one or more notes to be selected. Deletes the selected note(s)
• Edit – Operates on a single selected note. Allows changing the length, pitch, velocity, etc.
• Legatize – Operates on a multi-note selection. Extends note ends to meet the next note’s beginning.
• Quantize – Operates on one or more selected notes. Quantizes the note start/ends to a defined grid.
• Remove Overlap – After this operation, each new note onset will cut off any notes that were held on

before the new note was struck.
• Transform – Allows transforming the note pitch, velocity, and other parameters using logical

operations.

MIDI Control (CC) Automation

MIDI Controls use the same conventions as automation, except that you can only have MIDI controller
automation inside a MIDI region. You can only click to create new control points if there is a MIDI region on
the timeline at that location.

If you want to apply these MIDI operations to all the notes in a region, you can use the
Grabber (“G”) tool, and right-click on the region(s). The MIDI submenu allows you to apply
these operations to all notes in the selected region(s), without having to select the notes
separately.

*
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MIDI Velocity bars

The note “velocity” may be displayed inside MIDI notes as a “bar”. See the image below:

Velocity is displayed as both a “color” change ( increasingly saturated color with higher velocity ) … and also
with a bar indicator inside the note.

This feature can be enabled or disabled in Appearance->Editor->MIDI Regions
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14.7.2. Velocity Lollipops
MIDI tracks have an associated velocity lane where you can access each note’s velocity and also draw a
crescendo across multiple notes and channels at once.

Select a MIDI region, and the region’s notes will appear in the velocity lane:
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14.8. Virtual MIDI Keyboard
The Virtual MIDI Keyboard can be used to provide MIDI triggers and controls. We doubt you could
seriously play any music on it, but if you can you’ve got real talent.

To turn on the virtual keyboard, go to the Window pulldown menu and select “Virtual Keyboard”. The
keyboard will open in a new window, and is always on top of the Mixbus window (meaning, you can’t hide or
cover it).

Virtual Keyboard Controls:
• MIDI channel selector
• pitch bend slider
• 8 parameter controller knobs, each with selectable MIDI channel
• Transpose selector, with a range of +/- 12 notes
• keyboard layout button to select various optional mappings of the computer keyboard to the virtual

keyboard (QWERTY, DVORAK etc). In the image above the mapping is set to QWERTY.

• Config menu providing the following controls:
◦ velocity parameter settings
◦ Octave and Range controls to select which part of the 0-127 MIDI range is covered by the

keyboard.
▪ Octave is self explanatory, which octave is the keyboard playing in, the possible range is

C-1 to G9

Harrison Consoles Mixbus - 9_en

Page 482 of 848



▪ Range adjusts the size of the keyboard, from 2 octaves ( 25 keys) to 11 octaves (128
keys)

• Bank/Patch menu providing the following controls:
◦ fill-in
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14.9. MIDI Channels
This video introduces the concept of MIDI Channels in Mixbus.

https://www.youtube.com/embed/0Nw0gSA7_po?rel=0
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14.10. MIDI Plugins
This video demonstrates the use of several MIDI plugins available in Mixbus.

https://www.youtube.com/embed/pnaFFA_AZII?rel=0
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15. Scripting

What is a “script”?
A “Script” is a text that follows a specific format, and operates like a small program inside the main Mixbus
program. This text (or “script”) can be typed inside Mixbus, and immediately used by Mixbus, rather than
first being “compiled” as part of Mixbus’s source code.

Mixbus can have an “unlimited” number of scripts provided by Harrison, or developed by the user.

We expect the number of provided scripts to grow quickly, as our users develop new scripting ideas.

Mixbus uses “Lua” for its internal scripting language.

What is Lua?

Lua is a simplified programming language that is specifically designed for programs like Mixbus to use
internally.

Here is a very simple example of a Lua command:

Session:set_transport_speed (1.0)

This command would cause Mixbus to start the transport at speed 1.0. ( i.e. 100% or “Play”)

There is some additional text at the top of the script file that defines the script’s name and other details to
Mixbus.

How do I use Lua scripts?

Several example Lua scripts are provided for your use. There are 3 common ways to initiate a script.
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Lua scripts initiated directly from the “Scripting” window:

In Window->Scripting you can view a text editor where Lua scripts may be viewed, edited, and executed.
You may type Lua text directly into the text editor, and then initiate the script by clicking ‘Run’ in the bottom-
left corner.

In the bottom-right corner, you’ll find a menu which provides a selection of available scripts. Some of the
available Action scripts are ready-to-use. Another set of scripts, called “snippets” are provided as starting
points for your own Lua scripts. For example there are “snippets” that advance through each of the
session’s tracks.

The most common usage of scripts is to recall an existing script, and change it slightly for your immediate
needs.

For example: the “rename tracks” script will remove the text “track” from all of your tracks. But perhaps you
need to remove the word “session_song_” from all of your track names. In that case, you will load the
“rename tracks” script, but modify the text that it is removing or replacing.

You may “save” your scripts for later recall.
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Lua scripts triggered as an “action” in the toolbar, or by keyboard shortcuts:

In Edit->Script Manager, you’ll find a dialog that allows you to assign scripts to action buttons, keyboard
shortcuts, or session events:

In Preferences->Appearance->Toolbar, you can enable up to 8 action buttons, and assign a Lua script to
each of the buttons. The script can even generate its own icon, as shown here for the “create Drum Tracks”
script:

Right-click on an action button to assign an action to it. You may also assign a Lua script directly to a
keyboard shortcut.

Lua scripts triggered by Session events:

Lua cripts can be triggered by events inside the session.

For example, a script can be triggered “when the transport is stopped”, or “when a marker is reached”.

The details of session-event scripts are currently beyond the scope of this manual.
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Lua scripts as DSP Plugins:

A Lua script can be loaded as a DSP plugin. Users will find the provided Lua DSP plugins in the plugin
manager, with type “Lua”.

Developing DSP plugin scripts is beyond the scope of this manual.

Developing your own Lua scripts:

Lua Scripting is developed by the Ardour open-source community, with Harrison’s funding and support.
Developing your own Lua scripts is beyond the scope of this manual, but you can find regularly-updated
details on this page.
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16. Templates
Mixbus allows you to create “Session Templates” and “Track templates” to partially automate your workflow:

Session Templates

A “session template” is a file that stores all the settings for a session, except for the actual audio, midi, and
automation region data. When creating a new session in the “New Session Dialog”, you may choose to
select a template. This will restore the settings of the templated session including track layout, track names,
plugins, mixer settings, and preferences.

To create a session template, select “Save as template” from the main Session menu.

Learn more about Session Templates here: Session Templates.

Track Templates

A “track template” is a file that stores the settings for a track. When creating a new track in the “New Track
Dialog”, you may choose to select a template. This will restore the settings of the templated track.

To create a track template, right-click on the mixer strip and choose “Save as template”

Learn more about Track Templates here: Track Templates.

Scripted Templates

It is possible to create “scripts” which can automate certain tasks, and can act on further input from the user.
The Mixbus package includes examples of scripts that operate as Session and Tracks. Creating scripted
templates is beyond the scope of this manual. Contact mixbus@harrisonconsoles.com or visit the Mixbus
forum for more details.

For more details about the Lua scripting language used in Mixbus, please see Scripting

Template Manager

The Template window ( Window->Templates ) allows you to view, manage, and share your “template” files.
Both Session templates and Track templates can be shared in the Template manager window:
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Select a template item on the left, and you can choose to Rename or Remove the selected item.

“Export All” – this creates a compressed archive file ( with the extension .tar.gz ) which includes all of your
template files. You may send this file to other users who might want to use your templates

“Import” – this button allows you to select a compressed archive file (with the extension .tar.gz) which will
then be extracted into your session and track template folder.
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17. Importing Files

Importing via Drag&Drop

Audio & MIDI Files may be imported to Mixbus by dragging and dropping them from a file browser into the
editor window. The file will be imported to the track where it is dragged; if you want to create a new track for
the file, then drag the file to the empty area at the bottom of the editor canvas.

Importing Audio files with the Import dialog

Using the import window (Session->Import) is a much more flexible and powerful way to import files to
Mixbus.

https://www.youtube.com/embed/otZgZs3CDYM?rel=0
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The Import dialog allows you to add existing media and has 2 tabs at the top: “Browse Files”, and “Search
Tags”.

• The Path Bar: Shows your current path and allows you to navigate back “up” the directory tree.
• The Location Bar: Allows you to directly type in the name of a file in this directory or enter the entire

path via text (the “notebook” button shows or hides the Location bar).
• Places: A list of common locations on your computer. The top two items, “Search” and “Recently

Used”, are always there. Clicking “Search” allows a text entry to search your system. Warning: This
can take a LONG time. The lower section provides shortcuts to commonly-used locations. You can
Add and Remove these locations using the buttons underneath. You can also remove or rename
locations by right-clicking on them.

The main area shows a list of files in the current directory. They can be sorted by Name, Size, or Modified
Date by clicking on the headers at the top of the columns. Underneath is a selector to show “Audio Files,
MIDI Files, Audio and MIDI Files” (files with recognized audio file extensions such as .wav), or it can show
“All Files”.

To the right of the file selector is the Sound File Information area. When a file is selected in the browser, you
get a report of the number of channels, sample rate, and in the case of broadcast wave files, the timestamp

NOTE: On MacOS, your external hard drives will be found under “Volumes”.*
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when it was recorded. There is also an area to enter metadata “tags” for the audio files. Tagging files this
way makes it very easy to find them in the future, using the “Search Tags” tab. If a MIDI file is selected you
get a report of number of channels, Format, Length, and Timestamp.

Finally, there are options to Audition the files. You can click “Play” to play the file, Stop to stop playing, or
choose auto-play so that files automatically start playing when you click on them. By default files will play
when you double-click on them. There is also a level-fader on the right side that allows you to trim the
audition level.

Add Files …:

• As New Tracks: Each file will be imported to a new track.
• To Region List: The imported files will be imported to the region list but no tracks will be created. This

is useful if you are importing individual hits or effects into the region list, where you will use them to
replace existing sounds.

Insert at:

• Use File Timestamp: After importing the file will be located at the file’s time stamp (if it is a bwav file).
• At Edit Point: After importing the file will be located at the edit point.
• At Playhead: After importing the file will be located at the playhead location.
• At Session Start: After importing the file will be located at the session’s start marker.

Mapping:

• One Track Per File: Each file will be appear on one track. If the file is stereo, it will be a stereo track.
If there are more than 2 channels then they will be ignored.

• One Track Per Channel: Each channel of each file will appear as a track. If a file is stereo, it will be
converted to 2 mono tracks. An 8-channel wav file will be converted to 8 mono tracks.

• Sequence Files: If this option is selected, then the files will be imported to a track, and will be
imported sequentially on the timeline.

• Merge Files: This option ONLY appears when 2 files of identical length are selected. “Merge files” will
load the 2 mono files as a stereo file.

MIDI Track Names:

• By track number : this will use the MIDI file’s track numbers, as the name for the newly-created
track(s)

• By Track Name : this will used the MIDI file’s embedded “track name” information to name the newly-
created track(s)

• By Instrument name : this will used the MIDI file’s embedded “instrument” information to name the
newly-created track(s)

The most important buttons are underneath. These buttons control the modes that will
dictate how files are imported.

!
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Conversion quality:

If the file has a different sample rate than the current session, it is necessary to do sample rate conversion.
This determines the quality and it is always recommended that “Best” is used.

Instrument:

If MIDI data files are imported this option will install a basic synth plugin on those tracks called
“ReasonableSynth”. This built-in utility allows you to audition your MIDI performances without any plug-in
parameters to set incorrectly. It may be deselected and substituted with another plugin via the drop down list
or after the track has been added to the session.

Use MIDI Tempo Map:

If enabled, Mixbus will import the MIDI Tempo markers from the first selected MIDI file, and apply it to the
session’s tempo map.

Copy Files to session:

Tags:

If you have used the Tag feature to “tag” files that are used in the past, then you can use the Search Tags
tab to find those files quickly. In this case, we searched for the term “shout” which was added to the files on
the previous page. They instantly appear in the file area to be auditioned and imported.

IMPORTANT!! If you want to use a file as-is, you can uncheck “Copy Files to session” box.
This saves disk space by not duplicating the file into the session. No sample-rate
conversion is performed. Your files can sound sped-up or slowed-down if their sample rate
does not match the sample rate of the session. By default, files are always copied to the
session with appropriate sample rate conversion. If “Edit> Preferences>Misc->Always Copy
Imported Files” is enabled, then this option will be grayed-out.

!

Note: If a file is “linked” into the session without being copied into the session, then the
sound won’t be available if the file is moved or deleted. For example, if the file is on a
removable hard drive then it might not be available next time the session is used. Use this
at your own risk.

*
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17.1. Freesound search & import
Freesound (freesound.org) is a collaborative online collection of Creative Commons licensed sounds.

The Session->Import dialog has a tab at the top where you can search the freesound database and directly
import these sounds into your project.

Freesound allows you to browse, download and share sounds that you can use in your projects.

To learn more about the files at Freesound, and how you can share them, we encourage you to read the
Freesound FAQ page

Searching the Freesound database:

Tags: enter your search-text here, and any files with that ‘tag’ will be listed in the dialog.
Sort: you can define some rules to sort the resulting file-list, like “Most Downloaded”
License: choose an appropriate license for your project, and filter the results for that license
More: this button will load an additional page of files for you to audition or import
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Similar: some files, when selected, allow you to search for similar files

Click ‘Search’ to populate the dialog with a list of files.

Logging-in to Freesound:

The first time you initiate a download from Freesound, a browser window will launch and invite you to create
a freesound user account. After creating an account, you will be provided with a key-code that identifies
your Mixbus software as a valid mechanism to search and download sounds.

Auditioning and importing files:

When you click on a file, you must wait for the download to complete before you can audition the file.

The Freesound tab is a special ‘search’ function of the Import dialog, and operates with all the features and
options of the Import dialog, with one exception: you cannot drag&drop files from the Import dialog to your
session; you must first import the files to your Source List (or to a new track) before you can use them. In
the future we might allow you do download directly to your Clip List, or provide a Freesound search dialog
directly in the Cue page.

more details about Freesound:

When you click on a sound to audition it, the file is downloaded to your computer and saved in your Mixbus
cache folder, in a subfolder called “freesound”.

On mac, this folder is: {Mac HD}/Users/{your username}/Library/Caches/MixbusX/freesound
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18. Exporting Files
Please watch the following video for an overview of exporting features in Mixbus:

Differences between Bounce, Consolidate, and Export

Mixbus has multiple ways of “rendering” audio into contiguous audio files.

Bounce

The least-used method, “Bouncing” is a way to store a drum hit or sound effect that will be reused later in
the project. A new region will be created in the region window. The bounced region will have the region’s
gain, gain curve, and fades applied to the audio. You can later drag this region back into the project
wherever you need it.

To initiate a Bounce action, right-click on a region and choose “Bounce”. A new region will appear in the
Editor List, inside the “Region” tab.

https://www.youtube.com/embed/NT5Zo1OHKaQ?rel=0
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Consolidate

“Consolidate” allows you to select a time-range consisting of many regions, and create a single region on
the timeline. This can simplify future edits or exporting operations, because the various layers, gain curves,
fades, and other region properties are made into a single contiguous audio region which can be manipulated
more easily.

To initiate a Consolidate action, you will select a time-range with the Range tool (this can consist of multiple
tracks), right-click on the Range, and choose Consolidate. The regions under the selection will be
consolidated into contiguous audio regions.

Exporting

“Exporting” is used to generate one or more files, outside of the Mixbus session, in the file-location and
format that the user defines. “Exporting” is how you create the final stereo output file of a song, or a series
of songs and markers for a CD, or a video for posting on YouTube.

There are many ways to initiate an “Export”, and Mixbus supports many, many options. A single Export
event might generate multiple files, in multiple formats, with multiple different , and with or without metadata
such as CD markers, song names, etc. Exporting is probably one of the most complicated (but powerful)
features of Mixbus.

Exporting to an Audio File
Once a mix is ready for delivery, you will need to generate a final output from Mixbus. There are several
ways to initiate an Export from Mixbus; each method helps to define the tracks that will be exported, the
start/end times of the exported file, and the format of the files to be created.

Initiating an Export

There are 5 common ways to initiate an export:

• Session>Export>Export to Audio File(s)
• Session>Export>Stem Export
• Session>Export>Export to Video File
• (Selected Region)->Right Click->Export
• (Range Selection)->Right Click Menu->Export

Export to Audio File(s)

This method initiates the most common export. The Export dialog will appear, prompting you for details such
as the exported filename and location, the file format, and the time-ranges that you would like to export.

You can cancel an Export operation at any time by closing the dialog and/or clicking Cancel.*
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Stem Export

This initiates an export of individual tracks. In the “Channels” tab, you may select whether to apply the
channel processing, or to leave the track contents unaffected. Each track or bus will generate a separate
audio file. If you choose multiple timespans, then you will receive a separate audio file per time span.

Export to Video File

This initiates an export similar to the main session export, but it generates a video file by combining the
video track with the master-bus outputs.

Region export

This simply exports the selected audio region into any format that the user chooses. This does not include
any mixer-strip or plugin effects.

Range export

This initiates an export, just like the session export, but it automatically selects the selected time-range as
the start/end times for the exported file.

Setting the format for the export:
In the Export window are 3 tabs across the top:

• File format
• Time Span
• Channels

File Format tab

The File format tab allows control of settings such as bit depth, sample rate, compression type, location to
be saved, and file name structure.

Additionally,options for generating a “Loudness Report”, as well as automated uploading to SoundCloud is
available (must first have a SoundCloud account via www.soundcloud.com).

When choosing “Export to Audio File(s)”, Mixbus will automatically choose the master bus
output, and the session start/end markers for an export. But you can override the settings to
choose a different time span, in the Export dialog window. If you choose multiple timespans,
then you will receive one audio file per time span. This allows you to export ranges that are
non-contiguous, overlapping, or even nested.

*
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Multiple format exporting:

Many files formats may be generated and exported at one time by clicking “+ Add another format”.

• Export Session to Audio File (the most common option): This exports the entire range from the Start
marker to the End marker.

• Export Selected Range to Audio File: This exports the current Range selection to an audio file (Note:
this can also be triggered by right-clicking on the selected range and choosing “export range”).

• Export Selected Regions to Audio File: This exports a length of time starting at the first selected
region, and continuing to the end of the last selected region.

• Export Range Markers to Multiple Audio Files: This very powerful feature allows you to export several
ranges (songs) at one time. The resulting files will use the region names as the file names.

Before the export is initiated, you must choose the location and format of the exported file.

Export to File: Enter the path and file name that you wish to create. This defaults to the sessions “export”
folder. Click “Browse” to see a file browser and navigate to a different folder.

• Export Source: Under the “Channels” tab choose “Master Output” to export the master bus output of
Mixbus. additionally you can export individual tracks separately, or control the Left/Right assignment
of tracks to the file.

• Channels: Chooses whether the resulting file will be Stereo or Mono.

Prior to version v5.2, exporting to MP3 required a post-export command. Now, you may
select mp3 directly in the Format dialog.*
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Once a format(s) is chosen it may be edited.
The formats are editable using this dialog box:

Edit Export Format Profile:

• File Format: (the list depends on the system’s available options). For CD quality,
choose WAV.

• Sample Format: The “32-bit” setting means 32-bit integer format. This is ultra-high resolution but does
not accommodate signals over 0dBFS. The “float” setting is 32-bit floating point which accommodates
signals over 0 dBFS which is preferred in most cases. For CD quality audio choose 16-bit.

• Sample Rate: For CD-quality audio choose 44.1 kHz.
• Conversion Quality: This is only enabled if the export sample rate is not the same as the session. The

setting “best” is recommended.
• Dither Type: None, Rectangular, Shaped Noise, or Triangular. The “None” or “Shaped” settings are

recommended.
• CD Marker File Type: CUE & TOC. These file types may be utilized by CD-burning software to define

track indexes, track names, and other metadata.
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If a project is intended to be published as a CD, you will want to create CD markers so Mixbus will generate
a TOC (table of contents) text file for the CD.

Label: this is the name that will appear in the list of formats.

Post-export command: this feature can be used to launch a scripted operation on the exported file. More
details here: (blank)

Time Spans tab

This tab allows you to choose one or more time-spans. Each selected time-span will be exported, using the
settings in the “Format” and “Channels” tabs. For example if you have 2 different formats chosen, and 2
different time spans, then 4 files will be created during the export.

Time-spans include:

• Session Start/End ( this is selected by default if you trigger a Session->Export to Audio File )
• Range Selection ( this is selected by default if you trigger the export by right-clicking on a Range ). If

no range is selected, then this does not appear
• Named ranges: If you have created named ranges ( for example, your session has multiple songs on

the timeline, and each is assigned a named range) then they will appear here.

Realtime Export

Use this option if your session makes use of external hardware audio processing.

Normally, Mixbus maximizes your CPU to perform the fastest-possible export. However,
some users have external devices, such as rackmount analog gear or external MIDI
synthesizers, which cannot be used at faster-than-realtime speed. In the past, we required
these users to manually create a bounce track and mixdown to it, rather than using the
normal Export features. Realtime Export provides all the same features as a regular export,
but it limits the engine to run in “real time” so external gear can be utilized during the export.

*
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Channels Tab

The Channels tab allows the user to choose which tracks or buses will be exported. The operation is slightly
different, depending on the way the export was initiated.

When “Session->Export to Audio Files” is selected, Mixbus will select the Master bus for export. But the
user may change this selection to choose any tracks and/or buses. Mixbus will “sum” the track outputs into a
single file.
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When “Session->Stem Export” is selected, Mixbus will not select any tracks or buses by default. The user
must select which tracks or buses to export. Each selected track will result in one exported file. The track’s
output is used to define the number of channels in the exported file. If a track is mono throughout, then it will
result in a mono audio file. If the track has 2 outputs (stereo) then the resulting file will be stereo.

The selection of the “Channels” tab is combined with the “Format” and “Time Range” tabs. If you are doing a
“stem export”, with 8 tracks selected, and 2 formats, in 2 different time spans, then this will result in 8×2×2 =
32 different files on export!

Export Analysis:

If you enable the “Export Analysis” checkbox, then Mixbus will display a summary of the exported file:

When stem exporting, the user may choose whether to apply the track’s processing ( fader,
mute, eq, compressor, and plugins ) or to export the raw audio without processing.*
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Export Report and Analysis

The Export Analysis dialog may be displayed after an export The export analysis window provides these
features:

• LUFS loudness measurement
• LU (Loudness Unit) histogram
• LU Range
• Waveform display, with peak indicators
• Peak Sample value + True Peak value
• Spectrogram view

These tools provide you an extra level of confidence that your track sounds great and meets common
deliverable requirements for distribution and broadcast.

The following video describes the export report and analysis tool in more detail.
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This updated video demonstrates additional uses of exporting and export analysis.

https://www.youtube.com/embed/UL1s5oubozs?rel=0
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The following video describes how to “bounce” the master bus down to a new stereo track:

https://www.youtube.com/embed/WvYp31y_fbU?rel=0
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The following video describes how to export multiple ranges into separate audio files:

The following video shows the “Export” features of Mixbus v2; this additional information is still sometimes
useful for v3 users:

https://www.youtube.com/embed/1tCTd6JmqXY?rel=0

https://www.youtube.com/embed/rWURWqJVWcg?rel=0
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https://www.youtube.com/embed/wddiGR-Y1bk?rel=0
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18.1. Post-Export Command Reference
The “Post Export Command” can be used to operate on files after the export process has completed.

command arguments
Arguments may be passed to the command interpreter using these aliases:

%f Full path and filename of the exported audio file
%d Directory containing the exported audio file (including trailing directory separator)
%b Basename of the exported audio file (without extension)
%s Path to the current session file
%n Name of the current session file
%% A literal percent sign

Any part of the command-line enclosed in double-quotes (") will be used as-is.

For example, exporting an mp3 file can be done by inserting lame -b320 %f which will convert the exported
audio file (‘%f’) to a 320 kbs mp3 using the lame encoder (provided lame is installed first on the system).

Example: File copy to a backup drive on windows:
cp %f D:/backup

Example: converting to mp3 using a third-party encoder
(such as LAME)

To export MP3’s you will need to edit one of your export profiles (or make a new one). For details on how to
do that, visit the Exporting manual page. Additionally you will need access to the “LAME” encoder (despite
the name, the “lame” encoder is widely regarded as one of the best-sounding mp3 encoders), as a program
that can be launched from a command-line.

The LAME utility can be downloaded from multiple sources.

• For Windows: the one we use on our testing machine is RareWares LAME Bundle.
• For mac, we use Thalictrum’s LAME (this will make it available from the terminal)
• For Linux machines (debian based at least) you can probably install lame directly from your package

manager. For example: “sudo apt-get install lame”

NOTE: Since version 5.2, you can select mp3 as a format in the Export dialog.*
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Finally, set up your command post export to run the lame encoder:

1. Edit your existing export format
2. In the section “command post export” (located at the bottom of the format page) you can choose to run a
system command after your export has finished, and we link to some variables that you can use like %f
being the absolute file-path of your newly exported file.
3. Set your post export command to run the lame encoder on your newly acquired file. See the picture for an
example of our setup.

Use these at your own risk.*
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If the executable file isn’t available in your command-line PATH, then you will need to tell Mixbus the
absolute path to the executable. Instead of just putting “lame” you would need to do: “path\to\lame.exe %f”

Hit export and now you will have an MP3 file exported automatically!
(note that some LAME implementations will need additional commands to export at higher bit rates, and
some might require a slightly different syntax to the one provided)
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19. Tempo, Metronome, & the Grid

Defining a Song’s Tempo and Meter
Mixbus allows simple creation and editing of a musical time/tempo map for each session. The meter and
tempo map is controlled with the Meter and Tempo rulers. To show these rulers, right-click in the ruler area
underneath the transport buttons and check the boxes for the Meter and Tempo rulers. Alternatively, you
can use the View menu to hide/show the rulers.

Here are some reasons that you might want to set the Meter/Tempo for your song:

1. To record with a “click” or metronome to help maintain consistent time among different performers and
parts.

2. To use the Grid to facilitate editing (if the audio follows the tempo map of the song).
3. To add MIDI segments or loops, and have them follow the tempo changes.

By default, Mixbus starts with a single Tempo and Meter marker, set to 120 bpm and 4/4, respectively. If the
session has a fixed tempo (or doesn’t use tempo at all ), then it is not necessary to create additional
markers; and clicking on the Tempo button will adjust the session’s initial tempo marker.

In other cases, you may want the tempo to change at different times during the session. In this case you will
right-click on the existing markers and set the tempo to the desired tempo and time signature. Right-clicking
in the Meter/Tempo rulers allow you to create new Meter or Tempo markers.

Tempo Controls
You can click on the “tempo” button underneath the clock, and this will launch the Tempo dialog:

You may select the initial Meter Marker, and move it to match the start of your song. This
allows you to align the first measure (bar) line with your song’s start. Use the tempo-
mapping tools in Tempo Maps to match the editors bar|beat clock with your natural
performance.

*
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The tempo dialog provides these options:

• Tap Tempo: click this button repeatedly to set a tempo
• Beats per Minute: type a new tempo here, or use the +/- buttons to increment the tempo
• Tempo Starts at: this indicates the measure/beat where the tempo change occurs; edit these fields if

needed.
• Tempo Type: tempo markers can be Ramped or Constant. Learn more about tempo ramps here:

Tempo Maps
• Lock Style: learn more about music-locked tempo markers here: Audio Time vs Music Time (NOTE:

the initial tempo marker is always locked to music time, so this option does not appear)

Time Signature (Meter) Controls
You can click on the “TS” (Time Signature) button underneath the clock, and this will launch the Meter
dialog:

The tempo dialog provides these options:

• Beats Per Bar: the numerator of the time signature
• Note Value: the denominator of the time signature
• Meter Starts at Bar: this indicates the measure where the meter change occurs; edit these fields if

needed.

When you click the “tempo” button under the clock, you are always adjusting the most-
recently passed tempo marker (when the dialog was launched). If the song only has one
tempo marker, then you’re adjusting the global tempo.
*

Tip: Here’s an easy way to set the tempo for a song: record a portion of the song, and then
select one bar with the Range tool. Now click “Edit->Tempo->Set Tempo from Edit Range”
to set the tempo.
*
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• Lock Style: learn more about music-locked meter markers here: Audio Time vs Music Time (NOTE:
the initial tempo marker is always locked to music time, so this option does not appear)

Using the Metronome (click)
To play a click sound during playback and recording, enable the “Metronome” button near the top-right of
the edit window:

The rate of the click is defined by the session’s Tempo and Meter rulers.

You can visit Preferences->Metronome to edit the click’s sound; or just right-click on the metronome button
to immediately view the properties.

Using the Grid
Editing with the “Grid” allows you to make edits perfectly aligned with other events. If the grid is set to
musical time (and the audio was recorded to a click) then editing can be done very quickly without zooming
in, because you know all edits will happen on a musically-sensible time.

To learn more about Snap + Grid settings, visit Snap and Grid

Note: Meter changes can only occur at the beginning of a new measure..*
Note: the first “Meter” marker may be dragged away from time 0:00. This allows you to start
the musical timeline (bar 1, beat 1) anywhere in the session. You can drag it to the start of
your song so the bar|beat readout will match your musical score.
*

You can mouse-wheel ( or 2-finger scroll, on a touchpad ) to adjust the metronome’s volume
directly from the transport window.*
Tip: It is common practice to leave some time at the beginning of a song, rather than
starting from the zero indication. Some common choices are 8 measures, 1 minute, 10
minutes, or 1 hour. This allows space at the beginning of the song to add an intro, place a
sync click or test tones, or just make editing easier by allowing some unallocated space at
the beginning of the track.

*
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Adapting the Grid, also known as “Tempo Mapping”
Even the best live performances don’t have perfect tempo. Real music breathes with subtle (or sometimes
dramatic!) tempo changes.

You can adjust the Grid to your performance using the ‘Tempo Mapping’ feature, or the Grid Tool

Advanced users can take advantage of BBT Markers to set the song-position and tempo, anywhere in the
timeline.

Once you’ve ‘mapped’ the beat positions and tempos in a performance, you can use the musical grid for
snapped-cursor editing, clip launching, midi accompaniment, or tempo-aware effects & instrument plugins.
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19.1. Tempo Maps

What is a Tempo Map?
By default, every Mixbus session starts with an initial Meter marker of 4/4, and an initial Tempo marker of
120 bpm.

However, the user may add additional Tempo and Meter “markers” which change the tempo on the timeline.
See: Tempo, Metronome & the Grid

Changing the tempo of a performance, using tempo markers
Tempo markers can be manually modified on the Tempo ruler. Double-click or right-click on a tempo marker
to access various features of the tempo marker.

In this mode, Tempo changes are represented as individual markers which may be adjusted and deleted.
Changes to the tempo markers will ‘ripple’ through the session and may have dramatic effects of the timing
of future events.

Tempo Mapping a live audio performance with the tempo
ruler
Even the best live performances don’t have perfect tempo. Real music breathes with subtle (or sometimes
dramatic!) tempo changes.

Since audio regions do not move when the tempo moves, you can adjust the session tempo markers
directly. This operation is described below:

MIDI regions, sequencer-type plugins, and Clip-playback is bbt-aware: this means they will
stretch to follow the tempo.

!

Unlike some other DAWs, Mixbus does not currently stretch your audio when the tempo
changes. We may provide this ability in the future.

!
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Once you’ve ‘mapped’ the beat positions and tempos in a performance, you can use the musical grid for
snapped-cursor editing, clip launching, midi accompaniment, or tempo-aware effects & instrument plugins.

Constant vs Ramped tempo markers

A “constant” tempo marker will set a steady tempo which continues until the next tempo marker is reached.

A “ramped” marker will cause the tempo to gradually change to meet the tempo value of the marker that

https://www.youtube.com/embed/rrr9lr_Pbkg?rel=0

In the future, audio regions might move and stretch when the tempo changes; in anticipation
of that functionality, there is a dedicated ‘Grid Tool’ which adjusts the time & tempo with NO
effect on any data … whether audio, midi, or automation … on the timeline.

!
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succeeds it. This allows you to track the natural speedup/slowdown of a live performance, or create a
natural ritardando at the end of the song. The tempo “ramp” is shown with a sloped line, indicating the
difference between the two tempos:

Editing tempo markers & the tempo lane

There are several ways to manipulate the tempo markers on the tempo ruler:

• Click & drag the tempo marker to change its location on the timeline
• Right-click on the tempo marker to change its properties
• Shift+Right-click to remove a tempo marker
• Shift+drag up/down on a tempo marker to change its tempo value
• Hold “Ctrl” (“Cmd” on Mac) while dragging a tempo marker to make a copy with the same tempo.

Additionally, you can edit the Tempo Line itself

• Shift+Click on the tempo-line between 2 tempo markers. Drag it left/right to adjust the tempo of the
previous marker.

• Shift+Ctrl-click on the tempo line to create a “pinch”. A “pinch” adjusts the tempo line between 2
markers, and adjusts them in such a way that it does not move the succeeding markers.

Importing a tempo map from MIDI
Mixbus can import a “tempo map” from an existing MIDI file. To do that, use the Import dialog to choose the
MIDI file. And enable the checkbox for “import tempo map”.

If you are unable to Shift+Drag on the Tempo Line, please visit Preferences->Editor-
>Modifiers and click “Reset to Recommended Defaults” (or make sure that “When Beginning
a Drag -> Constrained Drag Using:” is set to “Shift”).

!

MIDI files do not allow gradual “tempo ramps”. Each tempo marker in the file will indicate a
discrete change to a new tempo. For that reason, MIDI tempo changes will not be as
‘smooth’ as Mixbus’s tempo ramps.
*
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19.2. Audio Time vs Beat Time

What is the difference between Audio time and Beat time?
Audio time ( or “real” time ) is the length and tempo of a performance as executed and recorded. Whereas
“beat” time is a series of arranging data (notes and rests) that can be executed very quickly, or very slowly,
and still be considered the same.

In “beat” time, a quarter-note is a quarter note, regardless of tempo. MIDI consists only of arrangement
data, and so it is possible to arrange a MIDI sequence and later increase or decrease the tempo. Just like
musicians playing from a score, the arrangement’s tempo will increase, but the musical expression and
timbre will remain largely unchanged.

When recording audio, the performers are recorded in real-time subject to the players’ own tempo and
interpretation of the music. And once recorded, you cannot easily change the tempo of the recording. Once
audio is recorded, it requires quite extensive processing and manipulation to change the tempo … and even
more so if you don’t want the pitch to change as well ( i.e. the “chipmunk” effect )

The problem is that Mixbus (and other DAWs) are expected to show both MIDI and Audio data on the same
timeline. And there’s some ambiguity: one can imagine audio data (such as a single drum hit) that has no
inherent tempo, and can be considered arrangement data, and subject to tempo changes in the musical
timeline; or one can imagine a MIDI event that is related to the audio timeline and should not move if (for
example) the tempo is changed.

Why is this so hard?
Attempting to shorten or lengthen an audio performance, after it is recorded, requires the sound to be
digitally manipulated which will incur some loss of quality. Because Mixbus is intended for high-quality
editing, mixing, and mastering tasks, we have chosen to give priority to the “audio” timeline. But there are
equally valid reasons why a user might be more interested in the “music” time, and so both music and
audio-timelines must coexist.

Consider these examples:

• A live performance is recorded, and the musicians have varied widely in tempo and meter. The user
would like to develop a “grid” which follows the varying tempo, and allows editing to the “grid”, just as
if the performance were recorded strictly to a metronome. Or perhaps the user would like to add MIDI
arrangement using a musical score editor, and these notes must somehow be synced to the
performance’s tempo.

• A MIDI performance is generated with a fixed tempo. Later, a vocal and instrumental tracks are added
to the MIDI arrangement, and these tracks are edited with crossfades to assemble the best-sounding
mix. Now the arranger would like to gradually decrease the tempo at the end of the song ( i.e.
ritardando ). The MIDI events, being tied to the Music timeline, will stretch farther apart, but will stay
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in tune. But what will become of the audio regions?
• A session which mixes spoken-word sections with musical sections. During a musical portion

(implemented with MIDI), the tempo is increased, so the musical portion finishes faster than it did,
when the audio was recorded. Should the audio voiceover move left to accommodate the shorter
musical segment?

Mixbus has some mechanisms to accommodate these situations. But it can get quite complicated.

How do you use Audio Time and Beat Time?
Every item on the timeline ( regions, markers, and automation control points ) must be either connected to
the “audio” timeline, or the music timeline. If an item is attached to the musical timeline, then any changes to
the BBT (bar-beat-tick) timeline will be moved along with the musical timeline. For example, if you increase
the tempo then the regions will move to occur earlier.

What are the default settings for each item on the timeline?
By default, audio regions use the audio timeline. Changes to the tempo will not move or stretch audio
regions.

By default, MIDI regions use the “beat” or “music” timeline. Changes to the tempo will move midi regions
and the notes inside …. UNLESS you are using the Grid Tool. When using the Grid Tool to adjust the grid,
nothing moves, including the midi notes inside a region.

Tempo markers are glued to the BBT timeline, by definition. Tempo markers will move to accommodate
prior tempo changes. UNLESS you are using the Grid Tool … when using the Grid Tool, then changes to a
tempo marker are not propagated to later tempo markers.

Plugin-Automation control points are attached to the audio timeline.

Markers (like Loop, Punch, Arrangement and Cue) can be either Audio or Music Time. This change is made
globally during the creation of the session:

Choosing the time domain for your session:
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If you choose “Beat” Time, then:

• the new session will show tempo rulers, arrangement rulers, and cue rulers
• any changes to the tempo map will move the rulers to match. This means: if your punch-range starts

on bar 8, then it will always start on bar 8, even if you change the tempo and move the position of bar
8.

If you choose “Audio” Time, then;

• the new session will show minutes:seconds rulers, CD markers. It will hide the tempo markers,
arrangement ruler, and cue ruler.

• rulers will not move when you change the tempo. If your punch-range starts at 5:00 minutes, then it
will start at 5:00 minutes regardless of any changes to the session’s tempo map

…however, you can later change your mind, and change the session’s default timebase, in Session-
>Properties->Misc

So what is the preferred workflow for managing a project that
mixes Audio events, and Beat (MIDI) events?
Generally speaking, Mixbus is optimized to work in one of these 2 ways:

1) Record a live performance on the audio timeline, (optionally) map the tempo, and then record MIDI
instruments. You can later tweak the tempo map, and the MIDI events can follow, if desired.
2) Arrange your song in MIDI, and adjust tempos/timeline as needed. Then record audio, and never again
move the tempo/BBT-map after you’ve started recording audio.

This is complicated stuff. Investigating other DAW manuals and videos will reveal that there is no easy,
high-quality, non-destructive way to solve these issues.
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19.3. BBT Markers (Bar markers)
BBT Markers, or “Bar Markers” provide the ability to elegantly define a grid for editing or sequencing, even
in challenging real-world situations like having multiple songs on a timeline.

Right-click in the Bars:Beats ruler to create a BBT marker.

• Drop a BBT marker ‘anywhere’ on the timeline to define a Bar-Beat position (like 1|1|0).
• You aren’t limited to setting the 1. If you don’t want to tempo-map a whole song, you can define a

specific time (like: “bar 49, the start of the breakdown”) where you want to define a grid, but you don’t
care about the prior times.

• You can even introduce multiple “1|1|0” times, if you have multiple songs on your timeline (!!!)
• BBT markers also include their own tempo and meter information, so you can define a new tempo

starting on the BBT marker.
• You can move BBT markers after creating them, if you need to land it ‘exactly’ on the beat.
• Tempo-changes to the ‘left’ of a BBT marker will not propagate through the BBT marker. This allows

you to make changes to the tempo of a prior song or section, without ruining the tempo of the new
section.

• BBT markers introduce a subtle new paradigm: you can now record a band (either live, or in-studio)
and then quickly and elegantly assign a grid to any part of the performance, for ease in editing,
arranging, clip-launching, or midi accompaniment. Extended intros, false starts, and short segments
(“let’s just play the chorus again”) can be accommodated.

Why is this important?
In traditional, linear recording (to analog or digital tape) it was always the case that you could record
multiple takes (or songs) in a single session. And your ‘mixer’ settings would largely apply to all the takes
that were recorded in the session.

Despite all the advances in digital editing and arranging, other DAWs do not handle this situation well. Most
DAWs allow you to create scenes or snapshots or alternate views, or even allow you to open multiple
sessions at once. But those are all poor workarounds for what we really want: multiple songs on a timeline,
each with their own timecode position, tempo, and editing grid. Or not! The beauty of BBT markers is that
you can assign a tempo/grid where you need it, and ignore it when you don’t!
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20. Menu Reference
This menu reference documents selections available to the user. In many cases menu selections are self
explanatory and require no elaboration. Other items may require explanation, in which case a brief passage
will be provided. In other cases links to specific pages of this manual will be provided.

Most menu actions have an associated keyboard shortcut. You can change the default shortcuts by visiting
Window->Keyboard Shortcuts.

Why are some menu items disabled or greyed-out?

Some menu items, particularly the items in the “Edit”, “Track” and “Region” menus, will be disabled if there
is nothing selected which might apply the operation. For example, the item “Track->Remove” will only be
available if one or more tracks are selected.
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20.1. Session Menu
The Session menu provides the main functions of session management:

• New: More here
• Open: More here
• Recent: More here
• Close: More here

• Save: More here
• Save As: More here
• Rename: More here

• Snapshot (& keep working on current session): More here
• Snapshot (& switch to new version): More here

• Save Template: More here

• Archive: NEW in v4. This allows the user to store the current snapshot in a compressed format, using
only the needed audio and (optionally) converting the audio files to a lossless compressed format.
The resulting archive (zip file) can be reopened from the Mixbus “open” dialog.

• Metadata: More here

• Add Track or Bus:More here

• Import: More here

• Open Video: Will import video with audio (the audio embedded within a video can also be extracted).
See Video

• Remove Video: Removes video from the timeline but not from the session folder.

• Export: More here
• Clean-up: More here

• Properties: More here

• Quit: Saves the currently opened session and closes Mixbus.
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20.1.1. Metadata

Session files include “metadata” which can include information about the project including the composer(s),
engineers, etc. Metadata is stored inside the session file in a simple XML format.

The Metadata dialog is launched from the Session menu:

https://www.youtube.com/embed/anlRLGZxjIs?rel=0
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The User tab includes information about the primary user of Mixbus. This includes the Name, Email, Web,
Organization and Country information. This is a global setting and will be applied to future sessions. This
information is purely for convenience and for documentation purposes.

There are 3 specific ways that this information is used within Mixbus:

Email: automatically entered into the Freesound entry box in the Export dialog.
Organization: This text is stored in broadcast wave file metadata.
Country: This text is stored in broadcast wave file metadata.

The User information is stored outside the session file and is persistent across sessions.

The remaining tabs (Track, Album, People, and School) record data that is stored in the session file. The
data is stored in an industry-standard XML format, and can be easily read and manipulated by 3rd party
applications or scripts. Contact Harrison if you are interested in further development of Mixbus metadata.
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20.1.2. Session Properties
Session properties are settings for the currently loaded session. These are session-specific controls such as
the timecode format, audio file format, and monitoring setup for this session.

Menu Options

Timecode
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Sync
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Fades
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Media

The audio data format that Mixbus uses internally. New audio recordings will be stored in this format, and
files will be converted to this format when imported.

• Float (floating point 32 bit) (default value) Allows extra headroom above 0 dBFS for JACK-enabled
connections and/or bounces within Mixbus.

• 24 bit: If you plan to record live sources from a A/D converter and do not use internal bouncing-to-
disk, then 24 bit will save some disk space.

• 16 bit: If working with audio sourced from a CD, this uses half the storage space of “float” option.

Audio File Format: File Type

The file type that Mixbus uses internally. New audio recordings will be stored in this format, and files will be
converted to this format when imported.

• Broadcast Wave: Industry standard .wav files with an additional time-stamp that may be used in some
software. File size is limited to 4GB.

• Wave: Industry standard PCM file. File size is limited to 4GB.
• Wav64: Industry standard PCM file. Uses 64 bit length value in the header allowing nearly limitless

recording length at any sample rate.
• CAF: Same as Wav64, but this format is only common on OS X.
• FLAC: Open source lossless codec. FLAC’s algorithm can typically be reduced to between 50 and 70
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percent of its original size while still retaining full lossless quality.

Locations
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Filenames
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Monitoring
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Meterbridge
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Misc Tab
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20.1.3. Clean-up
Bring all media into session folder:

This function will locate all audio and MIDI data that may be scattered across multiple folders, or even
multiple hard drives, and copies or moves all audio and/or MIDI associated with that session into the
session folder. Once this is done the user can be assured that the session folder will contain all the
necessary audio/MIDI in one convenient location.

A real world example:

While working with a session you may pull new material from many different locations on your hard drive,
CD drive, or network. After saving the session, Mixbus will know where to find all of these bits of audio the
next time the session is opened on that particular computer. But if your session file is on a portable hard
drive and most (but not all) of your audio files are also on that portable hard drive and you take that hard
drive to a different computer, or studio, expecting to open the session, you may be confronted with a
dialogue box indicating the session was unable to located certain audio files. Running the “Bring all media
into session folder” alleviates this problem.

The same is true for archiving of a session. If the user does not invoke the “Bring all media into session
folder” function before archiving then the archive may be incomplete.

Clean-up unused sources:

Clean-up will move all unused files to a folder labeled “dead” within the session folder. Clean-up is a
destructive operation and all undo/redo history will be lost.

Flush Waste Basket:

Deletes audio files located in the “dead” folder.

Located under Session>Bring all media into session folder. This important function serves
2 purposes:
• Allows portability of sessions
• Allows for the archiving of sessions

!

It maybe useful to run the clean up function located under Session>Clean up in conjunction
with “Bring all media into session folder”. There maybe no need to transport or archive
unused material.
*
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A note about Session Cleanup.

There are a few reasons why cleanup might not save much space:

1. Because all of the session snapshots are inside the session folder, Mixbus knows when a region is
used by a different snapshot. So it may not “clean up” as much as you expect.

2. If you recorded a very long file, but only use a very small snippet, this reference to the file will keep
the file from being cleaned up. If you “bounce” the regions (making a new, short file of exactly the
length of the region) then you might see a bigger space savings. But note that this means you can no
longer extend the fade handles for that region; there’s no longer any information left outside the
region.
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20.2. Transport Menu

• Start/Stop
• Play >

◦ Play Selection
◦ Play w/Preroll
◦ Start/Continue/Stop
◦ Play from Edit Point and Return
◦ Play Loop Range

• Start Recording
• Stop and Forget Capture: this stops the current recording, and permanently deletes any audio files

that were recorded in the current pass. This cannot be undone.
• Enable Record
• Record w/Preroll: see here for more details
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• Set Loop from Selection
• Set Punch from Selection
• Set Session Start/End from Selection

• Forward
• Rewind
• Transition To Roll
• Transition To Reverse

• Playhead >
◦ Playhead to Mouse
◦ Playhead to Active Mark
◦ Center Playhead
◦ Nudge Playhead Forward
◦ Nudge Playhead Backward
◦ Move to Next Transient
◦ Move to Previous Transient
◦ Playhead to Next Grid
◦ Playhead to Previous Grid
◦ Playhead to Next Region Boundary
◦ Playhead to Previous Region Boundary
◦ Playhead to Next Region Boundary (No Track Selection)
◦ Playhead to Previous Region Boundary (No Track Selection)
◦ Playhead to Next Region Sync
◦ Playhead to Previous Region Sync
◦ Jump to Next Mark
◦ Jump to Previous Mark
◦ Goto Zero
◦ Goto Start
◦ Goto End
◦ Goto Wall Clock

• Active Mark >
◦ To Next Region Boundary
◦ To Previous Boundary
◦ To Next Region Sync
◦ To Previous Region Sync

• Markers >
◦ Add Mark from Playhead
◦ Remove Mark at Playhead
◦ Toggle Mark at Playhead
◦ Locate to Mark 1
◦ Locate to Mark 2
◦ Locate to Mark 3
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◦ Locate to Mark 4
◦ Locate to Mark 5
◦ Locate to Mark 6
◦ Locate to Mark 7
◦ Locate to Mark 8
◦ Locate to Mark 9
◦ Set Session Start from Playhead
◦ Set Session End from Playhead

• Time Master: (for JACK sync only) : when this is enabled, Mixbus will serve as master to report the
Bar|Beat|Tick information to the JACK clock

• Punch In/Out
• Punch In
• Punch Out
• Auto Input : Learn more in the Monitoring section.
• Follow Range : Learn more in the transport section.
• Auto Play : The transport will automatically play whenever you locate the playhead to a new position.
• Auto Return: Returns playhead to last starting position, when the transport is stopped.
• Click: Toggles the Click (Metronome) sound on & off.
• Follow Playhead : The edit window will scroll to follow the playhead when the playhead reaches the

edge of the editing canvas.
• Stationary Playhead : If enabled, AND Follow Playhead is enabled, then the timeline will scroll behind

the playhead. This requires significant CPU and disk resources, so it is not recommended for large
sessions.

• Panic: Sends MIDI note off to all channels. Details here
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20.3. Edit Menu

• Undo
• Redo
• Undo Selection Change
• Redo Selection Change
• Cut
• Copy
• Paste

• Select >
◦ Select All Objects
◦ Select All Visible Lanes
◦ Select All Tracks
◦ Deselect All
◦ Invert Selection
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◦ Set Range to Loop Range
◦ Set Range to Punch Range
◦ Set Range to Selected Regions
◦ Select All After Edit Point
◦ Select All Before Edit Point
◦ Select All Overlapping Edit Range
◦ Select All Inside Edit Range
◦ Select All in Punch Range
◦ Select All in Loop Range
◦ Move Range Start to Previous Region Boundary
◦ Move Range Start to Next Region Boundary
◦ Move Range End to Previous Region Boundary
◦ Move Range End to Next Region Boundary
◦ Start Range
◦ Finish Range
◦ Select Next Track or Bus
◦ Select Previous Track or Bus

• Delete : this deletes either the selected Regions or the selected Range in the editor canvas.

• Crop: This splits regions under the selected range, and then removes all regions outside of the
selected range.

• Split/Separate : If a “range” selection exists, the regions under the range will be split at the start and
end of the range. If no selected range exists, then the regions will be split at the edit point. Learn
more about the Edit Point here.

• Separate >
◦ Separate Under: if you select a region, this will separate the regions in underlying layers, at the

same start/end as this region
◦ Separate Using Loop Range : this will separate the selected region on the Loop Range

boundaries
◦ Separate Using Punch Range : this will separate the selected Region on the Punch Range

boundaries

• Align >
◦ Align Start
◦ Align Start Relative
◦ Align End
◦ Align End Relative
◦ Align Sync
◦ Align Sync Relative

• Fade >
◦ Fade Range Selection
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◦ Set Fade In Length
◦ Fade In
◦ Set Fade Out Length
◦ Fade Out

• Tag Last Capture : This will allow you to enter a “tag” (text string) for all of the Sources created in the
most recent recording take. For example you might make a note of a “Good Take” or “Bad Take” here.
You can later sort Sources by their Take name in the Editor -> Source List

• Remove Last Capture : this deletes all the Regions and Source Files created in the most recent
recording take. NOTE: this operation is destructive: it actually deletes the file and saves the disk
space. So only use this option when you are sure you don’t want that take!

• Edit Point >
◦ Change Edit Point
◦ Change Edit Point Including Marker

• Snap Mode >
◦ No Grid
◦ Grid
◦ Magnetic
◦ Next Snap Mode
◦ Next Snap Choice
◦ Previous Snap Choice
◦ Next Musical Snap Choice
◦ Previous Musical Snap Choice

• Snap to >
◦ Snap to CD Frame
◦ Snap to Timecode Frame
◦ Snap to Timecode Seconds
◦ Snap to Timecode Minutes
◦ Snap to Seconds
◦ Snap to Minutes
◦ Snap to One Twenty Eighths
◦ Snap to Sixty Fourths
◦ Snap to Thirty Seconds
◦ Snap to Twenty Eighths
◦ Snap to Twenty Fourths
◦ Snap to Twentieths
◦ Snap to Sixteenths
◦ Snap to Fourteenths
◦ Snap to Twelfths
◦ Snap to Tenths
◦ Snap to Eighths

Harrison Consoles Mixbus - 9_en

Page 545 of 848



◦ Snap to Sevenths
◦ Snap to Sixths
◦ Snap to Fifths
◦ Snap to Quarters
◦ Snap to Thirds
◦ Snap to Halves
◦ Snap to Beat
◦ Snap to Bar
◦ Snap to Mark
◦ Snap to Region Start
◦ Snap to Region End
◦ Snap to Region Sync
◦ Snap to Region Boundary

• Tempo
◦ Set Tempo from Region = Bar
◦ Set Tempo from Edit Range = Bar

• Smart Object Mode: More here

• Show Automation Lane on Touch : When this is enabled, then clicking on any knob control (such as
an EQ knob, compressor knob, or plugin’s knob) will immediately show the associated Automation
lane in the editor for that control. This is especially convenient when dealing with a plugin with many
parameters, and you don’t want to dig through the menus to find the associated automation lane.

• Lua Scripts
◦ Script Manager: see Scripting
◦ (presets configurable from Script Manager)

• Preferences: More here
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20.3.1. Preferences Window
The Preferences window can be found under the menu item Mixbus->Preferences in OS X, and under the
menu item Edit->Preferences in Windows and Linux.

The preferences window is organized by category in the left hand column of the window. Some categories
have subcategories that you can navigate by clicking on them.

p(banner tip). The Preferences window defines the global options that will be applied to all
of the sessions on your machine. Global preferences define the way you like to work and
the way your system is set up (such as your MIDI control surfaces or timecode sources). If
you want to change settings for a particular session, go to Session Properties.

*

Harrison Consoles Mixbus - 9_en

Page 547 of 848



20.3.1.1. General

Audio/MIDI Setup
This button will open the Audio/MIDI Setup Window. Details for this window can be found here: Audio/MIDI
Setup

Checking the box “Try to auto-launch audio/midi engine” will start the audio engine without opening the
“Audio/MIDI Setup Window” when you open a session . The “Audio/MIDI Setup Window” will only open if
there is a problem with the I/O interface or any of the other parameters in the setup.
If the box is unchecked, the “Audio/MIDI Setup Window” will open every time you open a session.

Editor Undo
These check boxes allow you to control the number of undo levels and history depth when editing.

Limit Undo History

This option should be enabled to limit the memory and disk space that Mixbus will use to store Undo
information. Select a number of operations that you’d like Mixbus to remember within a given session.

Save Undo History

This option specifies how many commands are available to undo after a session is saved and re-opened.
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Previous commands from prior work on the session will still be available to undo even when a session is
first re-opened.

Verify removal of last capture

When this option is enabled, Mixbus will display a confirmation message when the “stop and remove last
capture” action is used.

Session Management

Make periodic backups of the session files

If this is enabled, Mixbus occasionally creates a date-stamped snapshot in the session’s “backup” folder.
Mixbus stores a backup snapshot every 5 minutes, but this might be delayed if the transport is playing or
recording. To recover from a backup snapshot, visit our support FAQ: Session Auto Backup

Default Folder for new Sessions

This option specifies the default location that appears in the New Session dialog pulldown.

Maximum Number of Recent Sessions

This option defines how many sessions will be displayed in the New Session dialog list.

Import

Drag and Drop Import

If this box is checked, files that are drag & dropped into the session will be copied into the session, rather
than “referenced” from their existing location, wherever that may be (such as on a removable hard drive). In
cases where you work extensively from external sound libraries or loops, and you don’t want to store
redundant copies of those audio files in the session, you might choose to disable this option. Recorded files
are still stored inside the session folder.

Session snapshots take very little space, and we encourage users to keep this checkbox
enabled. In rare cases, Harrison support may ask you to disable this option to see if it has
any effect on performance or behavior. Regardless of the “periodic backup” setting, Mixbus
stores a “pending” file whenever you start a new recording. This makes it very likely that,
even in the case of a crash or power outage, a recording in process can be recovered.

*
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Export
When an export is performed and these checkboxes are enabled, Mixbus will also save an image file of the
resulting loudness analysis and a screenshot image of the mixer page. This can be a useful record to keep
with your exported master file.
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20.3.1.2. Appearance

Appearance

Theme

Color faders with track/bus colors

The color assigned to your track will also color the faders in the Mixer Window
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Draw “flat” buttons

Removes gradients from the buttons (may result in easier viewing on some monitors).

Draw “boxy” buttons

Selects between rounded or square corners (may result in easier viewing on some monitors).

LED Meter Style

If this option is enabled, the Meterbridge meters will appear with segmented “LED style” meters instead of a
solid bar.

Graphical User Interface

Highlight Widgets on Mouseover

If enabled, widgets will be “highlighted” when the mouse passes over them.

Show tooltips If Mouse Hovers Over a Control

Update Clocks at TC Frame Rate

Normally clocks update approximately 10 times per second. This option will cause the clocks to get updated
at the selected video frame rate, for those users who need to watch the frame counter more accurately.

Blink Rec-Arm Buttons

This option blinks the track rec-arm buttons; this can be a more obvious indication when a track is armed.

Blink Alert Indicators

This option blinks the Alert indicators “Solo” “Audition” “Feedback” at the top of the screen when they
display.

Graphics Acceleration
(MAC only) these settings can be used to troubleshoot or possibly fix problems with slow graphics
redrawing. It is recommended that you use the default setting (Yes, with Retina scaling) unless told to
change this value by a Harrison support representative.
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20.3.1.2.1. Recorder
This selector controls how physical inputs are displayed in the Record window. “Automatic” will display the
physical inputs horizontally up to 16 inputs, and vertically for larger numbers of inputs. Alternately you can
select all horizontal or all vertical regardless of the number of inputs.
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20.3.1.2.2. Editor

General

Use name highlight bars in region displays

This option toggles the display of the highlight bars with names at the bottom of each region, as was default
in earlier versions of Mixbus.

Region color follows track color

When enabled, regions are drawn the same color as the track. If disabled, all regions will be the same color,
not affected by the track’s selected color.

Track name ellipsize mode

This selector applies to the track name displayed at the left of each track in the Editor window. When the
track name is too long to be completely displayed, you can select leftmost, center or rightmost part of the
name to display.
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Add visual gap below audio regions

This selector controls the vertical spacing of the tracks in the editor window. You can select a gap size or no
gap between tracks.
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Waveforms

Show waveforms while recording

This option toggles whether to display region waveforms during recording. It is a useful reference, but does
use more system resources. It’s ok to leave on in most modern computers.

Show saveform clipping

This option toggles the indication of waveform clipping in the region display. If disabled, regions will not
show red indicators when a region exceeds 0dBFS.

Waveform clip level

This option gives you a horizontal fader to adjust where the waveform clip level is calculated, from 0 to
-50dBFS.

Waveform scale

This setting does not change the gain of the signal, it is strictly a visual aid that makes the waveforms
appear “fatter” with two different waveform rendering scales. The two options are:

• Linear: Displays the audio waveform in a linear fashion. This is the most common display scale in
most DAWs.

• Logarithmic: Displays the audio waveform so that quiet sounds can be more easily seen on the
screen. The display is disproportionate, giving more visual resolution to low-level signals and less
visual resolution at higher-level signals.

Waveform shape

This setting does not change the gain of the signal, it is strictly a visual aid. The two options are:

• Traditional (Default): Waveforms are drawn around a “zero” axis in the middle of the region.
• Rectified: Waveforms are drawn with “zero” on the bottom of the region, and the wave values are

shown in an absolute-value (rectified) magnitude offset

Editor Meters

Show meters in track headers

This option toggles whether meters are shown in the track headers in the editor window. Disable this to hide
the small meters at the right edge of track headers in the editor. Enabling this option is useful to help
monitor & identify tracks as you listen, but uses more system resources.

Limit track header meters to stereo

If this option is enabled, then Mixbus will only show stereo meters in the editor’s track header, even if the
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plugin has many outputs.

MIDI Regions

Display first MIDI bank/program as 0

By default, Mixbus shows banks&programs starting with “1”. This option shows the more technically-correct
numbering starting with “0”.

Don’t display periodic (MTC, MMC) SysEx messages in MIDI Regions

Check this box to prevent SysEx message events from being visible on a MIDI track.

Show velocity horizontally inside notes

These boxes allow you to control how note velocity information is displayed in a MIDI track.

Use colors to show note velocity

Yellow indicates a lower velocity and Red indicates a higher velocity

Harrison Consoles Mixbus - 9_en

Page 557 of 848



20.3.1.2.3. Mixer

Limit inline mixer strip controls per plugin

This selector controls the total number of plugin controls that can be displayed in the plugin area of a mixer
strip.
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20.3.1.2.4. Toolbar

Toolbar

Main Transport Toolbar Items

These checkboxes select the controls provided in the Transport toolbar. For example, “Display Master Level
Meter” will display or hide the master level meter that appears in the top-right corner of the editor window.
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Display Record/Punch options

Display Latency Compensation Info

Display Secondary Clock

Display Selection Clock

Display Monitor Section Info

Display Navigation Timeline

Display Master Level Meter

Display Action-Buttons

These checkboxes control how many shortcut buttons are available in the toolbar. Shortcut buttons are
discussed in the section Primary Windows: Editor, Mixer and Recorder.

In this picture 4 shortcut buttons are displayed, however the checkboxes allow display of up to 12 buttons.
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20.3.1.2.5. Size and Scale

User Interface Size and Scale
Adjust this value to increase or decrease the text used in menus, buttons, and dialogs. 100% is the default
value. Settings below 80% may be difficult to read. Adjusting the scale requires a restart, so buttons can
resize themselves to fit the new text size.

Due to the way that MacOS handles fonts (due to retina, etc), this slider does not appear on
macOS. Instead, you should visit MacOS System Preferences->Displays, and increase the
scaling.

!
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Mixer Strip Scale

The selector allows resizing of the mixer strips to fit your screen.

How many mixer-strip elements (EQ, Gate, Comp, Sends and Input) may be shown simultaneously?
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This allows you to control how many mixer strip elements are displayed at once. This is tied in to the
resolution of your video card and monitor. Simultaneous display of all the mixer strip elements requires a
video monitor with 4K resolution. However many are selected, Mixbus will only display up to the limits of
your video system.

The checkbox will have Mixbus warn you on startup if the settings are in conflict with the capabilities of your
video system.

Watch this video for more on size and scaling options:

https://www.youtube.com/embed/O7mDXSB_aNs?rel=0
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20.3.1.2.6. Colors
This window provides a way to customize every color used by Mixbus. There are three tabs.

Items

This tab lists each Object, alphabetically, and displays the color associated with that object. Click on the
color to modify.

Palette

This tab shows the color palette used by Mixbus, when selecting colors. You can click on each color to
modify it, which will become part of the new available palette.

Transparency

This tab lists everything in Mixbus that can be rendered with Transparency. Each object has a slider to
adjust the amount of transparency.
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20.3.1.2.7. Quirks

Various Workarounds for Windowing Systems

Rules for closing, minimizing, maximizing, and stay-on-top can vary with each version of your OS and the
preferences that you’ve set in your OS. You can adjust the options below to change how Mixbus’s windows
and dialogs behave. These settings will only take effect after Mixbus is restarted.

Use visibility information provided by your Window Manager/Desktop

All floating windows are dialogs

Mark all floating windows to be type “Dialog” rather than using “Utility” for some. Requires restart of Mixbus.
This can help if you find that some popup dialogs are appearing behind the main window, or otherwise not
being managed correctly by your desktop.

Transient windows follow front window

Makes transient windows follow the front window when toggling between the editor and mixer. Requires
restart of Mixbus.
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20.3.1.2.8. Translation

Translation

Internationalization

Use Translations

This option allows Mixbus to accommodate multiple languages and conventions, such as a decimal point
being “.” in some languages and “,” in others.option allows Mixbus to accommodate multiple languages and
conventions, such as a decimal point being “.” in some languages and “,” in others.
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20.3.1.3. Editor

Editor

Region Information

Show xrun markers in regions

Selecting this box will display xrun warnings as markers in an affected region.

Show gain envelopes in audio regions

When creating gain envelopes in a region, this option allows you to specify whether “gain envelopes” in
audio regions are shown only with the Draw or Edit tools, or in all modes. More information on the affected
modes are found in the section Region Gain Automation.

Scroll and Zoom Behaviours

Zoom with vertical drag in rulers

When this option is enabled, you can click and drag vertically in the ruler of the Editor to zoom in & out.
Dragging up zooms out, dragging down zooms in.
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Double click zooms to selection

Enabling this option allows you to quickly zoom to whatever regions you have selected by simply double-
clicking on one of the selected regions.

Update editor window during drags of the summary

By default, when dragging the “summary” view, the editor will be updated live. If your system is unable to
redraw the editor window quickly enough, you can disable this option.

Auto-scroll editor window when dragging near its edges

When enabled: if you drag a region close to the edge of the editor, it will begin scrolling to accommodate the
move.

Auto-scroll speed when dragging playhead

This selector sets the scrolling speed when dragging the playhead:

Limit zoom & summary view beyond session extends to

This selector sets limits on zoom & summary views to a predetermined time past the end of the current
session length.
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Editor Behavior

Move relevant automation when regions are moved

(default: ON) When you drag a region, this will also move any automation points that are within the region’s
bounds. NOTE: this will overwrite any existing automation in the destination location.

Ignore Y-axis when adding new automation points

Automation edit cancels auto-hide

This checkbox refers to the “Show Automation Lanes on Touch” capability. There is a video “Show
Automation on Touch” in the section Fader, Pan and Plug-in Automation explaining this feature.

When this box is checked, auto-hide after making a change to the automation is disabled. If you edit an
automation parameter the automation lane will remain visible after the change rather than hiding itself.

Default fade shape

This option allows you to specify the default shape for crossfades, between Linear, Constant power,
Symmetric, Slow, or Fast.
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Regions in Edit Groups are edited together

This option allows you to specify the behavior of grouped regions in the editor window. The grouped regions
can be edited together either only if they have identical length, position and origin (indicating that they are
likely from the same source material and have been edited in sync), or whenever they overlap in time (if a
region has any overlap with the currently-selected region, then it will move with the region).
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Layering Model

This option allows you to specify the layering behavior of regions. The default is Manual Layering, where
the user is expected to manually control each region’s layer. Or, Later-is-higher defines region layering so
that later regions will be assigned a higher layer.

Split/Seperate

In Range Mode

Controls what happens to regions after split in Range Mode.
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In Object Mode

Controls what happens to regions after split in Object Mode.
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20.3.1.3.1. Snap

Snap:

General Snap Options:

Snap threshold (pixels)

Approximate grid/ruler granularity (pixels)

Show “snapped cursor”

Snap Rubberband selection to grid

In the editor, when doing a “rubber-band select” ( drawing a box to select multiple regions or control points ),
the box edges will snap to the grid.
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Grid Switches to alternate selection for Internal Edit tools

Rulers automatically change to follow the Grid mode selection

When “Snap” is enabled, snap to:

Markers

Region Sync Points

Region Starts

Region Ends

Grids
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20.3.1.3.2. Modifiers

Modifiers:

Keyboard Modifiers

This section allows you to change the keyboard modifiers Shift, Command, Control, Alt, as well as the
lesser-used Windows keys, and combinations thereof, when using the mouse to click, drag, and trim in the
Editor window. Using these keyboard modifiers you can adapt Mixbus to the editing workflow you prefer.
Several parameters are offered:

Select Keyboard Layout

Currently Mixbus provides a single set of predefined keyboard shortcuts. If we later provide additional
keybindings, they will appear here.

When Clicking

You can change which modifier(s) activate Edit, Delete, and Insert Note.

When Beginning a Drag

You can change which modifier(s) activate Copy items, Constrain drag, and Push points.
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When Beginning a Trim

You can change which modifier(s) activate Trim contents, Anchored trim, and Resize notes relatively.

While Dragging

You can change which modifier(s) activate Ignore snap and Snap relatively.

While Trimming

You can change which modifier(s) activate Resize overlapped regions

While Dragging Control Points

You can change which modifier(s) activate Fine adjust.

Reset

This button will reset all modifiers above to their recommended defaults.
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20.3.1.4. MIDI

MIDI

Session

Allow non quarter-note pulse

Initial program change

Mixbus will send this MIDI program-change to the MMC port, when a new session is opened.

Audition

Sound MIDI notes as they are selected in the editor

When this option is enabled, clicking on a MIDI note in the editor will cause it to play.

Virtual Keyboard
The Virtual Keyboard is covered in section Virtual Midi Keyboard.
This selector provides different mappings of the virtual keyboard to your computer keyboard, which may be
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any of several popular computer keyboard layouts.

MIDI port options

MIDI input follows MIDI track selection
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20.3.1.4.1. Midi Port Config

MIDI port config
The checkboxes configure the MIDI port to carry Music data, Control data, or both.
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20.3.1.5. Transport

Transport

General

Prompt for new marker names

Stop at the end of the session

When enabled if Mixbus is not recording, it will stop the transport when it reaches the current session end
marker. When disabled Mixbus will continue to roll past the session end marker at all times.

Keep record-enable engaged on stop

To prevent accidental overwriting this is off by default.

Reset default speed on stop

Disable per-track record disarm while rolling

When enabled this will prevent you from accidentally stopping specific tracks recording during a take.
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12dB gain reduction during fast-forward and fast-rewind

This will prevent the unpleasant increase in perceived volume that occurs when fast forwarding or rewinding
through certain kinds of audio.

Preroll

There are several options here including Bars (1, 2, or 4), Zero (no preroll at all), and Seconds (0.1 to 2.0)

Looping

Play loop is a transport mode

When enabled the loop button does not start playback but forces playback to always play the loop. When
disabled the loop button starts playing the loop, but stop then cancels loop playback.

Loop fades

This selector controls audio fading at the boundaries of a looping region.
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Dropout (xrun) Handling

Stop recording when an xrun occurs

A buffer xrun will produce noise. Checking this option prevents this noise from accidentally being recorded.

Create markers where xruns occur

When enabled, this option creates new markers on the timeline whenever an xrun occurs.

Reset xrun counter when starting to record

Checking this box will make the xrun counter in the recording window reset every time a new record is
started.

Plugins

Silence plugins when the transport is stopped.

This checkbox will stop processing and silence the output of plugins when the transport is stopped. This
might apply to any plugin which creates sound, such as virtual instruments, or to things like reverb and
delay. This can save battery life, and is OFF by default.
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20.3.1.5.1. Chase

Chase

MIDI Machine Control (MMC)

This checkbox and selector sets whether Mixbus responds to MMC commands, and allows you to assign
device ID to Mixbus.

Transport Masters

Clicking on the button will open the Transport Masters window. Properties and use of the Transport Masters
window can be found in the section Transport Masters
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MIDI Clock

This option allows you to set the resolution of the incoming MIDI clock in quarternote beats per minute.
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20.3.1.5.2. Generate

Generate
This window controls Mixbus’ output of timecode (both LTC and MTC) , MIDI Machine Control commands,
and the MIDI beat clock.

Linear Timecode (LTC) Generator

Enable LTC Generator

The checkbox enables the LTC generator. When enabled, Mixbus will send LTC from the LTC port. The LTC
generator can be routed to an audio track using the routing tool.

Send LTC while stopped

When enabled Mixbus will continue to send LTC information even when the transport (playhead) is stopped.
This checkbox is grayed out if “Enable LTC Generator” is not selected.

LTC generator level [dbfs]

The slider allows setting the level of the peak volume of the generated LTC signal in dBFS. A good value is
0 dBu^= -18 dBFS in an EBU calibrated system.
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LTC Output Port

This selector will set a default output on the audio interface for the LTC signal, connected to this output
when the session is opened. In the picture this session uses a 64-wide Dante interface, the LTC may be
sent by default to any of these outputs.

MIDI Time Code (MTC) Generator

The checkbox enables the MIDI time code generator. A maximum limit on varispeed may be set.

MIDI Machine Control (MMC)

The checkbox enables Mixbus to send MMC commands. The MMC device ID is set here.

MIDI Beat Clock (MCLK) Generator

The checkbox enables the MIDI beat clock generator.
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20.3.1.6. Plugins

Plugins

Scan/Discover
The Scan for Plugins button initiates a new scan for any new plugins you may have installed along the paths
listed in the VST path box. A pop up dialog window shows the progress of the scan operation.

Scan Timeout

If a plugin exceeds this time when scanning, this might indicate a bug in the plugin. In this case the scan will
be aborted and the plugin will be put on the “blacklist”. Plugins sometimes take a long time to scan, because
they are checking online for licensing information or updates. Adjust this value to accommodate your
plugin’s needs.

General

Scan for [new] Plugins on Application Start

New plugins are searched, tested and added to the cache index on application start. When disabled new
plugins will only be available after triggering a ‘Scan’ manually.

Harrison Consoles Mixbus - 9_en

Page 587 of 848



Always Display Plugin Scan Progress

When enabled, Mixbus will display a dialog window showing each plugin being scanned. This is ON by
default.

Verbose Plugin Scan

Open Plugin Manager Window When Missing Plugins Are Found

Make new plugins active

By default, Mixbus will immediately enable a plugin when it is added. If you disable this option, then newly-
added plugins will be “disabled” by default.

Set Up Sidechain Ports When Loading Plugin With AUX Inputs

LV1/LV2
This option, when enabled, will conceal LADSPA (LV1) plugins if a corresponding LV2 plugin is installed.
This can ensure you are always using a more up to date plugin.

Instrument

Ask to replace existing instrument plugin

When an instrument is added to a track that already has an instrument, Mixbus will prompt you to replace
the existing instrument. This is ON by default.

Interactively configure instrument plugins on insert

When a plugin with multi-outputs is added to a track, this option will cause Mixbus to prompt the user for the
desired channel configuration: mono, stereo, or multichannel.

Statistics
The selectors allow setting of the maximum lengths of the plugin usage-count chart and the recently used
chart.

The reset button resets the plugin usage statistics.
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20.3.1.6.1. GUI

GUI

Plugin GUI

Automatically open the plugin GUI when adding a new plugin

When a new plugin is added to the strip, the plugin’s UI will be shown. This is ON by default. Note that this
only applies when a single plugin is added. If you add multiple plugins at once, the GUI will not appear
automatically.
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Show Only One Plugin Window At A Time

Closing A Plugin GUI Window

Mixer Strip Inline Display

Show Plugin Inline Display on Mixerstrip by default

When a plugin with an “inline display” is added, this option will cause the inline display to be shown
automatically

Don’t automatically open the plugin GUI when the plugin has an inline display
mode

When a plugin with an “inline display” is added, this option will cause the inline display to be shown instead
of the plugins main UI.
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20.3.1.6.2. VST
VST

This area is blank because VST plugins are obsolete.

VST2.x

The buttons allow you to clear the cache or the “ignore” list.

VST2 Cache

Clicking this button will clear the VST2 “cache” which is a list of VST2 plug-ins that have been scanned.
Mixbus will only load plug-ins that have been scanned and are in the cache. So clicking this button will
disable VST2 plug-ins in Mixbus until paths have been scanned.

VST2 Ignorelist

When a plug-in crashes on scanning, it is placed in the “Ignorelist” and will not be scanned in the future.
Click this button to clear all blacklisted plug-ins so they can be scanned.

VST2 Path

The heading and some details below will vary depending on the platform on which you are running Mixbus
(MAC, Linux, Windows PC).

The VST2 Path is a list of directories that Mixbus will use to scan for VST2 plug-ins. This path may not be
directly edited by the user, but can be cleared, added to, and set to defaults with the buttons provided.
Clicking this button launches a dialog box that allows the user to specify which folders contain VST2 plug-
ins.
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Add opens a dialog box that allows you to add new folders. Highlight the desired folder and click “OK” to
add it to the VST2 path. Pressing Delete (this button will be lit only if you have selected a path) will remove
the selected path from the VST scan. Restore to Default will set the VST path to those folders that are
defined as VST2 paths in your computer’s operating system. In Windows, this includes paths set in the
registry as well as the environment variable VST_PATH.

Path: shows the current path through your computer system where Mixbus will look for VST2 plugins.

VST3

The buttons allow you to clear the cache or the blacklist.

VST3 Cache

Clicking this button will clear the VST3 “cache” which is a list of VST3 plug-ins that have been scanned.
Mixbus will only load plug-ins that have been scanned and are in the cache. So clicking this button will
disable VST3 plug-ins in Mixbus until paths have been scanned.

VST3 Ignorelist

When a plug-in crashes on scanning, it is placed in the “Ignorelist” and will not be scanned in the future.
Click this button to clear all blacklisted plug-ins so they can be scanned.

Additional VST3 Path

This button allows you to specify additional paths to search for VST3 plugins. Note the warning message.
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Automatically Show “Micro Edit” Tagged Controls on the Mixer Strip

Checking this box will show plugin controls with “Micro Edit” capability directly on the mixer strip.

VST2/VST3

Checking this box will conceal LV2 plugins if a corresponding LV3 plugin is installed. This can ensure you
are always using a more up to date plugin.
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20.3.1.7. Monitoring

Monitoring

Recording monitoring handled by:

This selector sets whether monitoring is to be done by Mixbus, or by external hardware:

Auto Input Does Talkback

This checkbox enables “Auto Input does Talkback”. If “Auto Input does Talkback” mode is enabled, then
Mixbus will monitor the input of all tracks, even unarmed ones, during stop. In a multi-room setup, this
feature allows easier setup of your instrument or communication among members of a band, because all the
live mics are passed through to the master bus output so everyone can hear themselves through the
monitoring system (which might consist of foldback buses). This option only takes effect when Auto Input is
enabled in the Transport menu.

See Monitoring for more details.

Solo

Solo controls are Listen controls

When this is enabled, Solos will appear on the “monitor” output, but they do not mute the master bus output.
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This allows the engineer to listen to a solo, without affecting the master bus output in those cases where the
master bus is being recorded “live” and should not be interrupted.

Exclusive Solo

When this option is enabled, only one track or bus can be in solo at any given moment. If another track or
bus is selected, then it will become the only track or bus that is in solo mode.

Show solo muting

When this option is enabled, soloing one track or bus causes a yellow outline to be drawn around all the
other tracks or busses which are muted by the solo selection. Every track or bus that is not solo’ed will be
effected in this way, to remind you why the track is not audible.

Soloing overrides muting

When this option is enabled, pressing the solo button will allow the audio on that track or bus to be heard,
even if the mute button is also pressed. When this option is not enabled, then the mute button still continues
to function, even if the track is solo’ed.

Solo-in-place mute cut (dB):

Listen Position

The selector chooses between pre-fader and after-fader listening.

PFL signals come from

The selector chooses pre-fader soloing to come from before or after plugin processors. Default is AFTER
processors.

AFL signals come from

The selector chooses after-fader soloing to come from before or after post fader plugin processors, but
always before panning.
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20.3.1.8. Signal Flow

Signal Flow

Master

Enable Master Bus output gain control

Selecting this checkbox will add an adjustable post-fader gain trim to the master bus output. Note this
affects the Master bus output, NOT the master bus monitoring path.
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Default Track/Bus Muting Options
These checkboxes control what is muted when Track or Bus mute button is engaged.
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Mute Affects Pre-Fader Sends

Mute Affects Post-Fader Sends

Mute Affects Control Outputs

Mute Affects Main Outputs

Send Routing

Link Panners of Aux and External Sends with main Panner by default

This checkbox links the panners of channel strip Aux Sends and External sends to the main panner on the
strip.

For more information on Aux sends and how their panning works, see the section DAW Style Mixing Buses
for more details.

For more information on External sends, see the section Redirects: Plug-ins, Sends & Inserts.

Audio Regions

Replicate Missing Region Channels

If you send a mono region on a stereo channel, this option will cause the mono signal to appear on both left
and right channels. If this option is disabled, then the mono region will only be heard from the left side of the
channel.

Harrison Consoles Mixbus - 9_en

Page 598 of 848



20.3.1.9. Metronome

Metronome

Metronome

Emphasis on first beat

When enabled, this option uses a different tone, with a higher pitch, on the first beat of each measure to
make it easier to hear where each bar begins. When disabled, the same tone is used on each beat.

Use built-in default sounds

Enables a simple option to automatically generate a useable click track with the metronome using built-in
default sounds. If you prefer to use your own sounds, de-select this option and load your sounds below.

Audio File

If the default sounds are disabled, browse to define the sound file for the “click” used by the metronome.

Emphasis audio file

If the default sounds are disabled, browse to define the sound file for the “emphasis click” used by the
metronome. The emphasis click occurs on the first beat of each measure.
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Gain level

Adjustable from – infinity to +6 dB

Options

Enable metronome only while recording

Checking this box will enable the metronome only while recording.
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20.3.1.10. Control Surfaces

Control Surfaces

Enable Control Surface Protocol

This option allows you to specify the Control Surface Protocol you’d like to use. Some options, like Generic
MIDI, OSC, and Mackie are common standards that may be used by a variety of control surfaces. Others,
like Ableton Push 2, PreSonus FaderPort, and Stenberg CC121 are Mixbus’ implementation of specific
controllers available. If you’d like to use one of these products, enable it here, and tweak the various options
below.

Edit the settings for selected protocol (it must be ENABLED first)

Once you have enabled a protocol above, you can edit the settings for that protocol by clicking the button,
which will launch a new dialog box.
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20.3.1.11. Metering

Metering

Meterbridge meters ( NOTE: these options only apply to the
meters in the Meterbridge window )

Peak Hold Time

The hold time for the peak-hold indicators. Ranges from off to short, medium, and long.

DPM fall-off

The decay rate of audio meters, ranging from Off (instant decay) to Slowest (6.6dB/sec decay rate).

Meter line-up level; 0dBu

This selector configures the reference level for all meters configured as IEC1/Nordic, IEC2/PPM and VU
meters.

IEC1/DIN Meter line-up level; 0dBu

This selector sets the reference level specifically for meters configured to IEC1/DIN standard.
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VU Meter standard

This selector sets the 0 VU reference level for VU meters. Standard for recording is 0VU = +4 dBu.
Broadcast applications typically use 0VU = +8 dBu.

Peak Indicator Threshhold (dBFS)

This slider allows you to set the threshold of the peak indicators.

Default Meter Types
These selectors allow you to separately specify what kind of metering algorithm is used for tracks, buses
and the master bus. Several options are available for each.

Default Meter Type for Master Bus

Default Meter Type for Busses

Default Meter Type for Tracks

Region Analysis

Enable automatic analysis of audio

If this is enabled, Mixbus will always analyze audio (to find transients) when files are imported to a session.
This might cause imports to take longer, but it saves time when you try to “skip to next transient”.
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20.3.1.12. Performance

Performance

DSP CPU Utilization

Signal processing uses

This option defines how many “threads” Mixbus will create to process audio signals. If you use a lot of tracks
and plug-ins, then Mixbus will require significant CPU resources. This setting allows Mixbus to use multiple
processors in parallel, thereby taking advantage of modern computers with 2, 4, or more CPU cores.

• all but one processor is the default setting. This setting reserves one processor so your computer
does not feel sluggish when Mixbus is heavily loading your CPU.

• all processors might allow Mixbus to run more tracks/plug-ins with the risk of causing other desktop
applications feeling sluggish.

CPU/FPU Denormals
Denormals relate to 32 bit floating point processing used by Mixbus. Some plugins, when used in Mixbus,
generate “denormals” which is an invalid processor state that causes random high CPU spikes. If you
believe a plugin is generating denormals, you can enable this checkbox for the track, and see if it helps the
problem. For more on denormals click here: http://en.wikipedia.org/wiki/Denormal_number
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Processor Handling

This option attempts to use internal CPU settings to avoid denormals. In a few cases, plugins that cause
CPU spikes can be improved by enabling this option, or one of the other “denormal” options.

Disk I/O Buffering
A smaller buffer allows mixbus to load sessions and locate faster. If you receive a message like “your disk
was not able to keep up with Mixbus”, then you should increase the buffer size. If you have fewer tracks
(8-16), and/or a very fast disk (SSD), then you can use very low buffer sizes, and Mixbus will feel extremely
responsive. Generally speaking, Mac requires larger buffers than Windows and Linux.

Preset

There are four preset options: small sessions, medium sessions, large sessions, and custom, which
allows you to set your own buffer times using the sliders for playback and recording.

Playback (seconds of buffering)

Increase this value if Mixbus reports “your disk was not able to keep up with playback”. Increasing the buffer
might cause a slight delay when Mixbus locates, because it is buffering more audio before playback can
start.

Recording (seconds of buffering)

Increase this value if Mixbus reports “your disk was not able to keep up with recording”.

Memory Usage

Waveform image cache size (megabytes)

This slider allows you to set the size, in Megabytes, of the waveform image cache. For large projects with a
lot of tracks, setting this higher may improve screen rendering times to improve performance. For smaller
projects, or for systems with smaller amounts of RAM, the cache size can be reduced.

Automation

Thinning factor

This option removes data points within the automation draw points. Excessive draw data may reduce
system responsiveness with little to no audio benefit. Larger numbers means more thinning, and therefore
fewer draw points but more responsiveness.
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Automation sampling interval

This option determines the rate (in milliseconds) at which automation points are acquired. If the density of
automation points is too high system responsiveness may be reduced.

Automatables

Limit automatable parameters per plugin

This selector sets upper limit on the number of parameters that are automated in plugins.
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20.3.1.13. Video

Video

Video Server

Show Video Export info before export

When enabled, an information window with details is displayed before video export dialog.

Show Video Server Startup Dialog

When enabled, the video server is never launched automatically without confirmation.

Advanced Setup (remote video server)

When enabled you can specify a custom video server URL and docroot.

Video Monitor

Custom Path to Video Monitor (Jadeo.app) – Leave empty for default.
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20.3.1.14. Triggering

Triggering

This menu allows you to specify the location of where user-created sound clips are stored. A single button
clears the specified directory.
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20.4. Region Menu
This menu give the user access to many editing features for regions or tracks in the canvas.
The region you intend to work with must first be selected or the menu selections with be grayed out.

Region menu includes:

• Insert Region From Region List : If a region is selected in the “Region List” (in the editor sidebar) then
this action will insert it at the Edit Point.

This option is grayed out in the picture above because there is no edit point defined in this example.

• Play Selected Regions
• Tag Selected Regions
• Loop : sets the “Loop” range to match the region, and starts looping the transport.
• Rename : allows the user to change the name that appears in the region’s top corner.
• Properties : launches a dialog showing the region’s name, position, length, gain, and other properties.
• Loudness Analysis : Performs a loudness analysis on the region, reporting its dBFS and LUFS

loudness, as well as spectral energy
• Spectral Analysis : Performs a spectrum analysis on the selected region(s). Use this to compare the

spectrum of sound in multiple selected regions.
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Edit

• Pitch Shift : initiates a dialog which allows you to shift the region’s pitch up or down, either as a
percentage or in semitones.

• Split at Percussion Onsets : performs a “percussive note onset” analysis, and then splits the regions
on the detected hits

• Make Mono Regions : splits a stereo (or multichannel) region into multiple mono regions. These mono
regions appear in the editor sidebar list, “Regions”

• Close Gaps : removes any space between the selected regions, creating a butt joint between each
region

• Place Transient : manually places a “transient” marker inside the region, at the Edit Point. Transient
markers can be used for the grid or other editing actions.

• Rhythm Ferret
• Strip Silence

select track(s) or region(s) you would like to detect silence. Batch processing possible by selecting
multiple tracks or regions. Once the analysis has completed the areas that have met the criteria for
silence will be highlighted.

• Reverse : this reverses the audio region’s sound, so it plays “backwards”.
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Layering

• Raise to Top : raises the selected region to the top of the layer stack.
• Raise
• Lower
• Lower to Bottom
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MIDI

• Transpose : launches a dialog, allowing the user to transpose all MIDI notes up or down
• Insert Patch Change : Inserts a patch change at the Edit Point. See this section on MIDI Patches
• Quantize : launches a dialog which edits the midi note start and/or end times to exact grid locations

on the music timeline.
• Legatize : extends the selected note(s) so the end of each note reaches the beginning of the next

note (legato)
• Remove Overlap : trims each MIDI note so that it ends before another note begins (portamento)
• Transform : launches a dialog with various MIDI operations
• Unlink from other copies : by default, a copied MIDI region will be “linked” to the source region. Any

change to either region will affect all copies. This action will unlink the selected region(s) so they may
be edited with no changes to the copies.

• Deinterlace into layers :
• List Editor : this launches a dialog that allows the user to see and edit MIDI events.

Gain

• Opaque: when disabled, the region will not obscure the regions below it; instead you will hear the
region combined with the regions below it.

• Mute: when enabled the region will not play and will be treated as if it were “transparent” to regions
below it

• Normalize: adjusts the selected regions’ gain to reach a specified value ( see Normalize Regions )
• Boost Gain : increases the region gain by 1dB
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• Cut Gain : decrease the region gain by 1dB
• Reset Envelope : this resets the region’s gain envelope to “unity”
• Invert Polarity: The waveform in the selected region is inverted
• Envelope Active : if unchecked, the region’s gain envelope will be ignored.

Position

• Move to Original Position : if the file was originally recorded in Mixbus, or if it has a file timestamp
(broadcast wave file), then this action will move the selected region(s) to the original location.

This option is grayed out in the picture above because the selected region in this example is already in its
original position.

• Snap Position To Grid : moves the region to the nearest grid (snap) location.
• Lock : if enabled, the region cannot be moved on the timeline.
• Glue to Bars and Beats : If enabled, the region is attached to the “music” timeline. See “Audio Time vs

Music Time”:”#audio-time-vs-music-time
• Lock to Video : if locked to the video, then the region will move when the session’s video file is moved

on the timeline.
• Set Sync Position : Sets the region’s sync point to the Edit Point ( when initiated from a menu, the

sync point is always the playhead ) : see “”:#align-regions
• Remove Sync : Removes the region’s sync point. It will align (or snap) to the region’s start
• Nudge Later : moves the region by the amount shown on the “nudge” clock in the editor toolbar.
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• Nudge Earlier
• Nudge Later by Capture Offset : moves the region by one buffersize; this is sometimes useful to

correct mis-aligned recordings due to soundcard latency
• Nudge Earlier by Capture Offset
• Sequence Regions : the selected regions will be sequenced in a series, with no space between them.

Markers

• Add Region Cue Marker: adds a “cue marker” to the Region’s Source, at the location specified in the
Region. see: Region Cue Markers

• Clear Region Cue Markers: removes all cue markers visible in the selected Region’s Source.
• Convert Region Cue Markers to CD Markers: for all selected Regions, this creates a CD Marker

corresponding to each Cue Marker
• Convert Region Cue Markers to Global Markers: for all selected Regions, this creates a Location

Marker corresponding to each Cue Marker

Harrison Consoles Mixbus - 9_en

Page 615 of 848



Trim

• Trim Start at Edit Point : trims the selected region(s) so they start at the edit point.
• Trim End at Edit Point : trims the selected region(s) so they end at the edit point.
• Trim Loop : trims the selected region(s) to the Loop range.
• Trim Punch : trims the selected region(s) to the Punch range.
• Trim Previous : trims the selected regions to meet the previous region’s end.
• Trim Next : trims the selected region to meet the next region’s start.
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Ranges

• Set Loop Range : Set the Loop start/end markers to this region’s start/end.
• Set Punch : Set the Punch start/end markers to this region’s start/end.
• Add Single Range Marker : create a Named Range marker corresponding to the selected region(s)’s

start/end.
• Add Range Marker Per Region : create a Named Range marker corresponding to each selected

region.

This is grayed out in the picture above because in this example only one region exists in the selected range.

• Set Range Selection : Set the Range Selection start/end to the selected region(s)’s start/end.
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Fades

• Fade In : if unchecked, the region’s fade-in will be disabled, resulting in a hard cut (not recommended)
• Fade Out : if unchecked, the region’s fade-out will be disabled, resulting in a hard cut (not

recommended)
• Fades : toggles the selected region(s)’s fade-in and fade-out simultaneously
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Duplicate

• Duplicate : copies the region, and pastes the copy immediately at the end of this region.
• Multi-Duplicate : duplicates the region multiple times ( a dialog will prompt for the number of times to

duplicate )
• Fill Track : duplicates the region enough times to fill the region to the Session End marker.

Export

• The region can be exported (including region gain, gain envelope, and fade in/out) to a new file, to
any disk location, and in the format of the user’s choice.

Bounce (without processing)

• The region will be bounced (including region gain, gain envelope, and fade in/out ) to a new file, which
will appear in the editor sidebar Region list.

Remove

• The region is deleted.
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20.4.1. Strip Silence
The Strip Silence command can be found under Region>Edit>Strip Silence. You must first select the
track(s) or region(s) in which you would like to detect silence. Batch processing is possible by selecting
multiple track or regions. Once the Strip Silence dialogue has been opened Mixbus will begin analysis on all
selected tracks or regions (allow time based on CPU speed and track/region length). Once the analysis has
completed the areas that have been determined to contain silence will be highlighted.

There are 3 adjustments available:

• Threshold: This sets the audio level for detecting silence and is adjustable by 1 dBFS increments.
Any audio below the set threshold will be considered silence.

• Minimum length (in milliseconds, default =1000 (1 second)): Allows control of the shortest time
period that will be considered silence.

• Fade Length (in samples, default =64): This setting adjusts the length of fades at the transitions of
detected silence and detected audio.
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20.4.2. Normalize Regions

Normalize Region
Normalizing audio is a method to automatically adjust the gain control(s) to meet a target volume level.

You may normalize an audio region in the timeline, or you may normalize the final output during Export (see:
Export)

The “Normalize Regions” dialog can be launched in one of 2 ways:

• use the menu item Region->Gain->Normalize (or the associated shortcut)
• right-click on a Region and choosing “{Region name}/gain/Normalize…”

The operation will be applied to all selected regions.

Normalizing the regions to meet a peak value is enabled by default.

There are also options to normalize regions to an RMS or LUFS value.

• Peak: adjusts the region’s gain so their maximum digital peak value meets the defined value
• RMS: adjust the region’s gain so their short-term RMS value meets the target value
• LUFS: adjusts the regions gain so their long-term loudness meets the target value

There’s also an option to normalize each region separately, or to calculate the gain correction for all regions
and apply only the max value calculated across all the regions. This is important if, for example, you have a

TIP: You can use Ctrl+A (or Cmd+A on Mac) to select ALL regions in the timeline at one
time. This is sometimes useful if you import tracks with widely varying levels.*

Harrison Consoles Mixbus - 9_en

Page 621 of 848



pair of tracks representing a stereo source and you want to have the same gain applied to both tracks so the
stereo balance doesn’t shift.
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20.4.3. Region Cue Markers
Region Cue Markers can be added to a Region at the Edit Point (either the Mouse or the Playhead position)
of the selected region(s).

Region Cue Markers have these properties:

• They have a name which will be displayed alongside the marker (by default, you must name a Cue
Marker as soon as it is created)

• Cue Markers move with the region, so if you move or duplicate a region, the marker moves/copies
with it

• Cue Markers are stored in the region’s “Source” file, which means:
◦ you can trim a region to hide a marker, but you can later re-expose it if you extend the region

again
◦ if you remove a Region Cue in any Region for that source, all associated regions will also lose

that Cue marker

Region Markers may be ‘promoted’ to CD Markers or global Location Markers in the main timeline. This
allows you to (for example) move some song-parts (verse 1, chorus, etc) around, and then promote them to
the main timeline after you’ve finished your edits.
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20.5. Track Menu
A track header must first be selected to access many of the items in this menu.

Most of these items can also be found in the track header context menu, which is accessed by right-clicking
on a track header. Generally speaking, right-clicking on a track will only affect the single track, while the
Track menu will affect all selected tracks.

• Add Track, Bus, or VCA : Adds additional channels to the editor and mixer. Learn more here.
• Import : Learn more in the Import section.
• Mix Tools : Initiates a scripted action which an affect multiple tracks. Learn more here.
• Duplicate Tracks/Busses : creates a “duplicate” of selected Track(s), including EQ, bussing, plugins.

A dialog prompts whether to include the regions (playlist) in the duplicate tracks.
• Toggle Record Enable : toggles record enable for the selected track(s).
• Toggle Solo
• Toggle Mute
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• Playlists
◦ Show Playlist Selector
◦ New Playlist for All Tracks
◦ New Playlist for Rec-Armed Tracks
◦ New Playlist for Selected Tracks
◦ Copy Playlist for All Tracks
◦ Copy Playlist for Rec-Armed Tracks
◦ Copy Playlist for Selected Tracks

• Insert Time : Inserts blank time at the selected time, and optionally move all markers to the right.
• Remove Time: Deletes selected range and markers (from ALL tracks). Everything to the right moves

left to close the gap.
• Remove Gaps
• Move Selected Tracks Up
• Move Selected Tracks Down
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• Height
◦ Fit Selection (Vertical)
◦ Largest
◦ Larger
◦ Large
◦ Normal
◦ Small

• Toggle Active : Toggles the state of all selected tracks; inactive tracks will become active, and vice-
versa. Inactive tracks utilize no CPU or disk access; they are completely disabled. This option cannot
be changed while Mixbus is playing.

• Remove
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20.5.1. Mix Tools

What are Mix Tools?
In the main menu, under the “Track” menu, you will find several operations which can automate certain
tasks that are commonly encountered while mixing.

Currently, 4 Mix Tools are provided:

Reset Mixer

This tool applies to all the mixer channels, and it resets the knobs to their default positions. You may choose
from the list if you’d like to save certain mix settings. Note that this CANNOT be undone.
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Track Organizer

This tool provides a list of all the tracks in the session, along with simplified interface to rename the tracks
as well as assign a color, comment, or group to each track:
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Scenes

This tool allows you to store and recall specific scenes.
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Store and Recall Mixer Settings

Store:

The current settings of the mixer may be stored in the Session folder, or in your globally-accessible
preferences folder. Choose “Global” if you think you might want to use these settings on a different session,
someday.
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• Name : Enter the name of the file here.
• Selected Tracks Only : If this is checked, then only the selected (red-colored) tracks will be saved to

the file.

Recall:

First, choose whether to load a file from your Global settings, or from within the current session:
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Select the file that you would like to import:

Mixer files contain the mixer-strip Input Trim, Polarity, EQ, Compressor, Panning, Mixbus
Sends, Master Bus Sends, and Plugins. They do not include Sends or Inserts in the
channelstrip.

!

Each of the provided actions in the “Track Tools” menu is implemented as a Lua script. It is
possible to edit the script manually, to change or improve the script’s behavior. This is an
advanced topic for customization. To chat with developers about this feature, visit the
Mixbus user forum.

*
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20.6. View Menu

• Maximise Editor Space : when this is enabled, the Mixbus “editor” window will try to make itself
fullscreen. The exact behavior will differ depending on your OS version.

• Maximise Mixer Space

Harrison Consoles Mixbus - 9_en

Page 633 of 848



• Region Layers >
◦ Stacked Layer Display : switches all selected tracks (or ALL tracks if none are selected) to a

“Stacked” layer view
◦ Overlaid Layer Display : switches tracks to “Overlaid” view.
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• Automation >
◦ Toggle All Existing Automation: selected tracks (or ALL tracks if none are selected) show every

automation lane that has any control-points in it (click this again to hide them)
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• Primary Clock >
◦ Focus On Clock : the primary clock will get “focus” for text entry, so you can type in a time

location.
◦ Timecode : switches the primary clock to show “Timecode” format. Learn more here.
◦ Bars & Beats
◦ Minutes & Samples
◦ Samples
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• Secondary Clock >
◦ Timecode : switches the secondary clock to use “Timecode” display format. Learn more here.
◦ Bars & Beats
◦ Minutes & Samples
◦ Samples
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• Rulers >
◦ Min:Sec
◦ Timecode
◦ Samples
◦ Bars & Beats
◦ Meter
◦ Tempo
◦ Ranges
◦ Loop/Punch
◦ CD Markers
◦ Markers
◦ Video
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• Zoom >
◦ Zoom In : zooms the timeline to show a smaller time interval.
◦ Zoom Out
◦ Zoom to Session : zooms the timeline to show the entire length between the Session Start and

End markers.
◦ Zoom to Extents :
◦ Zoom to Selection : zooms the timeline to show the length of the selected Range, AND

vertically to show the track selection.
◦ Zoom to Selection (Horizontal) : zooms the timeline to show the length of the selected Range
◦ Fit Selection (Vertical) : zooms the editor so the track/region selection fills the vertical space of

the screen.
(grayed out in the picture above)

◦ Toggle Zoom State : reverts to the previous zoom state
◦ Expand Track Height : increases the height of all selected tracks
◦ Shrink Track Height : decreases the height of all selected tracks
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• Zoom Focus >
◦ Zoom Focus Left : when this is selected, Mixbus will zoom to the “left” side of the screen. (this

only applies when using the -/+ shortcut keys)
◦ Zoom Focus Right
◦ Zoom Focus Center
◦ Zoom Focus Playhead
◦ Zoom Focus Mouse
◦ Zoom Focus Edit Point
◦ Next Zoom Focus
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• Scroll >
◦ Scroll Tracks Down
◦ Scroll Tracks Up
◦ Scroll Forward
◦ Scroll Backwards
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Options which are not applicable to your particular video monitor setup will be grayed out, as in the picture
above.
There might also be differences between PC and MAC computers.

Here is a similar screenshot from a MAC computer, showing the options not seen above:
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• Video Monitor >
◦ Original Size
◦ Letterbox
◦ Always on Top
◦ Fullscreen
◦ Timecode
◦ Frame Number
◦ Timecode & Background
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• Editor Views >
◦ Save View 1 : Saves the current editor “viewport” – including the timeline and track zooming.
◦ Goto View 1 : recalls the “viewport” stored in View 1
◦ Save View 2
◦ Goto View 2
◦ Save View 3
◦ Goto View 3
◦ Save View 4
◦ Goto View 4
◦ Save View 5
◦ Goto View 5
◦ Save View 6
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◦ Goto View 6
◦ Save View 7
◦ Goto View 7
◦ Save View 8
◦ Goto View 8
◦ Save View 9
◦ Goto View 9
◦ Save View 10
◦ Goto View 10
◦ Save View 11
◦ Goto View 11
◦ Save View 12
◦ Goto View 12

**this feature is only available while the session is open and is not saved when the session is closed*

• Show Editor Mixer : Toggles visibility of the mixer-strip on the Edit window
• Show Editor List : Toggles visibility of the editor sidebar list, on the right side of the editor window.
• Show Summary : Toggles the visibility of the “summary” (world) view at the bottom of the editor.
• Show Group Tabs : Toggles visibility of the “group” tabs at the top of the mixer, and the side of the

editor.
• Show Marker Lines : Toggles visibility of lines below each “marker”

• Mixer: Toggle Mixer List : Toggles visibility of the mixer sidebar list, on the left side of the mixer
window.

• Mixer: Show Mixbuses: Toggles visibility of the scrollable & resizable “Mixbus” pane in the mixer
window.

• Mixer: Show VCAs: Toggles visibility of the scrollable & resizable “VCA” pane in the mixer window.
• Mixer: Show Monitor Section: Toggles the “monitor section” visibility, if one is enabled in Session-

>Properties->Monitoring.
• Mixer: Show Foldback Strip: Toggles the “foldback strip” which can display a selectable foldback strip

from the available foldbacks

• Mixer Strips: Toggle Rec/Input
• Mixer Strips: Toggle Gate (Mixbus32C Only)
• Mixer Strips: Toggle Comp (Mixbus32C Only)
• Mixer Strips: Toggle EQ (Mixbus32C Only)
• Mixer Strips: Toggle Sends (Mixbus32C Only)
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20.7. Window Menu

Click on an item to visit the topic

• Audio/MIDI Setup
• Editor
• Mixer
• Recorder
• Cue Grid
• Preferences
• Meterbridge
• Locations
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• Big Clock: A scalable clock window for distance viewing. Right Click for formats.

• Transport Controls: a resizable window that shows transport (play/stop/rewind) buttons; suitable for
touchscreens

• Virtual Keyboard: This opens the Virtual Keyboard window. More information here.
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• Library Downloader: Enables you to download and install clips from the clip library.

• Audio Connections: More here
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• MIDI Connections: A grid that allows making MIDI connections between channels, sends, and
hardware I/O
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• Plugin Manager: This window allows you to manage installed plugins.

• License Manager: Displays the status of your Mixbus and Harrison LV2 plugin licenses.
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• Scripting
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• Templates window allows you to manage session templates.

• Transport Masters: a window that displays all the available timecode inputs, their current status, and
allows the user to choose which one Mixbus will chase. More information here

• Keyboard Shortcuts
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• Plugin DSP Load: This window displays the CPU usage of the plugins currently in use. You can use it
to evaluate whether a plugin may be using too much processing resource.

• Performance Meters: This window displays the CPU loading of the active session.

• MIDI Tracer: This window allows the user to view incoming and outgoing MIDI messages, for
troubleshooting
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• Log: The LOG window provides a history of warnings and errors which might be useful to troubleshoot
problems.
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20.7.1. Locations Window
The Locations window provides another view of the Location Markers, Loop Range, Punch Range, Ranges,
and CD Ranges that appear on the “rulers” of the Editor window. This window allows you to see all of the
existing markers in one window with all of the parameters displayed.

• Goto: Moves the Playhead to the associated Marker or the start/end of the associated Range.
• Use PH: Assign the current Playhead location to the marker or the start/end of the associated Range.

• New Marker:
• New Range:

Harrison Consoles Mixbus - 9_en

Page 655 of 848



20.7.2. Audio Connections Manager Window
The Audio Connections Manager window allows you to view all active Audio port connections in your
session. This is a global overview allowing you connect any source to any destinations.
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Destinations and Sources include:

• Hardware.
• Audio Tracks
• MIDI Tracks
• Audio and MIDI Busses
• Master and Monitor
• Sidechains (if any are in the session)
• Misc. tracks (Auditioner, LTC, CLick Track)

In this patch-bay-like overview of the session, click on any grid pair to connect them, and enjoy a seamless
and intuitive way to connect audio throughout your session and hardware!
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20.7.3. Meterbridge
The Meterbridge can be found under Window>Meterbridge and can be toggled via a check box.

The Meterbridge window is a compact and re-sizable view of all meters for all tracks, mix buses and master
bus levels available during a session. 10 metering standards are available and are user selectable by right
clicking on each meter.

Available metering:

• Peak
• RMS + Peak
• IEC1/DIN
• IEC1/Nordic
• IEC2/BBC
• IEC2/EBU
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• K20
• K14
• K12
• VU

Most users involved with music production will find Peak metering a good choice during tracking. This meter
type helps the user avoid digital clipping. This is because peak meters are calibrated to 0 dBFS (decibel full
scale). When the meter reads 0 no more bits are left to capture dynamics.

Most music production users may find Peak+RMS Metering, K Metering, or VU metering useful on the
master bus.

The 4 remaining metering standards are of the IEC type and are typically used for broadcast work and
allows for consistency of volume within the broadcast industry.

Located at the bottom of each meter is a rec-enable button. Under the rec-enable button is the track name.
Right clicking on the track name allows the user to change the height of this area. Advanced configuration
allows the addition of Solo, Mute, Monitor Playback and Monitor Input.

At the top of each meter is a button to reset peak warning indicators. You can Ctrl+left click to reset the
group or Ctrl+Shift+left click to reset all peak warning indicators.

Meterbridge properties:

The Meterbridge is user customizable by going to to the menu Session>Properties>Meterbridge

It is possible for a recorded signal to be clipped before being digitized and displayed on a
meter. As a result, a safe level can be displayed on any meter and in any DAW. No DAW
meter will show if a signal has clipped before being digitized.

!

The K system is extremely useful and is a new standard that has gained traction. K14 is
suitable for the vast majority of music production. As the name suggest it allows for 14 dB of
headroom. K20 allows for 20 dB of dynamic headroom and is useful for less compressed
“audiophile” recordings or large movie theater soundtracks. K12 is useful for Television
broadcast etc. The K metering system has been devolved by Bob Katz.

*
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Advanced configuration of the meters is available in Edit > Preferences > Metering.
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20.7.4. Plugin Manager
The Plugin Manager provides a complete list of plugins that were found on your system, and data about
each plugin’s scan results.

Access the Plugin Manager by selecting “Window->Plugin Manager”:

The columns of the plugin list are sortable (click the column header to sort by that field). Columns include:

• Status : this can be one of:
◦ OK : the plugin was successfully scanned, and is available for use in Mixbus’s Plugin Selector

and other menus
◦ Concealed : a new version (VST3) of this plugin replaces the older (VST) version, although it

can still be loaded if a prior session uses it
◦ New : a new plugin was found in the index, but has not yet been scanned
◦ Stale : this plugin can no longer be found on your computer
◦ Updated : the plugin’s binary file is newer than the prior version we scanned (perhaps a new

version was installed?)
◦ Error : mixbus tried to load the plugin, but failed either due to a crash in the plugin, or perhaps

the plugin was waiting on user input, and was timed-out
◦ Incompatible : similar to error, but this usually means the plugin is the wrong binary format

(32bit vs 64bit mismatch)
• Ign (Ignore) : click this box to prevent a plugin from loading. un-checking the box will result in Mixbus

immediately scanning the plugin and making it available
• Fave (Favorite) : click this checkbox to make a plugin a Favorite (see: Plugin Favorites)
• Hide : click this checkbox to prevent a plugin from appearing in the plugin selector and other menus;

although it can still be loaded if a prior session uses it
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• Type : AU, VST, VST3, or LV2 – click this column to sort your plugins by type. You might want to
‘hide’ all but one format of a plugin for example

• File : this is the file location of the plugin, on disk
• Name : the name of the plugin. For most formats (AU, VST, and VST3), Mixbus can’t know the name

until the plugin has been successfully loaded
• Creator : the plugin’s developer. For most formats (AU, VST, and VST3), Mixbus can’t know the

creator until the plugin has been successfully loaded
• Tags : see Plugin Tags

Search
The Search bar on the left allows you to filter the plugin list by typing a keyword. By default, Mixbus will
search the name, creator(maker) and filename. But you can also enable searching for type, tags, and file
path. Here are some tips to use the search bar:

• if you know you have a brand of plugin installed, but the plugins are missing the name or creator
fields, you can enable the path button and search for the brand (like; “Waves”) to see if any files were
found with that text in the file path name.

• if you want to filter the list to show only VST3’s, enable only the ‘type’ button and enter VST3 in the
search bar
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Scan Actions

• Discover New/Updated : scan your computer for new or updated plugins, without losing your existing
plugin information

• Update Index Only : click this button to have Mixbus scan your system for newly-installed plugins
• Re-Scan Selected : click this to re-scan the plugin that is highlighted in the list
• Re-Scan Faulty : click this button to re-scan plugins with the status New; Error; Stale; or Updated.

(plugins marked OK are not re-scanned)
• Re-Scan All : click this button to clear all prior scan information, and re-scan your system for

plugins
• Clear Stale Scan Log : remove any items from the list that are no longer on your computer

Preferences
These buttons recreate some of the options that are available in the Preferences->Plugins dialog.

Scan Log
Select any plugin to display its scan-log in this area. This is where you will find more details about the
results of scanning a specific plugin. Harrison’s support staff might ask you to send this information to them,
in the case of a plugin that doesn’t load.
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20.7.5. License Manager
The “License Manager” dialog allows the user to view which Harrison features are currently licensed, and it
also allows the user to download a new license once purchased.

Each of the available items is listed on the left, and if a license is installed, then the name of the licensee is
provided on the right side ( typically, you should see your own name for each product that is licensed )

Three buttons are provided to help manage licenses:

• Visit Online Store : if an unlicensed row is selected, this button will open a web-browser page where
you can purchase a license.

• Open License Folder : this will open a file-browser window with the user’s HOME folder where the
license files are stored.

• Download License : this opens a dialog. Paste any Harrison license link into the field, and Mixbus
will download and save the license file to your HOME folder. ( more details here )

Harrison Consoles Mixbus - 9_en

Page 666 of 848



20.7.6. Plugin DSP Load
The Plugin DSP Load Window enables the user to see how much or how little their thrid-party plugins are
affecting the session’s overall alloted DSP usage in milliseconds.

It can be enabled by ticking it’s menu entry in Window->Plugin DSP Load. Once loaded it can be moved
freely.

The DSP Load window features statistics for each plug-in covering it’s:

• Minimum DSP calculation time.
• Maximum DSP calculation time
• Average DSP calculation time.
• Standard Deviation (σ).
• A meter showing where it lies between 0 and the session’s current max DSP calculation time (1000 x

(buffersize / samplerate))

Harrison Consoles Mixbus - 9_en

Page 667 of 848



20.7.7. Performance Meters
This dialog provides an overview of the computer’s audio processing performance.

It is sometimes the case that a very fast computer displays low CPU usage; and yet it occasionally is
delayed (or: “interrupted”) so that it cannot meet the deadline imposed by the audio system’s input/output
buffers. The Performance Meters dialog is intended to help troubleshoot this problem.

The reports include:

• Buffer size: this is the user’s selection for bufferize and the resulting milliseconds of latency incurred
by the buffer

• Idle: this reports on the percentage of time spent idling between each soundcard buffer
• DSP: this reports on the percentage of time spent in DSP processing for the soundcard buffer
• Engine: a sub-category of DSP, this reports how much time the audio engine (soundcard I/O and

resampling) is using
• Session: a sub-category of DSP, this reports how much time the session (channel processing,

plugins, bussing, etc) is using.

Desktop computers are not intended to be “woken up” at the audio rate of 44, 48, or 96k times per second.
So in a computer’s digital audio system, the audio data is buffered (accumulated) in the soundcard before
being offered to the operating system for processing. When a soundcard’s “recording” buffer is offered to
the computer’s CPU, Mixbus has an opportunity to process the audio buffer and then return it to the
soundcard before the soundcard needs to “play” it out again. At a buffersize of 1024 samples, and 48kHz,
this means that Mixbus must ‘wake up’ every 21 milliseconds, process the audio, and return it to the
soundcard before the deadline is met.

The “Performance Meters” dialog collects this data and reports it to the user. The values captured are the
worst case for any buffer that the computer has received. So the value won’t exactly match the
instantaneous DSP% reported in the top of the main window. This “worst case” data is used to determine
the realtime stability and performance of a computer.

The “Idle” and “DSP” numbers will always combine to match the available buffersize/latency.
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20.8. Help Menu
• About
• Manual: Links to this manual
• Videos: Links to Mixbus Instructional videos
• User Forums: Links to The Mixbus user forum
• Developer Chat: Links to IRC (Internet Relay Chat)
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21. Keyboard Shortcuts
Any “action” found in the Mixbus main menu can be initiated from a keyboard “shortcut”.

By default, Mixbus provides a selection of keyboard shortcuts that provides a good balance between easy-
to-remember mnemonic actions (such as “L” for looping) and ergonomic actions for power users ( such as J
and K for trimming a region’s start/end ).

You can change the key shortcuts via Window->Keyboard Shortcuts in the main menu. If you change your
keyboard shortcuts, your shortcuts will be stored in the user preferences folder.

Mixbus provides a set of “Global” shortcuts that work from any window. These global shortcuts generally
control the Transport (which you’ll want from any window) and the window-switching functions. The Global
shortcuts take precedence over the window shortcuts.

• Tabs : This selects between the “Global” shortcuts, and the window-specific ( Editor, Mixer, etc )
shortcuts

• Shortcut browser : Use this area to find shortcuts ( categorized by their normal menu location )
◦ To assign a shortcut: select an action with your mouse, and then press the keyboard shortcut
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(with modifier) that you’d like to assign to that action
◦ If you try to assign a keyboard shortcut that is already in use, Mixbus will tell you which action is

already assigned, and prevent you from “stealing” it.
• Search bar: use this field to display only the shortcuts that match the search term. For example “play”

will hide any actions that don’t have the word “play” in their name.
• Remove Shortcut : click this to clear the currently-selected shortcut.
• Reset Bindings : click this button to reset ALL of your shortcuts to the factory defaults for your

platform ( Mac, Win or Linux )
• Print Bindings: click this to “print” a complete list of your shortcuts to a web page. ( you can then make

a hardcopy print of this page from your browser, if you like )

Viewing your keyboard shortcuts
Because keybindings change slightly between Mac and Windows, and because we are regularly adding new
features that might require keybindings, we no longer provide the keybindings in this manual. You can see
the current keybindings for any action beside the corresponding item in the main menu.

The “number pad”, which appears on some full-size keyboards, has some special behavior. You can read
more about it here: Using a Number Pad

If you’d like to print your current keyboard shortcuts, visit Window->Keyboard Shortcuts and
click the button “Print Keyboard Shortcuts”. This will open your internet browser window,
with a list of currently active keyboard shortcuts.
*
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21.1. Using the Number Pad
Many full-size keyboards provide a “number pad” on the right side.

Locating to a marker, using the number pad
To locate to a marker, click the “.” (period), then type the number of the marker ( for example, “12” ) and
then press “.” again. This will locate to the designated location marker (“12”, in this case). Markers are
designated by their location on the timeline, not by their creation time or their name. So when locating
with the number pad, jumping to “3” will always be later on the timeline than “2”, regardless of what the
markers are named.

Operating the transport from the number pad

Number Pad Action notes

0 play/stop Performs just like the spacebar.

1 reverse play Click again to increase the rewind speed.

2 forward play Click again to increase the forward speed.

3 record-roll Arms the master record button, and initiates Play.

4 loop-roll Starts playing the selected loop range (if any).

5 loop record

6 Toggle Punch On/Off

7 Toggle Metronome On/Off

8 Toggle “Auto Return”

9 Toggle “Follow Edits”

The remaining Number Pad keys are reserved for future use.
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22. Video
Mixbus can load a (single) video file to associate with the session. The video reference is displayed in a
ruler above the editor, and (optionally) also shows moving video in a separate video window.

Mixbus does not allow editing of the video. However, you can export the video, with your audio mix, into a
new video. And you can set start & stop time for that video.

Video is largely developed by the Ardour open-source community. You can learn more about the video-
display features in the relevant sections of the Ardour manual: http://manual.ardour.org/video-timeline/

Video playback requires an external “server” called Harvid, and (optionally) an external video window.
These utilities are included in the Mixbus package, but installation steps are different for each OS:

Installation on Windows
On Windows, the Mixbus installer provides Harvid (the video server) and Jadeo (the video playback
window). To install them, select the “video tools” checkbox in the installer.

Installation on Mac
On Mac, the Mixbus application already includes Harvid (the video server). The Mixbus package provides
the Jadeo video viewer as a separate application in the DMG. If you want to use the video window, you
must drag the included XJadeo video viewer into your Application folder, so Mixbus can find it.

Installation on Linux
On Linux, the Mixbus installer provides Harvid (the video server) and Jadeo (the video playback window).
No additional steps are required.

Video Formats Supported:
D = Demuxing supported
E = Muxing supported
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• E 3g2 3GP2 (3GPP2 file format)
• E 3gp 3GP (3GPP file format)
• D 4xm 4X Technologies
• E a64 a64 – video for Commodore 64
• D aa Audible AA format files
• D aac raw ADTS AAC (Advanced Audio Coding)
• DE ac3 raw AC-3
• D act ACT Voice file format
• D adf Artworx Data Format
• D adp ADP
• E adts ADTS AAC (Advanced Audio Coding)
• DE adx CRI ADX
• D aea MD STUDIO audio
• D afc AFC
• DE aiff Audio IFF
• DE alaw PCM A-law
• D alias_pix Alias/Wavefront PIX image
• DE amr 3GPP AMR
• D anm Deluxe Paint Animation
• D apc CRYO APC
• D ape Monkey’s Audio
• DE apng Animated Portable Network Graphics
• D aqtitle AQTitle subtitles
• DE asf ASF (Advanced / Active Streaming Format)
• D asf_o ASF (Advanced / Active Streaming Format)
• E asf_stream ASF (Advanced / Active Streaming Format)
• DE ass SSA (SubStation Alpha) subtitle
• DE ast AST (Audio Stream)
• DE au Sun AU
• DE avi AVI (Audio Video Interleaved)
• E avm2 SWF (ShockWave Flash) (AVM2)
• D avr AVR (Audio Visual Research)
• D avs AVS
• D bethsoftvid Bethesda Softworks VID
• D bfi Brute Force & Ignorance
• D bfstm BFSTM (Binary Cafe Stream)
• D bin Binary text
• D bink Bink
• DE bit G.729 BIT file format
• D bmp_pipe piped bmp sequence
• D bmv Discworld II BMV
• D boa Black Ops Audio
• D brender_pix BRender PIX image
• D brstm BRSTM (Binary Revolution Stream)
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• D c93 Interplay C93
• DE caf Apple CAF (Core Audio Format)
• DE cavsvideo raw Chinese AVS (Audio Video Standard) video
• D cdg CD Graphics
• D cdxl Commodore CDXL video
• D cine Phantom Cine
• D concat Virtual concatenation script
• E crc CRC testing
• E dash DASH Muxer
• DE data raw data
• DE daud D-Cinema audio
• D dds_pipe piped dds sequence
• D dfa Chronomaster DFA
• DE dirac raw Dirac
• DE dnxhd raw DNxHD (SMPTE VC-3)
• D dpx_pipe piped dpx sequence
• D dsf DSD Stream File (DSF)
• D dsicin Delphine Software International CIN
• D dss Digital Speech Standard (DSS)
• DE dts raw DTS
• D dtshd raw DTS-HD
• DE dv DV (Digital Video)
• D dvbsub raw dvbsub
• E dvd MPEG-2 PS (DVD VOB)
• D dxa DXA
• D ea Electronic Arts Multimedia
• D ea_cdata Electronic Arts cdata
• DE eac3 raw E-AC-3
• D epaf Ensoniq Paris Audio File
• D exr_pipe piped exr sequence
• DE f32be PCM 32-bit floating-point big-endian
• DE f32le PCM 32-bit floating-point little-endian
• E f4v F4V Adobe Flash Video
• DE f64be PCM 64-bit floating-point big-endian
• DE f64le PCM 64-bit floating-point little-endian
• DE ffm FFM (FFserver live feed)
• DE ffmetadata FFmpeg metadata in text
• D film_cpk Sega FILM / CPK
• DE filmstrip Adobe Filmstrip
• DE flac raw FLAC
• D flic FLI/FLC/FLX animation
• DE flv FLV (Flash Video)
• E framecrc framecrc testing
• E framemd5 Per-frame MD5 testing
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• D frm Megalux Frame
• DE g722 raw G.722
• DE g723_1 raw G.723.1
• D g729 G.729 raw format demuxer
• DE gif GIF Animation
• D gsm raw GSM
• DE gxf GXF (General eXchange Format)
• DE h261 raw H.261
• DE h263 raw H.263
• DE h264 raw H.264 video
• E hds HDS Muxer
• DE hevc raw HEVC video
• E hls Apple HTTP Live Streaming
• D hls,applehttp Apple HTTP Live Streaming
• D hnm Cryo HNM v4
• DE ico Microsoft Windows ICO
• D idcin id Cinematic
• D idf iCE Draw File
• D iff IFF (Interchange File Format)
• DE ilbc iLBC storage
• DE image2 image2 sequence
• DE image2pipe piped image2 sequence
• D ingenient raw Ingenient MJPEG
• D ipmovie Interplay MVE
• E ipod iPod H.264 MP4 (MPEG-4 Part 14)
• DE ircam Berkeley/IRCAM/CARL Sound Format
• E ismv ISMV/ISMA (Smooth Streaming)
• D iss Funcom ISS
• D iv8 IndigoVision 8000 video
• DE ivf On2 IVF
• D j2k_pipe piped j2k sequence
• DE jacosub JACOsub subtitle format
• D jpeg_pipe piped jpeg sequence
• D jpegls_pipe piped jpegls sequence
• D jv Bitmap Brothers JV
• DE latm LOAS/LATM
• D live_flv live RTMP FLV (Flash Video)
• D lmlm4 raw lmlm4
• D loas LOAS AudioSyncStream
• DE lrc LRC lyrics
• D lvf LVF
• D lxf VR native stream (LXF)
• DE m4v raw MPEG-4 video
• E matroska Matroska
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• D matroska,webm Matroska / WebM
• E md5 MD5 testing
• D mgsts Metal Gear Solid: The Twin Snakes
• DE microdvd MicroDVD subtitle format
• DE mjpeg raw MJPEG video
• E mkvtimestamp_v2 extract pts as timecode v2 format, as defined by mkvtoolnix
• DE mlp raw MLP
• D mlv Magic Lantern Video (MLV)
• D mm American Laser Games MM
• DE mmf Yamaha SMAF
• E mov QuickTime / MOV
• D mov,mp4,m4a,3gp,3g2,mj2 QuickTime / MOV
• E mp2 MP2 (MPEG audio layer 2)
• DE mp3 MP3 (MPEG audio layer 3)
• E mp4 MP4 (MPEG-4 Part 14)
• D mpc Musepack
• D mpc8 Musepack SV8
• DE mpeg MPEG-1 Systems / MPEG program stream
• E mpeg1video raw MPEG-1 video
• E mpeg2video raw MPEG-2 video
• DE mpegts MPEG-TS (MPEG-2 Transport Stream)
• D mpegtsraw raw MPEG-TS (MPEG-2 Transport Stream)
• D mpegvideo raw MPEG video
• DE mpjpeg MIME multipart JPEG
• D mpl2 MPL2 subtitles
• D mpsub MPlayer subtitles
• D msnwctcp MSN TCP Webcam stream
• D mtv MTV
• DE mulaw PCM mu-law
• D mv Silicon Graphics Movie
• D mvi Motion Pixels MVI
• DE mxf MXF (Material eXchange Format)
• E mxf_d10 MXF (Material eXchange Format) D-10 Mapping
• E mxf_opatom MXF (Material eXchange Format) Operational Pattern Atom
• D mxg MxPEG clip
• D nc NC camera feed
• D nistsphere NIST SPeech HEader REsources
• D nsv Nullsoft Streaming Video
• E null raw null video
• DE nut NUT
• D nuv NuppelVideo
• E oga Ogg Audio
• DE ogg Ogg
• DE oma Sony OpenMG audio
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• E opus Ogg Opus
• D paf Amazing Studio Packed Animation File
• D pictor_pipe piped pictor sequence
• D pjs PJS (Phoenix Japanimation Society) subtitles
• D pmp Playstation Portable PMP
• D png_pipe piped png sequence
• E psp PSP MP4 (MPEG-4 Part 14)
• D psxstr Sony Playstation STR
• D pva TechnoTrend PVA
• D pvf PVF (Portable Voice Format)
• D qcp QCP
• D qdraw_pipe piped qdraw sequence
• D r3d REDCODE R3D
• DE rawvideo raw video
• D realtext RealText subtitle format
• D redspark RedSpark
• D rl2 RL2
• DE rm RealMedia
• DE roq raw id RoQ
• D rpl RPL / ARMovie
• D rsd GameCube RSD
• DE rso Lego Mindstorms RSO
• DE rtp RTP output
• E rtp_mpegts RTP/mpegts output format
• DE rtsp RTSP output
• DE s16be PCM signed 16-bit big-endian
• DE s16le PCM signed 16-bit little-endian
• DE s24be PCM signed 24-bit big-endian
• DE s24le PCM signed 24-bit little-endian
• DE s32be PCM signed 32-bit big-endian
• DE s32le PCM signed 32-bit little-endian
• DE s8 PCM signed 8-bit
• D sami SAMI subtitle format
• DE sap SAP output
• D sbg SBaGen binaural beats script
• D sdp SDP
• D sdr2 SDR2
• E segment segment
• D sgi_pipe piped sgi sequence
• D shn raw Shorten
• D siff Beam Software SIFF
• E singlejpeg JPEG single image
• D sln Asterisk raw pcm
• DE smjpeg Loki SDL MJPEG
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• D smk Smacker
• E smoothstreaming Smooth Streaming Muxer
• D smush LucasArts Smush
• D sol Sierra SOL
• DE sox SoX native
• DE spdif IEC 61937 (used on S/PDIF – IEC958)
• E spx Ogg Speex
• DE srt SubRip subtitle
• D stl Spruce subtitle format
• E stream_segment,ssegment streaming segment muxer
• D subviewer SubViewer subtitle format
• D subviewer1 SubViewer v1 subtitle format
• D sunrast_pipe piped sunrast sequence
• D sup raw HDMV Presentation Graphic Stream subtitles
• E svcd MPEG-2 PS (SVCD)
• DE swf SWF (ShockWave Flash)
• D tak raw TAK
• D tedcaptions TED Talks captions
• E tee Multiple muxer tee
• D thp THP
• D tiertexseq Tiertex Limited SEQ
• D tiff_pipe piped tiff sequence
• D tmv 8088flex TMV
• DE truehd raw TrueHD
• D tta TTA (True Audio)
• D tty Tele-typewriter
• D txd Renderware TeXture Dictionary
• DE u16be PCM unsigned 16-bit big-endian
• DE u16le PCM unsigned 16-bit little-endian
• DE u24be PCM unsigned 24-bit big-endian
• DE u24le PCM unsigned 24-bit little-endian
• DE u32be PCM unsigned 32-bit big-endian
• DE u32le PCM unsigned 32-bit little-endian
• DE u8 PCM unsigned 8-bit
• E uncodedframecrc uncoded framecrc testing
• DE vc1 raw VC-1 video
• DE vc1test VC-1 test bitstream
• E vcd MPEG-1 Systems / MPEG program stream (VCD)
• D vivo Vivo
• D vmd Sierra VMD
• E vob MPEG-2 PS (VOB)
• D vobsub VobSub subtitle format
• DE voc Creative Voice
• D vplayer VPlayer subtitles
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• D vqf Nippon Telegraph and Telephone Corporation (NTT) TwinVQ
• DE w64 Sony Wave64
• DE wav WAV / WAVE (Waveform Audio)
• D wc3movie Wing Commander III movie
• E webm WebM
• E webm_chunk WebM Chunk Muxer
• DE webm_dash_manifest WebM DASH Manifest
• E webp WebP
• D webp_pipe piped webp sequence
• DE webvtt WebVTT subtitle
• D wsaud Westwood Studios audio
• D wsvqa Westwood Studios VQA
• DE wtv Windows Television (WTV)
• DE wv raw WavPack
• D xa Maxis XA
• D xbin eXtended BINary text (XBIN)
• D xmv Microsoft XMV
• D xwma Microsoft xWMA
• D yop Psygnosis YOP
• DE yuv4mpegpipe YUV4MPEG pipe

Syncing Mixbus to Non-Linear Editing software
See: (Clocks & Synchronization)

Harrison Consoles Mixbus - 9_en

Page 680 of 848



23. Preferences
This page discusses the preference folder. If you would like to learn about the preference window please
visit Preference Window

Your Mixbus preferences are stored in 2 places:

Session->Properties

• This stores the preferences for the current session
• For more details see Session Properties Window

Edit->Preferences ( or Mixbus->Preferences on Mac OSX )

• This stores your global preferences which are applicable ALL sessions
• For more details, see Preferences Window

Preferences file location, and clearing the preferences:
Mixbus preferences are stored in the Mixbus preference folder. The location of the folder varies with each
OS ( Mac, Windows, or Linux )

You can clear your preferences by deleting a single file or the entire Mixbus preferences folder. If Mixbus
cannot find a preferences folder or file, it will create a new one with default contents. More details about the
Preferences folder can be found in Power-User Topics.
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24. Clocks & Synchronization

Clocks
Mixbus provides two clocks which display the current position of the playhead. Having 2 clocks is a
convenience: for example you can leave one clock showing “musical” time (such as bars/beats) while the
other clock shows time in hours:minutes: seconds.

Right-click on a clock to change the mode of the clock. A menu appears with the available options.

Some clock modes have smaller sub-displays which show the current meter/tempo, SMPTE format, or
sample rate (in applicable modes).

It is possible to click on a clock and directly enter a time code location directly. Pressing “Enter” will locate
the playhead to the new time.

Synchronization
Mixbus allows selection of several synchronization sources: Internal, LTC, MTC, and JACK

• Internal: The playhead position is defined by Mixbus; all transport commands come from Mixbus.
• LTC: The playhead position and transport state will be determined from incoming LTC (SMPTE)

timecode.
• MTC: The playhead position and transport state will be determined from incoming MIDI Time Code.
• JACK: The playhead position and transport state will be determined from JACK. Transport commands

initiated from Mixbus will be applied to all JACK-synchronized programs. (JACK is a third party
program, and is not included with Mixbus 3, however, MB3 can utilize JACK if it is installed in your
system.)

To learn more about clocks in the transport toolbar, visit the Transport Bar section.*
Note: There are several other clocks in Mixbus, such as the Nudge clock and the SMPTE
offset clock. These clocks can also be set to any mode, so you can (for example) set the
nudge clock to advance in bars:beats instead of minutes:seconds.
*

Tip: you can point at a clock element (minutes, seconds, beats, or whatever) and use the
mouse-wheel (or 2-finger scroll on a touchpad) to quickly tweak the value without entering it
manually.
*
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• Time Master (JACK only): Only one JACK-synchronized program can be the “Time master”. When
JACK sync is used the timelines of the synchronized programs are located using the sample-clock
offset. Since different programs may have different tempo maps, or methods of handling musical time,
the “time master” identifies the machine that will define the musical time (bars/beats) position of the
song. This is for advanced users only.

Note: A list of JACK-aware programs is listed at: http://jackaudio.org/applications*
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24.1. External Synchronization

Synchronization
Mixbus can synchronize to external hardware or software in three ways:

• LTC (Linear Time Code, sometimes called SMPTE) fed from an audio input.
• MTC (Midi Time Code) fed from a MIDI input
• Midi Clock (sometimes called Midi Beat Clock) fed from a MIDI input
• JACK

In all 3 cases, Mixbus can be the source ( it sends the timecode to the other devices or software) or a
destination (in which case Mixbus will “chase” the other source). In most cases, the digital workstation
should be the Master (source) device, so Mixbus will normally be the Master. But there are cases when you
need to do it the other way, too.

Each method has different requirements and capabilities.

• LTC (sometimes called SMPTE) uses a channel of audio to encode a continuously-running timecode
position. The master device generates this signal, and the chasing devices use this stream to
determine the master’s position and speed. LTC has the benefit of using everyday audio signals for
sync, but the underlying software has to be pretty smart to decode the position. Implementations vary
from very good to very bad.

• MTC is similar to LTC, but uses a MIDI channel to encode the position. It is much easier for
developers to interpret, and it uses widely available MIDI cables and connections. However it is
slightly less robust because of the decoupling between the MIDI and the audio clocks in most
computers.

• JACK allows 2 or more software applications on your computer to share their timecode position and
speed, without any audio or MID connections required by the user. JACK synchronization has several
benefits over MTC & LTC, but it is not likely to be available on most commercial software, or external
gear like a drum machine.

The “Internal/External Sync” button enables or disables external chase. If external sync is disabled, the
button shows “Internal”, and Mixbus will use its own internal clock and transport controls.

Regardless of the “Internal/External Sync” button, Mixbus always sends sync, so other*
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You select the synchronization source from the Preferences. Sync source is globally selected, it doesn’t
change with each session you have open. This matches most people’s needs, since most people have a
studio setup that doesn’t change depending on the session they are using.

When syncing to external timecode, you will see a display showing the current external timecode value, and
a “Delta” value indicating Mixbus’s offset from the master device:

Mixbus’s timecode sync functions are largely developed by the Ardour open-source community. For more
details, see the applicable chapters in the Ardour manual: http://manual.ardour.org/synchronization/
timecode-generators-and-slaves/

machines can follow it.
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24.2. Transport and Timecode Sync
External transport is composed of 2 different mechanisms:

1. Transport position ( for example: measure 4, beat 2, or SMPTE location 00:05:01.5 )
2. Transport speed ( for example: playing, stopped, or rewinding )

Methods of Transport and Timecode Sync using MIDI

MMC ( “midi machine control” ) sends commands like Play, Stop, Locate, and Rewind when they are
initiated by the master.

MTC ( “midi transport control’” ) sends a continuous stream of the master’s position. From this, the playback
speed can be derived.

Often MMC and MTC are combined in a single MIDI wire, to provide actions like “locating”, as well as
continuous transport position of the master.

It is also common to send MMC commands from multiple machines to the Master machine. in this way,
pressing the “Play” button on a remote machine can tell Mixbus to start playing. Mixbus then sends MTC
timecode to all chasing machines so they sync to the master’s position.

Methods of Transport and Timecode Sync using audio

LTC ( “Linear Time Code” ) typically uses the SMPTE protocol to provide the current position, like MTC. It is
sent at a higher rate than MTC and can therefore provide more accurate time sync. LTC requires an audio
port on the master & slave devices. LTC is common among professional video equipment, but not very
prevalent among musical devices such as drum machines.

Factors that affect quality of synchronization

It is recommended that the digital recorder (usually Mixbus) is the master device, and sends a sync signal to
the slave device(s).

To maintain “perfect” sync between 2 devices, you should use digital devices that are driven by a common
master sample-rate clock. If 2 devices are using the same digital clock, then once sync is achieved, both
devices will play at the same rate. This is why it is important to use a master sample-clock when possible.

The quality of the synchronization will be heavily dependent on the quality of the sync signal from the
master machine, and the ability of the slave machine to follow the sync signal.

MIDI input&output from a computer suffers from problems of “latency” (delay) & “Jitter” (changing delay).
This is worst with USB-connected devices which are subject to the USB protocol buffering. For this reason,

Harrison Consoles Mixbus - 9_en

Page 686 of 848



Generating an external clock from Mixbus ( Mixbus is Master )

This method is preferred when you’d like to sync an external device ( like a drum machine ) to Mixbus. This
is the most common use for MTC/MMC synchronization.

By default, Mixbus is already configured to send MTC/MMC. To send the sync signal to an external device,
the user must only connect Mixbus’s MTC+MMC ports to the appropriate MIDI wire. To do that, click on
Window->MIDI Connections. Then select “Mixbus Misc” on the left tab, and “Hardware” on the bottom tab.
Then click in the grid to make connections, as shown below:

Syncing Mixbus to an external clock ( Mixbus is Slave )

Mixbus can respond to external timecode control ( via MMC or OSC ) or timecode sync ( via MTC or
LTC/SMPTE audio )

External Sync is initiated with the “Internal/External” sync button, to the right of the transport buttons on the
editor.

Synchronization sources and options are set in the Preferences Window

When slaved to an external clock, Mixbus uses a high quality DLL (delay-locked-loop) to stabilize the
incoming signal. This allows Mixbus to synchronize closely with an external signal, even if it has a lot of
jitter.

If the sync source uses the same digital master clock as Mixbus, then once sync is achieved, they are
guaranteed to continue playing & recording at the same rate.
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If the 2 sources do NOT have the same sample-rate clock, then Mixbus’s behavior changes between
playback and recording:
1) When playing back material, Mixbus will speed up & slow down to match the incoming clock position.
2) When recording material, Mixbus will achieve sync when recording starts, and recording will continue at
the sample-clock rate, regardless of the changes in the incoming clock position.

Also see External Synchronization

Mixbus’s transport and timecode sync functions are largely developed by the Ardour open-source
community. For more details, see the applicable chapters in the Ardour manual:

• http://manual.ardour.org/synchronization/timecode-generators-and-slaves/
• http://manual.ardour.org/synchronization/overview-of-timecode-related-settings/
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24.3. Transport Masters
To access the Transport Masters dialog, go to the Window menu and choose “Transport Masters”.

In the window the user can select the Mixbus clock source. Four choices are available:

• JACK
• MTC (MIDI Time Code)
• LTC (Linear Time Code) (SMPTE)
• MIDI clock

Controls

• Select: select which of the timecode inputs that Mixbus will chase
• Name: in the case of multiple timecode sources of the same type, the user may assign a name here.
• Type: one of the available sync options: LTC, MTC, or Midi Clock
• Source: Select the appropriate audio (for LTC) or MIDI (for MTC/Midi Clock) input
• Format: a display of the incoming timecode format. Determined automatically. This cannot be

changed.
• Sync Position + Delta: the current timecode position of the sync engine, and its delta with respect to

this timecode source (in seconds, milliseconds, or samples)
• Last Message + Age: the value of the last message received at the input, and the time it was

received (if this isn’t changing then it suggests your input is not clean)
• Active Commands: some TC formats can send transport commands embedded in the timecode. Set

the options you’d like to activate here.
• Clock Synced: if the timecode source uses the same digital clock as Mixbus, then you should select

this option. It allows Mixbus to sync more quickly and closely since we know the speeds of the 2
devices are identical.

• 29.97/30 : check this box to indicate that the timecode source is 29.97
• Remove (only available for user-added timecode sources)

Add a new transport master: Click this button to create a new LTC, MTC, or Midi Clock source. You may
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have multiples of each source, and choose which one to chase.

Keep Rolling if sync is lost: in an important recording, you might prefer for Mixbus to continue playing/
recording even if the sync input is lost or no longer matches Mixbus’s transport state.

Previous versions of Mixbus would not permit recording during varispeed operation. Starting
in v6, Mixbus will varispeed to chase the clock source selected, and allow recording while
varispeeding.
*
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25. External Control

Mixbus can respond to external controllers using 4 different
protocols:

Generic MIDI ( also called “MIDI Learn” )

Mixbus can accept MIDI control-messages from any MIDI-enabled device that sends CC (continuous
controller) or NRPN messages. Many MIDI keyboards include MIDI controller knobs and switches that can
be bound to Mixbus mixer-strip controls or transport controls.

Mixbus can use controls directly by using “MIDI Learn”. With this method, you tell Mixbus exactly what
control you want to adjust on-screen, and then you turn your physical controller to “assign” it to that knob.

Alternatively, you can use a pre-defined “Binding map” which preconfigures your device’s controls to work
with Mixbus. You can choose from a predefined list, or you can create your own binding file, and share it
with other Mixbus users.

Mackie MCU

The “Mackie Control” protocol allows controllers with motorized faders (typically 8 or more) to control the
Mixbus mixer.

Presonus Faderport

The Presonus Faderport is an inexpensive controller with 1 motorized fader, one knob, and several buttons.
Mixbus provides a dedicated control mode for the Faderport.

OSC control

OSC ( Open Sound Control ) is a network protocol that allows you to control Mixbus from an ethernet-
connected controller.

Enabling External Controllers

Mixbus will recognize a number of external controller protocols, but the ones you need must be enabled in
Edit -> Preferences -> Control Surfaces.
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Enable the controller protocol you need by checking the box for the controller you have.
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25.1. MIDI Control Surfaces
Generic MIDI Control

https://www.youtube.com/embed/xfdSe2aPKDI?rel=0
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Mixbus can respond to MIDI control messages such as transport control, knobs, sliders and switches.

MIDI remote-control protocols are largely developed by the Ardour open-source community, and you can
find documentation on the Ardour website.

Mixbus uses 2 different mechanisms for MIDI control surfaces:

• MIDI Learn: http://manual.ardour.org/using-control-surfaces/generic-midi/midi-learn/
• MIDI Binding Maps: http://manual.ardour.org/using-control-surfaces/midi-binding-maps/

https://www.youtube.com/embed/k0UBT3MScZE?rel=0
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25.2. Mackie MCU-compatible fader
controllers

https://www.youtube.com/embed/ywl_YMh8j9A?rel=0
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Mixbus supports fader controllers that use the Mackie “MCU” protocol

To use a Mackie control device, you must follow these steps:

1. Consult the device’s manual, and configure the device for “Mackie Control” protocol ( not HUI )
2. Open Preferences->Control Surfaces, and click the checkbox to enable “Mackie”
3. Double-click the Mackie line to open the configuration panel.
4. Choose your device, or the closest equivalent, from the “Device Type” list
5. Choose the MIDI input and output ports for the device

…. after step 5, the faders should immediately jump to their correct position.

Because the capabilities of fader controllers vary widely, you may find that some buttons don’t exist, or don’t
work as expected, on your device. The documentation below applies to the original Mackie MCU, and very-
similar devices such as the Behringer X-Touch.

Encoder Assign Buttons:

The Encoder Assign buttons define what the knobs above each fader do.

https://www.youtube.com/embed/RoNzXnUNrDQ?rel=0
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• Track: To use the Track controls, you must first “select” a channel using a channel Select button. The
8 knobs will switch to show the channel’s Input trim, solo isolate, solo lock, and polarity switches.

• Pan/Surround: This is the default setting. When this is selected, each channel’s knob will control its
pan. Clicking the knob will toggle the master bus assign on/off.

• EQ: To use the EQ controls, you must first “select” a channel using a channel Select button. The 8
knobs will switch to show the selected channel’s EQ settings (this varies for channels vs mixbuses vs
master bus )

• Send: To use the Send controls, you must first “select” a channel using a channel Select button. The
8 knobs will switch to show the channel’s mixbus send levels. You can adjust the send level with a
knob, or click the send to enable/disable it. You may also click the “Flip” button to control the mixbus
send levels from the fader.

• Plug-In: this feature is currently unimplemented.
• Inst: For Mixbus, “Inst” is used to control the channel compressor. To use the Compressor controls,

you must first “select” a channel using a channel Select button. The 8 knobs will switch to show the
selected channel’s compressor settings.

Global View Buttons:

The Global View buttons select which subset of available channels will be visible on the fader surface.

• Global View : this resets the view to showing channels in sequential order, with the first available
mixer channel on the far left of the surface.

• MIDI Tracks: this shows only the MIDI (instrument) tracks on the surface. Audio tracks and buses will
be skipped over, if you adjust the Channel or Bank buttons.

• Inputs: This shows “buses” that were created with the New Track dialog. Buses are often used as live
inputs to the mixer. MIDI tracks, audio tracks, and mixbuses will be skipped over, if you adjust the
Channel or Bank buttons.

• Audio Tracks: this shows only the Audio tracks on the control surfaces. Midi tracks and buses will be
skipped over, if you adjust the Channel or Bank buttons.

• Audio Inst: This operates the same as MIDI Tracks button.
• Aux: This operates the same as the Inputs button.
• Buses: This shows the mix buses.
• Outputs: Currently unimplemented; this will show the Click (metronome), Auditioner (solo bus), and

Monitor buses in the future.
• User: This shows the first 8 channels that are “selected” in the mixer GUI. This allows you to select a

discontiguous collection of channels, and control them side-by-side on the control surface.

The EQ, Send, and Dyn (“Inst”) modes will follow the selected channel. Selecting EQ mode,
and then selecting a different channel, will continue to show the EQ knobs, but for the new
channel. This is a very nice way to advance through your channels and adjust each
channels EQ, in turn.

!
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Function Buttons:

The 8 Function buttons can be assigned any “action” ( keyboard shortcut ) in the Macke setup dialog.

Modify:

The Modify buttons are used, similar to modifiers on your keyboard, to add additional features to the Mackie
protocols. For example, Shift+Undo is “Redo”. Note that the Mackie modifier keys do NOT affect what you
are doing with the keyboard/mouse. The “Shift” key is largely used for default functions. The “Control,
Command, and Alt” buttons are reserved for users to assign their own actions.

Automation:

The Automation buttons apply to the selected track’s fader. The “Group” button currently turns automation
OFF. “Latch”, and “Trim” are currently disabled, but these features will be added in the future.

Utility:

• Save: Saves the currently-opened session snapshot
• Undo: un-does the most recent editor operation (such as a recording). Shift+Undo to “redo”.
• Cancel: Deselects all tracks and objects.
• Enter: Selects all tracks.

Transport:

• Marker: Creates a new marker. Shift+Marker deletes the marker (if one is currently under the
playhead). Marker+ffwd = next marker; Marker+rewd = last marker

• Nudge: Combined with the ffwd/rewind buttons, this will nudge the playhead forward or back.
• Cycle: This initiates a “loop” playback between the Loop markers, if you are currently playing.

Shift+cycle = use currently selected range as the Loop range.
• Drop: sometimes called “Mark In”: This uses the current playhead location to set the selection start

time. Shift+Drop = Toggle Punch IN.
• Replace: sometimes called “Mark Out”: This uses the current playhead location to set the selection

end time. Shift+Replace = Toggle Punch OUT.
• Click: this toggles the Click (metronome) on and off. Shift+Click = Set Punch range to current range

selection.
• Solo: This clears any track solo’s that are currently engaged. Shift+Solo =
• Fader Bank: this advances the faders by 8
• Channel: this advances the channels by 1
• Scrub: currently no function is assigned to this button.
• Zoom: this modifies the directional arrows and Jog Wheel to “zoom” rather than move the view.
• Directional arrows: the directional arrows move the editor view. If the Zoom button is engaged, they

zoom the x and y axes.
• Jog Wheel: adjusting the wheel will move the playhead. If the “Zoom” button is engaged, then the

wheel zooms in&out on the timeline
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The Mackie MCU protocol support is largely developed by the Ardour open-source community. To learn
more about fader controllers using the Mackie MCU protocol, please visit the Ardour manual pages:
http://manual.ardour.org/using-control-surfaces/devices-using-mackielogic-control-protocol/

The Mackie remote-control protocol talks to the Mixbus session directly, and isn’t directly
related to what you see on the screen. However it does follow the order of tracks in the
mixer page, and it does not show “hidden” tracks.
*

Mixbus does not currently support the older Mackie “HUI” protocol. Many devices provide
the “HUI” protocol because it is the only 3rd-party protocol that can be used with ProTools.
However, the HUI protocol is very limited. Nearly every device implements the newer
“Mackie Control” protocol, which provides higher-resolution faders, more buttons, and other
benefits. Mixbus uses this better protocol to talk with your device. Check your device to see
which modes it provides.

*
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25.3. Presonus Faderport (original)

Presonus Faderport

The Presonus Faderport is a one-channel controller with a single touch-sensitive motorized fader, pan knob,
and transport controls. Mixbus has a special mode for the FaderPort which provides dedicated features for
this hardware.

When attached, the Faderport follows the selected (red-bordered) channel. You can change the selection
with the Faderport’s > and < buttons.

The Faderport has these controls:

• Fader
• Pan knob
• Mute / Solo / Rec-Arm
• Channel Select, including Output(*)
• Fader automation mode: Read, Write, Touch, Off

https://www.youtube.com/embed/tht2eiJIjiA?rel=0
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• Undo ( shift+Undo to redo )
• Punch : blinks when auto-punch (in or out) is enabled
• Transport Controls including Loop, Markers, and Goto Start/End, as shown.
• Mix, Proj, Trns, and User are user-assignable buttons, see below.

The “Bank” button is currently unused.

The Faderport’s control panel provides a means to assign functions to the various buttons:

Remote-control protocols are largely developed by the Ardour open-source community, and you can find
documentation about the FaderPort on the Ardour website: http://manual.ardour.org/using-control-surfaces/
Presonus_FaderPort/

Clicking the “Output” button will cause the Faderport’s fader and mute to control the Master
bus. Holding Shift+Output will cause the Faderport to control the MONITOR bus fader and
mute.
*

It is not currently possible to assign the Faderport to a VCA fader, but we expect to add this
feature immediately after v4.0.*

Harrison Consoles Mixbus - 9_en

Page 701 of 848

http://manual.ardour.org/using-control-surfaces/Presonus_FaderPort/
http://manual.ardour.org/using-control-surfaces/Presonus_FaderPort/


25.4. Presonus Faderport, Faderport8 and
Faderport16
Presonus Faderport8

The Presonus Faderport8 is an eight-channel controller with eight touch-sensitive motorized faders, a multi-
purpose encoder knob, and transport controls. Mixbus has a special mode for the FaderPort8 which
provides dedicated features for this hardware.

The Faderport8 may be used as an MCU device, but most users will prefer to use the custom “Faderport8”
mode. In this mode, the Faderport8 closely matches the behavior described in the Faderport8 manual when
controlling Presonus StudioOne. ( Presonus and StudioOne are trademarks of Presonus ).

To enable the Faderport8, visit the settings in Preferences->Control Sufaces:

Mixbus’s Faderport8 operation was funded by Harrison, and developed largely by the Ardour open-source
community. You will find up-to-date documentation for the Faderport8 operation at:
http://manual.ardour.org/using-control-surfaces/PreSonus_FaderPort8

The Faderport16 operates identically to the FP8, but it provides 16 faders.*
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25.5. Tascam US-2400
The Tascam US-2400 was produced from roughly 2007 – 2010. It provides 24 channels, each with a fader,
mute+solo+select switches, and a knob with led indications. It also has a master section with a master
fader, transport controls, and function keys.

Connecting the US-2400:

The US-2400 provides 6 separate MIDI input and output ports. Select the 4 input and 4 output ports as
described in the control panel.

The fifth pair of ports may be used as a “Generic MIDI controller” or for some other task.

The sixth pair of ports is unused. We believe this is likely used to light the “bank indicator LEDs” on the unit,
but no documentation has been found for this feature.

Function Keys:
Hold the “F-Key” button and press F1..F6 to trigger a function button. you can assign the action of the
function button as well as some other “Shifted” buttons using the “Function Keys” tab:

To utilize the US-2400, first make sure to set the unit to mode “4”. Refer to the US-2400
manual to set modes.*
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Operating the US-2400:
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Each channelstrip provides a touch-sensitive fader, Mute, Solo, and Select switch. By default, the
channelstrip knob provides left/right pan control of the channels. When the Select switch is lit for a channel,
the channel’s parameters are mapped to the 24 knobs:

Mixbus32c Input Mixbus Input Mix-Bus Master-Bus

1 Input Trim Input Trim Input Trim Input Trim

2 Left/Right Pan Left/Right Pan Input Trim unused

3 Compressor Threshold Compressor Threshold Compressor Threshold Compressor Threshold

4 Compressor Speed Compressor Speed Compressor Speed Compressor Speed

5 Compressor Mode Compressor Mode Compressor Mode Compressor Mode

6 Compressor Makeup Compressor Makeup Compressor Makeup Compressor Makeup

7 High-Pass Filter Freq High-Pass Filter Freq Tape Drive Tape Drive

8 Low-Pass Filter Freq Band 1 Gain Band 1 Gain Band 1 Gain

9 Band 1 Freq Band 1 Freq Band 2 Gain Band 2 Gain

10 Band 1 Gain Band 2 Gain Band 3 Gain Band 3 Gain

11 Band 2 Freq Band 2 Freq unused unused

12 Band 2 Gain Band 3 Gain unused unused

13 Band 3 Freq Band 3 Freq unused unused

14 Band 3 Gain unused unused unused

15 Band 4 Freq unused unused unused

16 Band 4 Gain unused unused unused

17 Mixbus Send 1 Level Mixbus Send 1 Level unused unused

18 Mixbus Send 2 Level Mixbus Send 2 Level unused unused

19 Mixbus Send 3 Level Mixbus Send 3 Level unused unused

20 Mixbus Send 4 Level Mixbus Send 4 Level unused unused

21 Mixbus Send 5 Level Mixbus Send 5 Level unused unused

22 Mixbus Send 6 Level Mixbus Send 6 Level unused unused

23 Mixbus Send 7 Level Mixbus Send 7 Level unused unused

24 Mixbus Send 8 Level Mixbus Send 8 Level unused unused

https://www.youtube.com/embed/QHJwTncc2e4?rel=0
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Master Fader
The Master fader has 3 special-function switches:
Select: this selects the Master bus and assigns its controls to the knobs, like any other channel.
Clr Solo: this clears any soloe’d channels and buses
Flip: This switches the first 8 faders (or 12 for 32C) to operate as the mixbuses instead of input channels.

Joystick:
The joystick is only operable in Mixbus32C

To utilize the joystick, first “Select” a channel, and then click the “NULL” button to tell Mixbus32C that the
joystick is active, and send the initial joystick position to Mixbus32C.

The Joystick has these functions:

• Left/Right will pan mixbuses 11 and 12
• Up/Down will adjust the level of mixbusses 11 and 12, in opposite order

Watch the video to see how this can be treated as a “surround panner” for a stereo signal!

Global section:
Click the “Pan” button to return to default operation, showing input channels and their associated pan knobs.

The “Meter” button switches the channelstrip knobs to show the meter level of the associated channel.

The “Chan” button switches the knobs above the faders to operate as 24 generic MIDI knobs which can
send MIDI CC values.

The “Send” buttons have no operation by default. Hold “F” and press one of the 6 Send keys to activate a
Function-key action. F-key actions are configured in the control panel.

Transport controls provide rewind, play, stop and master-record enable.

Bank +/- buttons are provided to increment the faders in banks of 24.

In & Out buttons are provided to trigger “Range select start” and “Range select End” function.
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OSC Control

The OSC protocol can be used to remotely control Mixbus via Ethernet.

OSC Control provides the ability to initiate any “action” (i.e. anything that can be activated by a keybinding),
as well as direct access to editor, track and bus settings. OSC can be used to “script” events in Mixbus
using an external scripting platform. A complete description of OSC is beyond the scope of this manual.

There are 3 common programs used to remotely control Mixbus:

• TouchOSC – see Harrison’s TTC-1 Control Layout for TouchOSC
• Lemur – see Harrison’s LTI Control Layout for Lemur
• Open Stage Control

The following is a summary of the features that are available
from OSC:

• (s) denotes a string argument

https://www.youtube.com/embed/jhr5BLH8AnM?rel=0
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• (i) denotes an integer argument
• (f) denotes a float argument

Sending this message will trigger the associated keybinding “action” in Mixbus:

• /access_action (s)

Transport Functions:

• /add_marker
• /add_marker (f)
• /access_action s
• /loop_toggle
• /loop_toggle (f)
• /loop_location (ii)
• /goto_start
• /goto_start (f)
• /goto_end
• /goto_end (f)
• /scrub (f)
• /jog (f)
• /jog/mode (f)
• /rewind
• /rewind (f)
• /ffwd
• /ffwd (f)
• /transport_stop
• /transport_stop (f)
• /transport_play
• /transport_play (f)
• /transport_frame
• /transport_speed
• /record_enabled
• /set_transport_speed (f)

Editor functions:

• /locate (ii)
• /save_state
• /save_state (f)
• /prev_marker
• /prev_marker (f)
• /next_marker
• /next_marker (f)
• /undo
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• /undo (f)
• /redo
• /redo (f)
• /toggle_punch_in
• /toggle_punch_in (f)
• /toggle_punch_out
• /toggle_punch_out (f)
• /rec_enable_toggle
• /rec_enable_toggle (f)
• /toggle_all_rec_enables
• /toggle_all_rec_enables (f)
• /all_tracks_rec_in (f)
• /all_tracks_rec_out (f)
• /cancel_all_solos (f)
• /remove_marker
• /remove_marker (f)
• /jump_bars (f)
• /jump_seconds (f)
• /mark_in
• /mark_in (f)
• /mark_out
• /mark_out (f)
• /toggle_click
• /toggle_click (f)
• /midi_panic
• /midi_panic (f)
• /toggle_roll
• /toggle_roll (f)
• /stop_forget
• /stop_forget (f)
• /set_punch_range
• /set_punch_range (f)
• /set_loop_range
• /set_loop_range (f)
• /set_session_range
• /set_session_range (f)
• /toggle_monitor_mute
• /toggle_monitor_mute (f)
• /toggle_monitor_dim
• /toggle_monitor_dim (f)
• /toggle_monitor_mono
• /toggle_monitor_mono (f)
• /quick_snapshot_switch
• /quick_snapshot_switch (f)
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• /quick_snapshot_stay
• /quick_snapshot_stay (f)
• /fit_1_track
• /fit_1_track (f)
• /fit_2_tracks
• /fit_2_tracks (f)
• /fit_4_tracks
• /fit_4_tracks (f)
• /fit_8_tracks
• /fit_8_tracks (f)
• /fit_16_tracks
• /fit_16_tracks (f)
• /fit_32_tracks
• /fit_32_tracks (f)
• /fit_all_tracks
• /fit_all_tracks (f)
• /zoom_100_ms
• /zoom_100_ms (f)
• /zoom_1_sec
• /zoom_1_sec (f)
• /zoom_10_sec
• /zoom_10_sec (f)
• /zoom_1_min
• /zoom_1_min (f)
• /zoom_5_min
• /zoom_5_min (f)
• /zoom_10_min
• /zoom_10_min (f)
• /zoom_to_session
• /zoom_to_session (f)
• /temporal_zoom_in (f)
• /temporal_zoom_in
• /temporal_zoom_out
• /temporal_zoom_out (f)
• /scroll_up_1_track (f)
• /scroll_up_1_track
• /scroll_dn_1_track (f)
• /scroll_dn_1_track
• /scroll_up_1_page (f)
• /scroll_up_1_page
• /scroll_dn_1_page (f)
• /scroll_dn_1_page
• /bank_up
• /bank_up (f)
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• /bank_down
• /bank_down (f)
• /use_group (f)

Controls for special strips:

• /master/gain (f)
• /master/fader (f)
• /master/db_delta (f)
• /master/mute (i)
• /master/trimdB (f)
• /master/pan_stereo_position (f)
• /master/select (f)
• /monitor/gain (f)
• /monitor/fader (f)
• /monitor/db_delta (f)
• /monitor/mute (i)
• /monitor/dim (i)
• /monitor/mono (i)

Controls for the Selected strip:

• /select/recenable (i)
• /select/record_safe (i)
• /select/mute (i)
• /select/solo (i)
• /select/solo_iso (i)
• /select/solo_safe (i)
• /select/monitor_input (i)
• /select/monitor_disk (i)
• /select/polarity (i)
• /select/gain (f)
• /select/fader (f)
• /select/db_delta (f)
• /select/trimdB (f)
• /select/pan_stereo_position (f)
• /select/pan_stereo_width (f)
• /select/send_gain (if)
• /select/send_fader (if)
• /select/send_enable (if)
• /select/master_send_enable (i)
• /select/send_page (f)
• /select/plug_page (f)
• /select/plugin (f)
• /select/expand (i)
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• /select/pan_elevation_position (f)
• /select/pan_frontback_position (f)
• /select/pan_lfe_control (f)
• /select/comp_enable (f)
• /select/comp_threshold (f)
• /select/comp_speed (f)
• /select/comp_mode (f)
• /select/comp_makeup (f)
• /select/eq_enable (f)
• /select/eq_hpf/freq (f)
• /select/eq_hpf/enable (f)
• /select/eq_hpf/slope (f)
• /select/eq_lpf/freq (f)
• /select/eq_lpf/enable (f)
• /select/eq_lpf/slope (f)
• /select/eq_gain (if)
• /select/eq_freq (if)
• /select/eq_q (if)
• /select/eq_shape (if)

Track Controls:

• /strip/mute (ii)
• /strip/solo (ii)
• /strip/solo_iso (ii)
• /strip/solo_safe (ii)
• /strip/recenable (ii)
• /strip/record_safe (ii)
• /strip/monitor_input (ii)
• /strip/monitor_disk (ii)
• /strip/expand (ii)
• /strip/select (ii)
• /strip/polarity (ii)
• /strip/gain (if)
• /strip/fader (if)
• /strip/trimdB (if)
• /strip/pan_stereo_position (if)
• /strip/pan_stereo_width (if)
• /strip/plugin/parameter (iiif)
• /strip/plugin/parameter/print (iii)
• /strip/plugin/activate (ii)
• /strip/plugin/deactivate (ii)
• /strip/send/gain (iif)
• /strip/send/fader (iif)
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• /strip/send/enable (iif)
• /strip/name (is)
• /strip/sends (i)
• /strip/receives (i)
• /strip/plugin/list (i)
• /strip/plugin/descriptor (ii)
• /strip/plugin/reset (ii)

Misc:

• /refresh
• /refresh (f)
• /strip/list
• /strip/list (f)
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Lemur

What is Lemur?
Lemur is a very advanced application that lets you build custom OSC and MIDI controller interfaces using a
powerful networking protocol implemented by your favorite digital audio work stations. These interfaces
have numerous applications from live performance to writing and, now, mixing. It runs on both iOS and
Android, allowing users of both platforms to share interfaces and run in tandem.

What is the LTI Lemur Touch Interface?
“LTI” is Harrison’s Lemur interface layout, developed in-house as a remote control surface for Mixbus, using
the Lemur application.

Because the LTI uses the Lemur editor application, the Harrison LTI controller layout may be modified by
you, the end-user.

https://www.youtube.com/embed/yDde6f1eWQ4?rel=0
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Instructions
Here are some instructions for use:

1. If you haven’t already, purchase the Lemur application from your relevant App Store. (Android and
iOS are both supported,)

2. Install the application and make sure it runs correctly on your device
(Generally speaking, we wouldn’t recommend running the LTI on a screen with a resolution lower
than: 1024×768)

3. Go to the Lemur downloads page and download the editor application to your computer or laptop.
4. Install the application to your computer and then open the application.
5. Download the LTI template here and then open it in the editor. It should look a lot like this:

6. Open up the Lemur application on your device and then connect your device to the template editor of
your computer using the play button at the top right of the editor and then verify that it has loaded
correctly on your tablet. This works over WIFI ONLY. You should see a connection like this:
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7. In Mixbus, go to Edit->Preferences->Control Surfaces and enable OSC via the check-box.
Additionally, make sure that “Port Mode:” is set to Auto Reply and not Manual Mode.

8. On your lemur application, open up the settings and make sure that OSC 0: points your computer’s
private wifi address with the port of 3819.
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9. Finally, Press the master connect (the big purple on on the connections interface) button and you
should see the ring around the button start to flash, like a heartbeat. This indicates that Mixbus is
sending signals back to the Lemur interface.
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TouchOSC

What is TouchOSC?
TouchOSC is a remote-control application that runs on iOS and Android phones and tablets.

TouchOSC sends “Open Sound Control” messages to any receiving app. Mixbus has a rich OSC-compatible
remote control API.

TouchOSC is not developed by Harrison; it is developed by Hexler, and it has its own community forums
and website. In keeping with Mixbus’s open-ended development model, users may view, modify, and edit
the TouchOSC layout that we’ve provided for Mixbus.

If you add a great new feature to the TTC-1 layout, be sure to share it with us, and we will incorporate your
changes so other users will get the benefit as well.

What is the TTC-1 layout?
TouchOSC can load different “layouts” which define the location of the buttons and widgets, and what
messages will be sent to Mixbus over the OSC protocol. We’ve developed a layout file that allows you to
remotely control Mixbus’s transport features. Because it needs a name, we called it TTC-1, or “TouchOSC
Transport Controller #1”

Installing and launching the TTC-1 controller layout for
Mixbus:

1. Purchase the TouchOSC application from your phone/tablet App Store. ( Android and iOS are both
supported,)

2. Also download the TouchOSC editor to your Desktop computer, from the TouchOSC web site
3. Download Harrison’s TTC-1 tablet layout here: ttc-1 download
4. On your desktop computer, launch the TouchOSC editor, and “Open” the layout file.
5. In the editor, click “Sync”.
6. In the TouchOSC application (on your phone/tablet), click “Layout -> Add From Editor”.
7. You should see you computer name appear in the “Found Hosts” list.
8. Select the new layout for the TouchOSC app, and you should see the TTC-1 control panel appear.
9. Determine your computer’s IP address on the wireless network that is shared with your phone/tablet.

10. Enter the computer’s IP address in the TouchOSC application.
11. In Mixbus, enable the OSC protocol in Preferences->Control Surfaces.

Using the TouchOSC TTC-1 Controller:
These 2 videos demonstrate the TTC-1 transport controller:
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https://www.youtube.com/embed/ve8ewSUMvCg?rel=0
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https://www.youtube.com/embed/jhr5BLH8AnM?rel=0

https://www.youtube.com/embed/jhr5BLH8AnM?rel=0
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25.6. External Transport Control

Transport Control
Mixbus transport (Play, Stop, Locate, etc.) can be controlled by an external input in 3 ways:

• MMC ( Midi Machine Control )
• OSC ( an Ethernet network protocol )
• JACK ( using the JACK server, if it is installed on your computer )

Mixbus’s external transport functions are largely developed by the Ardour open-source community. For more
details, see the applicable chapters in the Ardour manual: http://manual.ardour.org/synchronization/
overview-of-timecode-related-settings/
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25.7. SSL UF-8 / UF-1
• Mixbus provides dedicated support for SSL’s UF-8 and UF-1controllers via SSL360 software
• Combine up to (4) SSL UF8’s, and a UF1, for 33 motorized faders of mixing
• Direct access to Mixbus’s channelstrip EQ, Sends, and Dynamics from the UF8 knobs
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26. Pre-Installed Plugins for evaluation
Mixbus comes with a number of plugins pre-installed. The ACE plugins do not require any further licensing.
The “XT” plugins do require a separate license for each to enable their control panels. When you purchase a
license for one of these plugins the license file goes in your computer’s Home folder, the same place as
your Mixbus license.

These included plugins require a separate license for each.

XT-3D Triple Delay
XT-BC Bass Character
XT-DC Drum Character
XT-EG Expander/Gate
XT-EQ Equalizer
XT-DS De-Esser
XT-DM Dyno-Mite
XT-GV Gverb+
XT-LC Lookahead Compressor
XT-ME Mastering EQ
XT-MG Micro Glide
XT-MC Multiband Compressor
XT-SC Spectral Compressor
XT-SP Stunning Phaser
XT-TG Tom Gate
XT-VC Vocal Character
x42 EQ
x42 Whirl
x42 Meter Bundle

Unlike most unlicensed third-party plugins, the sound of these plugins is still effective when they aren’t
licensed. So if you share a Mixbus session with someone who doesn’t own a license for these plugins, the
sound as per your settings will remain correct.
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26.1. XT-3D Triple Delay
XT-3D Delay is a creative delay effect. Utilizing 3 separate paths for the Left, Right, or Center(sum), you can
create many different mono or stereo effects.

Best when used on: Vocals, Guitars, Drums and Keyboards.

Controls:

Input High Cut: Moving this slider to the left will decrease the amount of high frequencies that are fed to the
delay effect.

Input Low Cut: Moving this slider to the right will decrease the amount of low frequencies that are fed to the
delay effect.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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L,C,R: the effect has 3 delay paths: one dedicated for the Left, one dedicated for the Right channel, and a
third channel for the Center (sum of left+right). Each channel has an In knob (the level sent to the input of
this delay path), Out knob (output level of this delay path) and a Fine adjust (a small additional delay for this
path, which can be modulated.)

Wet/Dry knob: Turning this knob to the left will result in a 100% Dry sound (no effect is heard). Turning the
knob to the right will result in 100% Wet sound (no dry signal is heard). A momentary button for ‘Dry’ and
‘Wet’ allows you to audition the effect without permanently changing the knob setting.

Wet Level Trim: This knob adjusts the level of the “wet” signal. You can trim the effect up to +/-24dB with
this slider.

Modulation: Increasing this knob will slightly modulate the path delay times. This results in a subtle flanging
or pitch-modulation effect.

Tempo: The tempo may be entered by tapping the Tap button repeatedly, or adjusting the knob. If the
“Host” button is engaged, then the Tap and Tempo knobs will be disabled, and the plugin will use the host’s
tempo.

16th Snap: Engaging this button will lock the 3 delay icons to multiples of the tempo, when they are
dragged. This makes it easier to generate beat-synced effects.

Delay Icons L, C, R: Each of the three delay paths is represented by an icon on the graph. A green signal-
present indicator surrounds each icon, when the delay output has signal. Moving an icon to the left or right
will pan that delay path’s output. Dragging the icon lower will result in a longer delay time.

Presets: Each of these buttons will overwrite all of the current plugin parameters to match a predefined
preset. The selected presets are starting points for the most popular delay effects.

Feedback section:

The feedback section has the most dramatic effect on the effect’s decay. In many cases, you won’t need to
adjust these knobs because they are selected by the Presets. But a deep knowledge of the feedback knobs
will allow an experienced user to realize many sonic possibilities.

LR>C<LR: this knob adjusts the level of the left and right delayed output that is fed to the input of the center
delay path. Turning the knob “left” will feed the left&right output signals into the center’s delay path. Turning
the knob to the right will feed the output of the center path into the left&right paths. This knob is typically
used for spatial effects and long delays.

When the 3D delay is used on a bus, it is conventional to use the effect in 100% “Wet”
setting, and adjust the wet signal from the individual track “send” knobs. So the 3D Delay
uses 100% “Wet” as a default value for this knob.
*
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L<>R: this knob adjusts how much of the left’s output is sent to the right delay input, and vice versa. This
knob is used for ping-pong effects.

Feedback: this knob adjusts the overall level of feedback paths. Increasing the knob will reesult in more
pronounced feedback effect, and may result in howling feedback. For dramatic effects, you can automate
this knob to drive your effects at or near 100% feedback.

Linear: This knob affects each paths’ feedback from its input to its output. This is the most common
feedback mode.

Damping: This knob defines the cutoff frequency for the feedback path. Increase the damping knob to
emulate analog tape-style delays which result in successively less high-frequency content in each feedback
repeat.
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26.2. XT-BC Bass Character
XT-BC Bass Character is an effect intended for acoustic and electric bass instruments.

The Bass Character operates by detecting each musical note when it is played, and then applying an eq to
make the note sound fuller and brighter (or weaker and duller, if needed).

You can use the Bass Character plugin to solve a problem like: an electric bass with too much fundamental
and little harmonic content; or a bass amp that doesn’t provide enough fundamental for the played notes on
a 5-string bass.

Best when used on: Monophonic Bass instruments.

Scale + Spectrum Display:

The Bass Character plugin operates like an EQ, but with one difference: the EQ isn’t set at fixed
frequencies, but rather the eq is applied to each detected note.

The red “spectrum” curve shows the harmonic content of the detected note. The leftmost line indicates the
“fundamental” or first harmonic of the note. Each vertical line to the right indicates an additional harmonic

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*

NOTE: the XT-BC is for mono tracks only.*
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(2nd harmonic, 3rd, etc). You can use this graph to determine the balance of an instrument: whether it has
too much or too little fundamental, for example.

Controls:

The Bass Character plugin has 2 EQ bands: “Body” and “Clarity”. These bands are identical except that the
“Body” control is a low-shelving EQ by default, while the “Clarity” band is a high-shelf EQ.

In/Out switch: The green toggle switch enables/disables each band.

Peaking switch: The yellow toggle switch changes the band to a peaking.

Q slider: when the Peaking switch is engaged, the Q slider engages, and adjusts the Q ( sharpness ) of the
band’s filter.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.3. XT-CC Console Compressor
XT-CC Console Compressor is a full-featured compressor derived from Harrison’s high-end digital consoles.

Best when used on: Anything that needs dynamic level control or enhancement

Controls:

Main Input Threshold: The meter displays the input signal, and you should adjust the threshold to match
the peaks of the input signal, or slightly below. This sets the basic operating range of the compressor.

Gain Reduction meter: This shows the compressor gain reduction, up to the maximum allowable Depth of
15dB

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Gain Reduction History graph: This graph displays the last few seconds of the compressor gain-reduction,
allowing you to view a graphical representation of the compressor’s action over time

Depth: This knob sets the maximum allowable gain reduction that the plugin will apply.

Attack / Release: These sliders affect the compressor attack and release time, respectively.

Pgm (Program-dependent attack and release): allows the plugin to monitor the average level as well as the
peak level, to better retain the punch of drums or other dynamic sources.

Ratio: Increasing the ratio will make the compressor react more aggressively after the threshold is
exceeded. a 3:1 ratio means that an input signal exceeding the threshold by 3dB will only increase 1dB on
the output.

Knee: the knee affects the ratio so that the full ratio isn’t achieved until the input signal exceeds the
threshold by the ‘knee’ amount. Given a 3:1 ratio, and a 4dB knee, the ratio will be 1:1 when the signal
reaches the threshold, and the ratio will also increase until the full 3:1 ratio is being applied when the signal
exceeds the threshold by 4dB.

Makeup: this applies a volume-boost to the output signal. The operation of a compressor can reduce the
average level of a signal. Makeup-gain is provided to increase the output of the compressed signal.

External SC: enable this to have the compressor key from a ‘sidechain’ signal instead of the input signal.

Sidechain Listen: enable this to listen to the sidechain signal. This signal is post-sidechain-eq. If you have
selected an external sidechain then you will hear the external sidechain signal with the EQ applied.

Sidechain EQ: enable this to listen to apply an EQ to the sidechain signal. This can customize the
compressor’s action to emphasize or ignore a portion of the sidechain signal.

Sidechain EQ (shape): choose from the 7 available eq shapes

Sidechain EQ (graph): adjust the sidechain EQ’s frequency and gain (where applicable)

Presets: four starting presets are provided to apply settings of some common compression tasks. In many
cases you only need to adjust the threshold to match the input signal, to achieve a good compressor sound.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.4. XT-CQ Console EQ
XT-CQ Console EQ is a full-featured, unapologetically digital, parametric equalizer with a unique Search
Bar that helps you find and eliminate troublesome frequencies.

• 8 EQ bands with 20-20kHz range, 8 shapes including Notch, Q’s up to 100, and 18dB boost/cut
• 2 ‘steep’ filter bands (A&B) with HP/LP slopes up to 48dB/octave and a wide-notch shape
• Symmetric digital (‘de-cramped’) EQ & filter shapes are pre-warped to balance the response near

Nyquist
• Wide Notch filter shape provides a notch with a wider footprint to eliminate main power hum
• Innovative Search Bar provides a waterfall display of your signal, allowing you to see and hear the

frequencies you need to adjust:
• Grab a triangle to solo the equalizer band, and fine-tune the frequency you need to boost or cut
• Piano display helps you visualize the connection between frequencies and their musical significance
• Input & Output meters, and an output-trim slider, allow you to match the level of the equalized & dry

signal
• 6 preset ‘starting points’ provide common settings for the most common EQ tasks

Best when used on: Anything that needs serious equalization repair-work

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Controls:

Input Meter (IN): Reports the average intensity (volume) of the input signal (in stereo operation, this meter
shows only the Left side)

Output Meter (OUT): Reports the average intensity (volume) of the output signal, after it has been
processed by the EQ (in stereo operation, this meter shows only the Left side)

Trim: This slider adjusts the post-eq level. When applying wideband EQ, you can use the Trim slider to
match the input and output meters more closely. Combined with the Momentary Bypass (below), this allows
you to compare the pre- and post-eq signal with a compensated volume.

Presets: six starting presets are provided to apply settings of some common compression tasks. In many
cases you only need to adjust the threshold to match the input signal, to achieve a good compressor sound.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.5. XT-DC Drum Character
The XT-DC Drum Character is an effect intended for use on acoustic percussion instruments, particularly
snare and bass drums.

The Drum Character plugins operates by producing two distinct EQ curves on each of the primary part of a
percussion sound, the transient and the tail.

This allows you to control the exact sonic character of the initial hit of of the instrument (attack), as well as
the roll off (or tail).

Best when used on: Individual drum/percussing instruments

Attack & Tail Parametric EQs: The Drum Character plugin features two parametric EQs allowing you to
EQ both the attack and the tail different from one another

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Attack & Tail Waveform Display: Here you can choose where on the transient the attack and the tail
actually sit. This display is updated every time a new transient passes through.

Input Threshold: This vertical slider controls the amount of material that gets into the plugin.

Trim: This vertical slider allows you to trim the plugin output so the apparent volume after processing
remains the same as the unprocessed signal.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.6. XT-DM Dyno-Mite
XT-DM Dyno-Mite follows the dynamics of your track. It detects when the sound is “decaying” (gradually
diminishing after a louder transient). Dyno-Mite affects the decay rate, either lengthening or truncating the
sustain.

Best when used on: *Drum loops; MIDI drums; Drum overheads; Individual drum sounds.

Controls:

Threshold: The leftmost bar shows in the input signal level, and a slider to adjust the processor threshold.
The threshold should be set below the signal peaks shown on the meter. The lower the threshold is set, the
more pronounced the effect will be.

Sustain: the central knob controls the Sustain.

If you turn the knob to the right, this will increasingly add gain while the signal decays, resulting in a longer
sustaining sound. This is sometimes called “upward compression”. Room ambience will be increased along
with the decay of the signal.

If you turn the Sustain knob to the left, Dyno-Mite will accentuate the decay by reducing the level faster than
the unaffected signal. This results in a gated or “expanded” sound, with sharper transients and less room
ambience.

The meter displays the amount of gain increase (in green) or decrease (in red). When the Sustain knob is
set very low, an automatic makeup gain is applied. You will see this gain appear on the display.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Out Trim: the rightmost bar provides a trim control. You can use this control to adjust the final output level
after the effect is applied.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.7. XT-DS De-Esser
The XT-DS De-Esser is Harrison’s transparent, powerful plugin for taming excessive sibilance of vocal
tracks.

Input Meter, Threshold, and Ess meter:
The “Threshold” slider for the effect is overlaid on the input (“In”) meter.
Lowering the threshold will increase the sensitivity of the de-esser effect.
The “Ess” meter indicates the signal level inside the ess band. If the frequency band is set correctly for the
source material, then this meter will peak when Essy material is present.
Ess Freq and Ess Depth Control:
This section allows you to pick the low frequency cutoff (200 Hz – 8kHz) for the Ess, and the max
attenuation for the signal (-12dB – 0dB).
Hi Freq and Hi Depth Control:
This section features a shelving unit to tame some of the higher frequency (2 kHz – 12 kHz) content after
you’ve pulled out the ‘Ess’. Max attenuation for the shelf is -12dB.
Ess Center and Ess Width Control:
The ‘Ess Center’ control allows you to adjust both the Ess Freq and Hi Freq controls together allowing you
move the entire Ess Band in unison. The ‘Ess Width’ control allows you to control how wide or narrow the
Ess bandwidth is.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Attack:
The ‘Attack’ knob controls how long it takes the signal to get to from zero to full attenuation. (200μs – 20ms)
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26.8. XT-EG Expander/Gate
The XT-EG Expander / Gate is Harrison’s versatile tool for gating noise or gently increasing the dynamic
range of tracks.

Controls

Input Threshold: This vertical slider affects the onset of the Expander/Gate effect. You should set the
threshold to match the level of signal you want to hear. Signals quieter than this threshold will be affected.

Depth: this affects the maximum gain reduction that the effect will apply. For a full gate, you should set this
value to maximum. For gentle expansion, you should use a lower value.

Hold(ms): when the gate is “opened” by a loud-enough signal, the hold time ensures that the gate stays
open for at least this time. This knob is only operable when the “Expand” button is not engaged

Hysteresis: when the gate is “opened” by a loud-enough signal, this prevents the gate from closing until the
signal reduces by this much below the threshold. This knob is only operable when the “Expand” button is
not engaged

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Expand: when this button is engaged, the Hold and Hysteresis knobs are disabled, and the Ratio and Knee
controls become enabled.

Ratio: The ratio defines the aggressiveness of the expansion mode. A low ratio will require the signal to be
significantly lower than the threshold, before much gain reduction is applied. This knob is only operable
when the “Expand” button is engaged

Knee(dB): this knob affects the onset of the gate. A larger knee means that the effect’s onset will operate
as if the threshold were lower, but the onset of the gain-reduction will be more gradual. This knob is only
operable when the “Expand” button is engaged

Attack(ms): this adjusts how quickly the gate can “open” when a signal exceeds the threshold.

Release(ms): this adjusts how quickly the gate can close again, after the signal reduces below the
threshold.

Lookahead: Using lookahead allows the gate to open “before” the onset of a signal above the threshold;
this can prevent (for example) cutting-off the front of a drum hit. There are 2 levels of lookahead. When
lookahead is engaged, the plugin will report some latency to the host, so the host can delay other tracks to
match the drum sound back to its un-delayed timing.

Sidechain Controls

The “sidechain” is the signal-detector inside the expander/gate. Filtering the sidechain does not result in a
change to the sound of the signal, but it does affect how the gate opens/closes. For example, if you want to
gate a snare drum, it is often desirable to find and accentuate a strong frequency of the snare drum, so the
gate is more sensitive to that sound.

Sidechain Filter: Click this button to enable the sidechain filter.

Listen: Click this button to listen to the sidechain signal, with the filter applied.

Q: This adjusts the sharpness of the filter band.

Frequency: This moves the frequency of the band to boost. Move the filter until the sound you want to
expand/gate is accentuated, and other sounds are not.

The XT-EG does not have an external input to feed a sidechain signal other than the main
input. We might add this feature in the future.*
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26.9. XT-EQ Equalizer
Harrison’s XT-EQ Equalizer is a cost-effective, smaller version of the XT-ME Mastering EQ for tracks and
final mixes.

The XT-EQ has 10 bands of equalization. The filters provide a “flat top” response, meaning: if you boost 2
adjacent bands, the gain between the bands will be consistent. (unlike a traditional graphic eq, where 2
adjacent filters will create a camel-hump)

Each band has approximately 1 octave bandwidth. This makes the XT-EQ a very fast tool for focusing
instruments on their representative frequency ranges, and reducing (but not completely filtering) the range
outside their focus. The XT-EQ is an excellent mixing tool.

To adjust the eq, simply click anywhere and drag to “draw” the desired EQ curve. Because of the broad and
even pass-band between bands, “what you see is what you get”.

It is possible to adjust a single band (like a graphic eq) by clicking in the band and draggin up/down. Or
point your mouse at a single band and use the mouse-wheel to adjust only that band.

Hold “Shift” and drag across the EQ to reset the bands to 0dB.

Trim: This is a clean volume control that adjusts the output level. If you use a lot of EQ “cuts” then you may

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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need to increase this to match the level. And vice versa.

Momentary Bypass: Click and hold this button to momentarily defeat the EQ. It is a good idea to use the
Trim control to adjust the volume of the EQ’d signal so you can compare the effect of the EQ, and not just
the level difference caused by the EQ.
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26.10. XT-GV Gverb+
XT-GV Gverb+ is a creative reverb effect. Utilizing an algorithm that produces natural room sounds and lush
reverb effects alike.

Best when used on: Vocals, Guitars, Drums and Keyboards.

Controls:

Input High Pass Filter: Moving this slider will decrease the amount of low frequencies that are fed to the
reverb effect.

Input Low Pass Filter Moving this slider will decrease the amount of high frequencies that are fed to the
reverb effect.

Early Mix Every reverb has two distinct characteristics: Early reflections, and the reverb’s “tail”. Early
reflections define the shape characteristic of the room, and typically make it sound more natural as that is
how our ears typically hear a reverberation in the real world. The tail is a lush wash of reverberations that

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page The XT-GV Gverb+ used to be called simply “Gverb+” and was
part of the Plugin Essentials pack, but has since been separated. You may still see
literature that references its former status.

*
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tend to make reverb sound unrealistic. This slider controls the balance of the two.

Size The size slider controls the overall feeling of the ‘size’ of the room. Turning this down can cause the
reverb characteristic to become more personal or up-close. While turning it up can cause the characteristic
to feel as if you are in the back of a cathedral.

Decay The decay slider determines how long a reverb’s tail takes to “dissipate” or “fall off”.

Pre-Delay The Pre Delay controls the amount of time between the dry sound, and the early reflections and
reverb tail. Careful adjustment of this knob, or using multiple buses with different pre-delay values, can help
bring out elements in a mix. Typically this works great on a vocal that you want to stand out.

Damping The damping control controls the amount of amount of high frequency content in the reverb.
Dampening high frequency content helps promote a warmer reverb characteristic and sound.

Wet/Dry knob: Turning this knob to the left will result in a 100% Dry sound (no effect is heard). Turning the
knob to the right will result in 100% Wet sound (no dry signal is heard). A momentary button for ‘Dry’ and
‘Wet’ allows you to audition the effect without permanently changing the knob setting.

Wet Level Trim: This slider adjusts the level of the “wet” signal. You can trim the effect up to +/-24dB with
this slider.

When the Gverb+ reverb is used on a bus, it is conventional to use the effect in 100% “Wet”
setting, and adjust the wet signal from the individual track “send” knobs. So the Gverb+
reverb uses 100% “Wet” as a default value for this slider.
*
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26.11. XT-LC Lookahead Compressor
XT-LC Lookahead Compressor is a solution for very demanding compression tasks such as acoustic guitar,
full mixes, and live vocals. The XT-LC’s lookahead design can work where other compressors fall short.

Controls

Threshold: The triangle indication on the wide meter arc indicates the compressor threshold.

Ratio: The ratio knob controls the strength of the compression effect.

Knee: The ‘knee’ control defines how far the signal must exceed the threshold to achieve full compression.
A smaller knee setting will result in more aggressive compression.

Makeup Gain: The ‘Makeup Gain’ control allows you to apply additional gain to the output signal, to ‘make
up’ for the attenuation applied by the compression.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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26.12. XT-ME Mastering EQ
The XT-ME Mastering Equalizer is Harrison’s fastest, most precise, and most transparent EQ for finalizing
your mixes.

The XT-ME has 30 bands of equalization. The filters provide a “flat top” response, meaning: if you boost 2
adjacent bands, the gain between the bands will be consistent. (unlike a traditional graphic eq, where 2
adjacent filters will create a camel-hump)

Each band has approximately 1/3 octave bandwidth. Combined with the flat-top passband between bands,
this makes the XT-ME a highly desirable tool for mastering your final mix.

To adjust the eq, simply click anywhere and drag to “draw” the desired EQ curve. Because of the broad and
even pass-band between bands, “what you see is what you get”.

It is possible to adjust a single band (like a graphic eq) by clicking in the band and dragging up/down. Or
point your mouse at a single band and use the mouse-wheel to adjust only that band.

Hold “Shift” and drag across the EQ to reset the bands to 0dB.

Trim: This is a clean volume control that adjusts the output level. If you use a lot of EQ “cuts” then you may
need to increase this to match the level. And vice versa.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Filters: A low-pass filter and high-pass filter are provided. Click the green button to enable the filter, and
adjust the slider to move the cutoff frequency.

Momentary Bypass: Click and hold this button to momentarily defeat the EQ. It is a good idea to use the
Trim control to adjust the volume of the EQ’d signal so you can compare the effect of the EQ, and not just
the level difference caused by the EQ.
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26.13. XT-MG Micro Glide
XT-MG Micro Glide is a chorus effect plugin designed to thicken up and liven-up vocals and instruments.

Best when used on: Vocals. Bass, Synths, Guitars

Controls:

The XT-MG Micro glide has three controls:

Detune The knob controls the spread of the voices

Delay The knob controls the delay between each voice to add depth to the signal

Wet/Dry knob: Turning this knob to the left will result in a 100% Dry sound (no effect is heard). Turning the
knob to the right will result in 100% Wet sound (no dry signal is heard). A momentary button for ‘Dry’ and
‘Wet’ allows you to audition the effect without permanently changing the knob setting.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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26.14. XT-MC Multiband Compressor
XT-MC Multiband Compressor is a powerful 4-band compressor with phase-accurate crossovers.

Controls

Input Threshold: The primary control for the XT-MC is the input threshold slider. Pull the slider down until
the threshold is matched to your signal level. Then use the individual band thresholds to adjust the effect of
each band on your system.

Band controls (top): Each band has an In/Out Switch, a “Solo” button, a threshold slider (with

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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corresponding band input meter).

Band controls (graph): Inside the graph, you can grab a band edge to change the depth of each band, and
the crossover frequencies between each band.

LF Trim: This slider provides makeup gain for the lowest compression band.

Attack (200μs – 20ms): The ‘Attack’ knob controls how long it takes the signal above the threshold to reach
full compression.

Release (20ms – 200ms): The ‘Release’ knob controls how long it takes the signal, once it falls below the
threshold, to return to an uncompressed state.

Knee (3dB – 24dB): The ‘knee’ control defines how far the signal must exceed the threshold to achieve full
compression. A smaller knee setting will result in more aggressive compression.

Makeup Gain (0dB – 12dB): The ‘Makeup Gain’ control allows you to apply additional gain to the output
signal, to ‘make up’ for the attenuation applied by the compression.

Presets: A few starting-points for common tasks are provided.
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26.15. XT-SC Spectral Compressor
The AVA Spectral Compressor (AVA-SC) is a dynamics processor that allows you to apply compression
selectively across 18 frequency bands. These compression bands can either be spread out across the full
range of the spectrum, or focused on a specific frequency range for more precise control.

Best when used on: Practically anything!

Range:

Here you can select which frequency range you want to operate on. Typically, when using the Spectral
Compressor plugin on a full mix, you want to stay on the “Full Range” mode.

When using the Spectral Compressor plugin on individual instrument, it is more useful to pick from the
following ranges for utility:

High Mid (vocal compression plus de-essing, de-harshing, feedback clamping)
Mid (very focused vocal compression)
Low Mid (vocal compression plus rumble reduction)

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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Low (bass compression, full-mix bass smoothing, and/or rumble reduction)

Compressor Strength:

The compressor mode controls the range (in dB) which the input signal is allowed to go over the threshold
before the gain reduction reaches “max”.

Mode Range

Soft 24㏈

Moderate 20㏈

Hard 12㏈

Brutal 6㏈

Band Controls:

The main interface consists of six band “depth” sliders: Each of the 6 sliders represents 3 bands of
compression.

The green bar indicates the depth: the maximum amount of gain reduction that will be applied in that band.

Using the “Full Range” mode as an example: the 12-35Hz range will have 3 separate compressor bands in
that range. 12-35 Hz represents about 1.5 octaves, and each of the higher slider ranges contains about 1.5
octaves. So in the “full range” mode, there are 3 compressors in every 1.5-octave range, or said another
way: there’s a compressor operating in every half-octave range.

The tightest range is the “high” mode which focuses all 18 bands into only 2.5 octaves: That mode is for
taming squeaks and squeals in the upper ranges of hearing.

Controls:

Input threshold: Controls the main threshold for all materail entering the compressor.

Output Trim: Additional gain on the output of the compressor

Momentary Bypass: Press this button to temporarily bypass the effect. Releasing the button will re-apply
the effect.

This Plugin is also available as an AVA variant! Click here to find out more information!*
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26.16. XT-SP Stunning Phaser
XT-SP “Stunning Phaser” is a creative modulation effect similar to the classic Phaser guitar effect.

Unlike a traditional phaser, where the modulation is free-running, the XT-SP provides multiple methods to
sync the modulation LFO to the session’s playhead position. This makes it particularly useful as a
production & mixdown effect, because it always sounds the same.

Best when used on: Vocals, Guitars, Drums and Keyboards…. or anything that needs a bit of funk-ifying!

Controls:

Selecting various modes will enable/disable the associated controls, depending on their applicability.

Modes: Select one of 4 main modes:

• Vintage: A single sharp peak and 2 notches. Traditional, clean guitar-pedal sound.
• Wide: Several widely-spaced peaks and notches. A more complicated, but still clean sound.
• Tight: Several tightly-spaced peaks and notches. A dense and complicated sound.
• Sprung: In Sprung mode, the peaks and notches move faster as the frequency increases.

Oscillator Shape: select the modulation type:

• Sine: has a “dwell” time at the upper and lower limits. Adjust the vertical “shape” slider to increase the

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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steepness of the sine wave until it reaches a square wave.
• Triangle: the most common repeating-cycle shape for a phaser effect. Adjust the “shape” slider to

morph the triangle shape.
• Tri-Saw: Similar to the Triangle wave, but adjusting the “shape” slider will tilt the shape into a

sawtooth.
• Freeform: In freeform mode, the user is presented with sliders for 8 steps in the oscillator cycle. The

“shape” slider is disabled.
• Stepped: in this mode, the user is presented with sliders for 8 steps in the oscillator cycle. The

“shape” slider is disabled.
• Manual: in this mode, the user must adjust the “Base Freq” control manually, or automate it using

Mixbus’s automation features.

Frequency Knobs:
Range: this is the sweep-range of the effect, in octaves.
Base Freq: this is the lowest frequency that the sweep will reach. Frequencies below here will not be
strongly affected.

Barberpole modes: These modes use a sawtooth modulator shape, either climbing or descending. But
there is no discontinuity when the sawtooth resets; the peaks and notches continuously cycle like a rotating
barberpole. The resulting effect is good for applying a subtle downward or upward-spiraling effect durin
mixdown. Or with more aggressive settings, it can apply an envelope-filtered sound. When a barberpole
mode is selected, the Oscillator knobs will be disabled.

BPM: the BPM knob is used to set the rate of the oscillator.

• Free Run: in Free Run, the oscillator runs at the defined BPM, like a standalone guitar pedal.
• Sync Play: in this mode, the oscillator uses its own BPM setting, but it calculates the oscillator

position from the host timeline; so repeated playback will always sound the same.
• Host Sync: in this mode, the oscillator always follows the exact position and tempo of the host’s

timeline (“Hard Sync”)

Oscillator Display: this display shows the oscillator shape, as well as a vertical line representing the
current position of the oscillator value. Click & drag on the oscillator display to adjust the “phase offset* of
the oscillator. This allows you to synchronize the modulation to emphasize a particular rhythmic pulse in the
plugin’s input signal.

Stereo Width: If the Stereo version is used on a track, then the display provides 2 different lines, and a
“stereo width” knob which varies the distance between the 2 lines. For a dramatic stereo effect, use a very
small distance between the 2 lines.

Divisions: Each LED indicator represents a different subdivision of the base tempo. Use these settings to
increase or decrease the oscillator speed, while matching the tempo to the music. Select different ratios (1/
12 or 2/3 on a 4/4 meter) to create polyrhythms in the modulation.

Wet/Dry knob: Turning this knob to the left will result in a 100% Dry sound (no effect is heard). Turning the
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knob to the right will result in 100% Wet sound (no dry signal is heard). A momentary button for ‘Dry’ and
‘Wet’ allows you to audition the effect without permanently changing the knob setting.

Regeneration: Perhaps the most important knob, the regeneration (sometimes called feedback or
resonance) controls the sharpness of the filters by sending the signal through the filter multiple times.
Increase the regeneration knob for wild synth-like effects. The red light will indicate when the phaser
feedback path is saturated.
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26.17. XT-TG Tom Gate
No, Tom Gate isn’t somebody’s name. XT-TG Tom Gate is a gate plugin that is specifically made to work on
tom drums. It utilizes a special algorithm that is uniquely adapted to listen to a tom-tom drum and separate
the individual drum sound from the drum kit spill into its microphone.

Best when used on: Single Drum Mics, like Tom, Kick, or Snare drums.

Controls:

Despite being a powerful effect, the XT-TG Tom Gate only has six controls:

Learn Tom While playing a tom recording on the track that this plugin lives, holding down the ‘Learn Tom’
button will train the XT-TG to the sound and transient quality of your tom.

Learn Spill While playing a tom recording on the track that this plugin lives, holding down the ‘Learn Spill’

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*

Harrison Consoles Mixbus - 9_en

Page 756 of 848

https://harrisonconsolesstore.onfastspring.com/all-lv2


will train the XT-TG to the sound and transient quality of your microphone ‘spill’, i.e everything that isn’t a
tom.

Threshold The vertical slider in the middle controls the threshold of the gating.

Hold, Release, and Depth Controls the typical gate features like: How long to hold the gate open, how fast
the gate opens, and the level of gain reduction for the material that does not pass the gate.

In the top-right corner is a momentary-bypass button. Press this button to temporarily bypass the effect.
Releasing the button will re-apply the effect.

Harrison Consoles Mixbus - 9_en

Page 757 of 848



26.18. XT-TP Tremolo Panner
XT-TP “Tremolo Panner” is a creative modulation effect similar to guitar stompboxes, and including effects
of “slicers” and “harmonic tremolo” pedals.

Unlike a traditional tremolo, where the modulation is free-running, the XT-TP provides multiple methods to
sync the modulation LFO to the session’s playhead position. This makes it particularly useful as a
production&mixdown effect, because it always sounds the same on playback.

Best when used on: Guitars, Keyboards. Can also be used as a gating/pumping effect for drums.

Controls:

Oscillator Shape: select the modulation type:

• Swell: the traditional swelling tremolo effect, with a very short dwell. Adjust the vertical “shape” slider
to increase the steepness of the swell until it reaches a square wave.

• Sine: has a “dwell” time at the upper and lower limits. Adjust the vertical “shape” slider to increase the
steepness of the sine wave until it reaches a square wave.

• Triangle: the most common repeating-cycle shape for a phaser effect. Adjust the “shape” slider to
morph the triangle shape.

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*
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• Tri-Saw: Similar to the Triangle wave, but adjusting the “shape” slider will tilt the shape into a
sawtooth.

User Shapes: enabling one of these shapes will display controls for the user to draw their own oscillator
waveform shape

• Swells: Up to 16 individual “swells” can be adjusted in level.
• Linear: 16 control points, connected with smooth ramp between each point. The “shape” slider adjusts

a hold time around each point.
• Gated: up to 16 stepped control points. The “shape” slider adjusts the hold time after each point.

Shape Slider

• The shape slider affects the selected oscillator shape, typically making it steeper.

Modes: Select one of 4 main modes:

• Cut Lows: The tremolo will cut low frequencies, leaving higher frequencies intact.
• Cut Highs: The tremolo will cut high frequencies, leaving low frequencies intact.
• Cut Hi+Low: Alternately cut the high or low band (sometimes called a “harmonic tremolo” effect).
• Cut ALL: This cuts the volume of the signal, like a traditional tremolo pedal(Defaut).

BPM: the BPM knob is used to set the rate of the oscillator.

• Free Run: in Free Run, the oscillator runs at the defined BPM, like a standalone guitar pedal.
• Sync Play: in this mode, the oscillator uses its own BPM setting, but it calculates the oscillator

position from the host timeline; so repeated playback will always sound the same.
• Host Sync: in this mode, the oscillator always follows the exact position and tempo of the host’s

timeline (“Hard Sync”)

Oscillator Display: this display shows the oscillator shape, as well as a vertical line representing the
current position of the oscillator value. Click & drag on the oscillator display to adjust the “phase offset* of
the oscillator. This allows you to synchronize the modulation to emphasize a particular rhythmic pulse in the
plugin’s input signal.

Stereo Width: If the Stereo version is used on a track, then the display provides 2 different lines, and a
“stereo width” knob which varies the distance between the 2 lines. For a dramatic stereo effect, use a very
small distance between the 2 lines.

Divisions: Each LED indicator represents a different subdivision of the base tempo. Use these settings to
increase or decrease the oscillator speed, while matching the tempo to the music. Select different ratios (1/
12 or 2/3 on a 4/4 meter) to create polyrhythms in the modulation.

Wet/Dry knob: Turning this knob to the left will result in a 100% Dry sound (no effect is heard). Turning the
knob to the right will result in 100% Wet sound (no dry signal is heard). A momentary button for ‘Dry’ and
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‘Wet’ allows you to audition the effect without permanently changing the knob setting.
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26.19. XT-VC Vocal Character
XT-VC Vocal Character is an effect similar to the XT-BC Bass Character except it is optimized for vocals.

The Vocal Character operates by detecting each musical note sung and then applying an eq to make the
note sound fuller and brighter (or weaker and duller, if needed).

Best when used on: Vocals

Scale + Spectrum Display:

This plugin requires a license to enable the control panel. To purchase a license, visit
Harrison’s XT Plugin Page*

NOTE: the XT-VC is for mono tracks only.*
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The Vocal Character plugin operates like an EQ, but with one difference: the EQ isn’t set at fixed
frequencies, but rather the eq is applied to each detected note.

The red “spectrum” curve shows the harmonic content of the detected note. The leftmost line indicates the
“fundamental” or first harmonic of the note. Each vertical line to the right indicates an additional harmonic
(2nd harmonic, 3rd, etc). You can use this graph to determine the balance of an instrument: whether it has
too much or too little fundamental, for example.

Controls:

The XT-VC plugin has 2 EQ bands: “Body” and “Clarity”. These bands are identical except that the “Body”
control is a low-shelving EQ by default, while the “Clarity” band is a high-shelf EQ.

In/Out switch: The green button enables/disables each band.

Peaking switch: The yellow button changes the band to a peaking.

Q slider: when the Peaking switch is engaged, the Q slider engages, and adjusts the Q ( sharpness ) of the
band’s filter.

Momentary Bypass: the top-right corner is a momentary-bypass button. Press this button to temporarily
bypass the effect. Releasing the button will re-apply the effect.
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26.20. x42 EQ
x42 is a 4-Band Parametric EQ with Low/High Shelving, Filters, and pre- or post-EQ spectrum displays.

x42-eq features a “de-cramped” algorithm which accurately models analog gain, even when approaching the
Nyquist frequency. It was recently updated with a piano-keyboard that snaps your EQ frequencies to the
chromatic scale.

You can find more details about this plugin, and purchase a license, at the developer’s website:
https://x42-plugins.com/x42/x42-eq

This plugin requires a license to enable the control panel. To purchase a license, visit
https://x42-plugins.com/x42/x42-eq*
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26.21. x42 Whirl
x42-whirl recreates the sound and properties of the electromechanical rotating speaker device that brought
world-wide fame to the name and products of Don Leslie.

The Whirl is a great mono-to-stereo effect which can add stereo spaciousness to keys, guitars, or even
vocals.

You can find more details about this plugin, and purchase a license, at the developer’s website:
https://x42-plugins.com/x42/x42-whirl

This plugin requires a license to enable the control panel. To purchase a license, visit
https://x42-plugins.com/x42/x42-whirl*

When inserted on a mono channel, whirl will automatically convert your mono track into a
stereo output – no manual “pin connections” needed.*
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26.22. x42 Meter Bundle
A collection of audio-level meters following established standards.

You can find more details about this plugin, and purchase a license, at the developer’s website:
https://x42-plugins.com/x42/x42-meters

It includes needle style meters (mono and stereo variants):

• IEC 60268-10 Type I / DIN
• IEC 60268-10 Type I / Nordic
• IEC 60268-10 Type IIa / BBC
• IEC 60268-10 Type IIb / EBU
• IEC 60268-17 / VU

Stereo & Mono variants of bar-graph meters:

• 30 Band 1/3 octave spectrum analyzer IEC 61260
• Digital True-Peak Meter (4x Oversampling), Type II rise-time, 13.3dB/s falloff.
• True-Peak (4x Oversampling) + RMS (600ms integration time) combined with numeric readout
• K-12, K-14, K-20 / RMS type K-Meters according to the K-system introduced by Bob Katz
• DR-14 (crest factor / loudness range measurement method)

By default, the Plugin Manger window only shows audio effects plugins. The x-42 meters
are tagged “analyser”, and are categorized with the Utility plugins. To expose the list of
meter plugins, you can click “Show Utilities Only” or type “analyser” into the search bar.

!

This plugin requires a license to enable the control panel. To purchase a license, visit
https://x42-plugins.com/x42/x42-meters*
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and the following stereo plugins:

• EBU R128 Meter with Histogram and History
• Stereo Phase Correlation Meter (Needle Display)
• BBC Mid/Side M-6 (Needle Display)
• Goniometer (Stereo Phase Scope)
• Phase/Frequency Wheel
• Stereo/Frequency Monitor
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as well as these mono, technical troubleshooting plugins:

• Signal Distribution Histogram
• Bitmeter
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27. Included (FREE) Plug-ins

Plugins
Mixbus comes with a suite of pre-installed plugins (in addition to the console-style DSP that is built into
every strip)

• ACE Amplifier ( free, full-functioning )
• ACE Delay ( free, full-functioning )
• ACE Reverb ( free, full-functioning )
• ACE EQ ( free, full-functioning )
• ACE Compressor ( free, full-functioning )
• ACE Gate ( free, full-functioning )
• ACE Inline Scope ( source-code provided) with Inline display
• ACE Inline Spectrogram ( source-code provided) with Inline display
• ACE MIDI Monitor ( source-code provided) with Inline display
• x42 MIDI filter plug-ins ( free, full-functioning )
• x42 Stereo Routing ( free, full-functioning )
• x42-Digital Peak Limiter (free, full-functioning) with Inline display
• x42-Whirl — Simple (free, full-functioning)
• ACE High/Low Pass Filter ( source-code provided) with Inline display

Included Instrument plugins

• x42 SetBfree modeled tonewheel organ ( free, full-functioning )
• General MIDI Synth ( free, full-functioning )
• Blonde Bop drum instrument ( free, full-functioning )
• RedZep drum instrument ( free, full-functioning )
• Black Pearl drum instrument ( free, full-functioning )
• ACE Fluid Synth ( free, full-functioning )
• ACE Reasonable Synth ( free, full-functioning )
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27.1. ACE Plugins
The ACE (*A*rdour *C*ommunity *E*ffects) plugins are developed by the Ardour open-source community.
These plugins provide a basic suite of effects including EQ, Compression, Reverb and Delay, as well as
utilitarian tasks such as scrolling waveforms,

The source code for these plugins is available to be reviewed, or studied as the basis for your own plugins.

ACE EQ
The ACE EQ is a simple 6-band equalizer with 4 fully-parametric “bell” (peaking) bands, plus low-shelf and
high-shelf filters.

Each of the 4 bands has 3 controls:
Gain (the top knob): amount of boost or cut, in dB
Frequency: the center frequency for the boost or cut
Bandwidth: the width (in octaves) of the boost or cut. (this is the inverse of “Q” in some equalizers)

The High and Low shelves have 2 controls:
Gain: boost or cut, in dB
Frequency: the corner frequency of the shelf boost/cut.

There is an overall gain accessed by clicking on “Master” in the bottom-right corner.

The control panel has several notable features that are particularly well-suited to novice and/or student
users:

• The EQ bands are always located perfectly on the curve. This is slightly different than traditional
parametric EQs, and it results in a clean look.

• each EQ band displays the nearest note (on a chromatic 12-tone scale, based on A=440Hz)
underneath the frequency value

• the individual bands will highlight (bi-directionally) when you enter a band’s control area. This helps to
correlate the band graph with their control sliders.

Harrison Consoles Mixbus - 9_en

Page 771 of 848

https://github.com/Ardour/ardour/tree/master/libs/plugins


Inline display: the ACE EQ plugin provides a condensed “inline” display that shows the EQ curve in the
channelstrip.
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ACE Compressor

A ‘compressor’ reduces the volume of an input signal when the signal exceeds the specified threshold.

There is also a stereo version which analyzes both left and right signals, and then applies the maximum
calculated gain reduction to both sides.

ACE Compressor is a traditional compressor with the full suite of controls:

Sliders:

• Attack time: the time (in ms) to attain full gain reduction
• Release time: time (in ms) to return to 0dB after the signal is removed
• Knee: adjusts the aggressiveness of the gain-reduction element as the signal approaches the

threshold. A larger “knee” effectively lowers the threshold but also lowers the ratio, so that the onset
of gain-reduction occurs sooner but more gradually.

• Ratio: the ratio is the strength of the effect. At 1:1, no effect is applied. At 20:1, the threshold must be
exceeded by 20dB before the output increases 1dB.

• Threshold: this defines the input level where the compression will begin to take effect. Decrease the
threshold to compress more.

• Makeup Gain: since the effect of a compressor is to reduce the loudest signals, the result might sound
quieter than before compression. Use the makeup gain to increase the level. (the overall result is to
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increase the level of the signal’s quieter parts, therefore decreasing the dynamic range of the signal
and making it easier to hear fine details)

Switches:

• Enable: this engages or disengages the plugin. This parameter is smoothed and may be automated.
• Sidechain: when Sidechain is engaged, the plugin ignores the input signal, and instead uses an

externally-selected “sidechain” signal to feed the input detector (threshold, etc) see this topic for more
details: sidechain compression.

The compressor’s transfer-curve is displayed on the control panel, displaying the input-to-output levels of
the signal. A bouncing orange “dot” shows the current input-to-output ratio.

Inline display: the ACE Compressor plugin provides a condensed “inline” display when added to a mixbus
channelstrip, so you can see the input signal, threshold, and resulting gain reduction:

(shown here in stereo mode, with the “sidechain” input disconnected)

You must choose a release time that is longer than the attack time, or the behavior of the
plugin will be erratic.

!
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ACE Expander
An Expander reduces the signal’s volume when the signal is below the threshold (as opposed to a
compressor, which reduces the volume of a signal that is over the threshold). Set aggressively, an expander
can serve the function of a “gate” which completely mutes the signal when it gets quiet. Sometimes called a
“noise gate” because it is used to eliminate extraneous noise when the signal is below a desired threshold.

ACE Expander is a traditional expander with the full suite of controls:

Sliders:

• Attack time: the time (in ms) to attain full gain reduction
• Release time: time (in ms) to return to 0dB after the signal is removed.
• Knee: adjusts the aggressiveness of the gain-reduction element as the signal approaches the

threshold. A larger “knee” effectively lowers the threshold but also lowers the ratio, so that the onset
of gain-reduction occurs sooner but more gradually.

• Ratio: the ratio is the strength of the effect. At 1:1, no effect is applied. At 20:1, the threshold must be
exceeded by 20dB before the output increases 1dB.

• Threshold: this defines the input level where the compression will begin to take effect. Decrease the

https://www.youtube.com/embed/j8nkjk0U2KM?rel=0
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threshold to compress more.
• Makeup Gain: since the effect of a compressor is to reduce the loudest signals, the result might sound

quieter than before compression. Use the makeup gain to increase the level. (the overall result is to
increase the level of the signal’s quieter parts, therefore decreasing the dynamic range of the signal
and making it easier to hear fine details)

Switches:

• Enable: this engages or disengages the plugin. This parameter is smoothed and may be automated.
• Sidechain: when Sidechain is engaged, the plugin ignores the input signal, and instead uses an

externally-selected “sidechain” signal to feed the input detector (threshold, etc) see this topic for more
details: sidechain compression.

There is also a stereo version which analyzes both left and right signals, and then applies the maximum
calculated gain reduction to both sides.

Inline display: the ACE Expander plugin provides a condensed “inline” display when added to a mixbus
channelstrip, so you can see the input signal, threshold, and resulting gain reduction:

You must choose a release time that is longer than the attack time, or the behavior of the
plugin will be erratic.

!
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ACE Delay

Sliders:

• Time: the length of the delay from the initial input sound. Adjusting the slider displays both the
milliseconds and the BPM (referenced to the Divisor and Dotted selections)

• Divisor: (only when Sync BPM is enabled): sets teh delay time based on Mixbus’s current tempo
• Dry/Wet: when set to 0% (minimum), the input signal is passed through without any delay. When set

to 100%, the input signal is muted, and only the delay signal is heard.
• Feedback: the output of the delay can be sent through the delay again. This results in multiple

echoes. Setting this value very high can result in infinitely repeating echoes.
• LPF: A low-pass filter applied to the delay path. Reduce this value to recreate a vintage tape delay,

where each repeated echo gets duller.
• Output Gain: increases or decreases the output level of the effect

Switches:

• Tap: successively click this button with your mouse to set the delay time (in pulses of quarter-notes)
• Invert: When enabled, the feedback path’s polarity (phase) is inverted, resulting in a slightly different

character.
• Sync: When enabled, the plugin will use the Divisor selector to set the delay time, and ignore the

Time setting.
• Dotted: When enabled, the delay-time will be 1.5x the value of the divisor: “dotted 8th” means an

effective delay of “3 16ths”.
• Enable
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The following ACE plugins do not provide a
dedicated control panel. Instead they use
Mixbus’s “Generic Plugin Control Panel”

ACE Reverb
ACE Reverb is a minimal reverb plugin that gives fast&easy results.

Sliders

• Blend: at 0 (minimum), the signal is dry. At 1.0 (maximum) the reverb is purely wet.
• Room Size: increase this slider to increase the perceived room size, and make the decay longer.

ACE Amplifier
This is a simple clean volume control. The only parameter is “Gain” which may be adjusted +/-20dB

ACE High/Low Pass Filter
This plugin provides a high-pass and low-pass filter.

• Steepness: filter order may be adjusted from 12 to 48dB/octave. Higher numbers indicate a steeper
cutoff filter.

• Frequency: the cutoff frequency of the filter. frequencies out side of this range will be greatly reduced.
• Resonance: increasing the resonance will create a “bump” near the cutoff frequency, and further

sharpen the filter steepness. Extreme settings of resonance can result in very large signal peaks.

Inline display: the ACE High/Low Filter plugin provides a condensed “inline” display when added to a mixbus
channelstrip, so you can see the input signal, threshold, and resulting gain reduction:

The default settings for the delay are intended for for insertion directly on a track. If you
want to use the delay as a send/return effect on a bus, you should set “Dry/Wet” to its
maximum value.
*

The default settings for the reverb are intended for for insertion directly on a track. If you
want to use the reverb as a send/return effect on a bus, you should set “Blend” to its
maximum value.
*
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ACE Inline Scope
The ACE Inline scope displays a scrolling waveform view inside the mixer strip:

Controls:

• Logscale: if the signal is quiet, then enabling Logscale will increase the size of the waveform and
reveal quiet material, at the expense of less visual resolution for loud signals.

• Timescale: the display can show from 0.1seconds to 5 seconds at one time. Adjust this to scroll faster
or slower.

• Height: this adjusts the height of the waveform display in the strip
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ACE Inline Spectrogram
The spectrogram displays a scrolling view of the signal’s frequency content, with low frequencies on the left,
and high frequencies on the right.

Controls:

• Logscale: if the signal is quiet, then enabling Logscale will increase the size of the waveform and
reveal quiet material, at the expense of less visual resolution for loud signals.

https://www.youtube.com/embed/BUjcgxw2Svg?rel=0
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• FFT Size: smaller FFT sizes will result in a faster-scrolling display, but doesn’t show low-frequencies
as well.

• Height: this adjusts the height of the spectrum display in the strip.
• Range, Offset: if the display is too saturated, or nothing shows up, you can adjust these values to

better match your input signal level.

ACE Notch Bank
This plugin is useful to remove noise with a harmonic spectrum such as mains power hum, or motor noise.

Select the base frequency to match the fundamental of the noise ( 60Hz for U.S. power main), and choose
the number os stages to increase the number of harmonic filters above the fundamental. The Quality control
is the sharpness or “Q” of the filters.

Additionally, this plugin serves as an example DSP plugin written in the Lua scripting language. The source
code for this plugin can be found in your Mixbus application bundle, in Scripts/notch-bank.lua

https://www.youtube.com/embed/ONO0N7zDIqQ?rel=0
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ACE Slow-Mute
Another example DSP plugin written in the Lua scripting language. The source code for this plugin can be
found in your Mixbus application bundle, in Scripts/ACE slow-mute.lua

This plugin slowly mutes the signal when “Mute” is enabled. De-selecting “Mute” will return the signal to full
volume.

This plugin has no other controls.

ACE MIDI Plugins

General MIDI Plugins

The following video describes the included MIDI plugins.

https://www.youtube.com/embed/pnaFFA_AZII?rel=0

https://www.youtube.com/embed/pnaFFA_AZII?rel=0
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ACE MIDI Monitor

ACE MIDI Monitor is a troubleshooting tool that lets you see the flow of MIDI data in your tracks.

The plugin has an inline display that reports MIDI note “on/off” and MIDI controller messages directly in the
mixer strip. In the example image below, ACE MIDI Monitor is inserted directly before the “General MIDI”
synth and is reporting the controller and note-messages that are being sent to the synth.
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27.2. x42 Whirl (Simple)
x42-whirl (Simple) recreates the sound and properties of the electromechanical rotating speaker device that
brought world-wide fame to the name and products of Don Leslie.

x42-whirl calculates six reflections depending on the angles of the horn and drum as well as distance and
position of the microphones to emulate the reverberant scattering corresponding to the dimensions and
scattering characteristics of the cabinet. Furthermore the model accounts for artifacts such as signal
leakage from the tweeter which does not pass through the horn. The motor-control allows to set two target
speeds (slow/chorale and fast/tremolo) for each of the horn and drum rotors in RPM as well as acceleration
and deceleration time-constants in seconds (to reach half the speed).

The Whirl is a great mono-to-stereo effect which can add stereo spaciousness to keys, guitars, or even
vocals.
p(banner tip). When inserted on a mono channel, whirl will automatically convert your mono track into a
stereo output – no manual “pin connections” needed.

Whirl (Simple) does not provide a custom GUI. Instead it uses the generic control-panel with these controls:

• Enable: this switches the effect on&off, click-free
• Motors Ac/Dc: select the speed of the rotor horn and drum
• Horn Level: level adjustment for the horn (highs), in dB
• Drum Level: adjust the Drum level in dB
• Drum Stereo Width: move the slider left (lower) for a more mono sound. Move it right for a wider

stereo sound. 1.0 is the default stereo setting
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27.3. Stereo Routing
This simple plugin provides various utilities for stereo tracks and buses. You can use this plugin to reverse
left/right sides, and other utilitarian tasks.

The MId/Side converter is provided for tracks that were recorded using the mid/side
techniques. Use the decoder to resolve a mid/side recording into normal stereo signals. A
mid-side encoder is also provided, allowing you to convert the signal to mid/side format and
back. Converting to mid-side before a processor, and then back to stereo, can sometimes
provide a useful effect. You can use features like pin management to process only the ‘mid’
or ‘side’ channel.

*
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27.4. x42 Instrument Tuner
x42 Instrument tuner (or “Tuna”) is a high-quality tuner for acoustic and electric instruments.

“Tuna” features an auto-tuner mode (detect closest note) with an idiosyncratic GUI and optional spectrum
display. Unlike many other (FFT based) tuners, the algorithm follows the signal phase of the fundamental
note, which makes this tuner suitable for stretch tuned instruments.

Tuna also features an “inline” channelstrip display which allows it to remain visible on the mixer window
during recording or playback.

Best when used on: Monophonic instruments and vocals.

Tuner Display:

The tuner display is separated into 4 parts:

Text Display: The topmost text displays the pitch that is nearest the detected (input) note, and a numeric
display of the tuning error from the reference.

Tuner bar: the colored bar (green in the middle) is a representation of a traditional tuner, where center
indicates a perfectly in-tune note reference, and the left&right sides indicate when the note is flat or sharp.

Strobe: The third bar (moving boxes) is a visual indicator of the difference between the reference pitch and
the input. Sometimes called a “strobe” display, this provides a strong visual indication of the incoming
signal’s phase when compared to the reference…. this display often feels smoother & easier to match, than
the traditional flat/sharp display.

Signal Level: this indicates the detected signal level. If the level is too quiet, then the tuner will not try to

You can learn more about the x42 Instrument Tuner at the developer’s web site: x42*
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detect the pitch. If the signal is too high, it might indicate clipping which could invalidate the pitch detection.

Accuracy: If the pitch of the input signal varies widely, then the tuner will report that accuracy is
compromised.

Controls:

Tuning: This is the reference for tuning of note “A”. Default is A=440Hz.

Auto/Freq/Note selector: Auto: the tuner will try to detect incoming pitch. Freq: user defines the reference
frequency to tune to. Note: user defines the reference note. The latter options are provided in the rare case
that the tuner cannot auto-detect the note you are trying to tune to.

Inline Mode

When placed on a channelstrip in Mixbus, the Tuna plugin will appear with an inline display. This provides a
quick reference to check that your instrument input, or playback, is in tune.
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27.5. x42 DPL Limiter
x42-dpl is a look-ahead digital peak limiter based on Fons Adriaensen’s DPL-1. It is intended to be used as
final step to avoid clipping when mixing or mastering, but can also be used on individual tracks as well. It
comes in mono and stereo variants, the stereo version applies the same gain reduction to both channels.

A channel “inline” display is provided to give an indication when gain-reduction is being applied:

You can find more details about this plugin, and purchase a license, at the developer’s website:
https://x42-plugins.com/x42/x42-limiter

Harrison Consoles Mixbus - 9_en

Page 788 of 848



27.6. Instruments
Mixbus includes several Instrument plugins which can interpret your MIDI performance into sound.
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27.6.1. ACE Fluid Synth
This is a plugin implementation of Fluid Synth, a popular SoundFont playback engine.

ACE Fluid Synth can open SoundFont (.sf2 and .sf3) patch files.

A SoundFont consists of a library of sampled sounds as well as accompanying information on note
mapping, sound layering, velocity sensitivity, and other parameters.

While not as powerful as commercial sample libraries like Kontakt, SoundsFonts are readily available online
and can be quite high quality. Generally speaking, a SoundFont package can match the capabilities of any
state-of-the art “arranger” keyboard from 1995 through 2005.

Fluid Synth uses Mixbus’s generic control panel.

To use Fluid Synth, you must first download a Soundfont (.sf2 or .sf3) file, and then select it using the (SF2
File) browser in the control panel:

A built-in reverb and chorus effect can be utilized to audition sounds without assigning additional plugins on
your mixer.
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27.6.2. ACE Reasonable Synth
“Reasonable Synth” is a minimal instrument that makes a piano-like sound. RS responds to note inputs on
every channel. It is useful to troubleshoot MIDI problems such as verifying that your MIDI keyboard is
connected and working.

RS has no user-adjustable controls.

Because of its simplicity, RS is a great way to learn about MIDI and plugin signal flow in Mixbus. Add a
chorus or phaser effect after RS, and you’ll get a reasonably good electric piano sound.
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27.6.3. AVL Drumkits: Black Pearl and Red
Zeppelin
The AVL drum kits were developed by Glen McArthur at AVLinux, and packaged by Robin Gareus for use in
Mixbus.

When compared to the drumkits in Mixbus’s “General MIDI Synth”, the AVL drumkits utilize many more
velocity layers, and therefore can deliver a more nuanced and “real” sounding drum kit, when this is desired.

The AVL drumkits may output each drum sound on a separate output, and they serve to demonstrate
Mixbus’s multichannel instrument outputs. To learn more, see: multichannel instruments

The “Black Pearl” drumkit uses a smaller kick drum and a tight snare for a traditional “jazz” drum setup:

The “Red Zeppelin” drumkit uses a larger, boomier kick and a brighter, more sustaining snare for a more
aggressive“rock” sound:
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“Buskman’s Holiday” is a multisampled percussion kit containing “low budget” percussion elements. Liven
up your tracks with stomps, claps, tambourine, and … a bucket !
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27.6.4. General MIDI Synth
This synthesizer implements the General MIDI (GM) soundset, and various common extensions.

The synth responds to all 16 MIDI channels, as well as common control messages like pitch-bend, volume,
and filter cutoff.

For more details about using the General MIDI Synth, see: Multitimbral Instruments and “General MIDI”
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27.6.5. SetBfree Tonewheel Organ
SetBfree is a faithful recreation of the tonewheel organs popularized by the Hammond organ company.

Many instruments can be convincingly recreated by sampling each note; but the complex character and
many controls of a tonewheel organ require a more complex emulation. SetBfree is a faithful emulation of
every stage inside these iconic instruments.

Operation:
SetBfree responds to 3 different MIDI channels (1,2, and 3) for each of the 3 timbres (). This allows playing
the instrument from 3 simultaneous inputs (2 manual keyboards plus foot pedals). The various switches and
manuals may be controlled by your MIDI device controllers. (there are default config files for common
keyboards such as the Kurzweil 2500 or Oxygen61 included)

When opened, the plugin’s UI shows the most frequently accessed controls:

Controls
Users of a tonewheel organ will recognize the stops (sliders) and switches of the real thing.

• Stop sliders: (2 for the bass pedals, and 9 for each of the 2 manuals): adjust the overtones of the
timbre.

• Overdrive/Gain: (not present on the real device): this adjusts the amount of tube distortion in the
signal.

• Vibrato: these switches engage the vibrato for the 2 manual keyboards.
• V1/C1, etc … these switch positions select between various vibrato and chorus effects
• Tremolo (Drum and Horn) … these switches effect the speed of vibrato sent to the low (drum) and

high (high) speakers (for a full implementation of an accompanying rotating speaker, see whirl )
• Percussion: enabling these options provides a “click” (either soft or pronounced) when a manual key

is pressed.
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• Reverb: a built-in reverb effect recreates the sound of the instrument in a room, as it was likely to be
heard.

• Volume: master output level.

Detailed Operation:
Click the question-mark near the top-right corner to expose some additional functions that might be useful
when performing with the instrument:

In addition to the sound modeling, the organ is displayed as a 3-dimensional model. This allows the organ to
be manipulated in various ways, including playing the various manuals and changing the internal
components (and their effect on the sound):

More details about this plugin can found at the developer’s site: setBfree
Full source-code for the organ is provided at his site.
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27.7. MIDI Plugins
Mixbus provides a rich suite of MIDI Effects, utilities, and generators.
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27.7.1. MIDI Filters
Mixbus includes a free suite of open-source MIDI filters by developer Robin Gareus.

Name Description

CC2Note
Convert MIDI control change messages to note-on/off messages. Note off is queued 10msec
later.

MIDI Channel
Filter

Simple MIDI channel filter. Only data for selected channels may pass. This filter only affects
midi-data which is channel relevant (ie note-on/off, control and program changes, key and
channel pressure and pitchbend). MIDI-SYSEX and Realtime message are always passed on.
This plugin is intended for live-use, button-control. See also ‘MIDI Channel Map’ filter.

MIDI Channel
Map

Rewrite midi-channel number. This filter only affects midi-data which is channel relevant (ie
note-on/off, control and program changes, key and channel pressure and pitchbend).
MIDI-SYSEX and Realtime message are always passed thru unmodified.

MIDI Enforce
Scale

Filter note-on/off events depending on musical scale. If the key is changed note-off events of
are sent for all active off-key notes.

MIDI Event
Filter

Notch style message filter. Suppress specific messages. For flexible note-on/off range see
also ‘keyrange’ and ‘velocityrange’.

MIDI Key-
Range Filter

This filter allows to define a range of allowed midi notes. Notes-on/off events outside the
allowed range are discarded. If the range changes, note-off events are sent to currently active
notes that end up outside the valid range.

MIDI Keysplit

Change midi-channel number depending on note. The plugin keeps track of transposed midi-
notes in case and sends note-off events accordingly if the range is changed even if a note is
active. However the split-point and channel-assignments for each manual should only be
changed when no notes are currently played.

MapCC
Change one control message into another — combine with scalecc to modify/scale the actual
value.

MIDI Keys
Transpose

Flexible 12-tone map. Allow to map a note within an octave to another note in the same
octave-range +- 12 semitones. Alternatively notes can also be masked (disabled). If two keys
are mapped to the same note, the corresponding note on/events are latched: only the first note
on and last note off will be sent. The settings can be changed dynamically: Note-on/off events
will be sent accordingly.

MIDI Chord

Harmonizer – make chords from single (fundamental) note in a given musical scale. The scale
as well as intervals can be automated freely (currently held chords will change). Note-ons are
latched, for multiple/combined chords only single note-on/off will be triggered for the duration
of the combined chords. If a off-scale note is given, it will be passed through – no chord is
allocated. Note: Combine this effect with the ‘MIDI Enforce Scale’ filter to weed them out.
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MIDI Delayline
MIDI delay line. Delay all MIDI events by a given time which is given as BPM and beats. If the
delay includes a random factor, this effect takes care of always keeping note on/off events
sequential regardless of the randomization.

MIDI Channel
Unison

Duplicate MIDI events from one channel to another.

MIDI Strum

A midi arpeggio effect intended to simulate strumming a stringed instrument (e.g. guitar). A
chord is ‘collected’ and the single notes of the chord are played back spread out over time.
The ‘Note Collect Timeout’ allows for the effect to be played live with midi-keyboard, it
compensates for a human not pressing keys at the same point in time. If the effect is used with
a sequencer that can send chords with all note-on at the exactly time, it should be set to zero.

MIDI
Chromatic
Transpose

Chromatic transpose of midi notes and key-pressure. If an inversion point is set, the scale is
mirrored around this point before transposing. Notes that end up outside the valid range 0..127
are discarded.

MIDI
Monophonic
Legato

Hold a note until the next note arrives. — Play the same note again to switch it off.

MIDI Remove
Active Sensing

Filter to block all active sensing events. Active sensing messages are optional MIDI messages
and intended to be sent repeatedly to tell a receiver that a connection is alive, however they
can clutter up the MIDI channel or be inadvertently recorded when dumping raw MIDI data to
disk.

MIDI Duplicate
Blocker

MIDI Duplicate Blocker. Filter out overlapping note on/off and duplicate messages.

Note2CC Convert MIDI note-on messages to control change messages.

MIDI Note
Toggle

Toggle Notes: play a note to turn it on, play it again to turn it off.

MIDI N-Tap
Delay

This effect repeats notes N times. Where N is either a fixed number or unlimited as long as a
given key is pressed. BPM and delay-time variable allows tempo-ramps. On every repeat the
given velocity-adjustment is added or subtracted, the result is clamped between 1 and 127.

MIDI Thru MIDI All pass. This plugin has no effect and is intended as example.

MIDI
Quantization

Live event quantization. This filter aligns incoming MIDI events to a fixed time-grid. Since the
effect operates on a live-stream it will introduce latency: Events will be delayed until the next
‘tick’. If the plugin-host provides BBT information, the events are aligned to the host’s clock
otherwise the effect runs on its own time.

MIDI Velocity
Randomization

Randomize Velocity of MIDI notes (both note on and note off).

Scale CC
Value

Modify the value (data-byte) of a MIDI control change message.
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MIDI
Sostenuto

This filter delays note-off messages by a given time, emulating a piano sostenuto pedal. When
the pedal is released, note-off messages that are queued will be sent immediately. The delay-
time can be changed dynamically, changes do affects note-off messages that are still queued.

MIDI Velocity-
Range Filter

Filter MIDI note-on events according to velocity. Note-on events outside the allowed range are
discarded. If a Note-off is received for a note that was previously filtered, it is also not passed
though. If the allowed range changes, note-off events are sent to currently active notes that
end up outside the valid range.

MIDI Velocity
Adjust

Change the velocity of note events with separate controls for Note-on and Note-off. The input
range 1 – 127 is mapped to the range between Min and Max. If Min is greater than Max, the
range is reversed. The offsets value is added to the velocity event after mapping the Min/Max
range.
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27.7.2. MIDI Arpeggiators
A MIDI Arpeggiator is a plugin that accepts MIDI notes and generates a sequence of notes or chords related
to the input.

Combine an Arpeggiator plugin with our bundled “chord progression” clips, and you can arrange a synth
masterpiece in no time!

The 3 plugins are:

• Arpeggiator: a simple but full-featured MIDI note arpeggiator with divisions, up/down patterns, gate
time, and swing.

• Arpeggiator (Barlow): another simple monophonic arpeggiator, but this one modulates the note
velocities to produce rhythmic accents according to the time signature and division settings.

• Arpeggiator (Raptor): a very complicated polyphonic arpeggiator that plays chord inversions based on
the input. Enable the Raptor mode to let the arpeggiator generate additional notes (beyond what was
input) according to user-adjustable parameters like probability, harmonicity, and repetition. Raptor
mode enables pitch- and velocity-tracking. Enable the ‘loop’ switch when you want to keep an idea on
‘repeat’. You can even send program-changes from the plugin to your synth. And automate any
parameter including program-changes …. wow!

These plugins were contributed by Albert Gräf for the Ardour open-source project. Thanks to Albert for these
incredibly useful and fun new tools!

Extensive documentation on the features and behaviors of the arpeggiators can be found here: Using the
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Arpeggiators
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28. Power-User Topics

Session folder layout

Navigating to a session folder will display a series of files and folders:

• instant.xml : this file stores the most recently-used mouse mode, playhead location, and other
transitory information.

• {snapshot name}.ardour : each of these files represents a Snapshot, which stores all of the edits,
settings, and properties of a session.

• {snapshot name}.bak : backup files are occasionally generated for each snapshot
• {snapshot name}.pending : pending files snapshots that get created when an audio recording is

initiated. this allows us to recover audio data, even in the event of a crash or power outage. If a
pending file is found when Mixbus is re-launched, you will see the Crash Recovery dialog, and you
can choose to ignore or recover any lost information that was saved to the pending file.

• {snapshot name}.history : every snapshot file has a “history” file. The history file saves the UNDO
history for that snapshot.

• analysis: This folder contains data relevant to any audio files that Mixbus has analyzed for transient-
detection and note-detection. By storing this information, Mixbus doesn’t have to re-analyze audio
when you initiate one of these functions.

• dead: This folder serves as a waste basket for unused audio. Menu>Session>Clean-up>Flush
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Wastebasket: will delete audio files located in this folder. Click here for more
• export: This is the default location for exported files. Click here for more.
• externals: This folder contains a list of external files that are used in the session, but were not copied

into the session
• interchange: This folder contains imported audio, recorded audio, and MIDI files.
• peaks: Contains waveform images for display in the editor. It is safe to delete the contents of this

folder, and Mixbus will create new data when the session is re-opened.
• plug-ins: Contains plug-in settings. Some plugins (such as impulse-response based reverbs) need to

store more information than is practical in the session XML file. The extra plugin data is stored here.

Session XML file format
Mixbus session files use the industry-standard “Ardour” session file format. These files are plain human-
readable XML. Other workstations that use this format include Ardour and Waves Tracks Live.

A detailed description of the session format is beyond the scope of this manual, but here is an overview of a
session file contents:

• Config : defines the Session Properties that were chosen for this session.
• Metadata : the metadata information for the session ( personnel details, etc )
• Sources : a list of the audio and MIDI files that are used in this session
• Regions : a list of the regions (segments of an audio or MIDI file) used in the session
• Playlists : a list of playlists that are used in the session. A playlist is a sequence of regions, and their

specific settings (trim, fade, etc)
• Locations : a list of locations (markers, cd markers, region markers, loop/punch markers) that are

used in the session
• Bundles : a list of bundles ( a bundle is a group of input (or output) ports that are associated, such as

the 2 inputs of a stereo track )
• Routes : a list of “routes” ( tracks and buses ) that are used in the session. A Route has many sub-

fields:
◦ Currently selected playlist
◦ Channelstrip fader, EQ, compressor, and pan settings
◦ Plugins used in this route

Mixbus Preferences folder
The Mixbus “preferences” folder stores all of a user’s preferences, as shown in the Preferences dialog.

The preferences folder location varies with each OS, but it is always found inside the HOME (“~”) folder:

• Mac OS X: ~/Library/Preferences/Mixbus8
• Windows: ~/AppData/Local/Mixbus8
• Linux: ~/.config/mixbus8

Harrison Consoles Mixbus - 9_en

Page 804 of 848



(note:on Windows you might have to enable ‘show hidden files and folders’ in your file browser)

Inside the Preferences folder, you will find a list of files and folders:

• config : this file stores your user preferences
• instant.xml : this stores transitory information such as the last playhead location and window locations
• bindings file : this file stores your customized keybindings
• recent : this file stores the list of recently-opened sessions that is presented to you when you launch

Mixbus
• sfdb : this folder stores your metadata-info for any audio files that you’ve tagged in the Import dialog
• my-dark.colors : this file stores your personal Theme colors for the Dark theme. (Light theme is not

yet implemented)
• plug-in cache ( VST and/or AU ) : this folder stores a list of plugins that have been identified on your

computer. If you delete this folder or its contents, you will have to re-scan your plugins.

More details about the “instant.xml” file
The instant.xml file is a “semi-persistent” preferences file. It serves this purpose:

When you save a session, many of your preferences for this session are stored in the session’s local
instant.xml, and the global instant.xml. When you create a NEW session, the global instant.xml file is used
to create the new session’s instant.xml

There are many parameters that are stored in the instant.xml file:

• Window positions ( editor, mixer, meterbridge, plugins, etc )
• Action-Buttons assigned to the buttons in the toolbar
• Control Surface settings
• Clock mode selections
• Visibility of the Editor List and Mixer List panels
• Grid (snap) options
• Playhead position & zoom scale ( some instant.xml settings like this are ignored for a new session )
• Selected mouse mode (tool) in the editor
• How the region-list is sorted ( by date, name, or whatever )

These settings do not have any effect on the session’s sound. They are not part of the session data.

A session can have multiple snapshot files, but it has only one instant.xml that is shared among all the
snapshots.

If you delete any of these files or folders, Mixbus will recreate a new file with default settings
when it is re-launched.*
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What does this mean?

• When you create a NEW session, you’ll be pleasantly surprised to see that some of your most-recent
settings ( window positions, action-button assignments ) are already set-up for you in the new
session.

• When you return to an OLD session, you’ll find the session exactly as it was when you left it. Your
more recent sessions & preferences will not be applied. The session’s instant.xml will define the
window positions, etc.

• NOTE: if you visit an old session and save it, you will overwrite your current global instant.xml, and
those settings will be used in the next NEW session. This can be a nice feature, or a big annoyance.

This behavior is a compromise that was reached after many years of discussion & feedback. We are
constantly re-visiting these issues to see which parameters should be stored globally ( in preferences ), in
the global instant.xml, in the session’s instant.xml, and the session snapshot file(s).
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29. Appendix A: Common Support Questions
I purchased Mixbus, but it says it is “UNLICENSED” and I occasionally hear a burst of noise.

• Please check the Mixbus download email that arrived shortly after your purchase. The email should
include a link to your Mixbus license file, and instructions for installing it.

• For security reasons, the license links will become inactive after 7 days. To reset the license links,
please email Harrison support at: mixbus@harrisonconsoles.com Once you’ve downloaded the
license file from the link, you may store it on a backup drive or USB key for later use. Your name is
encrypted in the license file, so you should not share it with others.

• If you still have problems, please email Harrison support at: mixbus@harrisonconsoles.com

When I try to open the GVerb+ or 3D Delay, it says that the plugin is unlicensed. How do I get a
license?

• If you’ve already purchased these plugins, please check the installation email that arrived shortly after
your purchase. The email should include a link to your license file, and instructions for installing it.

• These plugins are part of the Plugin Essentials Pack which is available on our web store. The plugins
are included in the Mixbus installation, but to utilize the on-screen controls you must purchase a
separate license. The Essentials are available to all Mixbus users on all platforms ( Windows, OS X,
and Linux ) and are automatically installed as part of Mixbus. This allows you to share Mixbus
sessions with your friends and know that they will have the sound of the plugins available, even if they
haven’t purchased them! Neat, huh?

How do I show Mixbus where to find my VST plugins? ( Windows )

• In the main menu, click Window->Preferences->Plugins. Add the folder paths that point to your
plugins and click “Scan”. More Here

How do I report a crash in Mixbus? ( OS X )

• If you are using OS X and are still crashing at startup, the most likely cause is a plugin that Mixbus is
not able to scan at startup. When Mixbus reports “Mixbus has closed unexpectedly”, please click
“Generate Report”. This will open a window with the technical details of the crash report. Please copy/
paste this information into an email to mixbus@harrisonconsoles.com for support.

How do I launch Mixbus from a command-line prompt? ( for techies only )

• Windows: cd C:\Program Files\Mixbus4\bin Mixbus4.exe
• OS X: ARDOUR_BUNDLED=1 /Applications/Mixbus4.app/Contents/MacOS/Mixbus4
• Linux: cd /opt/Mixbus4/bin ./mixbus
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Where does Mixbus store its preferences?

Mixbus creates a folder with several files

• On Windows, the folder path is something like ~\AppData\Local\Mixbus4\ ( this varies with different
versions of Windows ).

• On Mac, the folder path is ~/Library/Preferences/Mixbus4
• On Linux, the folder path is ~/.ardour5

The Preferences folder contains these files, among others:
“config” stores the user’s preferences such as auto-backup and other items in the Options menu
“mixbus.bindings” stores the user’s selected keybindings (keyboard shortcuts) for menu actions
“ui.conf” stores your color, font, and other theme preferences
“announcements” stores the latest announcements from Harrison (usually this is empty unless a new
version is available)
“instant.xml” stores the user’s last-used preferences such as snap mode, mouse mode, zoom mode, etc.
“recent” lists the sessions that appear in the recently-used dialog
“sfdb” stores the metadata database which the Import dialog stores metadata about files that you’ve
“tagged” for later use.

If you delete the preference folder or any file inside it, Mixbus will create a replacement with default values
when it is next launched. Sometimes this will cause a delay at startup; for example on OS X, Mixbus will
have to re-scan the plugins when it is next launched.

Can I import Key bindings to another computer?

Yes, you have to manually copy the keybindings file from one computer to the other.

The file is found in your “preferences” folder:
~/Library/Preferences/Mixbus8 on Mac
~/AppData/Local/Mixbus8 on Windows

If your question is not answered here, feel free to email us at mixbus@harrisonconsoles.com for
support.
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30. Appendix B: Known Issues
• On systems with the minimum supported screen height (800 pixels for Mixbus, or 1200 pixels for

Mixbus32C), you may not be able to fit the editor or mixer window on your screen. You can visit
Preferences->Appearance and change the “mixer strip scale” to fit the mixer to your screen, but sizes
less than 100% will be compromised.

• Some third-party plug-ins may cause crashes, strange noises, or other problems. We strive to support
plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version,
Mixbus version, plug-in version, licensing mechanisms, etc.) it is not possible to guarantee that all
3rd-party plug-ins will work as expected on your system.

• On Windows, anecdotal evidence shows that a few devices (including the Roland “Capture” series,
Lexicon Lambda, Emu 0404, and Zoom R24) require that you enable the “Buffered I/O” setting. This
tells Mixbus to use an alternative ASIO mode which works better on these devices.

For more details, contact Harrison via email (mixbus@harrisonconsoles.com).
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31. Appendix C: Videos (Training and
Tutorial)
The videos on the following pages are provided for your convenience and are a great resource for learning
more about Mixbus and Mixbus32C. Some of these videos were produced using an earlier version of
Mixbus, however the bulk of the information is still very relevant.

If you have read the manual, then some of these videos may be familiar, as some are placed throughout the
manual, others are not.

These videos and more can also be found on our YouTube page. Don’t forget to subscribe to our YouTube
channel to be alerted to our new videos coming soon!

And don’t forget our Mixbus user forum for more Mixbus information, or to just hang out and discuss how fun
and easy it is to mix with Mixbus!
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31.1. Quick Start Guides

For Mac Users

Licensing and the Home Folder for Mac

https://www.youtube.com/embed/vif6VaAncxc?rel=0
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Quick Start Guide for Mac

For Windows Users

Licensing and the Home Folder for Windows

https://www.youtube.com/embed/83lsyy0ztKU?rel=0

https://www.youtube.com/embed/To5SOyd0Qw4?rel=0
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Quick Start Guide for Windows

https://www.youtube.com/embed/1ZU58nRzKI0?rel=0

https://www.youtube.com/embed/nMPqBaQOW-o?rel=0

https://www.youtube.com/embed/nMPqBaQOW-o?rel=0

Harrison Consoles Mixbus - 9_en

Page 813 of 848

https://www.youtube.com/embed/1ZU58nRzKI0?rel=0
https://www.youtube.com/embed/nMPqBaQOW-o?rel=0
https://www.youtube.com/embed/nMPqBaQOW-o?rel=0


https://www.youtube.com/embed/jhr5BLH8AnM?rel=0

https://www.youtube.com/embed/jhr5BLH8AnM?rel=0

https://www.youtube.com/embed/jhr5BLH8AnM?rel=0
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31.2. Mix Tips

Harrison’s Mix Tips Video Series. This video explains side-chaining in Mixbus 3.

https://www.youtube.com/embed/q1WoKW_TKYo?rel=0
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Harrison’s Mix Tips Video Series. This video explains gain staging in Mixbus 3

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0&start=135

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0

https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
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This video demonstrates how to use grouping and bussing to enhance your session workflow within Mixbus 3.

Harrison’s Mix Tips Video Series. This video demonstrates how to create a subgroup in Harrison Mixbus

https://www.youtube.com/embed/cuInwhnrtlk?rel=0

https://www.youtube.com/embed/cuInwhnrtlk?rel=0

https://www.youtube.com/embed/cuInwhnrtlk?rel=0

https://www.youtube.com/embed/67TcjTd7LIs?rel=0
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Harrison’s Mix Tips Video Series. This video demonstrates how to set up parallel compression in Mixbus.

Harrison’s Mix Tips Video Series. This video shows off some of the mouse shortcuts available in Mixbus.

https://www.youtube.com/embed/iESeTOSvX80?rel=0

https://www.youtube.com/embed/ep5ietQjaq4?rel=0
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Harrison’s Mix Tips Video Series. This video tells you everything you need to know about the EQ in Mixbus.

Harrison’s Mix Tips Video Series. This video details the compressors in Mixbus.

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0

https://www.youtube.com/embed/Sa3-ibczoK4?rel=0
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Harrison’s Mix Tips Video Series. This video explains many different types of clipping, and how it applies to
Mixbus.

Harrison’s Mix Tips Video Series. This video shows off the meters in Mixbus.

https://www.youtube.com/embed/cx_FqznRpbI?rel=0

https://www.youtube.com/embed/dPCUFlAsO8Q?rel=0
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Harrison’s Mix Tips Video Series. This video demonstrates how to use reverb in Mixbus.

Harrison’s “Shut Up and Mix” Video. Make sure annotations are turned on so you can see all of the mixing tips!

<< 31.1. Quick Start Guides | 31.3. Pro Tips >>

https://www.youtube.com/embed/fs0m-wFXdZ8?rel=0

https://www.youtube.com/embed/ZbHwcsU7r2o?rel=0
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31.3. Pro Tips

Episode 1 of Harrison’s Pro Tips video series for Mixbus. This video shows you how to quickly import tracks into
Mixbus, and gives an explanation of the import dialog window.

https://www.youtube.com/embed/otZgZs3CDYM?rel=0

https://www.youtube.com/embed/otZgZs3CDYM?rel=0
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Episode 2 of Harrison’s Pro Tips video series for Mixbus. This video demonstrates all of the export options
available in Mixbus.

Episode 4 of Harrison’s Pro Tips video series. This video demonstrates how to route audio from Pro Tools into
Mixbus.This is a power user function which Harrison does not provide technical support for.

https://www.youtube.com/embed/wddiGR-Y1bk?rel=0

https://www.youtube.com/embed/wddiGR-Y1bk?rel=0

https://www.youtube.com/embed/nJKSImri0vA?rel=0
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A follow-up to Harrison’s episode of Pro Tips on routing from Pro Tools into Mixbus. This video demonstrates
how to export audio tracks from Pro Tools to import into Mixbus. This is a power user function which Harrison
does not provide technical support for.

https://www.youtube.com/embed/QxGhN8w5D1s?rel=0

https://www.youtube.com/embed/aFWfLfrn_vU?rel=0

https://www.youtube.com/embed/aFWfLfrn_vU?rel=0
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Episode 5 of Harrison’s Pro Tips video series. This video demonstrates the region editing and crossfade features
of Mixbus.

<< 31.2. Mix Tips | 31.4. EQ Tips >>

Harrison Consoles Mixbus - 9_en

Page 825 of 848



31.4. EQ Tips

Episode 4 of Harrison’s Mix Tips Video Series. This video tells you everything you need to know about the EQ in
Mixbus.

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0

https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
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This Quick Tip demonstrates how to use the mid-band of the EQ to notch out a problem frequency on a track in
Mixbus.

This Quick Tip demonstrates how to place your instruments in the sound field using the EQ in Mixbus.

https://www.youtube.com/embed/O9WnyWbMim4?rel=0

https://www.youtube.com/embed/Xb-prKFUdi4?rel=0

https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
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This Quick Tip demonstrates how to create a “bump” for your bass guitar with the EQ in Mixbus. This can be
done with a HPF and a Low Shelf.

<< 31.3. Pro Tips | 31.5. Quick Tips >>

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
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31.5. Quick Tips

This short video demonstrates how to loop record.

https://www.youtube.com/embed/VOiyDFv8zt0?rel=0

https://www.youtube.com/embed/bXLtAYwH7XM?rel=0
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Demonstration of basic trim, fade, delete, copy, and paste operations including Smart Mode.

An example of sidechain compression used on a vocal track with a delay. Implemented using the built-in
sidechain compression features of Harrison Mixbus.

https://www.youtube.com/embed/7d33y5lVALg?rel=0

https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
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“Ripple” audio editing in the Mixbus workstation.

A power users tip on using mutes and solos.

https://www.youtube.com/embed/XZU26CNDwmE?rel=0

https://www.youtube.com/embed/O9WnyWbMim4?rel=0

https://www.youtube.com/embed/O9WnyWbMim4?rel=0
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This Quick Tip demonstrates how to use the mid-band of the EQ to notch out a problem frequency on a track in
Mixbus.

This Quick Tip demonstrates how to place your instruments in the sound field using the EQ in Mixbus.

https://www.youtube.com/embed/Xb-prKFUdi4?rel=0

https://www.youtube.com/embed/Xb-prKFUdi4?rel=0

https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
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This Quick Tip demonstrates how to create a “bump” for your bass guitar with the EQ in Mixbus. This can be
done with a HPF and a Low Shelf.

<< 31.4. EQ Tips | 32. Appendix D: MIDI Primer >>

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0

https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
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32. Appendix D: MIDI Primer
These pages will discuss basic MIDI messages, devices, and connections. It is intended to give enough
information to get you started. Much of the information is presented in a generic way, not necessarily
directly related to Harrison Mixbus. For specific MIDI for Mixbus click here.

What Is MIDI?

Musical Instrument Digital Interface, or MIDI, is a communication protocol that was published in 1983. The
intent was to allow 2 instruments, from 2 different manufactures, to communicate with each other. One
keyboard could be played while a second connected keyboard (with tone module) could sound the same
note at the same time, doubling the performance.

It is important to know that the information being transmitted is not audio! It is “performance data” in the
form of MIDI messages such as the note played, timing, velocity, etc.

Basic MIDI Devices

1. A MIDI Controller produces and transmits MIDI messages. Controllers can take on the functionality of
keyboards or guitars, etc. They are designed to capture the performance of a musician. They do not
produce sounds of their own.

2. A MIDI Instrument, or tone module, receives MIDI data and produces an audio output. It may be
software or hardware based. A user can have one controller connected to one or more tone modules.
Additionally, in the world of Digital Audio Workstations there are “plug-in” versions called virtual
instruments (VI).

3. A unit that combines a controller and instrument in one package will be referred to as a hybrid for the
purposes of this document. The most common form of this is often referred to as keyboard
synthesizer. It can generate MIDI performance data and audio via an internal tone module.
Sometimes the internal tone module can be switched off with a command known as Local Control. (If
you seek out something called a “MIDI hybrid device” you may come up short).

4. A MIDI Sequencer is a device or software application that can record, edit, and play back MIDI
events.

A single device can implement any combination of controller, instrument, and/or sequencer features. For
example, before computer sequencers were popular, it was very common to buy a keyboard that provided
the keyboard, internal tone module, and sequencing features in one device. These are sometimes called
“arranger” keyboards.

You may find tone module, tone generator, and sound engine are used interchangeably.

When a controller and tone module are combined together, there is often a function called
“Local Control” which determines whether the keyboard will control the internal tone
module directly. If you want to use a sequencer or DAW, you might use Local Control to
*
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MIDI Messages

The MIDI language is transmitted digitally. The information carried in the messages are note on, pitch,
velocity, program change, note off, and more. There are 2 types of MIDI messages; Channel messages and
System messages. These two sub groups can be further broken down and will be explained below. These
MIDI messages are sent to other devices via a MIDI cable. More on the MIDI cable a little later.

Channels Messages: Each channel message contains a channel assignment and as a result are assigned
to specific channels rather than sent globally. With the capability to transmit (Tx) and/or receive (Rx) on 16
channels, the user is offered some flexibility. Once a channel is establish the channel messages will deliver
instructions such as Program change, Note on, Note off, and more. With this you can send performance
data from one controller, on one specific channel, so that that one or more specific MIDI instruments on the
same Rx channel responds.

Voice and Mode Messages

The “Voice” portion of the channel message is the musical performance part and contains information
regarding the following:

• Note On: Identifies the note that will produce sound. The data sent is channel number, specific note
number, and key on velocity.

• Note Off: Identifies the note that will stop producing sound. The data sent is channel number, specific
note number, and key off velocity (notice that the note command has a discrete code for off and on.

disconnect the internal tone module from its keyboard. This way, when the controller sends
performance data to the computer sequencer, and the sequencer returns the data back to
the sound module, you don’t hear the notes from the sequencer and internal controller at
the same time.
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More on this later).
• Polyphonic Key Pressure (Aftertouch): Some controllers have the ability to sense how much pressure

was applied. The data sent is channel number, specific note number, and key pressure. If your
controller does not have aftertouch, a default of medium pressure (64 of 128 possible) is assigned.

• Control Change: Specifies what function of the synthesizer is to be controlled. The data sent is
channel number, controller number, and controller value.

• Program Change (sometimes called Program Select): Selects the type of sound that should be
played. The data sent is channel number and program number. In the early days of MIDI, when a user
wanted a custom sound he would need to patch cables. Today this cable patching process can be
replaced with a stored file in memory, hence the name “patch”. You may also hear the terms voice or
preset. These are essentially all the same thing. You can create your own patches or the manufacture
can provide them for you. Because of the format of the MIDI message, only 128 patches would be
recallable if it wasn’t for the Bank Message. Having multiple banks of patches, provides many more to
choose from.

• Pitch Bend: Modifies, in a continuous manner, the pitch of the note being played. The data sent is
channel number and pitch bend value.

The “Modes” portion of the channel message tells the MIDI instrument how to respond when it receives the
performance part or the message.

Mode Full Name Common Name

1 Omni – On/Poly Omni

2 Omni – On/Mono no common name

3 Omni – Off/Poly Poly

4 Omni – Off/Mono Mono

Omni On/Off is used to determine the utilization of available channels. If Omni is ON then it will Tx or Rx
data on all channels. If Omni is OFF then it will Tx or Rx on just one channel.

Mono/Poly tells the instrument whether to play 1 note at a time (Mono) or more than 1 note at a time (Poly).
The Mono modes are the least commonly used modes (mode 2 and 4).

Polyphonic capability is merely the ability to play 2 or more notes simultaneously. So if you want to play a 4
note chord you will need 4 note Polyphonic capability.

Multi Mode

With Multitimbral we are talking about many tones to produce a complex sound like a piano part, a violin
part, or a drum part. These are sometimes called “programs”,“patches”, or “presets”. You can have many
parts playing at once, each assigned to its own channel. Before Multitimbral there was Monotimbral, where
only one part could be played. Multitimbral can replace multiple notes with multiple programs so that we
may produce the sound of an entire band with one MIDI performance track.
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16 part Multitimbral playback capability is not uncommon today. Also be aware some manufactures may call
Multi mode something different. For example, the classic Yamaha Motif refers to it as “song mode”.

There are other commands that can be invoked with a mode message, such as reset all controllers, local
control, and all notes off.

Let’s address the “All Notes Off” message. As mentioned previously, the note on/off commands are discrete
messages. So what happens if a note is turned on and for some reason the Rx equipment never gets the
message to turn the note off? The “All Notes Off” message addresses this. It sends a Note Off command
across all channels. In Mixbus there is a “MIDI Panic button” on the left side of transport section that sends
the “All Notes Off” message. The button looks like an exclamation point. How appropriate!

above: the MIDI panic button circled in red

System Messages: These messages are mostly global and as such do not carry a channel assignment.

System Common Messages are for all MIDI devices in a network regardless of channel assignment. These
messages are things such as MIDI Time Code (MTC), MIDI Clock, Song Select, and Song Position Pointer.

Timbral, or timbre refers to tone quality. Timbre is how we determine the difference between
the sound a bell makes and the sound a sine wave makes. When pitch and loudness are
the same, much of the difference lies in the harmonics or timbre.
*
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System Real-time Messages are used for synchronization with all devices in the network that are clock
based such as sequencers and drum machines. These devices follow a tempo and need to be in sync. The
resolution of the timing is expressed as Pulses Per Quarter Note (PPQN).

System Exclusive Messages are not global. They operate more as a point to point type of operation. It’s
kind of a catch all command that allows manufactures to use it for a whole host of things. For example a
stored patch can be transmitted to and from equipment by the same manufacture. The manufacture can
register their equipment with The MIDI Manufacturers Association so that they can obtain an exclusive
SysEx ID so that only their equipment will respond to their commands. The code that one manufacturer uses
to write a patch is going to be different from another manufacturer so sending a Yamaha patch to a Roland
won’t do much good. This is because each manufacturer has their own unique way handling information
such as patches.

General MIDI (GM and GM1)

General MIDI is not actually a message but rather a standard that specifies certain functionality of MIDI
equipment. Without General MIDI, each manufacturer can assign whatever patch they wanted, to whatever
storage location they wanted. This would make it difficult to use different equipment from different
manufactures. For example, one manufacturer may have a French Horn for Bank 1 program 4, and another
manufacture may have that spot reserved for Viola. But General MIDI says that Bank 1 program 4 shall be a
Honky-tonk Piano. With this, when a command is sent from one device to another the musician can hope for
a sound closer to their expectation. General MIDI 1 elaborated on this and added even more specifications
to the standard.

The MIDI Cable

The MIDI cable is unusual in that both ends have a 5 pin male connector.

Pin layout:
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• Pin 1: Normally not used (proprietary systems may make use of)
• Pin 2: Terminated to a shield to eliminate noise
• Pin 3: Normally not used (proprietary systems may make use of)
• Pin 4 & 5: A twisted pair, and carries the 5 volt MIDI message

Sometimes this cable is called a MIDI DIN (Deutsches Institut fur Normung). The MIDI cable will carry MIDI
signals in one direction only. If you need MIDI messages to return, then you will need a second cable.

The MIDI DIN cable characteristics are:

• Unidirectional transmission
• Serial transmission
• Maximum recommended length is 50 feet (to insure reliability)
• Transmission speed is 31,250 bits per second

USB, FireWire, and Ethernet have become popular alternatives when connecting to computers. However, if
you need the full feature set that MIDI has to offer you will need MIDI cables.

Types of MIDI Ports

Often you will find 3 types of connections on MIDI equipment.

• MIDI out: Transmits the MIDI message
• MIDI in: Receives the MIDI message
• MIDI thru: Transmits a copy of the MIDI message found on the MIDI input (This facilitates daisy

chaining and star configurations).

MIDI Connections
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Fig. 1 above: A dedicated MIDI controller is connected to a tone module. This requires a MIDI cable. A USB
or FireWire cable will not work.
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Fig. 2 above: A dedicated MIDI controller is connected to a DAW such as Mixbus via a MIDI interface.
Running a Virtual Instrument plug-in within Mixbus replaces the dedicated tone module. The audio output
from Mixbus can be routed to an internal DAC / sound card or to an external audio interface.
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Fig. 3 above: A dedicated MIDI controller with USB MIDI out. In essence the MIDI interface is built-in to the
the controller eliminating the need for an external MIDI interface.
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Fig. 4 above: In this example the MIDI controller has an on board tone module. Now MIDI messages can be
sent from the computer to the MIDI controller so that audio can be produced with the on board tone module.
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Fig. 5 above: This is an example of a daisy chain configuration. A dedicated controller sends MIDI
messages to the first tone module which in-turn sends a copy of the signal to the second tone module. If the
chain is carried out too far, the signal will degrade and become unreliable.
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Fig. 6 above: This is an example of a star configuration. The Thru Box allows this configuration.
Connecting many tone modules to a central point causes less chance of signal degradation. The
advantages of this configuration increases with the number of devices on the network. For simplicity only 2
tone modules are shown. In practice many more may be connected causing the diagram to resemble a star
pattern as the tone modules branch out around a central point.
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Fig. 7 above: A merge box allows 2 MIDI controllers to send MIDI messages to a single tone module. An
example of this configuration could be that one of the controllers may be a keyboard and the other controller
could be a string instrument both playing together into one tone module.

The Interface From MIDI To Mixbus

You will typically need an audio interface with MIDI I/O as in figure 2 or 4 above, or you may opt for a USB
or FireWire connection as in figure 3. Of course you will also need need a MIDI controller. Although you can
input data straight into Mixbus via the various tools provided in the software, it can be an inefficient method
for recording an entire performance. These tools are best suited for making adjustments to an already
captured performance or for step entry.

above: some of the tools offered in Mixbus
below: the on screen keyboard (right click the MIDI track rec button)
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What MIDI Controller Should You Get?

Only you can decide what is best for you, but if you are new to MIDI a keyboard controller is a great choice
for general purpose use and by far the most popular because of its flexibility. You will want to consider the
number of octaves you would like the keyboard to cover. An alternative to a MIDI controller would be a
synthesizer, one that generates MIDI messages and can also contains its own tone module. But because it
can produce its own audio, it may cost more, take up more space, and be heavier. If you like the sounds a
MIDI hybrid makes, and if it has line level outputs, you can record the audio straight into Mixbus via an
audio interface as shown in figure 4 above.

Recording MIDI into Mixbus

To record a MIDI performance into Mixbus, first add a MIDI track. If you would like to hear your performance
thru Mixbus then be sure a Virtual Instrument plug-in is in the redirect box. You can use Plug-in Manager to
do this (by default a MIDI track will be created with the “Reasonable Synth” plug-in already in place).Then,
in the MIDI Connection Manager, confirm that your MIDI input device is connected to the track you wish to
record to. Record arm the track and click the master record button located in the transport section. Once the
transport rolls you will be able to record your performance. MIDI messages will now be captured into
Mixbus.

For more information click here
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33. Contact Information
Visit our website to see the latest news about Mixbus and plug-ins for Mixbus:
https://harrisonconsoles.com

For Mixbus support directly from Harrison, please email:
mixbus@harrisonconsoles.com

Visit our forum to chat with other users, and find common Mixbus questions & answers:
http://mixbus.harrisonconsoles.com/forum

Physical Address and Phone:

Harrison Consoles
750 Jim Parker Drive
Suite 103
Smyrna, TN USA 37167

+1 (615) 768-5501

Harrison Consoles Main Website
www.harrisonconsoles.com

Harrison Consoles Mixbus - 9_en

Page 848 of 848

https://harrisonconsoles.com/
mailto:mixbus@harrisonconsoles.com
http://mixbus.harrisonconsoles.com/forum
www.harrisonconsoles.com

	Table of Contents
	1. Introduction
	Welcome to Mixbus!
	1.1. About Mixbus
	1.1.1. Difference between Mixbus and Mixbus 32C
	1.2. About This Manual (online version and PDF download)
	2. Features & Specifications
	Mixer Features:
	Editor Features:
	General
	System Requirements:


	2.1. What’s Different About Mixbus?
	“True Analog” Sound
	Analog-style Workflow
	Open Source, Open Standards, Open Community

	2.2. Operational Differences from Other DAWs
	Console-like signal flow
	Flexible signal flow in the channel makes lots of tasks easy!
	Plug-ins are encouraged, but are not considered part of the core workflow.
	Regions may be stacked in layers
	Region Fades are Crossfades
	Less emphasis on Tools, more emphasis on Actions

	3. Installation
	Platform-specific information
	System Requirements
	Mac OS:
	Windows:
	Linux:
	All platforms:


	3.1. Installation – Windows
	A note about “Audio Setup” on Windows:
	A note about VST plug-ins on Windows:
	Uninstalling Mixbus

	3.2. Installation – OS X
	Installing Mixbus:
	Audio Input and Output:
	A note about third-party plug-ins on Mac OSX:


	3.3. Installation – Linux
	Sound card (I/O) support:
	Downloading and Installing Mixbus:

	3.4. License Installation – All Platforms
	License Installation
	Alternative methods for licensing
	Alternative locations for the Mixbus license file:



	3.5. Using Mixbus with JACK (optional)
	3.6. CPU Usage
	Why does Mixbus require more CPU usage than my other DAW?
	How do I increase the number of tracks or plugins that I can use?
	General comments about computer audio performance:

	4. Getting Started
	Getting Started (Overview)
	Need Help?

	4.1. Mixbus Conventions & Tips
	General Conventions
	Menus and keyboard actions:
	Selections:
	Mouse wheel:
	Right-click:
	Shift+Right-click: (Delete shortcut)
	Shift+click on mixer controls: (Group Override shortcut)
	Shift+Ctrl-click: (applies to ALL tracks)
	Middle-click: (non-latching mute/solo)
	Mixer Knobs and Faders:
	Floating-Point processing:
	Master Bus Volume:


	4.2. First Time Configuration
	First Time Configuration Dialog boxes:

	4.3. Starting a Session
	What is a Session?
	Session setup:


	4.3.1. Opening a Recent Session
	4.3.2. Opening an Existing Session
	Opening an Existing Session on Disk

	4.3.3. Creating a New Session
	Template selection:
	Session Location:
	Naming a Session:

	4.4. Session File Management
	Session Folders

	4.4.1. Session Snapshots
	What is a session snapshot?
	Creating snapshots:
	Selecting a snapshot:
	Choosing a snapshots from the New Session Dialog:
	Selecting a snapshot from the Editor List:
	Backup Snapshots


	4.4.2. Session Archive
	4.4.3. Session Templates
	What is a Session Template?
	Using Session templates:
	Managing & Sharing session templates:
	Where are my templates stored on disk?

	4.5. Audio Midi Setup Dialog
	Audio MIDI Setup
	Start/Stop
	Audio System:
	Driver (Windows-Only)
	Input Device & Output Device:
	Sample rate:
	Buffer size:
	Hardware monitoring:
	Device Control Panel:
	Autostart
	Refresh Devices
	Use Buffered I/O (Windows-only)


	Advanced Settings
	MIDI System
	Setup & Calibration
	Hardware input * output latency:
	Calibrate Audio:


	4.5.1. Latency and Buffer Size
	How do I choose a buffer size? And how does computer audio (really) work?
	Latency
	Buffer
	Sample Rate Vs. Buffer size
	Buffer size while mixing or editing
	Buffer size while recording
	Hardware Vs. Software Monitoring


	4.6. Status Bar
	4.7. Primary Windows: Editor, Mixer, Recorder and Cues
	The Transport Toolbar
	The Editor Window
	The Mixer Window
	The Record Window
	The Cue Window
	Maximize Mixer/Editor space

	4.8. Adding Tracks and Buses
	Adding Tracks, Buses and VCA’s
	What is the difference between Tracks, Buses and VCA’s?
	The “Add Track/Bus/VCA” dialog
	Session Templates



	4.8.1. Track Templates
	Creating Track templates:
	Using Track templates:
	Managing & Sharing track templates:

	4.9. Managing Tracks
	Naming Tracks
	Re-ordering tracks
	Selecting tracks
	What can I do with selected tracks?
	Other ways to select a track:


	4.9.1. Coloring Tracks
	Default track colors, and the track color palette

	4.10. Audio Input & Output
	Input
	Track I/O Selections

	Output
	Audio Connections Manager – the Routing Grid


	4.11. Transport (Play, Stop, etc)
	4.11.1. Transport Toolbar
	Transport Toolbar:
	Transport buttons:
	Transport controls are (from left to right):
	Record & Punch options:
	Transport modes:
	Follow Range Mode ( previously called “Follow Edits” or “Join Playhead” )
	Behaviors with Follow Range Mode on:
	Behaviors with Follow Range Mode off:

	Auto Return Mode

	Clocks
	Timecode Clock Mode:
	Bars:Beats Clock Mode:
	Minutes:Seconds Clock Mode:
	Samples Clock Mode:

	Alerts
	Selection Clock
	Mini-Timeline The mini-timeline provides a compact and convenient way to navigate the session.
	Master bus meter
	Scripted Action Buttons
	Page selection buttons

	4.12. Navigating the Editor Canvas
	
	Why is this so complicated?
	Learning to navigate the editor canvas


	4.12.1. Scrolling and Zooming in the Editor Window
	Scrolling
	Vertical Scrolling
	Horizontal Scrolling:
	Following the Playhead

	Zooming
	Zoom Focus

	Track Size & Waveform Scale
	Track Size
	Waveform scale


	4.12.2. Transport, Markers, and Rulers
	Ruler Bar
	Marker bars in the ruler area


	4.12.3. Summary View
	4.12.4. Mini-Timeline
	5. Recording
	Quick-Start for recording: following these steps to record some audio tracks!
	Recording Modes:


	5.1. Record Window
	Record Window
	Physical Inputs
	Input Display
	Level Meter
	Input Waveform
	Track Connection Indicator
	PFL
	“+” Button
	Input Name

	Tracks Section
	Track Arm Button
	Input Selector
	Playlist Select
	Track Name
	Monitoring
	Level Meter
	Track Number
	Record Timeline
	Record Toolbar
	Record Counter
	Discard Last Take
	X-Run counter
	Global Track Arming
	Monitoring Controls
	Auto Input

	Available Disk Space
	Reset Peak Hold

	Basic Recording
	Basic Overdubbing

	5.1.1. Recording Takes with Playlists
	Using Playlists as ‘Takes’
	Comping the best takes into a new Playlist
	Playlist actions in the Track menu
	Naming Playlists
	Record Window ‘Playlist’ buttons

	5.2. Audio Tracks
	What is a track? How do I create one?
	What is an Audio Track?
	How do I edit an audio track?


	5.3. Monitoring
	Monitoring
	Monitoring preferences
	Auto Input
	Auto Input Does Talkback
	Mixbus Monitoring Modes Chart


	5.4. The Click (Metronome)
	5.5. Punch Recording
	What is Punch Recording?
	How do I punch-record?


	5.6. Pre-Roll Recording
	What is Pre-Roll Or Count-In Recording?
	How do I Record with Pre-Roll?
	How do I Record with Count-In?

	5.7. Recording with Varispeed
	6. Editing
	6.1. Edit Window Overview
	Basic Editing Concepts
	Track Management
	Using Tracks
	Groups
	Recording, Loops and Punch Ranges
	Navigating in the Editor window: Zooming and Panning
	The Transport Menu and Toolbar

	6.1.1. The Editor List
	Track and Bus Management in the Editor

	6.1.1.1. Tracks & Buses Tab
	6.1.1.2. Sources Tab
	6.1.1.3. Regions Tab
	6.1.1.4. Snapshots Tab
	The snapshot list:

	6.1.1.5. Ranges and Marks Tab
	6.1.1.6. Clips Tab
	6.1.1.7. Arrangement Tab
	6.1.2. Track Headers
	Track Height

	6.2. Auditioning
	Auditioning a raw sound file or region with the “Auditioner Path”:
	Auditioning a sound in-place with the “Audition Action” in the editor:

	6.3. Regions and Ranges
	Regions
	Ranges
	Separating a Region Out of an Existing Track

	6.4. Object (Region) Editing
	Click above for video instructions.
	Object (Region) Editing
	Region Layers
	Audio region fades
	Region Context Menu
	Region Gain
	Region Specific Editing Options


	Nudging
	What is “Nudge”?
	What is the “Nudge Clock”?
	How do I nudge?

	6.4.1. Region Groups
	Implicit region groups: facilitate edits in a track-group
	Explicit region groups: connect groups regardless of their track or track-group affiliation
	Un-grouping your explicit region groups:

	Overriding the region group:

	6.5. Editing Tools & Modes
	Click above for video instructions.
	Edit Modes
	Editing Tools
	Object Tool ( see Region Editing )
	Range Tool
	Cut (scissor) Tool
	TimeFX Tool
	Draw Tool
	Contents Tool

	“Smart” Editing
	Selection conventions
	Operation Priority
	The Edit Point


	6.5.1. Grid Tool
	6.6. Range Editing
	Click above for video instructions.

	6.6.1. Section Editing
	6.6.2. Automation Range Editing
	6.7. Ripple Editing
	What is Ripple Editing?
	What operations are affected by Ripple?
	Types of Ripple Editing
	Ripple Edit demo

	6.8. Snap and Grid
	What is “Snap” and “Grid”?
	Snap Options:
	General Snap Options:

	“When Snap is Enabled, Snap To”
	Grid override:
	Relative Snap:
	Grid Units:


	6.9. Rhythm Ferret Window
	6.10. Region Sync and Alignment
	What is Aligning?
	Available alignment commands include:

	What is the region’s “Sync Point” ?
	Sync Point:
	To set a sync point:
	To move a sync point:
	To remove a sync point:



	6.11. Editing with Playlists
	What is a Playlist?
	Accessing a Track’s Playlist functions:
	Advanced menu
	Comping Playlists
	Using Playlists as a ‘backup’

	6.11.1. Playlist Selector dialog
	6.12. Polarity Optimization
	What is Polarity Optimization?
	Using Polarity Optimizer
	Results Dialog Box:
	Explanation of the preprocessing options:
	Optimization Results:


	7. Triggering Clips and Cues
	Video Demo : Triggering Clips and Cues

	7.1. Cue Window Overview
	Cue Channels on the Mix Page

	7.1.1. Cue Window Terminology: Slots, Clips, and Cues
	7.1.2. The Trigger Grid – Rows and Columns
	7.1.3. Showing and Hiding Tracks in the Cue Window
	Manually hiding and showing tracks from the Tracks list

	7.2. Playing and Stopping Clips
	Playing a Clip
	Clip Progress Indicator
	Stopping a Clip
	Follow Options

	7.3. Launching Cues (Rows of Clips)
	What is a Cue?
	What is Cue Isolate?
	Example usage of Cues and Cue Isolate

	7.4. Auditioning Clips
	Video Demo – Bundled Clip Content
	Special Considerations for Auditioning MIDI Files

	7.4.1. Selecting Patches for Audition of MIDI Files
	7.5. Bundled Clip Content
	Video Demo – Bundled Clip Content
	Mixbus Bundled Content:

	7.6. Adding New Clip Content
	7.6.1. Saving Clips to your User Clip Library
	7.7. Slots and Clip Properties
	What is a Slot?
	Selecting a Slot
	Slot Actions – context menu
	Launch Options
	Follow Options
	Stretch Options (Audio clips only)

	7.7.1. Clip Properties
	Clip Properties Panel

	7.7.2. Launch Options
	Launch Options Panel

	7.7.3. Follow Options
	Follow Options Panel

	7.7.4. Stretch Options
	Stretch Options Panel (Audio clips only)

	7.7.5. Dragging and Dropping Clip Properties
	7.7.6. Setting MIDI Patches for a Clip
	What is a Patch Change?
	Enabling or disabling patches for a Clip
	Choosing the patches for a Clip
	Where are patch names defined?

	7.8. Arranging with Follow Options
	What is a Follow Option?
	Jump -> Multi
	An example using Jump and Multi-Jump

	7.9. Arranging with Cue Markers
	Video demo of Cue Markers
	What are Cue Markers?
	Cue Marker Controls: Record and Play
	Triggering Cues on the timeline using Cue Markers
	Tweaking the Cue Trigger and Stop Positions

	7.9.1. Recording Cue Markers in real time
	7.10. Combining Clips and Linear Tracks (advanced)
	7.11. Comparisons to Ableton Live™
	Why does Mixbus’s Cue Window look so similar to Ableton Live™?
	Terminology Differences between Live and Mixbus
	What is different about Mixbus’s Cue Window when compared to the Session View of Ableton Live™?
	Other differences between Live and Mixbus:

	8. Mixing
	What is mixing?
	What are some mixing techniques?


	8.1. Mixer Window Overview
	Mixer Strips – Inputs, Mixbuses, Master, Monitor, and VCA’s.

	8.2. Metering
	Track Meters
	Master Meter (editor toolbar)
	Meter Bridge Window
	Channelstrip meters
	Channelstrip Compressor and Gate Gain-Reduction Meters
	Mixbus & Master Bus – Tape Saturation Meter
	Master Bus K-14 Meter
	Master Bus Phase Correlation Meter
	Master Bus Limiter

	8.3. Gain Staging
	Click above for video instructions.
	What is Gain Staging in Digital Audio?
	Floating-point processing
	Region Gain and Region Gain Curves
	Channel Strip Gain stages
	Mix bus
	Master bus
	Monitor Section (if enabled)
	VCA Faders (if enabled)


	8.4. Signal Flow
	What is signal flow?
	Mixbus’s signal flow

	8.4.1. Mono vs Stereo
	What is the difference between mono and stereo?
	2-channel audio is not necessarily stereo
	2-channel files are not necessarily stereo

	In Mixbus, what is the difference between a mono and stereo CHANNEL (i.e. TRACK)?
	Mono channels/tracks
	Stereo channels/tracks

	How do I resolve the problem if I’m given tracks/files that don’t match my needs?
	How do I convert a mono signal to stereo?
	How do I convert a stereo signal to a mono signal?
	How do I convert a stereo track to 2 mono tracks?
	How do I convert 2 mono tracks to a stereo track?

	8.4.2. Bussing
	What is a Bus?
	How do I use buses in Mixbus?

	8.5. Input Strip
	View Pulldown
	Other Buttons and Controls
	Polarity
	VCA
	Grp
	M

	General Operation

	8.5.1. Rec/Input (“Switcher”) Section
	8.5.2. EQ Section
	Channel Strip EQ

	8.5.3. Sends Section
	Bus Assignment
	Utilizing a mixbus as a “Group Bus”:
	Utilizing a mixbus as an “Effect Send”
	Bussing shortcuts

	8.6. Mixbus Strip
	Mixbus EQ
	Additional Feature

	8.7. Master Strip
	Master Bus EQ
	Tape Saturation Distortion Meter and Drive knob
	Monitor Panel Button

	8.8. Monitor Strip
	The Mixbus Monitoring Section:
	Examining the Various Volume Controls in a Typical System
	The Volume Control on Your Monitors
	The Audio Interface, or external Monitor Controller
	The Master Fader
	PFL or AFL Headphone setup.


	8.9. VCA Strip
	What is a VCA Strip?
	Creating a VCA Master
	Assigning a track to a VCA Master:
	VCA Strip Operation:


	8.10. Foldback Buses
	Creating Foldback Buses
	The Foldback Strip
	Routing to the Foldback Buses
	Getting It Out

	8.11. “DAW Style” Mixing Buses
	Creating a Mixing (“Aux”) Bus
	Routing to an Audio (“Aux”) Bus
	Panning Options
	Feedback Option

	8.12. Mute and Solo
	What are Mute and Solo?
	Solo Operations
	Solo Isolate
	Solo Safe
	Solo’ing with a Monitor section
	Solo’ing Mixbuses

	8.13. Redirects: Plug-ins, Sends & Inserts…
	Plug-in Control Sliders
	The Redirect Menu
	Redirect Box Signal Routing

	8.13.1. Processor Signal Flow
	Signal Flow through the Processor List:
	Why is this so complicated?
	Pin Connections

	8.13.2. Plug-ins
	What is a Plug-In?
	How do I add a Plug-In to a channel?
	Adding, Removing, Reordering, and Disabling Plug-ins
	Drag and Drop of Plugins
	Plug-in Favorite Window


	8.13.2.1. Plug-in Selector
	Main Plugin Window
	Plugin “Search” Box
	“Filter” section
	“Tags for Selected Plugin” section
	Plugins to be connected

	8.13.2.2. Generic Plugin Controls
	Plugin Analysis

	8.13.2.3. Plugin Favorites
	Mode Selector

	8.13.3. Sends and Inserts
	What is a “Send”?
	Aux Sends
	External Sends

	What is an “Insert”?
	Inserts
	Outputs
	Inputs



	8.14. Sidechain Compression
	What is Sidechain Compression?
	Other Uses of Sidechain
	Sidechains Using Third-party Plugins and the Plugin Pin-management Dialog
	Using Sidechains in Mixbus32c V9

	8.15. EQ Techniques
	8.16. Mastering Techniques
	What is Mastering?
	Master Bus Processing and Metering
	Master bus strip tone controls
	Master bus strip compressor
	Master Limiter
	Plug-ins
	Stereo Correlation (“Phase”) Meter
	K-14 Meter


	8.16.1. Normalization
	The Normalization Process
	Best Practices

	8.17. Loudness Analyzer-Normalizer
	9. Mixer Sidebar
	Favorite Plugins
	Track/Bus List
	Group List

	10. Mixer Scenes
	Using Mixer Scenes
	More details about mixer scenes

	11. Plug-ins
	Plug-ins
	A summary of plug-in support in Mixbus:
	Steinberg VST plug-ins (supported on all platforms)
	Steinberg VST3 plug-ins (supported on all platforms)
	LV2 plug-ins (supported on all platforms)
	LADSPA plug-ins (supported on all platforms)
	Digidesign AAX/TDM/RTAS plug-ins (no support currently).
	Windows DirectX plug-ins (no support currently)

	Latency Compensation

	11.1. Scanning for Plug-Ins
	11.2. Plug-in Tags
	Tagging Plug-ins

	12. Groups
	What is a Group?
	How do you create a group?
	Creating a group from the mixer window “Group” area.

	Options within a Group
	Grouping behaviors when the “Gain” is enabled
	Group Override


	12.1. Group Bar
	What is the Group Bar?
	Operations from the Group Bar:
	Creating an Edit Group with the Group Bar:

	The mix-window group bar.

	12.2. Quick Groups
	13. Automation
	Region Gain and Automation

	13.1. Fader, Pan and Plug-in Automation
	Automation
	Real-time (“Touch”) Automation:
	Automation Thinning:
	Punching in your automation with “Touch” mode:
	Graphical Automation Editing: Automation tracks


	13.2. Region Gain Automation
	Region Gain
	Mouse operations using the Range, Draw, and Edit tools inside a Region:
	Temporarily bypassing region gain


	14. Using MIDI
	What is MIDI, anyway?
	What can Mixbus do with MIDI?

	14.1. MIDI Tracks
	What is a track? How do I create one?
	What is a MIDI Track?


	14.1.1. Adding MIDI tracks
	Adding MIDI tracks
	Importing MIDI files to a new track:
	Creating a new MIDI Instrument track:

	Listening to a MIDI track.

	14.1.2. Recording MIDI
	A step by step guide to record MIDI performance data.

	14.1.3. MIDI Track Operations
	14.1.4. MIDI Filters
	What is a MIDI Filter?
	How do I add a MIDI Filter to a track?
	What MIDI filters are supplied with Mixbus?


	14.2. Virtual Instruments
	What is a Virtual Instrument?
	How do I create a Virtual Instrument track?
	What can I do with a virtual instrument?
	Using a virtual instrument with multiple outputs ( such as virtual drum instruments )
	Feeding a virtual instrument from multiple tracks


	14.2.1. Multichannel instruments
	Setting up a multichannel instrument with fanned-out tracks:
	Other operations and their effect on multichannel instruments:
	Printing your tracks:

	14.3. Sending to an external MIDI device
	External MIDI devices
	How do I send my MIDI to an external device?
	How do I change the sound preset (“patch”) of the external device?


	14.4. Multitimbral and “General MIDI”
	What is “Multitimbral”?
	What is General MIDI?
	How does Mixbus implement Multitimbral and General-MIDI synthesis?
	What is a soundfont?
	How do I use the General MIDI Synth?
	How do I choose a different patch/sound in the GeneralUser soundfont?
	How do I use other soundfonts?


	14.5. Step Entry
	14.5.1. MIDI Step Entry: Tutorial video
	14.6. MIDI Banks and Patches
	What is a MIDI Bank or Patch?
	How do I audition the patches in my external MIDI synth or VI plugin?
	Where do I specify the patch names that should appear in the patch dialog?
	Inserting a patch change during playback


	14.6.1. Adding MIDI Patch files
	What is a .midnam file?
	Where are Mixbus’s .midnam files located?
	How can I find a .midname file for my device?
	If I can’t find an existing .midname file for my device, how do I create one?
	The most important parts of the file are:
	The device’s manufacturer and model name:
	The patches that are provided in the device:
	The names for the MIDI controllers (CC’s) that are supported by the device:



	14.6.2. MIDI Follow Selection
	14.7. Editing MIDI Regions
	Grabber Tool
	Range Tool

	14.7.1. Editing MIDI Notes and Controls
	MIDI Control (CC) Automation
	MIDI Velocity bars

	14.7.2. Velocity Lollipops
	14.8. Virtual MIDI Keyboard
	Virtual Keyboard Controls:

	14.9. MIDI Channels
	14.10. MIDI Plugins
	15. Scripting
	What is a “script”?
	What is Lua?
	How do I use Lua scripts?
	Lua scripts initiated directly from the “Scripting” window:
	Lua scripts triggered as an “action” in the toolbar, or by keyboard shortcuts:
	Lua scripts triggered by Session events:
	Lua scripts as DSP Plugins:

	Developing your own Lua scripts:


	16. Templates
	Session Templates
	Track Templates
	Scripted Templates
	Template Manager

	17. Importing Files
	Importing via Drag&Drop
	Importing Audio files with the Import dialog
	Add Files …:
	Insert at:
	Mapping:
	MIDI Track Names:
	Conversion quality:
	Instrument:
	Use MIDI Tempo Map:
	Copy Files to session:

	Tags:

	17.1. Freesound search & import
	Searching the Freesound database:
	Logging-in to Freesound:
	Auditioning and importing files:
	more details about Freesound:

	18. Exporting Files
	Differences between Bounce, Consolidate, and Export
	Bounce
	Consolidate
	Exporting

	Exporting to an Audio File
	Initiating an Export
	Export to Audio File(s)
	Stem Export
	Export to Video File
	Region export
	Range export


	Setting the format for the export:
	File Format tab
	Multiple format exporting:

	Time Spans tab
	Realtime Export

	Channels Tab
	Export Analysis:
	Export Report and Analysis


	18.1. Post-Export Command Reference
	command arguments
	Example: File copy to a backup drive on windows:
	Example: converting to mp3 using a third-party encoder (such as LAME)

	19. Tempo, Metronome, & the Grid
	Defining a Song’s Tempo and Meter
	Tempo Controls
	Time Signature (Meter) Controls
	Using the Metronome (click)
	Using the Grid
	Adapting the Grid, also known as “Tempo Mapping”

	19.1. Tempo Maps
	What is a Tempo Map?
	Changing the tempo of a performance, using tempo markers
	Tempo Mapping a live audio performance with the tempo ruler
	Constant vs Ramped tempo markers
	Editing tempo markers & the tempo lane

	Importing a tempo map from MIDI

	19.2. Audio Time vs Beat Time
	What is the difference between Audio time and Beat time?
	Why is this so hard?
	How do you use Audio Time and Beat Time?
	What are the default settings for each item on the timeline?
	Choosing the time domain for your session:
	So what is the preferred workflow for managing a project that mixes Audio events, and Beat (MIDI) events?

	19.3. BBT Markers (Bar markers)
	Why is this important?

	20. Menu Reference
	Why are some menu items disabled or greyed-out?

	20.1. Session Menu
	20.1.1. Metadata
	20.1.2. Session Properties
	Menu Options
	Timecode
	Sync
	Fades
	Media
	Audio File Format: File Type
	Locations
	Filenames
	Monitoring
	Meterbridge
	Misc Tab


	20.1.3. Clean-up
	Bring all media into session folder:
	A real world example:

	Clean-up unused sources:
	Flush Waste Basket:
	A note about Session Cleanup.


	20.2. Transport Menu
	20.3. Edit Menu
	20.3.1. Preferences Window
	20.3.1.1. General
	Audio/MIDI Setup
	Editor Undo
	Limit Undo History
	Save Undo History
	Verify removal of last capture

	Session Management
	Make periodic backups of the session files
	Default Folder for new Sessions
	Maximum Number of Recent Sessions

	Import
	Drag and Drop Import

	Export

	20.3.1.2. Appearance
	Appearance
	Theme
	Color faders with track/bus colors
	Draw “flat” buttons
	Draw “boxy” buttons
	LED Meter Style

	Graphical User Interface
	Highlight Widgets on Mouseover
	Show tooltips If Mouse Hovers Over a Control
	Update Clocks at TC Frame Rate
	Blink Rec-Arm Buttons
	Blink Alert Indicators

	Graphics Acceleration

	20.3.1.2.1. Recorder
	20.3.1.2.2. Editor
	General
	Use name highlight bars in region displays
	Region color follows track color
	Track name ellipsize mode
	Add visual gap below audio regions

	Waveforms
	Show waveforms while recording
	Show saveform clipping
	Waveform clip level
	Waveform scale
	Waveform shape

	Editor Meters
	Show meters in track headers
	Limit track header meters to stereo

	MIDI Regions
	Display first MIDI bank/program as 0
	Don’t display periodic (MTC, MMC) SysEx messages in MIDI Regions
	Show velocity horizontally inside notes
	Use colors to show note velocity


	20.3.1.2.3. Mixer
	Limit inline mixer strip controls per plugin

	20.3.1.2.4. Toolbar
	Toolbar
	Main Transport Toolbar Items
	Display Record/Punch options
	Display Latency Compensation Info
	Display Secondary Clock
	Display Selection Clock

	Display Monitor Section Info
	Display Navigation Timeline
	Display Master Level Meter

	Display Action-Buttons


	20.3.1.2.5. Size and Scale
	User Interface Size and Scale
	Mixer Strip Scale

	20.3.1.2.6. Colors
	Items
	Palette
	Transparency

	20.3.1.2.7. Quirks
	Various Workarounds for Windowing Systems
	Use visibility information provided by your Window Manager/Desktop
	All floating windows are dialogs
	Transient windows follow front window


	20.3.1.2.8. Translation
	Translation
	Internationalization
	Use Translations



	20.3.1.3. Editor
	Editor
	Region Information
	Show xrun markers in regions
	Show gain envelopes in audio regions

	Scroll and Zoom Behaviours
	Zoom with vertical drag in rulers
	Double click zooms to selection
	Update editor window during drags of the summary
	Auto-scroll editor window when dragging near its edges
	Auto-scroll speed when dragging playhead
	Limit zoom & summary view beyond session extends to

	Editor Behavior
	Move relevant automation when regions are moved
	Ignore Y-axis when adding new automation points
	Automation edit cancels auto-hide
	Default fade shape
	Regions in Edit Groups are edited together
	Layering Model

	Split/Seperate
	In Range Mode
	In Object Mode


	20.3.1.3.1. Snap
	Snap:
	General Snap Options:
	Snap threshold (pixels)
	Approximate grid/ruler granularity (pixels)
	Show “snapped cursor”
	Snap Rubberband selection to grid
	Grid Switches to alternate selection for Internal Edit tools
	Rulers automatically change to follow the Grid mode selection

	When “Snap” is enabled, snap to:
	Markers
	Region Sync Points
	Region Starts
	Region Ends
	Grids



	20.3.1.3.2. Modifiers
	Modifiers:
	Keyboard Modifiers
	Select Keyboard Layout
	When Clicking
	When Beginning a Drag
	When Beginning a Trim
	While Dragging
	While Trimming
	While Dragging Control Points
	Reset



	20.3.1.4. MIDI
	MIDI
	Session
	Allow non quarter-note pulse
	Initial program change

	Audition
	Sound MIDI notes as they are selected in the editor

	Virtual Keyboard
	MIDI port options
	MIDI input follows MIDI track selection


	20.3.1.4.1. Midi Port Config
	MIDI port config

	20.3.1.5. Transport
	Transport
	General
	Prompt for new marker names
	Stop at the end of the session
	Keep record-enable engaged on stop
	Reset default speed on stop
	Disable per-track record disarm while rolling
	12dB gain reduction during fast-forward and fast-rewind
	Preroll

	Looping
	Play loop is a transport mode
	Loop fades

	Dropout (xrun) Handling
	Stop recording when an xrun occurs
	Create markers where xruns occur
	Reset xrun counter when starting to record

	Plugins
	Silence plugins when the transport is stopped.


	20.3.1.5.1. Chase
	Chase
	MIDI Machine Control (MMC)
	Transport Masters
	MIDI Clock


	20.3.1.5.2. Generate
	Generate
	Linear Timecode (LTC) Generator
	Enable LTC Generator
	Send LTC while stopped
	LTC generator level [dbfs]
	LTC Output Port

	MIDI Time Code (MTC) Generator
	MIDI Machine Control (MMC)
	MIDI Beat Clock (MCLK) Generator


	20.3.1.6. Plugins
	Plugins
	Scan/Discover
	Scan Timeout

	General
	Scan for [new] Plugins on Application Start
	Always Display Plugin Scan Progress
	Verbose Plugin Scan
	Open Plugin Manager Window When Missing Plugins Are Found
	Make new plugins active
	Set Up Sidechain Ports When Loading Plugin With AUX Inputs

	LV1/LV2
	Instrument
	Ask to replace existing instrument plugin
	Interactively configure instrument plugins on insert

	Statistics

	20.3.1.6.1. GUI
	GUI
	Plugin GUI
	Automatically open the plugin GUI when adding a new plugin
	Show Only One Plugin Window At A Time
	Closing A Plugin GUI Window

	Mixer Strip Inline Display
	Show Plugin Inline Display on Mixerstrip by default
	Don’t automatically open the plugin GUI when the plugin has an inline display mode


	20.3.1.6.2. VST
	VST
	VST2.x
	VST2 Cache
	VST2 Ignorelist
	VST2 Path

	VST3
	VST3 Cache
	VST3 Ignorelist
	Additional VST3 Path
	Automatically Show “Micro Edit” Tagged Controls on the Mixer Strip

	VST2/VST3

	20.3.1.7. Monitoring
	Monitoring
	Recording monitoring handled by:
	Auto Input Does Talkback

	Solo
	Solo controls are Listen controls
	Exclusive Solo
	Show solo muting
	Soloing overrides muting
	Solo-in-place mute cut (dB):
	Listen Position
	PFL signals come from
	AFL signals come from


	20.3.1.8. Signal Flow
	Signal Flow
	Master
	Enable Master Bus output gain control

	Default Track/Bus Muting Options
	Mute Affects Pre-Fader Sends
	Mute Affects Post-Fader Sends
	Mute Affects Control Outputs
	Mute Affects Main Outputs

	Send Routing
	Link Panners of Aux and External Sends with main Panner by default

	Audio Regions
	Replicate Missing Region Channels


	20.3.1.9. Metronome
	Metronome
	Metronome
	Emphasis on first beat
	Use built-in default sounds
	Audio File
	Emphasis audio file
	Gain level


	Options
	Enable metronome only while recording


	20.3.1.10. Control Surfaces
	Control Surfaces
	Enable Control Surface Protocol
	Edit the settings for selected protocol (it must be ENABLED first)


	20.3.1.11. Metering
	Metering
	Meterbridge meters ( NOTE: these options only apply to the meters in the Meterbridge window )
	Peak Hold Time
	DPM fall-off
	Meter line-up level; 0dBu
	IEC1/DIN Meter line-up level; 0dBu
	VU Meter standard
	Peak Indicator Threshhold (dBFS)

	Default Meter Types
	Default Meter Type for Master Bus
	Default Meter Type for Busses
	Default Meter Type for Tracks

	Region Analysis
	Enable automatic analysis of audio


	20.3.1.12. Performance
	Performance
	DSP CPU Utilization
	Signal processing uses

	CPU/FPU Denormals
	Processor Handling

	Disk I/O Buffering
	Preset
	Playback (seconds of buffering)
	Recording (seconds of buffering)

	Memory Usage
	Waveform image cache size (megabytes)

	Automation
	Thinning factor
	Automation sampling interval

	Automatables
	Limit automatable parameters per plugin


	20.3.1.13. Video
	Video
	Video Server
	Show Video Export info before export
	Show Video Server Startup Dialog
	Advanced Setup (remote video server)

	Video Monitor
	Custom Path to Video Monitor (Jadeo.app) – Leave empty for default.


	20.3.1.14. Triggering
	Triggering
	20.4. Region Menu
	Edit
	Layering
	MIDI
	Gain
	Position
	Markers
	Trim
	Ranges
	Fades
	Duplicate
	Export
	Bounce (without processing)
	Remove

	20.4.1. Strip Silence
	20.4.2. Normalize Regions
	Normalize Region

	20.4.3. Region Cue Markers
	20.5. Track Menu
	20.5.1. Mix Tools
	What are Mix Tools?
	Reset Mixer
	Track Organizer
	Scenes
	Store and Recall Mixer Settings
	Store:
	Recall:



	20.6. View Menu
	20.7. Window Menu
	20.7.1. Locations Window
	20.7.2. Audio Connections Manager Window
	20.7.3. Meterbridge
	Meterbridge properties:

	20.7.4. Plugin Manager
	Search
	Scan Actions
	Preferences
	Scan Log

	20.7.5. License Manager
	20.7.6. Plugin DSP Load
	20.7.7. Performance Meters
	20.8. Help Menu
	21. Keyboard Shortcuts
	Viewing your keyboard shortcuts

	21.1. Using the Number Pad
	Locating to a marker, using the number pad
	Operating the transport from the number pad


	22. Video
	Installation on Windows
	Installation on Mac
	Installation on Linux
	Video Formats Supported:
	Syncing Mixbus to Non-Linear Editing software

	23. Preferences
	Preferences file location, and clearing the preferences:

	24. Clocks & Synchronization
	Clocks
	Synchronization

	24.1. External Synchronization
	Synchronization

	24.2. Transport and Timecode Sync
	Methods of Transport and Timecode Sync using MIDI
	Methods of Transport and Timecode Sync using audio
	Factors that affect quality of synchronization
	Generating an external clock from Mixbus ( Mixbus is Master )
	Syncing Mixbus to an external clock ( Mixbus is Slave )

	24.3. Transport Masters
	25. External Control
	Mixbus can respond to external controllers using 4 different protocols:
	Generic MIDI ( also called “MIDI Learn” )
	Mackie MCU
	Presonus Faderport
	OSC control
	Enabling External Controllers


	25.1. MIDI Control Surfaces
	Generic MIDI Control

	25.2. Mackie MCU-compatible fader controllers
	Encoder Assign Buttons:
	Global View Buttons:
	Function Buttons:
	Modify:
	Automation:
	Utility:
	Transport:

	25.3. Presonus Faderport (original)
	Presonus Faderport

	25.4. Presonus Faderport, Faderport8 and Faderport16
	Presonus Faderport8

	25.5. Tascam US-2400
	Connecting the US-2400:
	Function Keys:
	Operating the US-2400:
	Master Fader
	Joystick:
	Global section:

	OSC Control
	The following is a summary of the features that are available from OSC:

	Lemur
	What is Lemur?
	What is the LTI Lemur Touch Interface?
	Instructions

	TouchOSC
	What is TouchOSC?
	What is the TTC-1 layout?
	Installing and launching the TTC-1 controller layout for Mixbus:
	Using the TouchOSC TTC-1 Controller:

	25.6. External Transport Control
	Transport Control

	25.7. SSL UF-8 / UF-1
	26. Pre-Installed Plugins for evaluation
	26.1. XT-3D Triple Delay
	26.2. XT-BC Bass Character
	26.3. XT-CC Console Compressor
	26.4. XT-CQ Console EQ
	26.5. XT-DC Drum Character
	26.6. XT-DM Dyno-Mite
	26.7. XT-DS De-Esser
	26.8. XT-EG Expander/Gate
	26.9. XT-EQ Equalizer
	26.10. XT-GV Gverb+
	26.11. XT-LC Lookahead Compressor
	26.12. XT-ME Mastering EQ
	26.13. XT-MG Micro Glide
	26.14. XT-MC Multiband Compressor
	26.15. XT-SC Spectral Compressor
	26.16. XT-SP Stunning Phaser
	26.17. XT-TG Tom Gate
	26.18. XT-TP Tremolo Panner
	26.19. XT-VC Vocal Character
	26.20. x42 EQ
	26.21. x42 Whirl
	26.22. x42 Meter Bundle
	27. Included (FREE) Plug-ins
	Plugins
	Included Instrument plugins


	27.1. ACE Plugins
	ACE EQ
	ACE Compressor
	ACE Expander
	ACE Delay

	The following ACE plugins do not provide a dedicated control panel. Instead they use Mixbus’s “Generic Plugin Control Panel”
	ACE Reverb
	ACE Amplifier
	ACE High/Low Pass Filter
	ACE Inline Scope
	ACE Inline Spectrogram
	ACE Notch Bank
	ACE Slow-Mute
	ACE MIDI Plugins
	General MIDI Plugins
	ACE MIDI Monitor


	27.2. x42 Whirl (Simple)
	27.3. Stereo Routing
	27.4. x42 Instrument Tuner
	27.5. x42 DPL Limiter
	27.6. Instruments
	27.6.1. ACE Fluid Synth
	27.6.2. ACE Reasonable Synth
	27.6.3. AVL Drumkits: Black Pearl and Red Zeppelin
	27.6.4. General MIDI Synth
	27.6.5. SetBfree Tonewheel Organ
	Operation:
	Detailed Operation:

	27.7. MIDI Plugins
	27.7.1. MIDI Filters
	27.7.2. MIDI Arpeggiators
	28. Power-User Topics
	Session folder layout
	Session XML file format
	Mixbus Preferences folder
	More details about the “instant.xml” file

	29. Appendix A: Common Support Questions
	30. Appendix B: Known Issues
	31. Appendix C: Videos (Training and Tutorial)
	31.1. Quick Start Guides
	For Mac Users
	For Windows Users

	31.2. Mix Tips
	31.3. Pro Tips
	31.4. EQ Tips
	31.5. Quick Tips
	32. Appendix D: MIDI Primer
	What Is MIDI?
	Basic MIDI Devices
	MIDI Messages
	Voice and Mode Messages

	Multi Mode
	General MIDI (GM and GM1)
	The MIDI Cable
	Types of MIDI Ports
	MIDI Connections
	The Interface From MIDI To Mixbus
	What MIDI Controller Should You Get?
	Recording MIDI into Mixbus

	33. Contact Information

